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การวิจัยคร้ังน้ีเปนการศึกษาความสัมพันธเชิงสาเหตุ โดยมีวัตถุประสงคดังน้ี 1) เพื่อศึกษาและเปรียบเทียบความสามารถทาง

คอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร เม่ือจําแนกตามสังกัดและขนาดของโรงเรียน 2) เพื่อพัฒนาโมเดลเชิงสาเหตุและผล
ของการรับรูความสามารถดานคอมพิวเตอรของตนเองท่ีมีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร และ 
3) เพื่อตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองท่ีมีตอความสามารถ
ทางคอมพิวเตอรท่ีพัฒนาขึ้นกับขอมูลเชิงประจักษ กลุมตัวอยางท่ีใชในการวิจัย คือ นักเรียนระดับชวงชั้นท่ี 4 ในกรุงเทพมหานคร จํานวน 
813 คน ตัวแปรท่ีใชการวิจัย ประกอบดวย ตัวแปรภายในแฝง 4 ตัวแปร ไดแก การรับรูความสามารถดานคอมพิวเตอรของตนเอง การ
ต้ังเปาหมาย ความผูกพันตอเปาหมายและความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร และตัวแปรภายนอก
แฝง 4 ตัวแปร คือ ระดับประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงม่ันในการทํางานและความวิตกกังวลในการใชคอมพิวเตอร 
โดยตัวแปรแฝง วัดจากตัวแปรสังเกตได รวมท้ังหมด 13 ตัวแปร เคร่ืองมือท่ีใชในการวิจัยคร้ังน้ีไดแก แบบสอบถามและแบบทดสอบ   
ซึ่งแบบสอบถามมีคาความเท่ียงสัมประสิทธิ์แอลฟาของครอนบาคของตัวแปรสังเกตไดต้ังแต 0.61-0.95 สําหรับแบบทดสอบมีคาความยากอยู
ระหวาง 0.25 กับ 1.00 และอํานาจจําแนกมีคาอยูระหวาง 0.00 กับ 0.88 มีคาความเท่ียงแบบ KR20 เทากับ 0.71 วิเคราะหขอมูลโดยใชการ
วิเคราะหคาสถิติพื้นฐาน การวิเคราะหสถิติทดสอบที (t-test) การวิเคราะหคาสัมประสิทธิ์สหสัมพันธแบบเพียรสัน และการวิเคราะห   
โมเดลลิสเรล 
 
 ผลการวิจัยท่ีสําคัญ สรุปไดดังน้ี 

1. นักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร มีความสามารถทางคอมพิวเตอร โดยมีคะแนนเฉลี่ยคิดเปนรอยละ 49.66 ของคะแนน
เต็ม โดยนักเรียนท่ีอยูในโรงเรียนสังกัดสํานักงานคณะกรรมการการศึกษาขั้นพื้นฐาน (สพฐ.) มีความสามารถทางคอมพิวเตอรสูงกวานักเรียน
ท่ีอยูในโรงเรียนสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) และยังพบวานักเรียนท่ีอยูในโรงเรียนขนาดใหญจะมี
ความสามารถทางคอมพิวเตอรสูงกวาโรงเรียนขนาดกลาง 

2. ตัวแปรท่ีมีอิทธิพลทางตรงตอการรับรูความสามารถดานคอมพิวเตอรของตนเองของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร 
ไดแก ตัวแปรระดับประสบการณเดิม ตัวแปรบุคลิกภาพภายในของผูเรียน ตัวแปรความมุงม่ันในการทํางานและตัวแปรความวิตกกังวลใน
การใชคอมพิวเตอร อยางไมมีนัยสําคัญทางสถิติท่ีระดับ .05 

3. ตัวแปรท่ีมีอิทธิพลทางตรงตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานครอยางมีนัยสําคัญทาง
สถิติท่ีระดับ .05 ไดแก ตัวแปรความผูกพันตอเปาหมาย และตัวแปรการต้ังเปาหมาย สวนตัวแปรท่ีมีอิทธิพลทางออมตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร อยางมีนัยสําคัญทางสถิติท่ีระดับ .05 คือ ตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง 

4. โมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองท่ีมีตอความสามารถทางคอมพิวเตอร โดย
ภาพรวม มีความสอดคลองกับขอมูลเชิงประจักษ โดยใหคาไค-สแควร (Chi-square) เทากับ 9.146 ท่ีองศาอิสระ เทากับ 11 ท่ีระดับความ
นาจะเปน เทากับ 0.608 มีคา GFI เทากับ 0.998 คา AGFI เทากับ 0.986 และคา RMR เทากับ 0.020 ตัวแปรในโมเดลสามารถอธิบาย   
ความแปรปรวนของความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันท่ี 4 ในกรุงเทพมหานคร ไดรอยละ 24.20 

ภาควิชา……วิจัยและจิตวทิยาการศึกษา. ลายมือช่ือนิสิต....................................................
สาขาวิชา…..วิจัยการศึกษา................... ลายมือช่ือ อ.ที่ปรึกษาวทิยานพินธหลัก.................
ปการศึกษา..2551………………………



 จ

# # 5083816927 : MAJOR EDUCATIONAL RESEARCH 
KEY WORD: CAUSAL MODEL, COMPUTER SELF-EFFICACY, COMPUTER PERFORMANCE 

CHUTIWAT SUWATTHIPONG: A CAUSE AND EFFECT MODEL OF COMPUTER SELF-
EFFICACY ON COMPUTER PERFORMANCE. THESIS ADVISOR: ASSOC. PROF. WANNEE 
KAEMKATE, Ph.D., 216 pp.  

 
 The objective of the research were 1) to study the level of upper secondary school students in Bangkok’s 
computer performance and to compare this in school under different authorities and of different school sizes.  
2) Development of a cause and effect model of computer self-efficacy on computer performance of upper secondary 
school students in Bangkok. And 3) to examine the goodness of fit of the model with empirical data. The research 
samples consisted of 813 upper secondary school students in Bangkok. Variables consisted of eight latent variables: 
previous experience, trainee personality, learning goal, computer anxiety, computer self-efficacy, goal setting, goal 
commitment and computer performance of upper secondary school students in Bangkok. These latent variables were 
measured by thirteen observed variables. The research data were collected by questionnaires and test. 
Questionnaires had Cronbach's alpha reliability coefficient of observe variable in the ranged of 0.61 – 0.95, test had 
level difficulty of the items was 0.67, discrimination power of the items was 0.34 and KR20 reliability coefficient of 0.72. 
Analyzed by employing descriptive statistics, t-test, Pearson’s product-moment correlation coefficient and LISREL 
analysis. 
 
The research finding were as follows: 

1. The upper secondary school students in Bangkok’s computer performance stood at 49.66 percent. And the 
students in the basic education commission have higher computer performance than students in the private education 
commission. And the students who studied in a large school are higher computer performance than students who 
studied in a medium size school. 

2. Previous experience, trainee personality, learning goal and computer anxiety variable had not the direct 
effect to computer self-efficacy of upper secondary school students in Bangkok, the level of significant being .05. 

3. Goal commitment and goal setting variable had the direct effect to computer performance of upper 
secondary school students in Bangkok. And computer self-efficacy variable had the indirect effect to computer 
performance of upper secondary school students in Bangkok. 

4. The causal model was valid and fitted with the empirical data. Indicated by the Chi-square goodness 
of fit test was 9.146, df = 11, p = 0.608, GFI = 0.998, AGFI = 0.986 and RMR = 0.020. The model accounted for 
24.20% of variance in the computer performance of upper secondary school students in Bangkok.  
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วิทยานิพนธเลมนี้ สําเร็จลุลวงไปไดดวยดี โดยไดรับความกรุณาเปนอยางยิ่งจาก             
รองศาสตรจารย ดร.วรรณี แกมเกตุ อาจารยที่ปรึกษาวิทยานิพนธ ที่ใหคําปรึกษา ใหแนวคิด 
คําแนะนํา และแกไขขอบกพรองในการทําวิทยานิพนธ ต้ังแตเร่ิมตนจนกระทั่งสําเร็จเสร็จส้ิน ผูวิจัย
ขอกราบขอบพระคุณเปนอยางสูงมา ณ โอกาสนี้ 

ขอกราบขอบพระคุณรองศาสตราจารย ดร.อวยพร เรืองตระกูล และอาจารย ดร.บุญเรือง  
เนียมหอม คณะกรรมการสอบวิทยานิพนธ ขอกราบขอบพระคุณผูชวยศาสตราจารย ดร.ณัฎฐภรณ 
หลาวทอง ผูชวยศาสตราจารย ดร.พาสนา จุลรัตน อาจารย ดร.สกล วรเจริญศรี อาจารย ดร.ประกอบ 
กรณีกิจ  อาจารยชยการ  คีรีรัตน ผูเช่ียวชาญตรวจสอบเคร่ืองมือทุกทานเปนอยางสูง ที่ใหความรู 
ใหคําแนะนํา และขอเสนอแนะที่เปนประโยชนตอผูวิจัยเปนอยางยิ่ง  ขอขอบคุณปานอยและพี่ตาย
ที่ดูแลนิสิตในภาควิชาเปนอยางดี และอํานวยความสะดวกในทุกข้ันตอนของการทําวิทยานิพนธ  

ขอขอบพระคุณบัณฑิตวิทยาลัย ที่ไดกรุณามอบทุนอุดหนุนวิทยานิพนธจนทําใหผูวิจัย
สามารถทําวิทยานิพนธสําเร็จไดดวยดี 

ขอขอบคุณคณะผูบริหารโรงเรียนมาแตรเดอีวิทยาลัย เขตปทุมวัน กรุงเทพมหานคร อาจารย
ปานทิพย โสภาษิต ผูอํานวยการโรงเรียน อาจารยวีณา รักษาสกุล หัวหนาฝายวิชาการมัธยม ครู
รัตนา ครูจิติมา ครูสถาพร ครูวิศิษฐ ครูเพ็ญศิริ ครูธนารีย ครูจินต ครูธนาวรรณ ครูกรรณิการ ครูเมทิรา 
และครูในโรงเรียนมาแตรเดอีวิทยาลัยที่ไมไดกลาวถึงทุกคน คุณจุฑา คุณพีรยุทธ คุณทัศนีย คุณพนิดา 
คุณคูบุญ คุณยุทธพงษ คุณนิพัทธา คุณนริศรา คุณจารุวรรณ คุณสุรศักด์ิ คุณสุทธิพงศคุณกมล 
และพี่ๆ เพื่อนๆ และนองๆ ภาควิชาวิจัยและจิตวิทยาการศึกษาทั้งในและนอกเวลาราชการที่ไมได
กลาวถึงทุกคน ที่คอยเปนกําลังใจใหแกผูวิจัยมาโดยตลอด รวมทั้งใหความชวยเหลือ และให
คําแนะนําทุกคร้ังที่ผูวิจัยมีปญหาในการทําวิทยานิพนธ  

ทายที่สุดนี้ ผูวิจัยขอกราบขอบพระคุณพอสุพัฒน และคุณแมสุวิมล สุวัตถิพงศเปนอยาง
สูงที่ใหทุนเรียน รวม ทั้งใหความรัก ความหวงใย คอยเปนกําลังใจ และเปนทุกๆ อยาง รวมถึงญาติ
พี่นอง ที่คอยไตถาม ใหกําลังใจและความชวยเหลือผูวิจัยเกี่ยวกับการทําวิทยานิพนธมาโดยตลอด 
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บทที่  1 
 

บทนํา 
 
ความเปนมาและความสําคัญของปญหา 
 

การศึกษาเปนรากฐานท่ีสําคัญอยางยิ่งในการพัฒนาประเทศชาติใหเจริญกาวหนา
ทัดเทียมกับประเทศอ่ืนในโลก ทั้งนี้เพราะการศึกษาเปนการพัฒนาคนใหมีความรู ความคิด              
มีความสามารถมีทักษะในการทํางานและดําเนินชีวิตในสังคมอยางมีความสุข เมื่อคนในชาติไดรับ
การพัฒนาแลว ยอมสงผลใหเกิดการพัฒนาประเทศชาติในทุกๆดาน  ดังนั้นประเทศไทยจึงไดมี
การกําหนดหลักสูตรการศึกษาข้ันพื้นฐาน เพื่อใหเปนแนวทางสําหรับใชในกระบวนการศึกษา 

 
หลักสูตรการศึกษาข้ันพื้นฐาน พุทธศักราช 2544 ไดมีการกําหนดจุดมุงหมายเพื่อพัฒนา

คนไทยใหเปนมนุษยที่สมบูรณ เปนคนดี มีปญญา มีความสุข และมีความเปนไทยโดยมี
คุณลักษณะอันพึงประสงค เชน ใหคนไทยไดมีการพัฒนาทักษะกระบวนการ มีความคิดสรางสรรค
และเห็นคุณคาในตนเอง ทางดานมาตรฐานการเรียนรูในการพัฒนาผูเรียนของแตละโรงเรียนกต็อง
ปรับการจัดการศึกษาใหเหมาะสม โดยใหคํานึงถึงสภาพปญหา ความพรอม เอกลักษณ            
ภูมิปญญาทองถิ่นนั้นๆ ดังนั้นในขอบขายเนื้อหา กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี 
ชวงช้ันที่ 4 จึงไดมีการจัดใหสถานศึกษาแตละแหงสามารถปรับรูปแบบหลักสูตรใหเหมาะสมย่ิงข้ึน
ไดในบางกลุมสาระ เชน ศิลปะ การงานอาชีพและเทคโนโลยี ซึ่งยังจําเปนตองเรียนอยู อาจจัดเปน
รายวิชาหรือรวมกันในลักษณะบูรณาการ  โดยท่ีการศึกษาวิชาคอมพิวเตอรจะเปนสวนหนึ่งของ
กลุมสาระวิชาการงานอาชีพและเทคโนโลยี 

 
คอมพิวเตอรเปนเทคโนโลยีใหม มีความทันสมัยซ่ึงนับวันจะกาวเขามามีบทบาทเพิ่มข้ึน

อยางมากในวงการศึกษา ทั้งนี้เปนเพราะคอมพิวเตอรมีคุณสมบัติและลักษณะพิเศษที่สามารถจะ
เอ้ืออํานวยในการเรียนการสอนและการบริหารงานตางๆใหมีประสิทธิภาพมากยิ่งข้ึน  คอมพวิเตอร
จะชวยเพิ่มแรงจูงใจใหกับผูเรียน (กิดานันท มลิทอง, 2543) 

 
เนื่องจากในสังคมปจจุบันความกาวหนาของคอมพิวเตอรไดกอใหเกิดการเปล่ียนแปลง

อยางรวดเร็ว และมีบทบาทสําคัญในดานเศรษฐกิจ อุตสาหกรรม และการศึกษาเปนอยางมาก 



 2
 

สําหรับประเทศไทยไดนําคอมพิวเตอรและเทคโนโลยีสารสนเทศมาใชประโยชนในวงการการศึกษา
เพิ่มมากข้ึน ต้ังแตในระดับหลักสูตรการศึกษาข้ันพื้นฐานจนถึงทุกหนวยงาน จึงเปนเหตุใหผูเรียน
ตองมีทักษะในการใชคอมพิวเตอร ผูเรียนตองสามารถใชงานคอมพิวเตอรสําหรับทํางานไดตรงกับ
ความตองการตลอดจนสามารถพัฒนาตนเองไดเต็มตามศักยภาพของผูเรียน   

 
จากการศึกษาแนวคิดและทฤษฎีของแบนดูรา พบวาการรับรูความสามารถของตน           

(Self-Efficacy) เปนปจจัยหนึ่งที่จะทําใหบุคคลคาดการณความสามารถของตนเองได โดยที่การ
รับรูความสามารถของตนเอง หมายถึง การที่บุคคลตัดสินใจเกี่ยวกับความสามารถของตนเองที่จะ
จัดการและดําเนินการกระทําพฤติกรรมใหบรรลุเปาหมายที่กําหนดไว ซึ่งในสถานการณที่บางคร้ัง
อาจจะมีความคลุมเครือ ไมชัดเจน มีความแปลกใหม ที่ไมสามารถทํานายส่ิงที่เกิดข้ึนได                    
ซึ่งสภาพการณเหลานี้มักจะทําใหบุคคลเกิดความเครียดได (Bandura, 1986) การรับรู
ความสามารถของตนเปนโครงสรางทางจิตอยางหน่ึงที่เช่ือวามีบทบาทสําคัญตอการตรวจสอบ
ตนเอง โดยเฉพาะอยางยิ่งเมื่อมีแรงจูงใจในระดับที่เหมาะสม เพื่อใหสามารถทํางานที่ไมมี
ความคุนเคยได (Bandura, 1977, 1982) ในเร่ืองคอมพิวเตอรก็เชนกัน ถาบุคคลใดมีการรับรู
ความสามารถของตนดานคอมพิวเตอรในระดับสูง บุคคลก็มีแนวโนมที่จะเรียนรูดานคอมพิวเตอร
ไดดี กิสท สชาวเรอร และโรเซ็น (1989) และมารทอกชิโอ และดูลบอรน (1994)  ไดกลาววา บุคคล
จะเรียนรูอยางมีประสิทธิผลมากข้ึน เมื่อบุคคลนั้นมีการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองเพิ่มข้ึน 

 
ดังนั้นการรับรูความสามารถดานคอมพิวเตอรของตนเองเปนส่ิงสําคัญที่จะทําใหผูเรียน

สามารถตัดสินตนเองไดวาตนเองมีความสามารถในการใชคอมพิวเตอรไดดีในระดับใด                        
ซึ่งในปจจุบันผูเรียนจะสามารถใชคอมพิวเตอรไดเปนและจะมีจํานวนมากข้ึนเร่ือยๆ แตผูเรียน
มักจะใชคอมพิวเตอรสําหรับการเลนอินเตอรเน็ต เลนเกมส สนทนา ดูหนัง ฟงเพลง ฯลฯ เพื่อความ
บันเทิงเปนสวนใหญ  ซึ่งถาหากมาคิดพิจารณาแลว ความสามารถทางดานคอมพิวเตอรสําหรับ
การใชงานทางการศึกษา  นักเรียนยังมีความสามารถทางคอมพิวเตอรที่อยูในระดับตํ่า   Marakas 
(1998)  จึงไดพัฒนาเหตุปจจัยและความสัมพันธตางๆที่ทําใหผูเรียนเกิดการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอร ซึ่งจากการศึกษางานวิจัยพบวา
มีตัวแปรที่มีความสัมพันธกัน ไดแก การต้ังเปาหมาย ความผูกพันตอเปาหมาย ความวิตกกังวลใน
การใชคอมพิวเตอร ความมุงม่ันในการทํางาน และบุคลิกภาพภายในของผูเรียน  
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 ผูเรียนในระดับมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4) เปนชวงชั้นที่มีความพรอมทางดาน
ทักษะคอมพิวเตอรเพราะไดใชคอมพิวเตอรเปนระยะเวลาหลายปนานกวานักเรียนในชวงช้ันอ่ืนๆ  
และนอกจากนี้ยังเปนชวงชั้นปสุดทายกอนที่ผูเรียนจะเขาศึกษาตอในระดับอุดมศึกษา ดังนั้น
ผูเรียนจึงมีการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทางคอมพิวเตอร
ดีกวานักเรียนในชวงชั้นอื่นๆ เชนกัน ดวยเหตุผลและความสําคัญดังกลาวผูวิจัยจึงมีความสนใจ 
ที่จะพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนระดับช้ันมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4)  
 
คําถามวิจยั 
 

การวิจัยคร้ังนี้ ผูวิจัยสนใจศึกษาในประเด็นคําถามวิจัยที่สําคัญ 3 ประการ ดังนี้ 
1. ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครอยูในระดับ

ใด และแตกตางกันหรือไม เมื่อจําแนกตามสังกัดและขนาดของโรงเรียน 
2. มีปจจัยใดบางที่มีอิทธิพลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ

ความสามารถทางคอมพิวเตอร และรูปแบบความสัมพันธระหวางการรับรูความสามารถดาน
คอมพิวเตอรของตนเองกับความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่  4  ใน
กรุงเทพมหานครเปนอยางไร 

3. โมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครท่ีพัฒนาข้ึนสอดคลอง
กับขอมูลเชิงประจักษหรือไม 
 
วัตถุประสงค 
 

 จากคําถามวิจยั 3 ประการ ผูวิจัยกาํหนดเปนวัตถุประสงคหลักสําคัญ 3 ประการ ดังนี ้
 1. เพื่อศึกษาและเปรียบเทียบความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4                  
ในกรุงเทพมหานคร จําแนกตามสังกัดและขนาดของโรงเรียน 
 2. เพื่อพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
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3. เพื่อตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                
ในกรุงเทพมหานครที่พัฒนาข้ึนกับขอมูลเชิงประจักษ 
 
ขอบเขตของการวิจัย 
 

 การวิจยัคร้ังนี ้ผูวิจัยกาํหนดขอบเขตของการวิจัย ดังนี ้
1. ประชากรที่ใชในการวิจัยในคร้ังนี้ คือ นักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร จํานวน  

161,763  คน โดยโรงเรียนที่ใชในการศึกษาคร้ังนี้ ประกอบดวย กลุมโรงเรียนที่มีขนาดใหญและ
ขนาดกลาง ในเขตกรุงเทพมหานคร  เพราะเปนโรงเรียนที่มีอุปกรณส่ือการเรียนการสอนทาง              
โสตทัศนศึกษา และเทคโนโลยีพรอม  

2. ตัวแปรที่ศึกษาในการวิจัยคร้ังนี้ ประกอบดวย ตัวแปรตามและตัวแปรตน ดังนี้  
 2.1 ตัวแปรตาม ไดแก ความสามารถทางคอมพิวเตอร ซึ่งเปนตัวแปรภายในแฝง
วัดไดจากตัวแปรสังเกตได 2 ตัว ไดแก คะแนนทดสอบโปรแกรมประมวลผลคําและคะแนนทดสอบ
โปรแกรมนําเสนอผลงาน 
 2.2 ตัวแปรตน ซึ่งเปนตัวแปรแฝง จํานวน 7 ตัวแปร ไดแก  
  2.2.1 ระดับประสบการณเดิม ซึ่งเปนตัวแปรภายนอกแฝง วัดไดจากตัว
แปรสังเกตได 2 ตัว ไดแก ระดับประสบการณในการใชโปรแกรมประมวลผลคําและการใช
โปรแกรมนําเสนอผลงาน 
  2.2.2 บุคลิกภาพภายในของผูเรียน ซึ่งเปนตัวแปรภายนอกแฝง วัดได
จากตัวแปรสังเกตได 2 ตัว ไดแก การเห็นคุณคาในตนเอง และความออนไหวทางอารมณ 
  2.2.3 ความมุงมั่นในการทํางาน ซึ่งเปนตัวแปรภายนอกแฝง วัดไดจาก
ตัวแปรสังเกตได คือ ระดับความมุงมั่นในการทํางาน  
  2.2.4 ความวิตกกังวลในการใชคอมพิวเตอร ซึ่งเปนตัวแปรภายนอกแฝง           
วัดไดจากตัวแปรสังเกตได คือ ระดับความวิตกกังวลในการใชคอมพิวเตอร 
  2.2.5   การรับรูความสามารถดานคอมพิวเตอรของตนเอง ซึ่งเปนตัวแปร
ภายในแฝง วัดไดจากตัวแปรสังเกตได 2 ตัว ไดแก การรับรูความสามารถในการใชโปรแกรม
ประมวลผลคําและการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 
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  2.2.6 การต้ังเปาหมาย ซึ่งเปนตัวแปรภายในแฝง วัดไดจากตัวแปร
สังเกตได คือ  ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน 
  2.7.7 ความผูกพันตอเปาหมาย ซึ่งเปนตัวแปรภายในแฝง วัดไดจาก         
ตัวแปรสังเกตได คือ ระดับความผูกพันตอเปาหมาย 
 
นิยามศัพทที่ใชในการวิจัย 
 

การรับรูความสามารถดานคอมพิวเตอรของตนเอง หมายถึง การที่ผูเรียนตัดสิน
ความสามารถของตนเองดานคอมพิวเตอรในการจัดการใหบรรลุเปาหมายที่กําหนดไว ซึ่งวัดได
จากตัวแปรสังเกตไดจํานวน 2 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถในการใชโปรแกรม
ประมวลผลคําและตัวแปรการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน  

การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา หมายถึง การที่ผูเรียน
ตัดสินความสามารถของตนเองในการใชโปรแกรมประมวลผลคําใหบรรลุเปาหมายที่กําหนดไว ซึ่ง
วัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดสรางข้ึนเอง  

การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน หมายถึง การที่ผูเรียน
ตัดสินความสามารถของตนเองในการใชโปรแกรมนําเสนอผลงานใหบรรลุเปาหมายท่ีกําหนดไว 
ซึ่งวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัยไดสรางข้ึนเอง 

ความสามารถทางคอมพิวเตอร หมายถึง คะแนนทดสอบที่ไดจากการใชโปรแกรม
คอมพิวเตอร ซึ่งวัดไดจากตัวแปรสังเกตได 2 ตัวแปร คือ คะแนนทดสอบโปรแกรมประมวลผลคํา
และคะแนนทดสอบโปรแกรมนําเสนอผลงาน โดยใชแบบทดสอบความสามารถทางคอมพิวเตอร
ในการทดสอบเปนแบบปรนัย 4 ตัวเลือก ที่ผูวิจัยไดสรางข้ึนเอง  

ระดับประสบการณเดิม หมายถึง ภูมิหลังในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน ซึ่งวัดไดจากตัวแปรสังเกตไดจํานวน 2  ตัวแปร ไดแก ตัวแปรระดับประสบการณใน
การใชโปรแกรมประมวลผลคําและตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน   

ระดับประสบการณในการใชโปรแกรมประมวลผลคํา หมายถึง ระดับจํานวนชวงป
ของประสบการณในการใชโปรแกรมประมวลผลคําและระดับจํานวนช่ัวโมงเฉล่ียตอวันในการใช
โปรแกรมประมวลผลคํา ซึ่งวัดเปนระดับความมากนอยของประสบการณจากแบบตรวจสอบ
รายการ (check list) ที่ผูวิจัยสรางข้ึน 
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ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน หมายถึง ระดับจํานวนชวงป
ของประสบการณในการใชโปรแกรมนําเสนอผลงานและระดับจํานวนช่ัวโมงเฉล่ียตอวันในการใช
โปรแกรมนําเสนอผลงาน ซึ่งวัดเปนระดับความมากนอยของประสบการณจากแบบตรวจสอบ
รายการ (check list) ที่ผูวิจัยสรางข้ึน 

บุคลิกภาพภายในของผูเรียน หมายถึง การรับรูของผูเรียนในการประเมินตนเอง
เกี่ยวกับความสามารถในการกระทําสิ่งตางๆ อันไดแกความคิด ความรูสึกที่บุคคลมีตอตนเอง 
ประเมินตนเอง เกี่ยวกับความพอใจ ความมีคุณคา ความสําเร็จ ความสําคัญ ความสามารถ ความ
มั่นใจ และการนับถือตนเองทั้งเชิงบวกและเชิงลบ  ซึ่งวัดไดจากตัวแปรสังเกตไดจํานวน 2  ตัวแปร 
ไดแก คือ ตัวแปรการเห็นคุณคาในตนเอง และตัวแปรความออนไหวทางอารมณ   

การเห็นคุณคาในตนเอง หมายถึง ความคิด ความรูสึกของผูเรียนที่มีตอตนเอง ประเมิน
ตนเอง เกี่ยวกับความพอใจ ในคุณคา ความสําเร็จ ความสําคัญ ความสามารถ ความเชื่อมั่น และ
การยกยองตนเองซ่ึงวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัย
ไดพัฒนามาจากแบบวัดของ Judge (2003)   

ความออนไหวทางอารมณ  หมายถึง ความรูสึกนึกคิดของผูเรียนที่มีตอตนเอง ในดาน
ความกังวลใจ ความรูสึกกดดัน ความไมมั่นใจในตนเอง และความรูสึกซึมเศราทอแทเกี่ยวกับการ
ทํางานใหประสบผลสําเร็จตามเปาหมายที่กําหนดไว ตลอดจนการใชชีวิตรวมกับผูอ่ืนในสังคมซ่ึง
วัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจาก
แบบวัดของ Judge (2003)   

ความมุงม่ันในการทํางาน หมายถึง ลักษณะการแสดงออกของผูเรียนที่มีเปาหมาย          
ในการเรียนรูและมุงเนนในการทํางานใหบรรลุผลสําเร็จ ซึ่งวัดไดจากแบบสอบถามแบบมาตร
ประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Button (1996) 

ความวิตกกังวลในการใชคอมพิวเตอร หมายถึง สภาวะที่ผูเรียนรูสึกหวั่นไหวตอการ 
ใชคอมพิวเตอรอันสงผลใหผู เ รียนเกิดความรูสึกทางลบที่มีตอคอมพิวเตอร ซึ่งวัดไดจาก
แบบสอบถามแบบมาตรประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ 
Heinssen (1987) 

การต้ังเปาหมาย หมายถึง หมายถึง การที่ผูเรียนคาดหวังและกําหนดรอยละของ
ผลสําเร็จในการใชโปรแกรมประมวลผลคํา(Microsoft Word) และโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) เปนเปาหมายตามทักษะของตนเอง ซึ่งวัดไดจากตัวแปรสังเกตไดจํานวน 
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2 ตัวแปร ไดแก ตัวแปรระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคําและตัวแปร
ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน 

ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา หมายถึง                    
การที่ ผู เ รียนคาดหวังและกําหนดรอยละของผลสําเร็จในการใชโปรแกรมประมวลผลคํา             
(Microsoft Word) ซึ่งวัดไดจากแบบตรวจสอบรายการ (check list)  ที่ผูวิจัยสรางข้ึน 

ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน หมายถึง                    
การที่ ผู เ รียนคาดหวังและกําหนดรอยละของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) ซึ่งวัดไดจากแบบตรวจสอบรายการ (check list)  ที่ผูวิจัยสรางข้ึน 

ความผูกพันตอเปาหมาย หมายถึง การที่ผูเรียนมีความรูสึกรับผิดชอบตอเปาหมายซึ่ง
เนนผลสําเร็จของงานที่ผูเรียนกําหนดไวซึ่งวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating 
scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Hollenback (1987) 
 
ประโยชนที่ไดรับจากงานวิจัย 
 

 1. ประโยชนในทางปฏิบัติ 
 ผลการวิจัยนี้จะทําใหทราบถึงปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร
ของตนเองและความสามารถทางคอมพิวเตอร  ทั้งทางตรงและทางออม ผลการวิจัยจะทําใหผูสอน
ทราบถึงรูปแบบความสัมพันธระหวางการรับรูความสามารถดานคอมพิวเตอรของตนเองกับ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 วามีสาเหตุมาจากปจจัยใด  และยังไดทราบ
วามีปจจัยใดบางที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถ
ทางคอมพิวเตอร  อันจะเปนประโยชนตอการนําไปสูการพัฒนาผูเรียนใหมีการพัฒนาระดับ
ความสามารถในการใชคอมพิวเตอรไดดียิ่งข้ึนตอไป 
 2. ประโยชนทางการวิชาการ 
 การศึกษาการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทาง
คอมพิวเตอรนี้  ผูวิจัยไดใชกระบวนการวิจัยเพื่อนําไปสูการสรางโมเดลเชิงสาเหตุและผล                 
ซึ่งสามารถใชเปนตนแบบในการพัฒนาโมเดลเชิงสาเหตุและผลในบริบทของทางการศึกษาวิจัย
เร่ืองอ่ืนๆ ดวย 
 
 



บทที่ 2 
 

เอกสารและงานวิจัยที่เก่ียวของ 
  
 การวิจัยในคร้ังนี้ มีวัตถุประสงคหลักเพื่อพัฒนาโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียน             
ชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร ซึ่งผูวิจัยไดแบงการนําเสนอเอกสารและงานวิจัยที่เกี่ยวของ
เปน 7 ตอน ดังนี้ ตอนแรก เปนการนําเสนอแนวคิด ทฤษฎีที่เกี่ยวกับการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง ตอนท่ีสอง เปนการนําเสนอแนวคิด ทฤษฎีที่เกี่ยวกับการต้ังเปาหมาย 
ตอนที่สาม เปนการนําเสนอปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
ตอนที่สี่ เปนการนําเสนอแนวคิดทฤษฎีที่เกี่ยวกับความสามารถทางคอมพิวเตอรและปจจัยที่
สงผลตอความสามารถทางคอมพิวเตอร ตอนท่ีหา เปนการนําเสนองานวิจัยที่เกี่ยวของโดย
แบงเปนงานวิจัยในประเทศและงานวิจัยตางประเทศ ตอนที่หก เปนการเสนอสาระเกี่ยวกับ
หลักการวิเคราะหโมเดลลิสเรล และตอนสุดทาย เปนการนําเสนอกรอบแนวคิดและสมมติฐาน
การวิจัย ซึ่งทั้ง 7 ตอนมีรายละเอียด ดังนี้ 

 

ตอนท่ี 1 แนวคิด ทฤษฎทีี่เกี่ยวกับการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
ในตอนแรกนี้เปนการนําเสนอแนวคิดทฤษฎีที่เกี่ยวของกับการรับรูความสามารถดาน

คอมพิวเตอรของตนเองประกอบดวยสาระสําคัญ ไดแก ความหมายของการรับรูความสามารถ
ของตนเอง ทฤษฎีพื้นฐานเกี่ยวกับการรับรูความสามารถของตนเอง กระบวนการกระตุนการรับรู
ความสามารถของตนเอง กระบวนการทางปญญาที่เกี่ยวกับขอมูลของการรับรูความสามารถของ
ตนเอง แหลงของการรับรูความสามารถของตนเอง มิติของการรับรูความสามารถของตนเอง การ
วัดการรับรูความสามารถของตนเอง คุณลักษณะของบุคคลที่มีการรับรูความสามารถของตนเอง 
และการรับรูความสามารถของตนเองดานคอมพิวเตอร  

 

1.1 ความหมายของการรับรูความสามารถของตนเอง 
มิลเทียดู (Miltiadou,1999) กลาววา การรับรูความสามารถของตนเอง (Self- Efficacy) 

เปนการประเมินศักยภาพของตนเองตอกิจกรรมที่ตองปฏิบัติ หากผูเรียนมีการรับรูความสามารถ
ของตนเองสูงยอมมีแนวโนมวาผูเรียนจะสามารถปฏิบัติกิจกรรมนั้นไดประสบความสําเร็จ ปจจัยที่
สงผลตอการรับรูความสามารถของตนเอง คือการไดเห็นตัวแบบของผูเรียนในช้ันเรียน จะให
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ประสิทธิผลสูงกวาการเรียนรูจากผูสอน รวมทั้งการไดรับแรงจูงใจจากส่ิงแวดลอมการเรียน                    
จะสงผลตอความเชื่อมั่นในการเรียนและการแสดงพฤติกรรมตางๆ 

แบนดูรา (Bandura, 1986) กลาววา การรับรูความสามารถของตนเอง หมายถึง การที่
บุคคลตัดสินเกี่ยวกับความสามารถของตนเองวาสามารถกระทําบางอยางในเหตุการณหนึ่งได
หรือไม ซึ่งในเหตุการณนั้นบางครั้งอาจไมชัดเจน แปลกใหม ไมสามารถคาดการณส่ิงที่จะเกิดข้ึน
ได โดยปจจัยที่เกิดข้ึนจากเหตุการณเหลานั้นสงผลใหบุคคลเกิดความเครียดข้ึนได ปจจัยที่สงผล
ตอการรับรูความสามารถของตนเองไมไดมีเพียงทักษะที่บุคคลมีในขณะนั้นเทานั้น หากแตข้ึนอยู
กับการตัดสินของบุคคลวาสามารถทําส่ิงใดไดดวยทักษะที่มีอยู โดยการรับรูความสามารถของ
ตนเองนี้สามารถใชทํานายพฤติกรรมของบุคคลไดดวย 

ชังค (Schunk, 2000) กลาววา การรับรูความสามารถของตนเอง หมายถึง ความเชื่อมั่น
ของบุคคลเกี่ยวกับความสามารถที่จะเรียนรู หรือกระทําพฤติกรรมตามความสามารถที่มีอยูซึ่ง          
ไมเหมือนกับการที่เรารูวาจะทําอะไร เปนการประเมินทักษะและความสามารถของบุคคลตาม
ระดับความสามารถที่มีอยู 

พาจาเรสและมิลเลอร (Pajares and Miller,1994) กลาววา การรับรูความสามารถของ
ตนเองเปนการตัดสินความสามารถที่บุคคลมีตอตนเองในการแสดงพฤติกรรมที่เฉพาะเจาะจงใน
แตละสถานการณซึ่งการรับรูความสามารถของตนเองนี้จะเกี่ยวของกับความเช่ือมั่นในตนเองของ
บุคคลดวย 

จากการใหความหมายของคําวา การรับรูความสามารถของตนเอง ของนักวิชาการ 
สามารถสรุปไดวา การรับรูความสามารถของตนเอง เปนความเชื่อมั่นในการตัดสินความสามารถ
ของตนที่มีตอดานใดดานหนึ่งนอกจากนี้ยังสามารถทํานายพฤติกรรมของบุคคลนั้นไดอีกดวย 

 

1.2 ทฤษฎีพื้นฐานเกี่ยวกับการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1986) กลาววา การรับรูความสามารถของตนเองมีพื้นฐานมาจาก

ทฤษฎีการเรียนรูทางสังคม (Social cognitive theory) ซึ่งแนวคิดดานทฤษฎีการเรียนรูทางสังคม
เนนการเปล่ียนแปลงพฤติกรรมของบุคคลโดยใชองคประกอบดานบุคคลเปนสําคัญ วิธีการหนึ่งที่
สามารถสรางการเรียนรูคือการที่บุคคลรับรูความสามารถของตนเองอยางถูกตองจะนําไปสูการ
เปลี่ยนแปลงพฤติกรรมการเรียนรูได 

แบนดูรา (Bandura, 1977) กลาววา การรับรูความสามารถของตนเองมีผลตอการตัดสินใจ
ที่จะกระทําพฤติกรรม การที่บุคคลจะกระทําพฤติกรรมใดหรือไมนั้นข้ึนอยูกับปจจัย 2 ประการ คือ 
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1. ความคาดหวังในความสามารถของตน (Efficacy expectation) ซึ่งตอมาไดเปล่ียนเปนคํา
วา “การรับรูความสามารถของตนเอง” (Self-Efficacy) และใหคํานิยามวาเปนการรับรูความสามารถ
ของตนเองที่จะจัดการและดําเนินการกระทําพฤติกรรมใหบรรลุเปาหมายที่คาดหวังไว 

2. ความคาดหวังในผลที่จะเกิดข้ึน (Outcome expectation) หมายถึง ความคาดหวัง          
ที่บุคคลมีตอพฤติกรรมเฉพาะอยางที่จะปฏิบัติที่จะนําไปสูผลลัพธตามที่คาดหวังไว เปนการหวงัใน
ผลที่จะเกิดข้ึนที่เนื่องมาจากพฤติกรรมที่ไดกระทําไปแลว ดังแสดงในแผนภาพท่ี 2.1 ดังนี้ 

 
 
    
    

 
 

 
 
แผนภาพที่ 2.1   ความสัมพันธระหวางการรับรูความสามารถของตนเองและความคาดหวงัผล 

  ที่เกิดข้ึน  
ที่มา : Bandura, 1977 

 

จากแผนภาพขางตนแสดงใหเห็นวา การรับรูความสามารถของตนเอง และความคาดหวัง
เกี่ยวกับผลที่จะเกิดข้ึนนั้นมีความสัมพันธกันมาก โดยที่ความสัมพันธระหวางทั้งสองตัวแปรนี้              
มีผลตอการตัดสินใจที่จะกระทําพฤติกรรมของบุคคลนั้น ๆ ซึ่งจะเห็นไดจากตารางที่ 2.1 ดังตอไปนี้ 

 

ตารางที ่2.1  แสดงความสมัพันธระหวางการรับรูความสามารถของตนเอง และความคาดหวังผล 
         ที่จะเกิดข้ึน (Bandura, 1977) 

ความคาดหวังเกี่ยวกับผลลัพธที่เกิดขึ้น  
สูง ต่ํา 

สูง มีแนวโนมที่จะกระทําแนนอน มีแนวโนมที่จะไมกระทํา การรับรูความสามารถ
ของตนเอง ต่ํา มีแนวโนมที่จะไมกระทํา มีแนวโนมที่จะไมกระทําแนนอน 

 

จากตารางขางตนแสดงใหเห็นถึงความสัมพันธระหวางการรับรูความสามารถของตนเอง
กับความคาดหวงัเกี่ยวกับผลที่จะเกิดข้ึนสามารถสรุปไดดังนี ้

บุคคล พฤติกรรม ผลลัพธ 

การรับรูความ         
สามารถของตนเอง 

ความคาดหวงัผล      
ที่จะเกิดข้ึน 
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1. บุคคลที่มีการรับรูความสามารถของตนเองสูง มีความคาดหวงัเกีย่วกับผลลัพธที่เกิดข้ึน
สูงจะมีแนวโนมที่จะกระทาํกิจกรรม หรือพฤติกรรมนัน้แนนอน 

2. บุคคลที่มีการรับรูความสามารถของตนเองตํ่า มีความคาดหวงัเกีย่วกับผลลัพธที่เกิดข้ึน
สูงจะมีแนวโนมที่จะไมกระทาํกิจกรรม หรือพฤติกรรมนัน้ 

3. บุคคลที่มีการรับรูความสามารถของตนเองสูง มีความคาดหวงัเกีย่วกับผลลัพธที่เกดิข้ึน
ตํ่าจะมีแนวโนมที่จะไมกระทาํกิจกรรม หรือพฤติกรรมนัน้ 

4. บุคคลที่มีการรับรูความสามารถของตนเองตํ่า มีความคาดหวงัเกีย่วกับผลลัพธที่เกิดข้ึน
สูงจะมีแนวโนมที่จะกระทาํกิจกรรม หรือพฤติกรรมนัน้แนนอน 
 จากทฤษฎีพื้นฐานเกี่ยวกับการรับรูความสามารถของตนเองทําใหสรุปไดวาการรับรู
ความสามารถของตนเองมีผลตอการแสดงออกทางพฤติกรรม และเม่ือบุคคลนั้นมีความคาดหวัง
สูงก็ยอมจะทําใหผลลัพธนั้นเกิดข้ึนอยางแนนอน 

 

1.3 กระบวนการกระตุนการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1994) กลาววา การกระตุนการรับรูความสามารถของตนเองจะ

สงผลตอพฤติกรรมของบุคคล ซึ่งประกอบดวย 4 กระบวนการดังตอไปนี้ 
1.3.1 กระบวนการทางปญญา (Cognitive Processes) การรับรูความสามารถ

ของตนเองมีผลตอกระบวนการทางปญญาหลายรูปแบบ พฤติกรรมของบุคคลสวนมากมี
จุดมุงหมายที่ถูกกํากับโดยการต้ังเปาหมายไวลวงหนา การต้ังเปาหมายของบุคคลจะไดรับอิทธิพล
จากการประเมินความสามารถของตนเอง คนที่มีการรับรูความสามารถของตนเองสูงจะ
ต้ังเปาหมายที่ สูงและทาทาย  มีความมุงมั่นที่จะบรรลุเปาหมายมากกวาคนที่มีการรับรู
ความสามารถของตนเองตํ่าและรูปแบบพฤติกรรมสวนใหญมักริเร่ิมจากรูปแบบการคิด เปนการ
คิดสรางสภาพการณลวงหนาและยอนทบทวน บุคคลที่มีการรับรูความสามารถสูงจะสรางภาพ
แหงความสําเร็จ ส่ิงนี้จะชวยแนะแนวทางและสนับสนุนการกระทํา สวนบุคคลที่สงสัยใน
ความสามารถของตนเองจะสรางภาพความลมเหลวไวลวงหนา กระบวนการคิดจึงทําใหบุคคล
ทํานายเหตุการณและพัฒนาแนวทางที่จะควบคุมส่ิงที่จะมีผลตอการดํารงชีวิตของตนเองในสภาพ
การเรียนรูบุคคลมุงเนนไปที่ความรูของตนที่จะแสดงความคิดเห็น เพื่อรวบรวมปจจัยตางๆนําไปสู
การตรวจสอบ โดยบุคคลจะพิจารณาการประเมินตนเองอีกคร้ังจากผลการกระทําระยะส้ันและ
ระยะยาว จดจําปจจัยตางๆ ที่ถูกตรวจสอบและจําวาตนเองทํางานใหดีไดอยางไร 

การเผชิญกับสภาพการณที่มีความกดดัน อุปสรรคหรือความลมเหลว บุคคลที่มี
การรับรูความสามารถของตนเองตํ่าจะมีความคิดวิเคราะหที่เอาแนนอนอะไรไมได มีระดับความ
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พึงพอใจตนเองในระดับตํ่า และคุณภาพการทํา งานจะดอยลง ในทางตรงกันขามบุคคลที่มีการ
รับรูความสามารถสูง จะต้ังเปาหมายที่ทาทายและใชการคิดวิเคราะหที่ดีในการที่จะบรรลุผลสําเร็จ 

1.3.2 กระบวนการจูงใจ (Motivation Processes) การรับรูความสามารถของ
ตนเองมีบทบาทสําคัญในการจูงใจตนเอง การจูงใจของบุคคลสวนใหญอยูในรูปของกระบวนการ
คิด บุคคลจะมีการจูงใจตนเองและช้ีแนะการกระทําของตนเองโดยการคิดลวงหนา บุคคลจะสราง
ความเชื่อจากการคิดวาตนเองสามารถทําอะไรได และมีความคาดหวังถึงผลของการกระทํา บุคคล
จะต้ังเปาหมายและวางแผนการกระทําของตนเอง  โดยรูปแบบการจูงใจทางความคิดมีลักษณะ
แตกตางกัน 3 ลักษณะ คือ การระบุสาเหตุ การคาดหวังผลและเห็นคุณคา และการต้ังเปาหมาย 
ซึ่งการรับรูความสามารถของตนเองจะมีบทบาทตอการจูงใจ ทางความคิดทั้ง 3 ลักษณะ ดังนี้ 

1.3.2.1 การรับรูความสามารถของตนเองมีอิทธิพลตอการระบุสาเหตุ  
คนที่มีการรับรูความสามารถสูงจะอางสาเหตุของความลมเหลวของตนวาเกิดจากการขาดความ
พยายาม คนที่เช่ือวาตนเองไมมีความสามารถก็จะอางสาเหตุของความลมเหลวน้ันวาเกิดจาก
ตนเองไมมีความสามารถ การระบุอางสาเหตุนี้จะมีผลตอแรงจูงใจ การกระทํา และปฏิกิริยา
อารมณโดยผานการรับรูความสามารถของตนเอง 
   1.3.2.2 การคาดหวังผลและเห็นคุณคา แรงจูงใจจะถูกควบคุมโดยการ
คาดหวังผลจากการกระทํา แตบุคคลจะกระทําพฤติกรรมภายใตความเชื่อที่วาตนเองสามารถทํา
อะไรไดและความเชื่อในผลที่เกิดจากการกระทํา อิทธิพลของการคาดหวังผลและเห็นคุณคาจะเปน
แรงจูงใจใหบุคคลกระทําพฤติกรรมนั้น สวนหนึ่งข้ึนอยูกับการรับรูความสามารถของตนเอง 

1.3.2.3 การต้ังเปาหมาย บุคคลจะต้ังเปาหมายที่ทาทายและประเมินผล
ยอนกลับจากเปาหมายที่ต้ังไว การต้ังเปาหมายที่ทาทายจะทําใหแรงจูงใจเพิ่มและยังคงอยู
เปาหมายตางๆ จะมีอิทธิพลตอบุคคลโดยผานกระบวนการภายในตนเองมากกวาจะเปนการ
ควบคุมแรงจูงใจและพฤติกรรมโดยตรง แรงจูงใจนั้นจะมีพื้นฐานมาจากการต้ังเปาหมายที่
เกี่ยวของกับกระบวนการเปรียบเทียบทางปญญา โดยการทําใหเกิดความพึงพอใจในตนเองจาก
เปาหมายที่ต้ังไว พฤติกรรมของบุคคลจะพึงพอใจในตนเองในการบรรลุเปาหมายที่มีคุณคาและ
สงเสริมใหตนเองใชความพยายามมากข้ึน โดยการไมพอใจกับการกระทําที่ตํ่ากวามาตรฐาน 
แรงจูงใจจากเปาหมายหรือมาตรฐานสวนบุคคลจะไดรับผลมาจากอิทธิพลในตนเอง 3 ประเภท 
คือ การพึงพอใจและไมพึงพอใจตนเองจากการกระทําการรับรูถึงความสามารถของตนเองที่จะ
บรรลุเปาหมายที่ต้ังไวและการปรับปรุงการต้ังเปาหมายดวยกระบวนการทางปญญา 
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1.3.3 กระบวนการทางความรูสึกและอารมณ (Affective Processes) การรับรู
ความสามารถของตนเองจะมีผลตอความเครียดและความกดดันเมื่อบุคคลเผชิญกับสภาพการณ   
ที่ลําบากมีอุปสรรคและจะมีผลตอระดับแรงจูงใจ บุคคลที่เช่ือในความสามารถของตนเองจะ
สามารถควบคุมความเครียดที่จะทําใหเกิดความวิตกกังวลได แตคนที่เช่ือวาตนไมมีความสามารถ
จะมีความวิตกกังวลสูงและมองวาสภาพแวดลอมที่เขาอยูเต็มไปดวยอันตรายและมีความวิตก
กังวลกับส่ิงตางๆ ที่จะเกิดข้ึน ความวิตกกังวลไมเพียงไดรับอิทธิพลจากการรับรูความสามารถที่จะ
กระทําพฤติกรรมเทานั้น แตยังไดรับอิทธิพลจากการรับรูความสามารถดานการควบคุมความคิดที่
รบกวนได การรับรูความสามารถดานการควบคุมความคิดเปนปจจัยสําคัญที่จะควบคุมความคิด
อันกอใหเกิดความเครียดและความกดดัน ทั้งการรับรูความสามารถในการจัดการและการรับรู
ความสามารถในการควบคุมความคิดจึงทํางานรวมกันที่จะชวยลดความวิตกกังวลและพฤติกรรม
หลีกเล่ียงได 

1.3.4 กระบวนการเลือก (Selection Processes) การรับรูความสามารถของ
ตนเองจะมีผลตอการเลือกกระทําพฤติกรรมโดยบุคคลจะเลือกกระทําในสถานการณที่ตนเองเชื่อ
วาทําได และหลีกเลี่ยงสถานการณหรือกิจกรรมที่บุคคลเช่ือวาเกินความสามารถของตนเองท่ีจะ
ทําไดบุคคลที่มีการรับรูความสามารถของตนเองสูงจะเลือกงานที่มีลักษณะทาทาย สวนบุคคลที่มี
การรับรูความสามารถของตนเองตํ่าจะทอถอยหลีกเล่ียงงาน เปนการปดโอกาสที่จะพัฒนา
ศักยภาพของตนเอง 

สรุปไดวากระบวนการกระตุนการรับรูความสามารถของตนเองประกอบ            
ไปดวย  4 กระบวนการ คือ กระบวนการทางปญญา กระบวนการจูงใจ กระบวนการทางความรูสึก
และอารมณและกระบวนการเลือก 

 

1.4 กระบวนการทางปญญาที่เกี่ยวกับขอมูลของการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1986) กลาววา ขอมูลที่เปนแหลงการรับรูความสามารถของตนเอง

ไมไดเขาสูตัวบุคคลได ตองผานกระบวนการประเมินทางปญญา ซึ่งจะตองอาศัยปจจัยตางๆ เชน 
สภาพการณทางสังคม สถานการณ หรือระยะเวลา เปนตน ซึ่งการประเมินทางปญญาเกีย่วกบัการ
รับรูความสามารถของตนเองนี้จะตองรวมระหวางองคประกอบ 2 สวนที่แยกกันอยูเขาไวดวยกัน 
คือ องคประกอบที่เกี่ยวกับรูปแบบของขอมูลที่บุคคลใหความสนใจ และองคประกอบที่เกี่ยวกับ
การเชื่อมโยง เพื่อนํามาใชในการตัดสินความสามารถของตนเอง โดยมีขอมูลที่สงผลตอการรับรู
ความสามารถของตนเองดังนี้ 
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1.4.1 ขอมูลความสามารถที่ไดจากการกระทํา (Enactive Efficacy Information) 
การไดรับประสบการณตรงจากการกระทําจะทําใหการรับรูความสามารถของตนเองเปลี่ยนไป โดย
การเปล่ียนแปลงข้ึนอยูกับปจจัยตางๆ ไดแก 

1.4.1.1 ความพยายามและการตัดสินความสามารถ บุคคลที่มีการรับรู
ความสามารถของตนเองสูง จะมองวาความพยายามมีความสัมพันธทางลบกับความสามารถ นั่น
คือถาใชความพยายามเพียงเล็กนอยก็สามารถทํางานที่ยากหรือทาทายใหประสบความสําเร็จได 
แตถาตองใชความพยายามอยางมากจึงจะประสบความสําเร็จ แสดงวาบุคคลนั้นมีความสามารถ
นอยกวาในขณะเดียวกันถาไดใชความพยายามแลวแตยังไมประสบความสําเร็จ ก็จะประเมินวา
ตนเองมีการรับรูความสามารถของตนเองตํ่า 

1.4.1.2 รูปแบบของการอนุมานสาเหตุ  บุคคลที่ เ ช่ือวาตนเองมี
ความสามารถจะอนุมานสาเหตุของความสําเร็จหรือความลมเหลววาเกิดจากปจจัยภายใน ซึ่ง
ไดแก ความพยายามหรือความสามารถของตนเอง สวนบุคคลที่มองวาตนเองมีความสามารถตํ่า 
จะอนุมานสาเหตุของความสําเร็จหรือความลมเหลววาเกิดจากปจจัยภายนอก ดังนั้น หากจะเพิ่ม
การรับรูความสามารถของตนเองจะตองใชความพยายามหรือความสามารถที่มีอยูใหมากที่สุด 
โดยพยายามหลีกเล่ียงการชวยเหลือจากภายนอกใหนอยที่สุด 

1.4.1.3 ความต้ังใจและความจํา คนที่มีการรับรูความสามารถของตนเอง
สูงจะเลือกจําแตเฉพาะการกระทําหรือประสบการณที่ประสบความสําเร็จของตนเอง สวนคนที่รับรู
ความสามารถของตนเองตํ่าจะจําแตการกระทําหรือเหตุการณในทางลบ 

1.4.2 ขอมูลความสามารถที่ไดจากการเห็นตัวแบบที่ประสบความสําเร็จ 
(Vicarious Efficacy Information) ขอมูลนี้จะมีผลตอการรับรูความสามารถของตนเอง หากบุคคล
มีการนําตัวแบบนั้นมาเปรียบเทียบกับตนเอง ลักษณะสําคัญของตัวแบบที่ประสบความสําเร็จ     
มีดังนี้ 

1.4.2.1 ตองมีลักษณะคลายคลึงกับผูสังเกต ทั้งทางดานเพศ อายุ ระดับ 
การศึกษาทักษะหรือประสบการณในอดีต เปนตน 

1.4.2.2 ตองมีความหลากหลาย ซึ่งจะทําใหผูสังเกตเกิดความคิดวาคนที่
มีลักษณะตางกันก็สามารถประสบความสําเร็จไดเชนกัน 

1.4.3 ขอมูลความสามารถจากการพูดชักจูง (Persuasory Efficacy Information) 
การตัดสินเกี่ยวกับความสามารถของตนเองนั้น ไมไดข้ึนอยูกับตนเองเพียงอยางเดียว ยังข้ึนอยูกับ
บุคคลอ่ืนที่มีความสามารถในการประเมินอีกดวย บุคคลอ่ืนที่จะมีสวนชวยในการตัดสินเกี่ยวกับ
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ความสามารถของตนเองนั้นจะชวยโดยการใชคําพูดชักจูงเพื่อใหเกิดการรับรูเพิ่มข้ึน การใชคําพูด
ชักจูงจะไดผลหรือไมข้ึนอยูกับองคประกอบตอไปนี้ 

1.4.3.1 ความนาเช่ือถือของผูชักจูง ถาผูชักจูงมีความนาเช่ือถือและ             
มีความสําคัญตอผูถูกชักจูงมาก ก็มีแนวโนมที่จะชวยเพิ่มการรับรูความสามารถของตนเองไดมากข้ึน 

1.4.3.2 การใหขอมูลปอนกลับ  จะสงผลที่สม่ํ า เสมอตอการรับรู
ความสามารถของตนเองโดยการใหขอมูลปอนกลับในทางการใหกําลังใจ การลบลางความเชื่อ
ที่วาตนเองไมมีความสามารถ จะชวยใหบุคคลมีความพยายามซึ่งจะสงผลใหประสบความสําเร็จ
ได และชวยเพิ่มการรับรูความสามารถของตนเองได 

1.4.3.3 การเพิ่มความพยายาม การพูดชักจูงจะชวยใหผูที่ถูกชักจูงเพิ่ม
ความพยายามในการทํางานไดมากข้ึน 

1.4.4 ขอมูลความสามารถทางรางกาย (Physiological Efficacy Information) 
จะตองพิจารณาจากปจจัยตอไปนี้ 

1.4.4.1 ประสบการณเดิม บุคคลที่มีประสบการณวาการตอบสนอง          
ตอส่ิงเราของรางกายตนเองชวยใหการกระทําพฤติกรรมนั้นประสบความสําเร็จ จะมีการรับรู
ความสามารถของตนเองสูงกวาบุคคลที่คิดวาการตอบสนองของรางกายทําใหกระทําพฤติกรรม
นั้นลมเหลว 

1.4.4.2 ระดับของการตอบสนองตอส่ิงเรา ในการตัดสินใจเกี่ยวกับ
ความสามารถของตนเองอยูที่ระดับการตอบสนองตอส่ิงเรา กลาวคือ ถารางกายตอบสนองตอส่ิง
เราในระดับปานกลางจะชวยใหการปฏิบัติงานนั้นมีผลดี ถามีมากหรือนอยเกินไปจะเปนอุปสรรค
ตอการทํางานได 

1.4.4.3 การอนุมานสาเหตุในการตอบสนองตอส่ิงเรา เปนการอางสาเหตุ
ของการตอบสนองวาส่ิงเรานั้นทําใหตนเองเกิดการตอบสนองเพราะอะไร  คนที่มีระดับ
ความสามารถสูงไมวารางกายจะมีการตอบสนองตอส่ิงเราในรูปแบบใดก็จะไมมีผลตอระดับ
ความสามารถของตนเอง แตถาคิดวาการตอบสนองนั้นเปนเพราะตนเองขาดความสามารถก็จะมี
แนวโนมที่จะมีการรับรูความสามารถของตนเองลดลง 

1.4.4.4 ลักษณะทางอารมณ บุคคลที่มีลักษณะทางอารมณตางกัน มีผล
ตอการรับรูความสามารถของตนเองตางกัน 

1.4.5 การรวบรวมขอมูลเกี่ยวกับความสามารถ (Integration of Self-Efficacy 
Information) ในการตัดสินเกี่ยวกับความสามารถของตนเอง นอกจากมีขอมูลหลายๆ รูปแบบแลว       
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ยังตองมีการใหน้ําหนักกับขอมูลเหลานี้ดวย วิธีการกําหนดน้ําหนักใหกับขอมูลจะแตกตางกันไปตาม
ลักษณะของงานที่ทําหรือปจจัยอ่ืนๆ บางคร้ังอาจใชกระบวนการตัดสินธรรมดาเขามาชวยซ่ึง              
จะกอใหเกิดการใหน้ําหนักที่ผิดพลาดหรือมองขามความสําคัญของขอมูลบางตัวไป 

สรุปไดวากระบวนการทางปญญาที่เกี่ยวกับขอมูลของการรับรูความสามารถของ
ตนเอง มีขอมูลที่สงผลตอการรับรูความสามารถของตนเอง ไดแก ขอมูลความสามารถที่ไดจากการ
กระทําขอมูลความสามารถที่ไดจากการเห็นตัวแบบที่ประสบความสําเร็จ  ขอมูลความสามารถ
จากการพูดชักจูง  ขอมูลความสามารถทางรางกาย และการรวบรวมขอมูลเกี่ยวกับความสามารถ 

 

1.5 แหลงของการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1986) กลาววา การรับรูความสามารถของตนเองพัฒนามาจาก

ปจจัยพื้นฐาน 4 ประการ คือ 
1.5.1 ความสําเร็จจากการกระทํา (Enactive Attainment) ถือวาเปนส่ิง                   

ที่มีอิทธิพลมากที่สุด ที่มีผลตอการรับรูความสามารถของตนเอง เนื่องจากเปนประสบการณที่
เกิดข้ึนโดยตรงกับตนเอง เมื่อประสบความสําเร็จหลายคร้ังจะทําใหมีการรับรูความสามารถของ
ตนเองเพิ่มมากข้ึนและจะย่ิงพัฒนาการรับรูใหเขมแข็งข้ึนอีกถามีประสบการณของความสําเร็จ
บอยคร้ังยิ่งข้ึน ดังนั้นเมื่อเกิดเหตุการณที่เปนปญหาหรืออาจจะลมเหลวบางในบางคร้ัง ก็จะมี
ผลกระทบตอการรับรูความสามารถของตนเองนอยมากหรืออาจจะไมมีเลย เพราะบุคคลเหลานี้จะ
มองวาความลมเหลวนั้นมาจากปจจัยอ่ืนๆ ตรงกันขามกับบุคคลที่ทํางานแลวประสบแตความ
ลมเหลวอยูเสมอๆ ซึ่งจะประเมินความสามารถของตนเองตํ่า และมีแนวโนมที่จะแผขยายไปยัง
สถานการณอ่ืนๆ ที่มีลักษณะคลายกัน 

1.5.2 การไดเห็นประสบการณของผูอ่ืน หรือการสังเกตตัวแบบ (Vicarious 
Experience) ซึ่งเปนประสบการณที่ผูอ่ืนประสบความสําเร็จ เมื่อบุคคลไดเห็นตัวอยางพฤติกรรม
ของผูอ่ืนที่มีลักษณะคลายกับตนเองกระทําพฤติกรรมแลวไดรับผลสําเร็จ จะทําใหมีการรับรู
ความสามารถของตนเองเพิ่มข้ึน ซึ่งจะมองวาผูอ่ืนที่ความสามารถเทากันหรือใกลเคียงกับตนเอง
ทําได บุคคลก็สามารถทําไดเชนกัน ในขณะเดียวกัน ถาไดเห็นผูอ่ืนที่มีลักษณะคลายกับตนเอง
ประสบความลมเหลว ก็อาจจะสงผลใหขาดความมั่นใจหรือประเมินความสามารถของตนเอง
ตํ่าลง การรับรูความสามารถของตนเองก็จะเปลี่ยนไป 

1.5.3 การพูดชักจูง (Verbal Persuasion) การพูดชักจูงเปนวิธีที่ใชกันอยาง
แพรหลายท่ีจะทําใหบุคคลเกิดความเชื่อวาเขามีความสามารถที่จะกระทําพฤติกรรมนั้นไดสําเร็จ 
วิธีนี้จะไดผลมากถาพูดในเร่ืองที่เปนไปได  แตถาการพูดชักจูงไมสอดคลองกับความจริงแลวอาจ
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ทํารายผูฟงใหรูสึกลมเหลว ขาดความไววางใจในตัวผูชักจูง  ดังนั้นคนที่จะพูดชักจูงควรเปนคนที่ผู
ถูกชักจูงใหความเชื่อถือไววางใจและมีความสําคัญหรือมีอิทธิพลตอตัวเขาพูดชักจูงไปพรอมๆ กับ
การสรางความสามารถใหกับบุคคลนั้นรวมกัน 

1.5.4 ภาวะทางกายภาพ และอารมณ (Physiological and Affective State) 
บุคคลมักใชขอมูลทางกายภาพในการประเมินความสามารถของตน โดยเฉพาะบุคคลที่ถูกกระตุน
อารมณทางลบ หรือบุคคลที่อยูในสภาพถูกขมขู เกิดความกลัวความวิตกกังวล หรือต่ืนเตน เชน 
การประเมินอาการต่ืนเตนเมื่อตองเผชิญความเครียด หรือสถานการณซับซอนวาเปนสัญญาณ
แสดงวาตนไมมีความสามารถเกิดการรับรูความสามารถตนเองตํ่าทําใหพฤติกรรมไดไมดี 
นอกจากนี้หากมีประสบการณความลมเหลวในอดีตก็จะกระตุนอารมณในทางลบและทําใหการ
รับรูความสามารถของตนเองตํ่าไปดวย  แตถาบุคคลสามารถควบคุมและระงับการถูกกระตุนทาง
อารมณได ทําใหการรับรูความสามารถของตนเองดีข้ึน และสงผลใหแสดงออกถึงความสามารถดี
ข้ึนดวย 

ทั้งนี้แบนดูรา (Bandura, 1986) ไดกลาวอีกวาการรับรูความสามารถของตนเอง
อาจเกิดจากแหลงใดแหลงหนึ่งหรือหลายแหลงรวมกันในน้ําหนักที่แตกตางกัน แหลงที่กอใหเกิด
การรับรูความสามารถของตนเองและผลที่เกิดกับบุคคลสามารถแสดงเปนแผนภาพท่ี 2.2  ดังนี้ 

 
 

 
 
 
 
 
 

 
 
แผนภาพที่ 2.2  แหลงที่มาของความตระหนักถึงความสามารถของตนเองที่มีตอพฤติกรรม 
ที่มา : Bandura, 1986 
 

นอกจากนี้แลวแบนดูรายังไดกลาวตอวาบุคคลที่รับรูความสามารถของตนเองสูง 
จะมีพฤติกรรมที่แสดงถึงการกระทําที่ประสบความสําเร็จ เชน มีการตื่นตัว มีความสามารถจัดการ

ความสําเร็จจากการกระทํา 

การไดเห็นประสบการณของผูอื่น 

การพูดชักจูงจากผูอื่น 

สภาวะทางกายภาพ และอารมณ 

แหลงที่มา 

ความตระหนักถึง
ความสามารถ 
ของตนเอง

พฤติกรรม 

การเลอืกพฤติกรรมหรือ
หลีกเลีย่งไมทําพฤติกรรม

ความพยายามและ
ความยนืหยดัในการทํางาน

แบบแผนความคดิและ
การตอบสนองทางอารมณ
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สถานการณตางๆได มีการกําหนดเปาหมายที่ชัดเจน มีการวางแผนและเตรียมการฝกฝนตนเอง 
สามารถแกปญหาเชิงสรางสรรคไดเรียนรูจากประสบการณลมเหลว เกิดความเครียดตํ่าและสังเกต
ความสําเร็จจากผูอ่ืน  สวนบุคคลที่มีการรับรูความสามารถของตนเองตํ่า จะมีพฤติกรรมที่แสดง
การกระทําที่ลมเหลว เชน เฉยชา หลีกเล่ียง งานยาก ขาดแรงจูงใจ คาดการณถึงความลมเหลว 
ขาดความพยายาม ขาดความกระตือรือรน วิตกกังวล เกิดความเครียด คิดแตคําแกตัว โทษความ
พายแพลมเหลว 

สรุปไดวาแหลงที่มาของการรับรูความสามารถของตนเองมีเหตุปจจัยมาจาก             
4 แหลง คือ ความสําเร็จจากการกระทํา การไดเห็นประสบการณของผูอ่ืน การพูดชักจูงผูอ่ืนและ
สภาวะทางกายและอารมณของตนเอง 

 

1.6 มิติของการรับรูความสามารถของตนเอง  
แบนดูรา (Bandura, 1977) กลาววา ลักษณะของการรับรูเกี่ยวกับความสามารถของแต

ละคนนั้นอาจแตกตางกัน ข้ึนอยูกับมิติ 3 มิติ ดังนี้ 
1.6.1 มิติเกี่ยวกับขนาด (Magnitude) หมายถึง ปริมาณความยากงายของงาน         

ที่บุคคลเช่ือวาตนสามารถปฏิบัติได ซึ่งจะแตกตางกันไปในแตละบุคคลในการกระทําพฤติกรรม
หนึ่งๆ หรือแตกตางกันในบุคคลเดียวกันเม่ือตองทําพฤติกรรมที่มีความยากงายแตกตางกัน 

1.6.2 มิติเกี่ยวกับการแผขยาย (Generality) หมายถึง ระดับความคาดหวัง
เกี่ยวกับความสามารถของตนเองในการนําไปปฏิบัติในสถานการณนั้น ซึ่งประสบการณ           
การปฏิบัติงานบางอยางกอใหเกิดความสามารถในการนําไปปฏิบัติในสถานการณอ่ืนที่คลายคลึง
กัน แตในปริมาณที่แตกตางกัน 

1.6.3. มิติเกี่ยวกับความเขม (Strength) หมายถึง ความมั่นใจที่บุคคลคิดวาตน
สามารถทํางานไดที่ระดับความยากตางๆ 

สรุปไดวามิติของการรับรูความสามารถของตนเองน้ันข้ึนอยูกับมิติ 3 มิติ คือ           
มิติเกี่ยวกับขนาด การแผขยายและความเขม 

 

1.7 การวัดการรับรูความสามารถของตนเอง  
ลีและบ็อบโก (Lee & Bobko, 1994) ไดรวบรวมงานวิจัยเกี่ยวกับการวัดการรับรู

ความสามารถของตนเองตามแนวทฤษฎีของแบนดูรา(Bandura, 1977) ที่วาการรับรูความสามารถ
ของตนเองเก่ียวของกับสถานการณเฉพาะ และประกอบดวย 3 มิติ คือ มิติเกี่ยวกับขนาดความ
ยากของงาน มิติเกี่ยวกับการแผขยาย และมิติเกี่ยวกับความเขม ในการวัดการรับรูความสามารถ
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ของตนเองที่จะนําเสนอตอไปนี้ไมวาจะใชวิธีใดก็ตาม คะแนนที่ไดจะมีความสัมพันธกับพฤติกรรม
หรือการปฏิบัติงานของบุคคล ซึ่งบุคคลจะถูกประเมินเกี่ยวกับการปฏิบัติงานตางๆ โดยมีวิธีการวัด
การรับรูความสามารถของตนเองดังนี้ 
  1.7.1 การวัดความเขม (Self – Efficacy Strength) เปนวิธีที่นํามาใชวัดการรับรู
ความสามารถของตนเองมากที่สุด วิธีการวัดทําไดโดยการถามผูตอบถึงความมั่นใจวาเขาสามารถ
ปฏิบัติงานท่ีมีความยากของงานเพ่ิมข้ึนไดเพียงใด ขอคําถามมักมีลักษณะใหประเมินความมั่นใจ
จากไมมีความม่ันใจ (0) จนถึงมีความมั่นใจเต็มที่ (10) หรืออาจทําโดยใชมาตราสวนแบบอื่นๆ           
ก็ได เชน จาก 0% ถึง 100% 

1.7.2. การวัดขนาด (Self – Efficacy Magnitude) เปนวิธีที่นิยมนํามาใชวัดการ
รับรูความสามารถของตนเองรองลงมาจากการวัดความเขม วิธีการวัดจะทําโดยการถามผูตอบวา
เขาสามารถปฏิบัติงานที่กําหนดใหที่มีความยากข้ึนไดหรือไม ซึ่งคําถามมักจะมีลักษณะเปนมา
ตราสวนชนิด ใช/ไมใช (yes/no scale) คําตอบ “ใช” จะมีคะแนน 1 คะแนน คําตอบ “ไมใช”              
จะมีคะแนน 0 คะแนน ดังนั้นหากไดคะแนนสูงแสดงวามีการรับรูความสามารถของตนเองสูง 

1.7.3 การวัดแบบผสม คือ การวัดที่ใชวัดทั้งความเขมและขนาดของความยาก 
โดยใชขอคําถามเดียวแตมีคําตอบแยกกันเปน 2 ชอง ชองหนึ่งเปนแบบ ใช/ไมใช สวนอีกชองหนึ่ง
จะเปนมาตราสวนประเมินคาหรือใชประเมินเปนรอยละ การรวมคะแนนทําโดยการรวมคะแนน
ของความเขมเฉพาะขอที่ผูตอบตอบวา “ใช” 

1.7.4 เปนวิธีวัดความเขมและขนาดของความยากเหมือนกับวิธีที่ 3 แตมีขอ
แตกตางกัน คือ แปลงคะแนนดิบ (Raw Score) ใหเปนคะแนนฐาน (Z Score) 

1.7.5 การวัดความเขมโดยใชขอคําถามเพียงขอเดียวเกี่ยวกับงานที่กําหนดแลว
ใหผูตอบประเมินคาระดับความมั่นใจของตนเองตอการทํางานที่กําหนดนั้น 

เทเลอรและคณะ ไดกลาววาในการวัดการรับรูความสามารถของตนเอง บุคคลจะ
ถูกขอใหประเมินเกี่ยวกับการปฏิบัติงานดานตางๆ แตปญหาที่เกิดข้ึนคือ พบวาความสัมพันธ
ระหวางการรับรูความสามารถของตนเองกับผลการปฏิบัติงานมีคาความสัมพันธกันนอย                    
ซึ่งอาจจะมีสาเหตุ ดังนี้ 

1. การปฏิบัติงานเฉพาะอยางมีความเกี่ยวของกับการรับรูความสามารถ
ของตนเองนอย เชน งานที่เกี่ยวกับการเส่ียงโชคตางๆ 
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2. มิติของงานทําใหการวัดการรับรูความสามารถของตนเองของบคุคลได
ไม ดี  เชน  ระดับความยากของงานมีความแตกตางกันนอยเกินไปทําใหการวัดการรับรู
ความสามารถของตนเองไมแตกตางกัน 

 3. สถานการณบางอยางทําใหความแมนยําในการประเมินการรับรู
ความสามารถของตนเองลดลง เชน งานนั้นยังใหมสําหรับบุคคลนั้น 

โดยสรุปแลวการวัดความการรับรูความสามารถของตนเองสามารถวัดได
โดยวัดความเขม วัดขนาด วัดแบบผสม วัดโดยแปลงคะแนนดิบเปนคามาตรฐาน และวัดแบบเขม
โดยใชขอคําถามเพียงขอเดียว 

 

1.8 คุณลักษณะของบุคคลที่มีการรับรูความสามารถของตนเอง 
โยเดอรและพรอกเตอร (Yoder and Proctor, 1988); กรรณิการ จิตตบรรเทา (2539); 

อัจฉรา เนตรลอมวงศ (2531) กลาววา บุคคลที่มีการรับรูความสามารถของตนเองจะมีคุณลักษณะ
และแนวคิดดังนี้ 

1.8.1 ปฏิบัติหนาที่ในความรับผิดชอบไดครบถวนการกลารับผิดชอบเม่ือกระทําผิด 
1.8.2 แสดงพฤติกรรมดวยการกระทํา และคําพูดที่เหมาะสมในสถานการณตางๆ 

ทั้งในและนอกหองเรียน ในลักษณะตางๆ 
1.8.3 มีความเชื่อมั่นในการกระทําของตนเอง และม่ันใจวาจะประสบความสําเร็จ

ในส่ิงที่ไดกระทํา 
1.8.4 ยึดถือความเช่ือของตนเองอยางมั่นคง มีเหตุผล ไมคลอยตามผูอ่ืนโดย

ปราศจากการไตรตรอง 
1.8.5 มีความคลองตัวสูง มีความกระตือรือรนอยูเสมอ 
1.8.6 ทํางานรวมกับผูอ่ืนไดดี มีความสามารถในการปรับตัวเขากับส่ิงแวดลอม 
1.8.7 รับบทบาทผูนําโดยปราศจากการลังเล คาดหวังวาจะไดเปนผูนําในบาง

โอกาส 
1.8.8 ไมหลีกเล่ียงปญหา และมีความสามารถในการแกปญหาเฉพาะหนาไดดี 
1.8.9 กลาแสดงความสามารถและความคิดเห็นของตนเอง หรือกลาซักถามขอ

สงสัยตางๆ 
1.8.10 การพึ่งตนเองในการแกปญหาดวยความสามารถของตนเอง 
1.8.11 มีความคิดริเร่ิมสรางสรรค และเปนมิตรกับผูอ่ืนไดงาย 
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แบนดูรา (Bandura, 1997) กลาววา ผูเรียนที่มีระดับการรับรูความสามารถของ
ตนเองจะมีคุณลักษณะเฉพาะไดแก การมีสวนรวมในการเรียนอยางเต็มใจ ทํางานอยางเต็ม
ความสามารถมีความเพียรที่ตอเนื่อง มีการตอบสนองทางอารมณทางลบในระดับนอยเมื่อประสบ
กับเหตุการณที่ยากกวาความสามารถที่มีอยู 
  โดยสรุปแลวคุณลักษณะของบุคคลที่มีการรับรูความสามารถของตนเองมักจะ         
มีลักษณะ มีความรับผิดชอบ มีความเชื่อมั่นในตนเอง มีความกระตือรือรน ทํางานรวมกับผูอ่ืนไดดี 
กลาแสดงออก สามารถพึ่งพาตนเองได 

 

1.9 การรับรูความสามารถดานคอมพิวเตอรของตนเอง  
เบคเกอรและชมิทซ (Beckers and Schmidt , 2001) เสนอปจจัย 6 ขอที่สงผลตอการรับรู

ความสามารถของตนเองเก่ียวกับคอมพิวเตอร คือ ความรูเกี่ยวกับคอมพิวเตอร (Computer 
literacy), สภาวะรางกายที่สนองตอคอมพิวเตอร (physical arousal in response to 
computers), อารมณที่มีตอคอมพิวเตอร (affective feeling about them), ความเชื่อในประโยชน
ของคอมพิวเตอร (beliefs about beneficial effects of computers), และผลตอคุณคาความเปน
มนุษย (beliefs about their purported dehumanizing effects) 

คอมโปและฮิกกิ้นส (Compeau & Higgins,1995) พบวาการรับรูความสามารถตนเองใน
การใชคอมพิวเตอรมีผลตอความคาดหวังเกี่ยวกับผลสําเร็จในอนาคตจากการใชคอมพิวเตอร เชน
ในอาชีพการงานและการประสบผลสําเร็จของบุคคล 

นอกจากนี้ ฮิล,สมิทซและมานน (Hill, Smith and Mann, 1987) พบวาประสบการณและ
รูปแบบของประสบการณเปนปจจัยสําคัญที่มีผลตอการรับรูความสามารถตนเองในการใช
คอมพิวเตอรมากกวาระยะเวลาที่ใช 

รอส, โฮกาโบม เกรยและฮันเนย (Ross, Hogaboam-Gray and Hannay 2001) ทําการ
ทดสอบโดยใหนักเรียนยายหองเรียนโดยเปล่ียนครูผูสอนคอมพิวเตอรที่มีการรับรูความสามารถ
ตนเองตางกัน ปรากฎวานักเรียนเรียนดีข้ึนและมีการรับรูความสามารถตนเองสูงข้ึนเมื่อไดเรียนกับ
ครูที่มีความมั่นใจในทักษะการใชคอมพิวเตอรของตัวเอง 

โดยสรุปแลวการรับรูความสามารถของตนเองดานคอมพิวเตอร เกิดจากความรูที่ตนเองมี
เกี่ยวกับคอมพิวเตอรซึ่งอาจจะมาจากประสบการณเดิมหรือไดเห็นจากผูอื่น  สภาวะอารมณใน
ขณะนั้น  ความเชื่อในประโยชนของคอมพิวเตอรและที่มีตอมนุษย 
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ตอนท่ี 2 แนวคิด ทฤษฎีที่เกี่ยวกับการต้ังเปาหมาย 
ในตอนสองเปนแนวคิดทฤษฎีที่เกี่ยวของกับการต้ังเปาหมายประกอบดวยสาระสําคัญ 

ไดแก ทฤษฎีการต้ังเปาหมาย ความหมายของการต้ังเปาหมาย คุณสมบัติของเปาหมาย ผลของ
การกลไกการต้ังเปาหมาย อิทธิพลของการต้ังเปาหมาย  ประเภทของเปาหมาย ซึ่งไดแก เจตคติใน
การทํางาน ความมุงม่ันในการทํางาน เปาหมายเพื่อผลประโยชนในอนาคต เปาหมายเพื่อตองการ
รางวัลจากภายนอกเหนือไดรับการยกยองและเปาหมายเพื่อการไดยอมรับทางสังคม ความผูกพัน
ตอเปาหมาย ซึ่งประกอบไปดวย ความหมายของความผูกพันตอเปาหมาย การวัดความผูกพันตอ
เปาหมายและบริบทของความผูกพันตอเปาหมาย 
  

2.1 ทฤษฎีการต้ังเปาหมาย 
กระบวนการตั้งเปาหมายมีพื้นฐานมาจากทฤษฎีการเรียนรูทางปญญาสังคม (Social 

Cognitive Theory) ของแบนดูราที่เช่ือวาพฤติกรรมของบุคคลเกิดข้ึนและเปล่ียนแปลงเนื่องจาก
กําหนดซึ่งกันและกัน ขององคประกอบ 3 อยาง คือ องคประกอบทางปญญา และสวนบุคคล (P) 
องคประกอบทางพฤติกรรม (B) และองคประกอบทางสภาพแวดลอม (E)  นั้นคือ พฤติกรรมของ
บุคคลเกิดข้ึนและมีการเปลี่ยนแปลงเนื่องจากปจจัยทางสภาพแวดลอมและปจจัยสวนบุคคล              
ที่กําหนดซึ่งกันและกันกับปจจัยทางดานพฤติกรรมและสภาพแวดลอม (Bandura, 1986) อางถึง
ใน สมโภชน เอ่ียมสุภาษิต, 2536)  ซึ่งเมื่อพิจารณาแลวปจจัยจากสวนบุคคลจะมีเปาหมายเปน
ตัวกําหนดทิศทางของพฤติกรรม ถาบุคคลใดมีเปาหมายบุคคลนั้นก็จะเกิดแรงจูงใจที่จะทํา
พฤติกรรมนั้นมาก ข้ึนไปดวย  ซึ่ งทฤษฎีการเ รียน รูปญญาทางสังคมตามแนวคิดของ 
Bandura(1977) เชื่อวา แรงจูงใจมีรากฐานมาจากปจจัยสวนบุคคล 2 สวนไดแก  
  2.1.1 ความสามารถในการคาดหวังผลการกระทําในอนาคต ซึ่งจะเปนแรงจูงใจ
ในการกระทําพฤติกรรมตางๆ 
  2.1.2 กระบวนการตั้งเปาหมายและการประเมินตนเอง แรงจูงใจนี้เร่ิมเกิดจาก
การเปรียบเทียบระหวางผลงานที่บุคคลนั้นทําไดกับเปาหมายที่ ต้ังข้ึนมา ถาผลงานที่ทําไม
สอดคลองกับเปาหมายที่ต้ังข้ึน จะทําใหเกิดความรูสึกไมพอใจในตนเอง ซึ่งมีผลในการผลักดันให
บุคคลนั้นใชความพยายามมากข้ึน  แตถาบุคคลนั้นประสบความสําเร็จตามเปาหมายที่ตนต้ังไว 
จะเกิดความพึงพอใจในตนเองและทําใหบุคคลนั้นมีแนวโนมที่จะใชความพยายามตอไป 

เอดวิน เอ ล็อค และแกรี พีลาแธม ไดสรางทฤษฎีการต้ังเปาหมายเมื่อป 1990 ไว
วา มีความเหนือกวาทฤษฎีความคาดหวังในดานที่เนนเปาหมายของความคิดแตละคนเพื่อนําไปสู
การสรางพฤติกรรม โดยมีความเชื่อวาแตละคนจะมีแรงจูงใจที่มีความมุงมั่นและเฉพาะเจาะจงใน
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การไปสูเปาหมายตามที่ไดต้ังเอาไว  (Kanfer,1994, cited in Haslam, 2001) การนําเปาหมายมา
ใชในการจูงใจเปนแนวทางท่ีไดรับความนิยมมากที่สุด เพราะมีความสัมพันธกับความปรารถนา  
หรือความตองการของแตละบุคคล ไปสูความต้ังใจและกอใหเกิดพฤติกรรมที่ตอบสนองความ
ตองการ ดวยวิธีการที่ใหบุคคลเขามามีสวนรวมในการต้ังเปาหมาย ในขณะท่ีบางคนกลาวไววา
วิธีการนี้เปนวิธีการที่ผิวเผินเกินไปและคงอยูไดไมนาน (Kelly,1991, cited in Haslam, 2001) 
เปาหมายที่มีความแตกตาง บวกกับแรงจูงใจที่แตกตาง และความรูความสามารถที่ตนมี จะได
ผลลัพธเปนส่ิงที่สามารถชวยใหคนสรางงานที่เกิดจากความคิดของตนเอง (Task self Inventory) 

ทฤษฎีการตั้งเปาหมายของล็อค (Locke’s Goal Setting Theory) เปนทฤษฎี          
ที่มีการนํามาใชโดยมีงานวิจัยและทําการวิเคราะหเมตา จํานวนมากที่สรุปถึงผลลัพธเชิงบวกของ
การนําทฤษฎีการตั้งเปาหมายไปใชใหเกิดผลการปฏิบัติงานที่ดีข้ึน(ล็อคและลาแธม, 1990)                  
เปนเทคนิคการจูงใจแบบหนึ่งโดยมีเปาหมายของบุคคลเปนจุดเ ร่ิมตนรวมกับการรับรู
ความสามารถของตนเอง ทําใหเกิดพฤติกรรมที่สงผลตอการทํางาน โดยมีตัวแปรกํากับ คือ ความ
ผูกพันตอเปาหมาย การไดรับการตอบกลับ ความสามารถ ความยุงยากในงาน และสถานการณ
ตางๆที่เกี่ยวของ ดังแผนภาพที่ 2.3 

 
 

 
 
 
 

 
 
 
 
แผนภาพที่ 2.3 ความสัมพันธระหวางเปาหมาย การรับรูความสามารถในตนเองตัวแปรกํากับ 

และผลการปฏิบัติงาน   
ที่มา : Schermerthorn, Hunt & Osborn, 2006 
 

 สรุปไดวาการต้ังเปาหมาย การรับรูความสามารถ สามารถสงผลตอความพยายาม             
ความอดทน ทิศทาง กลยุทธงานหรือแผนการ ที่มีผลตอผลการปฏิบัติงานโดยมีตัวแปรกํากับ คือ 

เปาหมายท่ีมีความยาก 
เปาหมายท่ีมีความเฉพาะเจาะจง 

การรับรูความสามารถของตนเอง 
ในระดับสูง  ความคาดหวังสูง 

มีความเก่ียวของกับกลไกตางๆ 
- ความพยายาม 
- ความอดทน 
- ทิศทาง 
- กลยุทธในงานหรือแผนการ 

ตัวแปรกํากับ(Moderator) 
- ความผูกพันตอเปาหมาย 
- การตอบรับ 
- ความสามารถ 
- ความยุงยากของงาน 
- สถานการณท่ีเก่ียวของ 

ผลการปฏิบัติงาน
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ความผูกพันตอเปาหมาย การตอบรับ ความสามารถ ความยุงยากของงานและสถานการณที่
เกี่ยวของ 

 

2.2 ความหมายของการต้ังเปาหมาย 
แบนดูรา (Bandura, 1986) ไดกลาววา การตั้งเปาหมาย หมายถึง การกําหนดเปาหมาย 

หรือการกําหนดเกณฑในการแสดงพฤติกรรมใดพฤติกรรมหนึ่งที่ตองการเปล่ียนแปลงซ่ึงทําให
บุคคลทราบพฤติกรรมที่จะตองกระทําอยางชัดเจน และใชเปนเกณฑในการประเมินเปรียบเทียบ
พฤติกรรมที่กระทําจริงกับพฤติกรรมที่กําหนดไววา พฤติกรรมนั้นมีการเปลี่ยนแปลงในลักษณะ
เชนใด เพื่อใชเปนขอมูลปอนกลับในการแสดงปฏิกิริยาตอตนเองทั้งทางบวกและทางลบตอไป 
 คอกซ (ธนากร ศรีชาพันธ, 2539; อางอิงจาก Cox, 1994) กลาววา ผูไดรับการฝกเกี่ยวกับ
การต้ังเปาหมายในการแสดงทักษะ จะมีโอกาสประสบความสําเร็จมากกวาผูที่ไมไดรับการฝกการ
ต้ังเปาหมาย 

รูอิลารด (Rouillard, 1995) ใหความหมายของเปาหมายวาเปนผลสรุปที่เกิดจากความ
พยายามที่ชัดเจนของคุณ 
 ราชบัณฑิตยสถาน (2542) ใหความหมายของเปาหมายวา หมายถึง บุคคลหรือส่ิงที่ใช
เปนเปาแหงการโจมตี หรือเปนศูนยกลางแหงความใสใจหรือสังเกต หรือเปนความมุงหมายเจาะจง
ใหไดตามเจตนา 
 สรุปไดวาการต้ังเปาหมาย หมายถึง การกําหนดเปาหมายที่จะนําไปสูการแสดงพฤติกรรม
อยางใดอยางหนึ่ง ซึ่งจะทําใหบุคคลนั้นไดเปล่ียนแปลงพฤติกรรมที่ตองกระทําอยางชัดเจน ซึ่งผูที่
มีการตั้งเปาหมายจะมีโอกาสประสบความสําเร็จในเปาหมายนั้นมากกวาผูที่ไมไดมีการ
ต้ังเปาหมาย 

 

2.3 คุณสมบัติของเปาหมาย  
เปาหมาย (Goal) คือส่ิงที่คนพยายามที่จะบรรลุโดยผานพฤติกรรมและการกระทํา Goal 

Setting Theory) เนนไปที่การจูงใจบุคคลเพื่อใชในการปฏิบัติงาน และยังเนนอีกวา การปฏิบัติงาน
ที่ทําไปนั้นจะตองไดมาซึ่ง การบรรลุผลสําเร็จ ของงานอันเปนที่ยอมรับในระดับหนึ่ง 

คุณสมบัติของเปาหมายนั้น แบนดูรา (Bandura, 1986) กลาววา คุณสมบัติของเปาหมาย
เปนตัวกําหนดเงื่อนไขการกระทําพฤติกรรมที่เกี่ยวกับการใชความพยายาม และการจูงใจในการ
ทํางาน ซึ่งมีคุณสมบัติ ดังนี้ 
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2.3.1 เปาหมายที่มีลักษณะเฉพาะเจาะจง เปนเปาหมายที่กําหนดข้ึนอยาง
ชัดเจนวาพฤติกรรมใดที่บุคคลตองทํา และควรปฏิบัติอยางไร เปาหมายนี้จะทําใหเกิดแรงกระตุน
และชี้แนะในการทําพฤติกรรม ซึ่งสงผลตอความพอใจในตนเอง และการรับรูความสามารถของ
ตนเอง 
  2.3.2 เปาหมายที่มีลักษณะทาทาย ระดับของเปาหมายมีผลตอปฏิกิริยาของ          
ผูปฏิบัติเองและความพยายามที่ใช หากบุคคลทํางานที่ทาทายสําเร็จตามเปาหมายบุคคลนั้นก็          
จะเกิดความพอใจและความพยายามมากข้ึน ในการตั้งเปาหมายที่ทาทายนี้ควรเปนเปาหมายท่ี
ใกลเคียงกับความเปนจริงไมงายหรือยากจนเกินไป 
  2.3.3 เปาหมายระยะส้ัน  มีผลตอแรงจูงใจของบุคคลและความคาดหวังใน
ความสามารถของตนเอง เพราะเปาหมายนี้ควบคุมการกระทําพฤติกรรมไดใกลชิดกวา ทําให
บุคคลไดพบกับความสําเร็จรวดเร็วข้ึน และไดขอมูลจากการปฏิบัติชัดเจนกวาดวย 
  2.3.4 เปาหมายที่สอดคลองกับความเปนจริง ชี้ใหเห็นถึงความกาวหนาและ
ตัดสินประสิทธิภาพของงานท่ีบุคคลปฏิบัติ การตั้งเปาหมายที่สูงเกินไปหรือตํ่าเกินไป ไมกอใหเกิด
ประโยชนตอแรงจูงใจ 

คุณสมบัติของการต้ังเปาหมายนี้ แรนด (Rand, 1967) อางถึงใน สุธีรา นิมิตรนิวัฒน 
2537) ไดกลาวสนับสนุนวา กระบวนการต้ังเปาหมายที่ดีตองคํานึงถึงความเฉพาะเจาะจง ความ
ยากของงานและเปาหมาย  การต้ังเปาหมายที่ชัดเจนและทาทายจะชวยสงเสริมใหผูเรียนมี
ความสามารถทางการเรียนสูงข้ึน 

สรุปไดวาคุณสมบัติของเปาหมาย คือตัวกําหนดเงื่อนไขในการกระทําพฤติกรรม ซึ่งมี
คุณสมบัติไดแก เปาหมายที่มีลักษณะเฉพาะเจาะจง มีลักษณะทาทาย มีระยะส้ันและสอดคลอง
กับความเปนจริง 

 

2.4 ผลของกลไกการต้ังเปาหมาย  
การต้ังเปาหมายในการกระทําพฤติกรรมมีผลตอแรงจูงใจ การรับรูความสามารถของ

ตนเอง และมีผลตอความสนใจเพิ่มข้ึน (Bandura, 1986) ดังนี้ 
  2.4.1 ผลตอแรงจูงใจ การต้ังเปาหมายในการกระทําพฤติกรรม มักทําใหบุคคลมี
แรงจูงใจทจะกระทําพฤติกรรมเพิ่มข้ึน โดยมีแนวโนมที่จะใชความพยายามในการกระทําเพื่อให
บรรลุตามเปาหมายที่ต้ังไวมากข้ึน ตามกระบวนการของการต้ังเปาหมายที่มีการกําหนดเปาหมาย
ดวยตนเอง  การไดรับขอมูลปอนกลับ และการประเมินตนเอง ซึ่งการต้ังเปาหมายดวยตนเอง 
(self-set goal) เปนกระบวนการที่บุคคลสรางเกณฑข้ึนมา เพื่อประเมินการกระทําดวยตนเอง ทํา
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ใหไดเปาหมายที่มีความเหมาะสมกับระดับความสามารถ รวมทั้งบุคคลรูสึกวาเปนผูกําหนดและ
ตัดสินใจดวยตนเอง จึงสงผลตอการยอมรับเปาหมายและการใชความพยายามที่จะบรรลุ
เปาหมายที่ต้ังข้ึน ซึ่งจะยังทําใหเขาตองรับผิดชอบและปรับปรุงผลการทํางานของตนเองใหมี
ความกาวหนา ในทางตรงกันขาม เปาหมายที่บุคคลอ่ืนกําหนดให เปนการแทรกลักษณะของการ
ควบคุม หรือกําหนดใหบุคคลตองทําบางส่ิงบางอยาง   
  2.4.2 ผลตอการรับรูความสามารถของตนเอง การบรรลุเปาหมายทําใหบุคคล
รับรูวาตนนั้นมีความสามารถสูงข้ึนเพียงใด อันสงผลตอการใชความพยายามในการปฏิบัติงานนั้น 
  2.4.3 ผลตอความสนใจเพิ่มข้ึน ซึ่งสืบเนื่องมาจากบุคคลนั้นมีประสบการณที่
พอใจในการบรรลุตามเปาหมายที่ตนต้ังเอาไว การต้ังเปาหมายที่เปดโอกาสใหบุคคลไดแสดง
ความสามารถและความพยายามในการลดความไมสอดคลองระหวางการกระทํากับเปาหมาย             
จะมีผลตอความสนใจเพิ่มข้ึน 
 การตั้งเปาหมาย ไดถูกนํามาใชในองคการไมเพียงแตเพื่อผลักดันระดับของผลการ
ปฏิบัติงานที่พนักงานไดรับการจูงใจใหมอบใหกับงานและองคกร แตยังชวยทําใหแนใจวา ผลการ
ปฏิบัติงานสามารถนําไปสูเปาหมายในอนาคตขางหนา  ทฤษฎีการต้ังเปาหมายไดอธิบายถึงชนิด
ของเปาหมายที่มีประสิทธิผลที่สุดในการสรางแรงจูงใจและผลการปฏิบัติงาน เปาหมายชนิดไหน
นําไปสูแรงจูงใจและผลการปฏิบัติงานที่ดี ตามทฤษฎี มีปจจัยที่สําคัญ 2 อยาง คือ ความ
เฉพาะเจาะจง (specificity) และความยาก (difficulty) ซึ่งเมื่อใชรวมกันแลว จะนําไปสูระดับของ
แรงจูงใจและผลสําเร็จของงานท่ีสูงข้ึนความเฉพาะเจาะจงของเปาหมาย (Specific goal) จะไป
นําไปสูผลการปฏิบัติงานไดดีกวาเปาหมายที่คลุมเครือ  
 ความยากในการบรรลุเปาหมาย (Difficulty Goal) จะนําไปสูแรงจูงใจและผลการ
ปฏิบัติงานที่สูงกวาเปาหมายกลางๆ  คือเปาหมายที่ยากแตไมใชวาเปนไปไมไดสําหรับบุคคล
สวนมากที่จะทําได ในทางปฏิบัติบุคคลก็สามารถบรรลุเปาหมายงายๆไดอยูแลว ขอเสนอของ 
Goal-setting theory ก็คือ เปาหมายที่ระบุชัดเจนและยากจะนําไปสูแรงจูงใจและผลการ
ปฏิบัติงานที่สูงกวาเปาหมายที่งาย กลางๆ ไมชัดเจน หรือไมมีขอบเขตของเปาหมายเลย  และยังมี
งานวิจัยอีกมากมายที่สนับสนุนขอเสนอของทฤษฎีนี้ และยังพบดวยวาแรงจูงใจและผลการ
ปฏิบัติงานที่มาจากการตั้งเปาหมายนั้นแตกตางกันในแตละวัฒนธรรมดวย 
 ส่ิงสําคัญก็คือเมื่อผูบริหารหรือผูนําไดต้ังเปาหมายเอาไวแลว ผูที่อยูใตบังคับบัญชา
จะตองยอมรับในเปานั้นดวย และยังตองมีขอผูกมัดทางใจที่จะตองไปใหถึงเปาหมายนั้นใหได  ซึ่ง
บางคร้ังผูบริหารและบุคคลอาจะตองมีการตั้งเปาหมายรวมกัน (participate in goal setting) เพื่อ
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เพิ่มการยอมรับและความผูกพัน (Commitment) ในเปาหมายนั้นดวย  การมีความเชื่อในตัวบุคคล
วาเขาสามารถทําพฤติกรรมบางอยางใหเปนผลสําเร็จสูง (self-efficacy) ยังเปนส่ิงยืนยันไดวา
บุคคลนั้นจะมีแรงจูงใจที่จะทําเปาหมายที่ยาก ความเช่ือนี้นําไปสูการยอมรับ ความผูกพันตอ
เปาหมาย และแรงจูงใจที่จะบรรลุเปาหมาย และ goal setting จะไดผลที่สุดเมื่อบุคคลนั้นได
รับทราบผลสะทอนจากการทํางานของตนวาเขาทํางานเปนอยางไร ดังแผนภาพที่ 2.4 ไดแสดง
ความคาดหวัง  การต้ังเปาหมาย และผลการปฏิบัติงานวามีความสัมพันธกันทั้งสามปจจัย 

 
 
 
 
 
 
 

 
 
แผนภาพท่ี 2.4 ความสัมพันธระหวางการรับรูความสามารถตนเอง (Self-efficacy) การ

ต้ังเปาหมายดวยตนเอง (Self-set Goal) และผลการปฏิบัติงาน 
(Performance) 

ที่มา : Locke and Latham, 1990 
 

จากภาพสรุปไดวา ความคาดหวังและการรับรูความสามารถตนเองสงผลใหเกิดการ
ต้ังเปาหมายในบุคคลและผลการปฏิบัติ  การต้ังเปาหมายสวนบุคคลก็สงผลตอผลการปฏิบัติงาน
ดวยเชนกัน 

ซึ่งผลที่เกิดจากกลไกการต้ังเปาหมาย ไดแก ผลตอแรงจูงใจ ผลตอการรับรูความสามารถ
ของตนเองและผลตอความสนใจของตนเองที่เพิ่มข้ึน ซึ่งการต้ังเปาหมายไดถูกนํามาใชในทุก
องคการเพื่อเปนแรงผลักดันและแรงจูงใจใหกับคนในหนวยงานนั้นๆ 

 

2.5 อิทธิพลของการต้ังเปาหมาย   
การต้ังเปาหมายมีอิทธิพลตอพฤติกรรม และสงผลตอการทํางานของบุคคล ดังนี ้
 

0.39
ความคาดหวัง ((Expectancy) 

การรับรูความสามารถตนเอง (Self-efficacy)

การต้ังเปาหมายสวนบุคคล 
(Personal Goal, self – set)

0.39 
0.42

ผลการปฏิบัติงาน 
(Performance) 
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  2.5.1 อิทธิพลของการต้ังเปาหมายที่มีตอพฤติกรรม 
อิทธิผลของการต้ังเปาหมายที่มีผลตอพฤติกรรมนี้ล็อค (Lock, 1981) ไดอธิบาย

ใน 4 ลักษณะ คือ 
   2.5.1.1 การกําหนดทิศทาง การต้ังเปาหมายทําใหบุคคลสามารถกาํหนด
ทิศทางการกระทําไดสอดคลองกับเปาหมาย 
   2.5.1.2 ความพยายาม เปนส่ิงที่เกิดข้ึนไดพรอมๆกับการกําหนดทิศทาง
ตามสัดสวนที่บุคคลรับรูวาตนมีความตองการในเปาหมายเพียงใด นั้นคือ หากนักเรียนมีความ
ตองการบรรลุเปาหมายที่ทาทาย  เขาตองเพิ่มความพยายามและความต้ังใจมากกวา                      
การต้ังเปาหมายที่งายหรือไมมีเปาหมาย 
   2.5.1.3 ความคงทน เปนระดับของความเพียรพยายามท่ีเพิ่มมากข้ึน  
เมื่อเวลาผานไป ดังนั้น ความคงทน จึงเปนการนําเอากลไกทั้งสองดังที่กลาวแลวมารวมกัน 
   2.5.1.4 การพัฒนากลยุทธ กลไกทั้งสามอยาง อันไดแก ทิศทาง การใช
ความพยายาม และความคงทนเปนผลโดยตรงจากการต้ังเปาหมาย ในขณะที่การพัฒนากลยุทธ 
ห รือวางแผนเพื่ อ ให เป าหมายบรร ลุผล  เปนผลโดยทางอ อมจากการ ต้ั ง เป าหมาย  
กระบวนการพัฒนากลยุทธเปนสวนประกอบสําคัญในปญญาทําใหเกิดการพัฒนาทักษะ หรือการ
แกปญหาเชิงสรางสรรค เมื่อบุคคลไดต้ังเปาหมายแลว เขาก็จําเปนตองวางแผนและจัดระบบการ
ทํางาน 

2.5.2 อิทธิพลของเปาหมายที่มีผลตอการทํางานของบุคคล 
อิทธิพลของเปาหมายที่มีผลตอการทํางานของบุคคลนี้ล็อคและลาแธม(Lock  

and Latham, 1990) ไดกลาวถึง ดังนี้ 
   2.5.2.1 เปาหมายทําใหบุคคลตองใชความพยายามและเพิ่มความ
พยายามมากข้ึน 
   2.5.2.2 เปาหมายกระตุนใหบุคคลมีความคงทนในการทํางาน 
   2.5.2.3 เปาหมายทําใหบุคคลมุงความสนใจไปที่กิจกรรมที่เกี่ยวกับ
เปาหมาย 
   2.5.2.4 เปาหมายทําใหบุคคลนําความรูหรือทักษะที่มีอยูแลวมาใชเพื่อ
ความสําเร็จ 
   2.5.2.5 เปาหมายจูงใจใหบุคคลคนหายุทธวิธีในการทํางานที่เหมาะสม 
วางแผนและใชยุทธวิธีนั้น 
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   2.5.2.6 เปาหมายทําใหผลการทํางานมีคุณคายิ่งข้ึน 
   2.5.2.7 เปาหมายทําใหบุคคลทราบคุณภาพในการทํางาน 
   2.5.2.8 เปาหมายระดับสูงทําใหบุคคลรูสึกพึงพอใจในตนเอง 

สรุปไดวาอิทธิพลของการต้ังเปาหมายสามารถสงผลตอ พฤติกรรม ซึ่งไดแก การกําหนด
ทิศทาง ความพยายาม ความคงทนและการพัฒนากลยุทธจากกลไกทั้งสามอยาง และสงผลตอ
การทํางานของบุคคล 

 

2.6 ประเภทของเปาหมาย   
ประเภทของเปาหมาย เราสามารถแบงไดเปน เจตคติในการทํางาน ความมุงมั่นในการ

ทํางาน เปาหมายเพื่อผลประโยชนในอนาคต เปาหมายเพื่อตองการรางวัลจากภายนอกเหนอืไดรับ
การยกยองและเปาหมายเพื่อการไดยอมรับทางสังคม  

2.6.1. เจตคติในการทํางาน 
ในโรงเรียนทั่วไปเมื่อนักเรียนทํางานสงครู นักเรียนมักไดรับทราบผลการเรียนรู 

(feedback) จากครูเกี่ยวกับงานที่ทําตอหนาบุคคลอื่นเสมอ เชน ครูติดผลงานของนักเรียนบน
บอรด ครูคืนรายงานใหนักเรียนตอหนานักเรียนคนอ่ืน ซึ่งทําใหนักเรียนคนอ่ืนมองเห็นเกรดของกัน
และกันหรือไมครูก็มักตําหนิ หรือแนะนักเรียนโดยการพูดใหเพื่อนๆ คนอ่ืนไดยิน  ซึ่งการกระทํา
ดังกลาวของครู ทําใหนักเรียนรูสึกเสียหนา จากเหตุการณเหลานี้เลยทําใหนักเรียนรูสึกกังวลและ
ใหความสําคัญกับการถูกมองวาเปนคนเกง หรือคนไมมีความสามารถในสายตาตัวเองและผูอ่ืน 
(เชน ครูครอบครัว และกลุมเพื่อน) และพยายามหลีกเล่ียงจากการถูกมองวาเปนคนไมเกง หรือไม
มีความสามารถ นักเรียนที่ใหความสําคัญหรือเปนกังวลเกี่ยวกับการถูกมองจากบุคคลอ่ืน             
ในลักษณะเชนนี้ เปนนักเรียนที่มีเปาหมายชนิดที่เรียกวา “เจตคติในการทํางาน (Performance 
Goals Orientation)” ลักษณะบุคคลที่มีเปาหมายประเภทนี้ ไดแก  เชื่อวาความสามารถของ
บุคคลมีความคงที่ ไมสามารถเปล่ียนแปลงได ดังนั้นบุคคลที่เกงไมจําเปนตองขยัน สามารถ
ประเมินผลงานที่ตนเองทําโดยเปรียบเทียบกับบุคคลอ่ืน เพราะไมอยากใหตนเองดูไมดี เปนคน          
ที่เลือกทํางานที่เปดโอกาสใหตนเองไดแสดงใหผูอ่ืนเห็นวาตนเองมีความสามารถ และพยายาม
หลีกเล่ียงงานที่ทําใหตนเองดูแยหรือไมเกง รูสึกผอนคลายและภูมิใจที่ไดทํางานที่งายจนประสบ
ความสําเร็จ การเรียนรูเกิดจากแรงจูงใจภายนอก โดยคาดหมายรางวัลจากบุคคลอ่ืน และ
พยายามหลีกเล่ียงการถูกตําหนิ ใชวิธีการเรียนรูที่ชวยในการเรียนแบบทองจําเทานั้น ตองการ
ทราบผลการเรียนรูที่เปนส่ิงที่ดีเทานั้น ไมตองการทราบถึงขอบกพรองของตนเอง ถางานที่ทําไม
ประสบความสําเร็จก็จะยกเลิกงานนั้นงายๆ และพยายามหลีกเล่ียงงานท่ีตนเองเคยลมเหลวมา
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กอนในอดีต บุคคลนั้นจะคิดวาครูผูสอนคือผูพิพากษาที่ทําหนาที่เปนผูใหรางวัลหรือการใหลงโทษ 
และคิดวาความลมเหลวเปนตัวบงช้ีถึงความไมเกง ไมมีความสามารถ และเชื่อวาความลมเหลวน้ี
จะเกิดข้ึนในอนาคต 

แตวาการมีเจตคติในการทํางาน (Performance Goals Orientation) มันก็อาจะทําให
เกิดผลเสียมากมาย เชน ในกรณีที่นักเรียนเช่ือวาความสําเร็จของตนเกิดจากการเปรียบเทียบ
ความสามารถของตนกับนักเรียนคนอ่ืนๆ นักเรียนก็จะคิดวาครูนาจะมีอคติกับนักเรียนบางคน 
และไมมีความยุติธรรมในการใหคะแนน ซึ่งอยางไรก็ตาม ก็มีความสัมพันธระหวางการมีเจตคติใน
การทํางาน กับการรับรูความสามารถของตนเองในหลายลักษณะดังนี้ 

1. ถานักเรียนมีการรับรูความสามารถของตนเอง( have high self-efficacy) ในการ
กระทํากิจกรรมอยางใดอยางหน่ึงสูง และมีเจตคติในการทํางาน (Performance Goals 
Orientation)  นักเรียนเหลานี้มีแนวโนมจะมีความเชี่ยวชาญในการกระทํากิจกรรมนั้นๆ  (Mastery 
Oriented)  นั่นคือนักเรียนเหลานี้จะมีความพยายามอยางสม่ําเสมอในการกระทํากิจรรมนั้น 
เพื่อใหตนเองประสบความสําเร็จ มีความเชี่ยวชาญ มีทักษะ และเกงกวานักเรียนคนอ่ืนๆ ในชั้น 
 2. ถานักเรียนมีการรับรูความสามารถของตนเองในการกระทํากิจกรรมอยางใดอยางหนึ่ง
ตํ่า (have low self – efficacy) และเจตคติในการทํางาน (Performance Goals Orientation)  
นักเรียนเหลานี้ก็จะพยายามหาทางหลีกเล่ียงในการกระทํากิจกรรมนั้นๆ เพื่อไมใหตนเองดูแย
หรือไมมีความสามารถ ซึ่งเราเรียกนักเรียนพวกนี้วา “Failure Avoiding Orientation” 
 ซึ่งที่แยที่สุด คือ ถานักเรียนมีเจตคติในการทํางาน (Performance Goals Orientation) 
และคิดวาตนไมมีความสามารถในการกระทํากิจกรรมใดกิจกรรมหน่ึง  (Lack Ability) เราเรียก
นักเรียนเหลานี้วาเปน “นักเรียนที่ส้ินหวังในการเรียน (Learned – Helpless Orientation)” ซึ่ง
นักเรียนประเภทนี้มักไมคอยมีความพยายามในการเรียน มักยกเลิกการทํางานตางๆอยางงายดาย 
และมักคิดวาตนเองไมมีความสามารถถึงแมจะทุมเทความพยายามมากเทาไรก็ตาม และนักเรียน
เหลานี้มักรูสึกหดหู และมีอาการซึมเศรารวมดวย  ดังนั้นถาครูไดทําความเขาใจในเร่ือง “ความส้ิน
หวังในการเรียนรู” จึงมีประโยชนสําหรับครูผูสอนอยางยิ่ง เพราะถาครูเขาใจวา “ความส้ินหวังใน
การเรียนรู” เกิดข้ึนไดอยางไร และมีผลตอแรงจูงใจในการเรียนและผลการเรียนของนักเรียน
อยางไร ก็จะชวยใหครูสามารถชวยนักเรียนไดกอนที่จะเกิดความสิ้นหวังอันเกิดจากการเรียนรู 

สรุปวาเจตคติในการทํางาน คือ ความรูสึกของผูเรียนที่มีผลตอการกระทําตางๆ ที่จะ
เกิดข้ึนตอผลการทํางานใดๆ ไมวาจะเปนในอดีต หรืออนาคต หรือความกลัวตอการทํางานที่
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ผิดพลาด โดยที่เปาหมายในการสรางงานจะมีความสัมพันธตอความเชี่ยวชาญหรือการกระทําใน
กิจกรรมนั้นๆ ได 

2.6.2 ความมุงม่ันในการทํางาน 
ลักษณะของบุคคลที่มีความมุงมั่นในการทํางาน ไดแก บุคคลนั้นจะมีความเชื่อ

วาความพยายามและความฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได          
เขาสามารถเลือกทํางานที่เปดโอกาสใหตนเองไดเกิดการเรียนรู และจะตองรูสึกผิดหวังและเบ่ือ
หนายถาตองทํางานที่งาย การเรียนรูที่เกิดข้ึนเกิดจากแรงจูงใจภายในของบุคคลนั้น  ตลอดจน
พยายามหาวิธีการเรียนรูตางๆ ที่ชวยทําใหการเรียนรูมีประสิทธิภาพมากข้ึนโดยทุมเทความ
พยายามอยางมากในการเรียนรู ถึงแมไมประสบความสําเร็จ ก็ไมยกเลิกที่จะทํางานช้ินนั้น  
สามารถประเมินผลงานที่ทําโดยเปรียบเทียบกับตนเองวามีความกาวหนาไปมากนอยอยางไร  
และเช่ือวาความพยายามและการฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได  
จะรูสึกพอใจกับผลงานที่ตนเองตองทํา ถึงแมวางานที่ทําจะไมประสบความสําเร็จทั้งๆที่ได
พยายามอยางเต็มที่แลว  ตองการทราบผลการเรียนรู เพื่อเปนขอมูลในการปรับปรุงการเรียนรูใหดี
ข้ึน ผูเรียนจะคิดวาครูผูสอนคือแหลงขอมูลสามารถใหคําแนะนําตางๆได  และคิดวาความ
ผิดพลาดเปนเร่ืองปกติและมีประโยชนในกระบวนการเรียนรู และสามารถนําเอาความผิดพลาดไป
ปรับปรุงการเรียนใหดีข้ึน และความผิดพลาดเปนตัวบงชี้ใหบุคคลเพิ่มความพยายามในการ
ทํางานใหมากข้ึน 

นักเรียนที่มีความมุงมั่นในการทํางาน มีความต้ังใจที่จะเรียนรูเพื่อกอใหเกิดความ
เช่ียวชาญในการกระทํากิจกรรมใดกิจกรรมหนึ่งเปนที่นาสังเกตวานักเรียนที่มีเปาหมายเพื่อการ
เรียนรู (Learning Goals) ทุกคนมีความต้ังใจที่จะทํากิจกรรมตางๆ ใหประสบความสําเร็จถึงข้ันมี
ความเชี่ยวชาญ (Mastery Orientation) ถึงแมวานักเรียนเหลานี้บางคนจะมีความสามารถดอย
กวานักเรียนคนอ่ืนๆก็ตาม 

สรุปไดวาบุคคลที่มีความมุงมั่นในการทํางาน จะพยายามกระทํากิจกรรมตางๆที่
จะชวยใหบุคคลสามารถเรียนรูไดดีข้ึน เชน มีความกระตือรือรน ต้ังใจเรียน ยอมรับขอบกพรอง
ของตนเองได ไมทอถอยกับความลมเหลวที่เกิดข้ึน และคิดวาการพยายามและการฝกฝนเปน
หนทางไปสูความสําเร็จ  

2.6.3 เปาหมายเพื่อผลประโยชนในอนาคต  
นักเรียนที่มีเปาหมายประเภทนี้มองการเรียนรูเสมือนผลตอบแทนที่จะไดรับใน

ระยะยาว ยกตัวอยางเชน นักเรียนสวนใหญเชื่อวาการมีผลการเรียนที่ดีมีความสําคัญ เพราะทาํให
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นักเรียนมีความรูความสามารถ และมีทักษะท่ีจําเปนสําหรับการประสบความสําเร็จในอาชีพใน
อนาคต หรือมีความสําคัญและมีประโยชนในการใชสมัครเขาศึกษาตอในสถาบันตางๆ 
ผลการวิจัยพบวานักเรียนที่มีเปาหมายประเภทน้ีมีแนวโนมที่จะเอาใจใสในการศึกษาเลาเรียน
อยางสม่ําเสมอ และมักจะใชเทคนิคการเรียนรูที่เปนทั้งการเรียนรูที่มีความหมาย (Meaningful 
Learning) และการเรียนรูชนิดทองจํา  โดยทั่วไปนักเรียนพวกนี้มีแนวโนมที่จะแสดง “Mastery 
Orientation” ในการเรียนรูดวยเชนกัน  

2.6.4 เปาหมายเพื่อตองการรางวัลจากภายนอกเหนือไดรับการยกยอง 
นักเรียนที่มีเปาหมายประเภทนี้เอาใจใสในการเรียนเพื่อตองการไดรับการยกยอง

ทางสังคม หรือการไดรับเงิน และรางวัลตางๆจากบุคคลอ่ืน งานวิจัยเกี่ยวกับการปรับพฤติกรรม
แสดงใหเห็นวาการใชส่ิงลอภายนอก เชน เงิน ขนม รางวัล และคําชมเชย สามารถชวยใหนักเรียน
ที่ข้ีเกียจ ไมสนใจเรียน หันมาเอาใจใสในการเรียนเพิ่มข้ึนได ซึ่งถึงแมวานักเรียนที่มีเปาหมายเพื่อ
ตองการรางวัลจากภายนอกหรือไดรับการยกยอง (Extrinsic reward or Recognition Goals) จะ
เอาใจใสในการเรียนรู แตระดับของการเอาใจใสในการเรียนก็ไมสูงหรือมีการเรียนรูที่ลึกซ้ึง และมี
ความหมายมากเทากับนักเรียนที่มีเปาหมายเพื่อการเรียนรู (Learning Goals) และเปาหมายเพื่อ
ผลตอบแทนในระยะยาว (Internalized Future – Utility Goals) 

2.6.5 เปาหมายเพื่อการไดยอมรับทางสังคม  
นักเรียนสวนใหญ โดยเฉพาะนักเรียนระดับประถมศึกษาทําการบานเพื่อใหครู

พอใจ ตองการใหครูรัก ซึ่งส่ิงเหลานี้สามารถบังเกิดกับนักเรียนระดับมัธยมศึกษา และระดับ
วิทยาลัยไดเชนกัน เพราะนักเรียนทราบวาครูเปนผูควบคุมและใหเกรดนักเรียน นอกจากนี้นักเรียน
บางคนพยายามหลีกเล่ียงการเปนคนเกง หรือมีความสามารถ เพื่อทําใหเพื่อนพอใจหรือยอมรับ 
เพราะนักเรียนคิดวาการเปนคนไมเกงมักดูนาสนใจ และเทห็ในสายตาเพื่อน (It is “cool” to do 
well in school) กลาวอีกนัยหนึ่งก็คือ นักเรียนที่มีเปาหมายประเภทน้ีจะตัดสินใจกระทํากิจกรรมที่
เพื่อนๆ หรือสังคมที่อยูยอมรับเทานั้นโดยไมสนใจวากิจกรรมท่ีกระทํานั้นจะถูกตองหรือเหมาะสม
หรือไม เชน นักเรียนพยายามแตงตัวเซอๆเหมือนกับเพื่อนในกลุม เพื่อใหเพื่อนยอมรับ  เปนตน 

2.7 ความผูกพันตอเปาหมาย  
เราสามารถศึกษาความผูกพันตอเปาหมาย จากความหมายของความผูกพันตอเปาหมาย 

การวัดความผูกพันตอเปาหมายและบริบทของความผูกพันตอเปาหมาย 
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2.7.1 ความหมายของความผูกพันตอเปาหมาย  
เมเออรและบรุนสเตียน (Maier & Brunstein, 2001) พบวาเปาหมายสวนบุคคล 

(Personal Goal) เปนการแสดงถึงการกําหนดทิศทางในอนาคตของแตละคนในการมุงมั่นเพือ่ชีวติ
และการมองหาความสําเร็จในชีวิตที่หลากหลาย เสนอวาประกอบไปดวยมิติสามดาน ซึ่งไดแก 
ความผูกพันตอเปาหมาย ความสามารถไปสูเปาหมาย และความกาวหนาในการทําสําเร็จตาม
เปาหมาย เหตุผลที่สําคัญในการกําหนดการติดตามทําตามเปาหมายนั้น เพื่อนําไปสูการกาวสู
ความสําเร็จตามเปาหมายซ่ึงสามารถชวยสรางเสริมความรูสึกที่ดีของแตละบุคคล ในทางกลับกัน
ถามีสภาวะที่ออนแอในการไปสูเปาหมาย สงผลใหทําลายความรูสึกที่ดีของบุคคลในงาน ดังนั้น
บุคคลจึงพยายามเพื่อผลสําเร็จและหลีกเล่ียงความกดดันตางๆ ที่เกิดข้ึนจากการไมสามารถบรรลุ
เปาหมาย ดวยเหตุนี้จึงเปนส่ิงสําคัญมากที่บุคคลนั้นตองมีทั้งความรูสึกที่แข็งแกรงตอเปาหมาย
ตามที่ตนมีความผูกพันกับเปาหมายนั้น และสถานการณตางๆในชีวิตที่ชวยสนับสนุนตอส่ิงที่เปน
เปาหมาย ซึ่งหากส่ิงเหลานี้ไดรับการสงเสริมในข้ันตนของการทํางาน ยอมสงผลใหแตละคนไดพบ
กับเปาหมายตามที่ตนต้ังไวเพื่อไปสูจุดสูงสุดตามที่แตละคนตองการในการทํางาน 

ความผูกพันตอเปาหมาย (Goal Commitment) สามารถใชเปนเคร่ืองบงช้ีถึงการ
ยอมรับและความพยายามในการทําใหสําเร็จตามเปาหมายของแตละบุคคล จึงมีความสําคัญตอ
การกระทําและการตัดสินใจที่มีความเกี่ยวของกับผลระยะยาว และยังเปนแหลงของแรงจูงใจอัน
ทรงพลังที่จะตานทานตอส่ิงตางๆทําใหบุคคลมีความพยายามตอไปเพื่อใหถึงเปาหมาย (Meyer, 
Becker and Vandenberghe, 2004) ความผูกพันตอเปาหมายมีนัยสําคัญกับการรับรู
ความสามารถของตนเองเพื่อการต้ังเปาหมาย บางบุคคลมีเปาหมายที่ตนไดต้ังข้ึน หากแตมีความ
ผูกพันในการยอมรับเปาหมายตํ่า ก็ไมสามารถสรางผลลัพธตามที่ตนตองการได ทั้งนี้การสราง
ความผูกพันตอเปาหมายที่ดีและการทําไดสําเร็จตามเปาหมายยอมสรางความพึงพอใจใหกับ
บุคคลนั้น และสงผลตอความพึงพอใจในชีวิตและการทํางานตอไป 

ดังนั้นความผูกพันตอเปาหมาย (Goal Commitment) จึงหมายถึง ระดับที่บุคคล
ยอมรับในความปรารถนาของตนเองและแสวงหาวิธีการที่จะไปใหถึงเปาหมาย เปนการสราง
ความสําคัญตอการกระทําและการตัดสินใจที่มีความเกี่ยวของกับผลระยะยาวที่เกิดจากตนเอง 
อันสงผลตอการพยายามทําใหเปาหมายที่ต้ังไวเปนจริง 

2.7.2 การวัดความผูกพันตอเปาหมาย 
ความผูกพันตอเปาหมายและการยอมรับเปาหมายมีความคลายคลึงกันและ

มักจะใชแทนกันในงานวิจัยของล็อคและลาแธม (Locke & Latham, 1990) และไดขอสรุปของ
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ความแตกตางวาการยอมรับเปาหมาย (Goal Acceptance) เปนการเร่ิมตนขอตกลงตาม
เปาหมาย สวนความผูกพันตอเปาหมาย (Goal Commitment) เปนความตานทานตอการ
เปล่ียนแปลงตอเปาหมายจนถึงระยะสุดทาย โดยมีวิธีการวัดความผูกพันตอเปาหมาย ดังนี้ 
   2.7.2.1 อีเรสและไซดอน (Erez and Zidon, 1984) พบวาความผูกพัน
ตอเปาหมายเปนตัวแปรตอเนื่อง (continuous variable) โดยวิธีการวัดทําไดโดยการใชคําถาม
รูปแบบตางๆที่มีความเกี่ยวของกับเปาหมาย เชน “คุณผูกพันกับการยอมรับเปาหมายสูเพียงใด” , 
“ ส่ิงตางๆไมสามารถทําใหฉันเพิกเฉยตอเปาหมาย” , “ ฉันเต็มใจรวมมือเต็มที่เพื่อความสําเร็จใน
คร้ังนี้” 
   2.7.2.2 การวัดความผูกพันตอเปาหมายทางออมทําไดโดยการ
เปรียบเทียบระหวางการวัดระดับเปาหมายท่ีมอบให กับเปาหมายของตนเองท่ีตนเปนผูต้ังจากนั้น
จึงสรุปความพยายามในการไปสูเปาหมาย พบวาวิธีการวัดทางตรงมีคาความสัมพันธเทากับ .71 
และวิธีการวัดทางออมเทากับ .59 และพบวาความรูสึกผูกพันที่แสดงออกมาจะเกิดข้ึนไดตอเม่ือ
ระดับเปาหมายสวนบุคคลไดรับการควบคุมล็อคและโชว (Lock & Shaw, 1984) 
   2.7.2.3 การวัดความผูกพันตอเปาหมายโดยวิธีการวัดจากการประเมิน
ของผูคนรอบขางทั้งดานความสามารถและความเหมาะสมในการทํางาน วาพฤติกรรมหรือการ
กระทํานั้นสามารถใชเปนพื้นฐานในการพิสูจนความผูกพันตอเปาหมาย จากการที่ผูยอมรับ
เปาหมายนั้นตองใชความพยายามอยางมากที่จะทําใหสําเร็จมากกวาการปฏิเสธสลานิค
(Salanick, 1997) 
 สรุปไดวาการวัดความผูกพันตอเปาหมายมีวิธีการวัดไดโดยใชคําถามรูปแบบตางๆที่มี
ความเกี่ยวของกับเปาหมาย โดยการเปรียบเทียบระหวางการวัดระดับเปาหมายที่กําหนดให และ
ใชวิธีการวัดการประเมินจากบุคคลรอบขาง โดยเมื่อรวบรวมแนวคิดตางๆจากงานวิจัยพบวามี
ความสัมพันธกันอยางลึกซึ้งระหวางความผูกพันตอเปาหมายและผลการปฏิบัติงาน แต
ขณะเดียวกันยังมีปจจัยอ่ืนๆอีกที่เปนตัวกําหนดความผูกพันตอเปาหมาย 

2.7.3 บริบทของความผูกพันตอเปาหมาย 
  ปจจัยที่สงผลตอการยอมรับในความปรารถนาหรือความพยายามในการยอมรับ
ระดับเปาหมาย จากความพยายามของแตละคนที่เชื่อวาการทําตามเปาหมายเปนส่ิงสําคัญ ไดแก 
อํานาจ อิทธิพลจากกลุม สาธารณสภาพ ส่ิงจูงใจและรางวัล การบริหารตนเองหรือการไดรับ
รางวัลจากภายใน การลงโทษ และคุณคาที่มีของความเปนไปไดที่จะเกิดข้ึน 
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อํานาจ (Authority) ผลของการใชอํานาจเพื่อการสรางเปาหมายดวยตนเองดวย
การตั้งระดับของผลการทําส่ิงตางๆตามเปาหมายดวยตนเอง ตามที่ลิเคิรตไดศึกษาในป 1967
พบวาเปาหมายในการขายของเซลลแมนและเปาหมายในการขายของผูจัดการมีความสัมพันธใน
ทิศทางเดียวกันคอนขางสูง  โอลหแฮม (Oldham, 1975) ศึกษาพบวาอํานาจจากผูบังคับบัญชา  
มีนัยสําคัญกับแนวโนมของการทํางานหนักเพื่อใหเปนไปตามเปาหมายที่ไดรับ ความผูกพันตอ
เปาหมายสงผลสะทอนตอการยินยอมทําตามอํานาจอยางถูกตอง ความสัมพันธระหวางเปาหมาย
และอํานาจเปนส่ิงที่ถูกกลาวถึงมานานแลววาอํานาจนั้นตองมาจากบุคคลอันควรและบุคคลนั้น
ตองไดรับการยอมรับจากบุคคลอ่ืนๆดวย เพราะฉะนั้นบุคคลที่มีอํานาจจึงควรมีความเขาใจในการ
ส่ือสารและมอบหมายคําส่ัง มีความเชื่อมั่นในวัตถุประสงคขององคการและมีความสนใจบุคลากร
ของตน เพื่อใหผูปฏิบัติสามารถทําตามเปาหมายไดทั้งกายและใจ เม่ือเปนเชนนี้ผูบริหารที่ใหการ
สนับสนุนในการไปสูเปาหมายและพนักงานสามารถรับรูถึงการไดรับความชวยเหลือนี้ยอมสงผล
ตอการทํางานที่มีประสิทธิภาพ  ความเชื่อในอํานาจที่ตนมี ดวยวิธีการต้ังเปาหมายรวมกันระหวาง
ผูปฏิบัติงานและผูบริหาร โดยวิธีการพูดใหคําแนะนํารวมกับการแสดงใหเห็นถึงส่ิงที่ผูปฏิบัติงาน
สามารถไปใหถึงเปาหมายจากวิธีการตางๆ รวมถึงแรงกดดันจากผูบังคับบัญชา สงผลตอ
ความรูสึกในการมีความผูกพันกับเปาหมายของพนักงาน ล็อคและลาแธม(Locke & Latham, 
1990) มีความเชื่อวาการมอบหมายเปาหมายจะเกิดประสิทธิภาพเมื่อ 
  1. อํานาจที่นําไปสูการต้ังเปาหมายมีความถูกตอง 
  2. การต้ังเปาหมายตองใชรวมกับการใหรางวัลและการลงโทษ 
  3. การต้ังเปาหมายตองนําไปสูผลทางบวกกับการรับรูความสามารถของตนเอง 
  4. การต้ังเปาหมายตองนําไปสูความถูกตองตรงตามขอมูลมากที่สุด 

5. การต้ังเปาหมายตองสนับสนุนความรูสึกประสบความสําเร็จ 
6. การต้ังเปาหมายนําไปสูการพัฒนาตนเอง 
7. การต้ังเปาหมายตองนําไปสูการทาทายคนใหพัฒนาตนเอง 
8. รูปแบบของการใชอํานาจตองประกอบไปดวย ความสามารถในการมองเหน็ได

อยางเปนรูปธรรม ไดรับการสนับสนุน มีความเชื่อถือได จัดเตรียมส่ิงของส่ิงตางๆ เพื่อความพรอม
ในการไปสูเปาหมาย การใชอํานาจอยางเหมาะสม ไดรับความรูและเปนส่ิงที่ชื่นชอบ 

อิทธิพลจากกลุม (Peer group Influence) เปนส่ิงที่พบมากในวงการอุตสาหกรรม             
ความผูกพันกับผลการผลิตที่ไดมาตรฐานเปนผลมาจากความสามัคคี เหนียวแนนของกลุม 
เชนเดียวกับ การศึกษาของซีชอร (Seashore, 1954 cited in Locke & Latham, 1990)  พบวา
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ระดับความสัมพันธที่เหนียวแนนและความปรารถนาของกลุมนําไปสูผลผลิตที่มาก   การสังเกตดู
การทํางานจากตนแบบที่มีความยากมากกวาแบบงาย สงผลใหผูที่ต้ังความผูกพันตอเปาหมายนัน้
เกิดความรูสึกเช่ือมั่นในความสามารถของตนเองสูง (self efficacy) ข้ึนไดจากตัวแบบที่มีการ
ทํางานที่ดีและ แบนดูรา (Bandura, 1986) ไดเสนอวาการไดเห็นรูปแบบที่ดีนั้นเปนเทคนิคที่มี
อํานาจในการ จูงใจสูงการแขงขันภายในกลุมสามารถชวยสนับสนุนความผูกพันตอเปาหมายได
ทั้งทางตรงและทางออม โดยวิธีการบอกใหทราบวาขณะนี้เขากําลังไดรับการประเมินอยูรวมกับ
ใครในกลุมและตนเองนั้นอยูในระดับใดในตอนนี้ จากการศึกษาของโรเบิรตและฮอลล (Robert & 
Hall, 1987 cited in Locke & Latham, 1990) พบวาการแขงขันทําใหผลการปฏิบัติงานสูงข้ึน
มากกวาเมื่อไมไดรับการเปรียบเทียบและเปาหมายที่ ต้ังข้ึนจะอยูในระดับสูงและมีความ
เฉพาะเจาะจงกวาเชนกัน เพราะการสะทอนผลกลับทําใหบุคคลตองแขงขันเพื่อพัฒนาตนเองดวย 

สาธารณสภาพ (Publicness) การเปดเผยขอผูกพันของตนถึงเปาหมายของตนในที่
สาธารณะไดผลดีมากกวาการต้ังเปาหมายเฉพาะกับตนเอง เนื่องจากมีความเปนไปไดที่แตละคน
ไมตองการใหผูอ่ืนรับรูหากไมสามารถทําใหเสร็จไดตามเปาหมาย วาตนเองนั้นขาดความซ่ือสัตย
หรือไมมั่นคง และตองยอมรับความอับอายในภายหลัง เปาหมายจะยิ่งไดผลดีเมื่อต้ังในท่ี
สาธารณะและบุคคลนั้นต้ังเปาหมายของตนเองไวตลอดเวลา 

ส่ิงจูงใจและรางวัล (Incentive and rewards) จากทฤษฎีเกี่ยวกับการสรางแรงจูงใจทาง
จิตวิทยาตางๆลวนมีความเห็นตรงกันวาความผูกพันในการกระทําตางๆเปลี่ยนแปลงไดจากความ
ชื่นชอบส่ิงจูงใจหรือรางวัล จากการศึกษาของ (Campbell,1984, cited in Locke & Latham, 
1990) พบวาการกระตุนใหกลุมตัวอยางทํางานที่ไดรับมอบหมายพรอมกับเปาหมายท่ีมีความ
เฉพาะเจาะจงมีนัยสําคัญกับการใหรางวัลที่เปนตัวเงิน 

การบริหารตนเองหรือการไดรับรางวัลจากภายใน (self-Adminstered or Internal 
Reward) จากการศึกษาของอีวานเซวิชและแมคมาฮอน (Ivancevich & McMahon, 1982, cited 
in Locke & Latham, 1990) พบวาไมมีความสัมพันธระหวางความผูกพันตอเปาหมายและผลการ
ปฏิบัติงานในกลุมผูเขารวมงานวิจัยที่เปนวิศวกร อยางไรก็ตามใหตามการใหผลตอบสะทอนกลับ
จากการประเมินตนเองไดสงผลตอการเพิ่มความผูกพันตอองคการและผลการปฏิบัติงานรวมกับ
การสะทอนผลกลับจากผูบริหาร การใหเหตุผลนี้ยังไมกระจางนักแตเช่ือวาการที่ตนเองสามารถ
บอกไดถึงส่ิงที่ตนเองเปนผูควบคุมการกระทํายอมดีกวาการที่ผูอ่ืนเปนคนบอก เชนเดียวกับ
งานวิจัยของแมสเตอรและคณะ (Master et al. 1977,  cited in Locke & Latham, 1990) ที่พบวา
การที่ตนเองเปนผูใหรางวัลสงผลตอการสรางแรงจูงใจมากกวาการที่ไดรับรางวัลจากผูอ่ืน 
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การลงโทษ (Punishment) การสรางความผูกพันดวยวิธีการต้ังสถานการณวาหากทาํไมได
ตามเปาหมายจะถูกลงโทษน้ันตองเปนส่ิงที่ทําโดยสมัครใจเทานั้น ขณะเดียวกันผูบริหารจะตอง
คอยสนับสนุนในการใหบุคคลไดพยายามไปถึงจุดหมายและไมผลักดันใหพวกเขาไปสูความ
ลมเหลว การใชเหตุผลในการลงโทษสงผลอยางมีประสิทธิภาพหากรูวิธีการใชอยางถูกตองและ
ตองไดรับการยอมรับดวยเชนกัน 

คุณคาที่มีและความเปนไปไดที่จะเกิดข้ึน (General Valenceand Instrumentality) 
คุณคาของเปาหมายนั้นข้ึนอยูกับวาจะใชส่ิงใดในการจูงใจแตละคน และความเปนไปไดที่จะ
เกิดข้ึนมีนัยสําคัญกับความผูกพันในเปาหมายจากการศึกษาของยูลคและลาแธม (Yulk & 
Latham, 1978 ,cited in Locke & Latham, 1990) บุคคลที่ไดเลือกเปาหมายเองยอมมีความ
ผูกพันตอเปาหมายนั้นดวย  การไดรับเปาหมายกอนการต้ังเปาหมายดวยตนเองกอใหเกิดความ
ไมลงรอยกันในเปาหมาย ทางที่ดีคือเม่ือเปาหมายที่ทํามีความยาก ควรใหแตละบุคคลไดมีโอกาส
กําหนดเปาหมายดวยตนเองที่ตองการจริงๆ กอนที่จะมอบเปาหมายในงานใหกับพวกเขา 
เนื่องมาจากส่ิงที่แตละบุคคลไดรับคือความพึงพอใจจากภายใน เชนเดียวกับความผูกพันใน
องคการ หรือความพึงพอใจในงาน 

สรุปไดวาบริบทของความผูกพันตอเปาหมายจะมาจาก อํานาจ อิทธิพลจากกลุม                   
สาธารณสภาพ ส่ิงจูงใจและรางวัล การบริหารตนเองหรือการไดรับรางวัลจากภายใน การลงโทษ 
และคุณคาที่มีของความเปนไปไดที่จะเกิดข้ึน 
 

ตอนท่ี 3 ปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง   
ในตอนสามเปนปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก  

ระดับประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางานและความวิตก
กังวลในการใชคอมพิวเตอร  

 

3.1 ระดับประสบการณเดิม  
ประสบการณเดิมสามารถศึกษาไดจาก ความหมายของประสบการณ ประสบการณกับ

ทฤษฎีการสรางองคความรูดวยตนเองและประสบการณเดิมกับการเรียนรูแบบหย่ังรู 
ความหมายของประสบการณ (Experience) 
ไดมีนักจิตวิทยาหลายทานไดใหความหมายเกี่ยวกับการเรียนรูจากประสบการณไวดังนี้ 
ประสบการณ หมายถึง การที่มนุษยผานภาวะการรับรู ไดเห็น ไดฟงและไดปฏิบัติดวย

ตนเองมาแลวบอยคร้ังจน สะสมเปนประสบการณและความชํานาญ เชนศิลปนที่มีใจรักและช่ืนชม
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ความงามของธรรมชาติโดยเฉพาะดอกไมนานาพันธุ จึงมักจะเขาไปสัมผัสช่ืนชมกับความงามของ
ธรรมชาติ เหลานั้น และนิยมถายทอดความงามดวยการวาดภาพธรรมชาติเปนพิเศษศิลปนบาง
คนจึงมีความเจนจัดในการวาดภาพสีน้ํา หรือนักเรียนอาจวาดภาพจากประสบการณใน
ชีวิตประจําวัน เปนตน  

โรเจอร (Rogers, 1969) ไดใหความหมายวา การเรียนรูจากประสบการณ หมายถึงความ
สมดุลระหวางการเปลี่ยนแปลงและการเจริญกาวหนาของบุคคล โรเจอรมีความเช่ือวามนุษยทุก
คนมีธรรมชาติของการอยากเรียนรู บทบาทของครูตองอํานวยความสะดวกโดยการจัดบรรยากาศ
ใหเอ้ือตอการเรียนรู ตอบสนองวัตถุประสงคของผูเรียน ดําเนินการจัดหาทรัพยากรที่เหมาะสมให
ความสําคัญระหวางปญญาและอารมณ จัดใหมีการแลกเปล่ียนความรูและการคิดอยางมีอิสระ
ปราศจากอคติ 

ดิวอ้ี (Dewey, 1938) ไดใหความหมายของการเรียนรูจากประสบการณวาเปนวงจรของ
การลองกระทําเปนการเรียนรูที่เกิดจากการกระทําจริง ผูเรียนเปนผูสรางความรูใหมหรือผูเรียน
ปรับเปล่ียนตนเองในการปฏิบัติตามบทบาทใหม 

จัช (Juch, 1983) ไดใหความหมายของการเรียนรูจากประสบการณวาเปนวงจรการเรียนรู             
ซึ่งเปนตัวแทนของการเรียนรูที่เกิดจากประสบการณ ในระยะของวงจรแหงการเรียนรูจะมีการ
จัดการเรียนการสอนโดยผูสอน แตผู เ รียนเองก็สามารถจัดไดดวยตนเอง การเรียนรูจาก
ประสบการณเปนเร่ืองปกติของกระบวนการในชีวิตประจําวัน เปนการเรียนรูจากประสบการณเดิม
ไปยังประสบการณอ่ืนๆ บางคร้ังเหมือนกับวงจรการอบรม บางคร้ังก็ผิดพลาดถาถาไมเขาใจ
เกี่ยวกับ ผูเรียนและวิธีการเรียนรู 

กอลป (Kolb, 1984) ไดใหความหมายของการเรียนรูจากประสบการณวาเปนกระบวนการ
เรียนรูที่เปนลักษณะแบบองครวมและมีความหลากหลาย ซึ่งรูปแบบในการพัฒนาผูใหญจะ
ประกอบดวยประเด็นที่เกี่ยวของกับวิธีการเรียนรูของประชาชน การเจริญงอกงาม และการพัฒนา 
ทฤษฎีการเรียนรูจากประสบการณจะเนนบทบาทสําคัญของการปฏิบัติจริงในกระบวนการเรียนรู 

ปฟเฟอรและบัลเลล (Pfeiffer and Ballew, 1988) ไดใหความหมายวาการเรียนรูจาก
ประสบการณวาเปนการกําหนดวัตถุประสงคในการกระตุนผูเรียนใหมีความรูสึกที่ดีในการเรียนรู
เหมือนกับส่ิงที่เขาคิด พยายามทําใหผูเรียนเกิดพฤติกรรมและอารมณความรูสึกใหม เกิดความรู
ใหม การเรียนรูจากประสบการณ จะเกิดเมื่อบุคคลเก่ียวของผูกพันธในกิจกรรม การวิเคราะห
ทบทวนอยางมีวิจารณญาณเชิงนามธรรมที่เปนประโยชนใหเหตุผลในการทํางาน โดยอิง
สมมุติฐาน 
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อีวาน (Evans, 1994) ไดใหความหมายของการเรียนรูจากประสบการณวา หมายถึง 
ความรูและทักษะที่ไดรับ ประสบการณจากการทํางาน จาการปฏิบัติ และการศึกษาที่ไมเปน
ทางการ โดยจะผานจากการศึกษาทุกประเภท  หรือจากดานสายอาชีพ  การเรียนรูจาก
ประสบการณ เปนวิธีการเรียนรูจากหนังสือ จากการบรรยาย การทดลอง ทฤษฎีการเรียนรูจาก
ประสบการณจึงเปนชุดวิธีการเรียนรูวิธีหนึ่งจากหลายๆ ชุด 

ลัคแมน (Luckman, 1996) ไดใหความหมายของการเรียนรูจากประสบการณวา เปน
กระบวนการที่ผูเรียนไดสรางความรู ทักษะ และคุณคาจากประสบการณตรง 

เครก (Craig, 1997) ไดใหความหมายวา การเรียนรูจากประสบการณ หมายถึงความรู 
ทักษะ หรือความสามารถที่ไดรับจากการสังเกต การไดรับกระตุน หรือการมีสวนรวมในการปฏิบัติ
และดําเนินกิจกรรมการเรียนรู โดยเขาไปรวมดวยความสมัครใจ รวมปฏิบัติ วิเคราะหขอมูลอยางมี
วิจารณญาณ และนําไปประยุกตใช ดังนั้นการเรียนรูจากประสบการณ จึงหมายถึงการเรียนรู
เพื่อใหไดประโยชนดานความรูและการเปล่ียนแปลงพฤติกรรม ซึ่งเกิดไดทั้งในช้ันเรียน นอกช้ัน
เรียน สถานที่ทํางาน การเรียนรูจากประสบการณเปนการเขามีสวนรวมเพื่อทดสอบทฤษฎีเพื่อ
ตอบสนองผูเรียนใหสามารถตอบคําถามและแสวงหาคําตอบไดดวยตนเอง 

สรุปไดวา ประสบการณเดิม หมายถึง ส่ิงที่คนเราไดเคยรับรูทางประสาทสัมผัส เชน การ
เห็น การไดยิน  การกระทําของตนเอง การไดใชคอมพิวเตอรโดยจากการกระทําของตนเอง ที่
เกี่ยวของและไมเกี่ยวของกับส่ิงนั้นโดยตรง ดังนั้นประสบการณเดิมจึงเกิดจากการเรียนรูจากอดีต
ที่ผานมา โดยที่ประสบการณเดิมเราสามารถแบงออกเปน 2 จําพวกใหญๆ คือ ประสบการณเดิม
ของตนเอง และการไดเห็นประสบการณความสําเร็จจากผูอ่ืน 

ประสบการณกับทฤษฎีการสรางองคความรูดวยตนเอง 
Constructionism เปนทฤษฎีทางการศึกษาที่พัฒนาข้ึนโดย Professor Seymour Papert แหง 

M.I.T. (Massachusette Institute of Technology) ทฤษฎีคอนสตรัคช่ันนิสซึ่ม (Constructionism) 
หรือทฤษฎีการสรางองคความรูดวยตนเอง เปนทฤษฎีการเรียนรูที่เนนผูเรียนเปนผูสรางองคความรู
ดวยตนเอง  

 
 
ทฤษฎีคอนสตรัคช่ันนิสซ่ึม (Constructionism) หรือทฤษฎีการสรางองคความรูดวยตนเอง  

เปนทฤษฎีการเรียนรูที่เนนผูเรียนเปนผูสรางองคความรูดวยตนเองทฤษฎีคอนสตรัคช่ันนิสซึ่ม                
มีสาระสําคัญที่วา ความรูไมใชมาจากการสอนของครูหรือผูสอนเพียงอยางเดียว แตความรูจะ

ประสบการณใหม / ความรูใหม + ประสบการณเดิม / ความรูเดิม = องคความรูใหมบุคคล
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เกิดข้ึนและถูกสรางข้ึนโดยผูเรียนเอง การเรียนรูจะเกิดข้ึนไดดีก็ตอเมื่อผูเรียนไดลงมือกระทําดวย
ตนเอง (Learning by doing) มีพื้นฐานอยูบนกระบวนการการสราง 2 กระบวนการดวยกัน  

กระบวนการที่ 1 คือ ผูเรียนเรียนรูดวยการสรางความรูใหมข้ึนดวยตนเอง ความรูจะ
เกิดข้ึนจากการแปลความหมายของประสบการณที่ไดรับ หากเปนประสบการณตรงท่ีผูเรียนเปน
ผูกระทําดวยตนเองจะทําใหเกิดการเรียนรูอยางมีความหมาย  
 กระบวนการที่ 2 คือ กระบวนการการเรียนรูจะมีประสิทธิภาพมากที่สุด หากกระบวนการ
นั้นมีความหมายกับผูเรียนคนนั้น 

สรุปไดวา ประสบการณกับทฤษฎีการสรางองคความรูดวยตนเอง เปนทฤษฎีการสราง
องคความดวยตนเองดวยการที่ผู เรียนไดลงมือดวยกระทําดวยตนเอง โดยอยูบนฐานของ
กระบวนการ 2 กระบวนการ 

ประสบการณเดิมกับการเรียนรูแบบหย่ังรู 
โคเลอร (Wolfgang Kohler) ไดกลาวเกี่ยวกับการเรียนรูแบบหยั่งรู (Insight Learning) วา 

จะเปนการลักษณะของการรวมปญหาแลวจึงแยกเปนขอยอย ก็จะเกิดความคิดข้ึนมาทันที ที่
เรียกวาการหย่ังเห็น โดยการการหย่ังเห็นจะเกิดข้ึนรวดเร็วข้ึนอยูกับการมีแรงจูงใจ, มปีระสบการณ
เดิมและการมองเห็นความสัมพันธของส่ิงเรากับปญหาได 

 

3.2 บุคลิกภาพภายในของผูเรียน  
บุคลิกภาพภายในของผู เ รียนสามารถศึกษาไดจาก  ความหมายของบุคลิกภาพ 

ความสําคัญของบุคลิกภาพ และประเภทของบุคลิกภาพ 
ความหมายของบุคลิกภาพ 
คําวา “บุคลิกภาพ” (Personality) มาจากภาษาละตินวา “Persona” แปลวา หนากาก

ของตัวละคร (An Actor’s Mask) ในทางวิชาการไดใหความหมายของบุคลิกภาพไวอยางลึกซ้ึง
โดยครอบคลุมถึงลักษณะบุคลิกภาพภายใน ดังเชน นิยามจากพจนานุกรมศัพทสังคมวิทยา
อังกฤษ - ไทย พ.ศ. 2524 ใหไววา “บุคลิกภาพ เปนผลรวมของความคิด ทาที และนิสัยซ่ึงสรางสม
จากมูลฐานองคประกอบทางจิตและทางกายภาพของบุคคลอันถายทอดมาทางชีววิทยาสวนหนึ่ง 
และจากแบบอยางวัฒนธรรมที่ถายทอดมาทางสังคมอีกสวนหนึ่งรวมถึงการปรับเหตุจูงใจความ 
ปรารถนาและความมุงประสงคของตัวบุคคลนั้นให เขากับความตองการ  และวิ สัยแหง
สภาพแวดลอม ทั้งทางสังคมและที่ไมเกี่ยวกับสังคม…” ซึ่งความหมายของบุคลิกภาพนั้นมี
นักจิตวิทยาไดใหความหมายแตกตางกันไป ดังนี้ 



 41
 

ออลพอรต (Allport, 1937) ไดใหความหมายวา บุคลิกภาพเปนองคประกอบที่มีการ
เคล่ือนไหวภายในตัวบุคคล ซึ่งเปนระบบทั้งทางดานรางกายและจิตใจซ่ึงจะเปนตัวกําหนดแบบ
แผนเฉพาะตัวของเขาในการที่จะปรับตัวเขากับส่ิงแวดลอม 

กิลฟอรด (Guilford, 1959) ใหความหมายไววา บุคลิกภาพเปนแบบแผนของคุณลักษณะ
อันเฉพาะตัวของบุคคล 

ศรีธรรม ธนะภูมิ (2525) ใหความหมายของบุคลิกภาพวา เปนลักษณะนิสัยหรือ
พฤติกรรมของบุคคลหนึ่งที่แสดงออกซํ้าๆ เพื่อตอบสนองและปรับตอส่ิงแวดลอม 

จรรยา สุวรรณทัต และดวงกมล เวชบรรยงรัตน (2529: 219) ไดใหความหมายของ
บุคลิกภาพวา หมายถึง แบบแผนพฤติกรรมของบุคคลใดบุคคลหนึ่งที่เปนที่รับรูกันโดยทั่วไปวาเปน
ลักษณะสวนรวมของบุคคลนั้น ประกอบไปดวยพฤติกรรมที่แสดงออกและศักยภาพภายในของ
บุคคลซึ่งทําใหมีความแตกตางจากบุคคลทั่วไป 

ทินวัฒน มฤคพิทักษ (2535) ใหความหมายของบุคลิกภาพวา เปนเอกลักษณหรือ
พฤติกรรมเฉพาะตัวของบุคคลใดบุคคลหนึ่งซ่ึงทําใหบุคคลนั้นแตกตางจากบุคคลอ่ืน 

กันยา สุวรรณแสง (2539) ไดใหความหมายไววา บุคลิกภาพเปนแบบแผนของพฤติกรรม
ของบุคคลที่คนทั่วไปรับรู 

จากความหมายดังที่ไดกลาวมาแลวสรุปไดวา บุคลิกภาพเปนแบบแผนของพฤติกรรมของ
บุคคล อันเปนผลรวมของลักษณะภายนอกและลักษณะภายในของบุคคล ซึ่งทําใหบุคคลนั้นมี
ลักษณะเฉพาะตัวที่เปนเอกลักษณทําใหเขาตางจากบุคคลอ่ืนปจจัยที่เปนองคประกอบของ
บุคลิกภาพของบุคคล ไดแก ปจจัยภายนอกที่มองเห็นไดอยางชัดเจน เชน รูปราง หนาตา 
กิริยามารยาท การแตงตัว วิธีการพูด การนั่ง การยืน ฯลฯ สวนภายใน คือ สวนที่มองเห็นไดยากแต
อาจทราบโดยการอนุมาน เชน สติปญญา ความถนัด ลักษณะอารมณประจําตัว ความใฝฝน
ปรารถนาในชีวิต  คานิยม ความสนใจ  ฯลฯ ซึ่งบุคลิกภาพของมนุษยเปนส่ิงที่ ไมตายตัว 
เปล่ียนแปลงไปตามกาละ การเรียนรู และส่ิงแวดลอมทางสังคมและวัตถุธรรม  

ความสําคัญของบุคลิกภาพ 
บุคลิกภาพมีความสําคัญตอการดํารงชีวิตในสังคมเปนอยางมาก ดังจะพิจารณาไดจาก

ประเด็นตางๆ ดังตอไปนี้ 
1. ความมั่นใจ ผูที่มีบุคลิกภาพดีจะมีความมั่นใจในการแสดงออกมากข้ึน ทําใหกลา

แสดงออก เพราะผูอ่ืนที่พบเห็นจะใหความสนใจและความเช่ือมั่น ดังนั้นโอกาสของการที่จะ
ประสบความสําเร็จจึงมีมากข้ึน 
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2. การคาดหมายพฤติกรรม ถารูวาบุคคลนั้นมีบุคลิกภาพอยางไรจะทํานายไดวาใน
สถานการณใดจะแสดงพฤติกรรมอยางไร 

3. การยอมรับความแตกตางระหวางบุคคล สามารถบอกไดวาบุคคลหน่ึงแตกตางจากอีก
บุคคลหนึ่งไดโดยสังเกตดูพฤติกรรมที่เกิดข้ึนเปนประจําสม่ําเสมอแกบุคคลนั้นๆ 

4. การตระหนักในเอกลักษณของบุคคล บุคลิกภาพทําใหคนมีลักษณะเฉพาะตัวที่เปน
ของตนเอง เปนแบบอยางแกบุคคลอ่ืนๆ 

5. การปรับตัวใหเขากับคนอ่ืนๆ การที่รูบุคลิกภาพของบุคคลอ่ืนทําใหปรับตัวเขากับเขาได
งายข้ึน 

6. ความสําเร็จ คนที่บุคลิกภาพดี ไดเปรียบคนอ่ืนเสมอ เปนพื้นฐานแหงความศรัทธา
เชื่อถือแกผูพบเห็น ชวยใหธุระการงานสําเร็จงายข้ึน ไดรับความรวมมือ และการติดตอดวยดี ไดรับ
ความสะดวกในการปฏิบัติหนาที่การงาน 

7. การยอมรับของกลุม คนที่มีบุคลิกภาพดียอมเปนที่ยอมรับของคนทั่วไป ใครๆ ก็
เรียกรองตองการ ชอบที่จะใหรวมอยูในกลุมทําใหเกิดความมั่นคงทางจิตใจ 

สรุปไดวาความสําคัญของบุคลิกภาพสามารถพิจารณาไดจาก ความมั่นใจ การคาดหมาย
พฤติกรรม การยอมรับความแตกตางระหวางบุคคล การตระหนักในเอกลักษณของบุคคล การ
ปรับตัวใหเขากับคนอ่ืนๆ ความสําเร็จและการยอมรับของกลุม 

 

ประเภทของบุคลิกภาพ 
ศรีธรรม ธนะภูมิ (2535) ไดกลาวถึงบุคลิกภาพของบุคคลที่อยูในเกณฑปกติซึ่งมีลักษณะ

เดน (Personal Traits) ของอุปนิสัยแตกตางกันไป ซึ่งในคนๆ เดียวอาจมีบุคลิกภาพมากกวา              
1 แบบได ลักษณะของบุคลิกภาพนี้จะแสดงออกชัดเจนเมื่อบุคคลเขาสูวัยผูใหญโดยแบงออกเปน 
12 ประเภท คือ 

1. บุคลิกภาพม่ันคง (Stable Personality) ไดแก ผูมีวุฒิภาวะของพัฒนาการทางอารมณ
และบุคลิกภาพสุขุมเยือกเย็น มีความรับผิดชอบสูง มีเหตุผล มีวิจารณญานในการแกปญหา 

2. บุคลิกภาพพึ่งพาผูอ่ืน (Dependent Personality) ไดแก ผูที่มีบุคลิกภาพออนแอ
ชวยเหลือตัวเองไมได 

3. บุคลิกภาพชอบหลีกเล่ียง (Avoidance Personality) ไดแก ผูที่ไมมั่นใจในการเขาสังคม 
กลัวการถูกตําหนิ พยายามหลีกเล่ียงกิจกรรมทางสังคม กลัวการถูกวิจารณและกลัวการเส่ียงภัย
ตางๆ 
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4. บุคลิกภาพด้ือเงียบ (Passive - Aggressive Personality) ไดแก ผูที่ชอบตอตานอยาง
เงียบๆ การแสดงพฤติกรรมที่เหมาะสมในฐานะสมาชิกของครอบครัวหรือในสังคมไมรับผิดชอบ
งาน ชอบอางเหตุผลเพื่อหลีกเล่ียงความผิดพลาดที่เกิดข้ึน 

5. บุคลิกภาพยํ้าคิดย้ําทํา (Obsessive Compulsive Personality) ไดแก บุคคล เจา
ระเบียบ เครงครัด ไมคอยยืดหยุน เขมงวดตอกฎเกณฑ ชอบบงการใหผูใกลชิดกระทําอยางที่ตน
ตองการ ไมไววางใจผูอ่ืนวาจะทํางานไดดีเสมอตน 

6. บุคลิกภาพหลงตนเอง (Narcissistic Personality) ไดแก คนที่มีลักษณะชื่นชมตนเอง
มากกวา มีความสามารถและประสบความสําเร็จสูง ออนไหวตอคําวิจารณของผูอ่ืนและไมคอย
เห็นอกเห็นใจผูอ่ืน เปนคนชอบอิจฉาริษยา ไมยินดีในความสําเร็จของผูอ่ืน 

7. บุคลิกภาพเรียกรองความสนใจ (Histrionic Personality) เปนคนเจาอารมณตองการ
คนสรรเสริญ ตองการการยอมรับและคําปลอบใจจากผูอ่ืนเสมอ อารมณเปล่ียนแปลงอยางรวดเร็ว          
ใชความเดนทางเพศของตนเองดึงดูดความสนใจจากผูอ่ืน 

8. บุคลิกภาพแบบก้ํากึ่ง (Borderline Personality) ไดแก ผูที่มีปญหาเกี่ยวกับความเปน
ตัวของตัวเอง (Identity) มีปญหาในการสรางมนุษยสัมพันธ อารมณเปล่ียนแปลงงายมีลักษณะ
หุนหันไมยั้งคิด ทําตามใจตนเอง อารมณแปรปรวน มีปญหาในการสรางความสัมพันธกับผูอ่ืนไม
แนใจในบทบาทของตนเอง 

9.บุคลิกภาพหุนหันพลันแลนและกาวราว (Impressive and Aggressive Personality)  
ไดแก ผูที่ไมวางแผนลวงหนาในการกระทําส่ิงตางๆ อารมณรอน โกรธงาย ควบคุมตนเองไดนอย 
ชอบทําส่ิงตางๆ อยางรวดเร็วและกาวราว 

10. บุคลิกภาพตอตานสังคม (Antisocial Personality) ชอบกอเร่ืองขัดแยงกับผูอ่ืนไม
สนใจความรูสึกของผูอ่ืน ไมสนใจกฎระเบียบตางๆ ชอบฝาฝนขอตกลงของหมูคณะเอาแตใจ ขาด
ความรับผิดชอบ 

11. บุคลิกภาพอารมณแปรปรวน (Affective Personality) ไดแก ผูที่มีอารมณเปลี่ยนแปลง
งาย เด๋ียวเศราสลับครึกคร้ืน ชอบแสดงออกอยางเปดเผย มีปญหาในการสรางมนุษยสัมพันธ 

12. บุคลิกภาพระแวง (Paranoid Personality) เปนผูชอบสงสัย ไมไววางใจในผูอ่ืน             
มองโลกในแงราย ไมคอยใหอภัยผูอ่ืน หากมีขอขัดแยงจะตอบโตรุนแรงและอาฆาตพยาบาท           
มักระแวงคูครองและผูใกลชิดวาไมซื่อสัตยตอตน 

13. บุคลิกภาพแยกตัว (Schizoid Personality) ไมชอบสังคม เปนคนเฉยๆไมแสดง
อารมณไมชอบแสดงความรักความสนิทสนมกับผูอ่ืน ชอบแยกตัวทําส่ิงตางๆ ตามลําพัง 
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แอริค ฟรอมม (Erich Fromm) นักสังคมศาสตรชาวเยอรมันนีไดอธิบายความเห็นตอการ
พัฒนาบุคลิกภาพวา “ โครงสรางของสังคมใดๆ ยอมกลอมเกลาบุคลิกภาพของสมาชิกใหเขากนัได
กับคานิยมสวนรวมของสังคมนั้นๆ” 

อับราฮัม มาสโลว (Abraham Maslow) นักจิตวิทยาชาวอเมริกัน ไดเสนอแนวคิดเกี่ยวกับ
ทฤษฎีทางบุคลิกภาพในชวงศตวรรษที่ 19-20 อยู 3 แนวคิดที่สําคัญ คือ 

1. แนวคิดกลุมจิตวิเคราะห เช่ือวาจิตใตสํานึกและพลังจูงใจที่ไรเหตุผล เปนตัวกระตุนให
คนทําพฤติกรรมนานาประการ รวมทั้งเปนตัวกําหนดลักษณะบุคลิกภาพของบุคคล 

2. แนวคิดกลุมพฤติกรรม มีทัศนะวาบุคลิกภาพของมนุษยยืดหยุนอยูใตอิทธิพลของ
สิ่งแวดลอมทางชีวภาพและทางสังคม มนุษยจะมีบุคลิกภาพอยางไรจะประสบความสําเร็จหรือไม
ข้ึนอยูกับลักษณะรูปแบบของส่ิงแวดลอมรอบตัว และเช่ือวาพฤติกรรมและบุคลิกภาพใดๆ อยู
ภายใตกฎเกณฑการเรียนรู 

3. แนวคิดกลุมมานุษยนิยม เปนแนวคิดที่มองธรรมชาติของมนุษยในแงดีงามวามนุษยมี
ความปรารถนาจะสรางสรรคความดี ความเจริญแหงตน และบุคลิกภาพของตน รูคุณคาในตนเอง          
มีความตองการที่จะรูจักตนและความสามารถเฉพาะตน  เพื่อจะไดนําพลังและความรู
ความสามารถดังกลาวมาใชไดอยางเต็มที่ 

สรุปไดวาประเภทของบุคลิกภาพสามารถแบงออกไดเปน 13 ประเภท ไดแก บุคลิกภาพที่
มั่นคง พึ่งพาผูอ่ืน ชอบหลีกเล่ียง ด้ือเงียบ ย้ําคิดย้ําทํา หลงตนเอง เรียกรองความสนใจ แบบก้ํากึ่ง 
หุนหันพลันแลนและกาวราว ตอตานสังคม อารมณแปรปรวน ระแวงและบุคลิกภาพแยกตัว 

จากการศึกษางานวิจัยของ ริชารดดี จอหนสัน (Richard D. Johnson, 2005) ไดกลาวถึง
ลักษณะของ บุคลิกภาพภายในไววา บุคลิกภาพภายในมีสวนทําใหเกิดการแสดงพฤติกรรมตางๆ 
ออกมาได บุคลิกภาพภายใน หมายถึง การรับรูในการประเมินตนเองเกี่ยวกับความสามารถในการ
กระทําส่ิงตางๆ ทั้งเชิงบวกและเชิงลบ ซึ่งแบงออกเปน 2 ดาน ไดแก การเห็นคุณคาในตนเองและ
ความออนไหวทางอารมณ 

 3.2.1 การเห็นคุณคาในตนเอง 
แบนดูรา (Bandura, 1986) ไดกลาววา  ความเห็นคุณคาในตนเอง หมายถึง การ

ประเมินตนเองของบุคคลวาตนเองเปนอยางไร ถาบุคคลใดมีความรูสึกวาตนเองเปนบุคคลที่ไรคา
จะกลาวไดวาบุคคลนั้นเปนผูมีความเห็นคุณคาในตนเองตํ่า ในขณะที่บุคคลใดไดแสดงความ
ภาคภูมิใจในตนเอง จะกลาวไดวาบุคคลนั้นเปนผูมีความเห็นคุณคาในตนเองสูง 
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คารเพนนิโต (Carpenito, 1983) กลาววา ความเห็นคุณคาในตนเองเปน
บุคลิกภาพอยางหนึ่งของบุคคลที่จะมีการตัดสินความมีคุณคาในตนเอง จากผลการประเมนิตนเอง
ในเร่ืองความสามารถและการยอมรับของสังคม 

นาตยา วงศหลีกภัย (2532) สรุปวา ความเห็นคุณคาในตนเอง หมายถึง ทัศนคติ
ที่บุคคลมีตอตนเอง มีความเคารพยอมรับในตนเองวามีความสําคัญ และความสามารถในการ
กระทําส่ิงตาง ๆ ใหประสบกับความสําเร็จ 

สรุปไดวา ความเห็นคุณคาในตนเองเปนผลรวมของแนวทางที่บุคคลรับรู และ
พิจารณาตัดสินคาของตนตามความรูสึกของทัศนคคติที่มีตอตนเองในเชิงบวก ในเร่ืองการประสบ
ความสําเร็จ  การยอมรับตนเอง การพึ่งตนเอง ความมั่นใจ คิดวาตนเองมีคาในสังคม  

3.2.2 ความออนไหวทางอารมณ 
ความออนไหวทางอารมณ หมายถึง ความคิดความรูสึกของผูเรียนที่มีตอตนเอง

ในดาน ความหดหู  อาการซึมเศรา ความรูสึกกังวลใจ  อาจจะมีอาการความกดดันเกิดข้ึนเมื่อ
ตนเองไดทํางานที่ลมเหลว ไมสามารถควบคุมการทํางานของตนเองได  เกิดความสงสัยใน
ความสามารถของตนเอง ซึ่งอาจจะนําไปสูความทอแทและส้ินหวังได 

 

3.3 ความมุงมั่นในการทํางาน 
ตามพจนานุกรม (2524) ไดใหความหมายของคําวา มุง มีความหมายวา ต้ังใจไว 
มั่น มีความหมายวา แน, แนนอน, แนน, แนนและทนทาน ไมขยับเขย้ือนหรือเปล่ียนแปลง

ไดงาย, แนนหนาทนทาน  
เมื่อไดนําคําวา มุง และม่ัน มารวมจึงเกิดคําวา มุงมั่น มีความหมายวา ต้ังใจไว แนนอนไม

เปล่ียนแปลงไดงาย 
สวนภาษาอังกฤษนั้น ใน Webster’s dictionary (1965) ไดกลาวถึงคําที่ตรงกับความ

มุงมั่นในภาษาไทยไวคือ คําวา “Intention” แปลวา ต้ังใจ เจตนา (intention = a determination to 
act in a certain way = การตัดสินที่จะกระทําในทาง/วิธีที่กําหนดไวอยางแนนอน) 

เม่ือนําคําวา”มุงมั่น” มาใชกับ “การทํางาน” เปน “ความมุงมั่นในการทํางาน” จึงนาจะมี
ความหมาย ความต้ังใจ แนวแนที่จะทํางานใหบรรลุความสําเร็จ มีความรับผิดชอบ ตอขอกําหนด
ของงาน มีการติดตามงานที่ทํา และหาวิธีการใหมๆ มาใชปฏิบัติงานใหดีข้ึนเร่ือยๆ 

ลักษณะของบุคคลที่มีความมุงมั่นในการทํางาน ไดแก บุคคลนั้นจะมีความเชื่อวาความ
พยายามและความฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได  เขาสามารถ
เลือกทํางานที่เปดโอกาสใหตนเองไดเกิดการเรียนรู และจะตองรูสึกผิดหวังและเบื่อหนายถาตอง



 46
 

ทํางานที่งาย การเรียนรูที่เกิดข้ึนเกิดจากแรงจูงใจภายในของบุคคลนั้น  ตลอดจนพยายามหา
วิธีการเรียนรูตางๆ ที่ชวยทําใหการเรียนรูมีประสิทธิภาพมากข้ึนโดยทุมเทความพยายามอยางมาก
ในการเรียนรู ถึงแมไมประสบความสําเร็จ ก็ไมยกเลิกที่จะทํางานช้ินนั้น  สามารถประเมินผลงานที่
ทําโดยเปรียบเทียบกับตนเองวามีความกาวหนาไปมากนอยอยางไร  และเช่ือวาความพยายาม
และการฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได  จะรูสึกพอใจกับผลงานที่
ตนเองตองทํา ถึงแมวางานที่ทําจะไมประสบความสําเร็จทั้งๆที่ไดพยายามอยางเต็มที่แลว  
ตองการทราบผลการเรียนรู เพื่อเปนขอมูลในการปรับปรุงการเรียนรูใหดีข้ึน  ผูเรียนจะคิดวา
ครูผูสอนคือแหลงขอมูลสามารถใหคําแนะนําตางๆได  และคิดวาความผิดพลาดเปนเร่ืองปกติและ
มีประโยชนในกระบวนการเรียนรู และสามารถนําเอาความผิดพลาดไปปรับปรุงการเรียนใหดีข้ึน 
และความผิดพลาดเปนตัวบงชี้ใหบุคคลเพ่ิมความพยายามในการทํางานใหมากข้ึน 

สรุปไดวาบุคคลที่มีความมุงมั่นในการทํางาน (Learning Goal Orientation) จะพยายาม
กระทํากิจกรรมตางๆที่จะชวยใหบุคคลสามารถเรียนรูไดดีข้ึน เชน มีความกระตือรือรน ต้ังใจเรียน 
ยอมรับขอบกพรองของตนเองได ไมทอถอยกับความลมเหลวที่เกิดข้ึน และคิดวาการพยายามและ
การฝกฝนเปนหนทางไปสูความสําเร็จ  

 

3.4 ความวิตกกังวลในการใชคอมพิวเตอร  
ความวิตกกังวลในการใชคอมพิวเตอรสามารถศึกษาไดจาก ความหมายของความวิตก

กังวล ประเภทของความวิตกกังวล กลไกการเกิดความวิตกกังวล สาเหตุของความวิตกกังวล ผล
ของความวิตกกังวล การประเมินความวิตกกังวล ระดับของความวิตกกังวลและความวิตกกังวลใน
การใชคอมพิวเตอร 

 

ความหมายของความวิตกกังวล  
ความวิตกกังวล (Anxiety) มีรากศัพทมาจากภาษากรีกและละติน รากศัพทที่มาจาก

ภาษากรีกมีความหมายวา “การกดหรือการรัดใหแนน” และรากศัพทภาษาละตินมีความหมายวา 
”ความแคบหรือความตีบตัน” จากรากศัพททั้ง 2 ภาษา ความหมายของความวิตกกังวลจะมี
ความหมายสอดคลองไปในทางเดียวกัน ซึ่งจะหมายถึง ความไมสุขสบาย ความกดดัน นอกจากนี้
ความหมายของความวิตกกังวลยังมีความหมายครอบคลุมไปถึง ความรูสึกหงุดหงิด ไมสบายใจ
ตอสถานการณที่ไมแนนอน ความรูสึกหวั่นเกรงตอผลที่จะเกิดข้ึน ความรูสึกกระสับกระสาย 
ความรูสึกอึดอัดไมสบายใจ ความรูสึกต่ืนตระหนก ความรูสึกไมมั่นใจเกี่ยวกับอนาคตลาดเดอร 
และมารค (Ladder &  Mark, 1971) 
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นอกจากนี้แลวยังมี นักจิตวิทยากลุมตางๆ ที่ไดสนใจศึกษาเกี่ยวกับความวิตกกังวล ก็จะ
ใหความหมายของความวิตกกังวลแตกตางกันออกไป ตามความเช่ือพื้นฐานของแตละกลุม
แนวความคิด ดังนี้ 

แนวคิดกลุมจิตวิเคราะหฟรอยด(Freud, 1943) ใหความหมายของความวิตกกังวลใน
ลักษณะที่เปนแรงขับพื้นฐานและเกี่ยวกับจิตไรสํานึก (uncondcious) โดยใหความหมายของ
ความวิตกกังวลไววา  เปนประสบการณ ความหวาดหวั่น ความตึงเครียด โดยมีสาเหตุที่ไมชัดเจน
ซึ่งสาเหตุที่ไมชัดเจนนี้มักจะเกี่ยวกับจิตไรสํานึก 

แนวคิดกลุมมนุษยนิยมโรเจอร (Roger, 1951) ไดใหความหมายของความวิตกกังวลโดย
เนนที่ความไมสอดคลองระหวางตนที่เปนจริง (Real self) และตนที่คาดหวัง (Ideal self) ซึ่ง
สภาวะเกิดความไมสอดคลองดังกลาวนี้จะทําใหเกิดความไมสมดุลทางจิตใจ ซึ่งจะเปนพื้นฐาน
ของการเกิดความวิตกกังวล 

แนวคิดกลุมปญญานิยมเบค (Beck, 1972) ไดใหความหมายของความวิตกกังวลวาเปน
ผลจากสภาพความกดดัน ที่บุคคลรับรูและประเมินจากสถานการณ ดังนั้นตามแนวคิดกลุมนี้จะให
ความสําคัญกับความคิดมากกวาสภาพความกดดันที่เกิดจริง กลาวคือ เมื่อมีสถานการณเกิดข้ึน
บุคคลจะรับรูและประเมินสถานการณที่เกิดข้ึนวาเปนการคุกคามหรือไม  ถาประเมินสถานการณ
วาเปนการคุกคาม สถานการณนั้นจะกลายเปนสถานการณที่กดดัน และจะกระตุนเกิดความวิตก
กังวล แตถาบุคคลประเมินสถานการณวาไมเปนการคุกคาม  สถานการณนั้นก็จะไมเปนความ
กดดัน สถานการณนั้นจะไมเปนส่ิงเราที่ทําใหเกิดความวิตกกังวล 

จากแนวความคิดของนักจิตวิทยากลุมตางๆ นั้นจะมีความหมายสอดคลองกันในสวนที่
กลาวถึงพฤติกรรมที่แสดงออกถึงความวิตกกังวล เชน รูสึกหวาดหวั่น รูสึกตึงเครียด ไมสบายใจ 
ฯลฯ  แตจะอธิบายการเกิดความวิตกกังวลตางกันออกไป คือ กลุมจิตวิเคราะหจะใหความสําคัญ
กับแรงขับพื้นฐานและจิตไรสํานึก กลุมมนุษยนิยมเนนที่ความไมสอดคลองกันระหวางคนที่
คาดหวังกับคนที่เปนจริง  แนวคิดปญญานิยมเนนที่การรับรูและประเมินสถานการณวาจะเปน
สถานการณที่รูสึกคุกคามหรือไม 

ฮอทสแมน (Holtzman, 1976) ไดกลาววาความวิตกกังวลจะเกิดข้ึนเมื่อบุคคลรับรูเปนส่ิง
เรานั้นวาเปนส่ิงเราที่มาคุกคามตนเอง และการประเมินวาส่ิงเรานั้นเปนภาวะคุกคามหรือไม จะ
ไดรับอิทธิพลจากความวิตกกังวลที่เปนคุณลักษณะเฉพาะตัวดวย ถาหากบุคคลประเมินวาส่ิงเรา
นั้นคุกคามตอตนก็จะทําใหเกิดความวิตกกังวลโดยมีการแสดงออกดังนี้ 
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1. มีการกระตุนการทํางานของระบบประสาทสวนกลาง ทําใหเกิดการเปล่ียนแปลงทางสรีระ  
2. เกิดความวิตกกังวลตอสภาพการณ 
3. มีการใชกลไกการเผชิญความเครียด (Coping mechanism) เพื่อจํากัดสาเหตุของ

ความวิตกกังวล หรือเพื่อลดความวิตกกังวล 
การแสดงออกของความวิตกกังวล ทั้ง 3 ประการนี้ จะมีปฏิสัมพันธซึ่งกันและกันและจาก

การรับรูการเปลี่ยนแปลงทางสรีระ จะทําใหบุคคลประเมินความรูสึกวารูสึกวิตกกังวล จึงทําให
พยายามหาวิธีลดความวิตกกังวล โดยใหเปล่ียนสภาพแวดลอมที่ทําใหเกิดความวิตกกังวล
พยายามเรียนรูที่จะแสดงออกอยางเหมาะสม มีการประเมินส่ิงเราใหมและเรียนรูวิธีลดความวิตก
กังวลโดยตรง เพื่อลดการกระตุนระบบประสาทสวนกลางและการเปล่ียนแปลงทางสรีระ 

สรุปไดวา ความวิตกกังวล หมายถึง พฤติกรรมที่แสดงออกถึงความวิตกกังวล เชน รูสึก
หวาดหวั่น รูสึกตึงเครียด ไมสบายใจ ตอส่ิงใดสิ่งหนึ่ง 

ประเภทของความวิตกกงัวล 
 สปลเบอรเกอร (Spielberger, 1972) ไดแบงความวิตกกังวลออกเปน 2 ประเภท คือ 
 1. ความวิตกกังวลตอสภาพการณ (State anxiety) เปนความวิตกกังวลที่เกิดข้ึนจากการ
ตอบสนองเฉพาะอยาง โดยจะเกิดข้ึนทันทีทันใดเมื่อมีส่ิงเรามากระตุนใหเกิดความไมพอใจหรือทํา
ใหเกิดอันตราย มีผลทําใหเกิดพฤติกรรมตอบสนองตอส่ิงเรานั้น โดยท่ีในชวงเวลาที่ถูกกระตุนเรา
นั้น จะเปนภาวะที่ตึงเครียด หวาดหว่ัน กระวนกระวาย มีการตื่นตัวของระบบประสาทอัตโนมัติ ซึ่ง
ความรุนแรงที่แสดงออกตอสภาวะเชนนี้ จะแตกตางกันไปตามความแตกตางระหวางบุคคล 
 2. ความวิตกกังวลที่เปนลักษณะประจําตัว (Trait anxiety) เปนความวิตกกังวลที่มีอยูใน
ตัวบุคคลจนกลายเปนลักษณะประจําตัวและมีลักษณะคงที่ และความวิตกกังวลที่เปนลักษณะ
ประจําตัวนี้จะไมปรากฏออกมาเปนพฤติกรรม แตจะเปนตัวเสริมของความวิตกกังวลตอ
สถานการณ คือ เมื่อมีส่ิงเรามากระตุนใหเกิดความไมพอใจหรือทําใหเกิดอันตราย  บุคคลที่มี
ความวิตกกังวลที่เปนลักษณะประจําตัวสูง จะมีความไวในการรับรูส่ิงเราที่ทําใหไมพอใจหรือทําให
เกิดอันตรายไดเร็วกวาบุคคลท่ีมีความวิตกกังวลที่เปนลักษณะประจําตัวตํ่า นอกจากนี้ความวิตก
กังวลที่ เปนลักษณะประจําตัว  และมีผลตอความรุนแรงของการเกิดความวิตกกังวลตอ
สถานการณ 

สรุปไดวาความวิตกกังวลที่เปนลักษณะประจําตัวจะเปนลักษณะประจําตัวของบุคคลที่มี
แนวโนมที่จะเกิดความวิตกกังวล ซึ่งเปนลักษณะของบุคลิกภาพที่ฝงแนนของแตละบุคคล แต
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ความวิตกกังวลตอสภาพการณ จะมีลักษณะเกิดข้ึนเฉพาะสถานการณ คือจะเกิดข้ึนเมื่อไดเผชิญ
กับสถานการณที่ถูกคุกคาม และเกิดข้ึนช่ัวคราวเฉพาะสถานการณ 

นอกจากแนวความคิดในการแบงประเภทของความวิตกกังวลออกเปน ความวิตกกังวลตอ
สภาพการณและความวิตกกังวลที่เปนลักษณะประจําตัวแลว Sarason et al. (1960) ไดแบง
ประเภทของความวิตกกังวลออกเปน ความวิตกกังวลตอสถานการณทั่วไป (Genaral anxiety) ซึ่ง
เปนความวิตกกังวลที่เกิดข้ึนโดยไมมีสถานการณเปนตัวกระตุนเราอยางเฉพาะเจาะจง และความ
วิตกกังวลตอสถานการณเฉพาะ (Specific anxiety) ซึ่งเปนความวิตกกังวลที่เกิดจากการ                      
มีปฏิกิริยาตอบสนองตอสถานการณที่มาคุกคามเฉพาะอยาง เชน การสอบ การเรียน การพูดหนาช้ัน 

กลไกการเกิดความวิตกกังวล 
 เอนดเลอรและเอ็ดเวิด (Endler & Edwards, 1982) อธิบายวาเม่ือบุคคลและส่ิงแวดลอม
มีปฏิสัมพันธซึ่งกันและกัน  บุคคลจะประเมินสถานการณที่เกิดข้ึนวาเปนภาวะคุกคามหรือไม              
ซึ่งการประเมินนี้จะมีความแตกตางกันออกไปตามลักษณะความวิตกกังวลที่เปนลักษณะ
ประจําตัว (Trait anxiety)ของแตละบุคคลและความรุนแรงของสถานการณที่เกิดข้ึน เมื่อบุคคล
ประเมินวาสถานการณนั้นเปนภาวะคุกคาม จะมีผลทําใหเกิดความวิตกกังวลตอสภาพการณ 
(State anxiety) และมีปฏิกิริยาตอบสนองตอความวิตกกังวลตามแผนภาพที่ 2.5 
 
 
 
 
 
 
 
 
 
 
แผนภาพที่ 2.5 กลไกการเกิดความวิตกกังวล 
ที่มา : Endler และ Edwards, 1982 

สถานการณ 
(Situation variable) 

ความวิตกกังวลที ่
เปนลักษณะประจําตัว 

(Person variable) 

การรับรูสถานการณ
วาเปนภาวะคุกคาม 

ความวิตกกังวลตอ
สภาพการณ

การตอบสนองตอ
ความวิตกกังวล 
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สรุปไดวากลไกการเกิดความวิตกกังวลจะเกิดจากสถานการณและความวิตกกังวลที่เปน
ลักษณะประจําตัวซ่ึงสงผลทําใหเกิดการรับรูสถานการณ อันจะมีผลใหเกิดความวิตกกังวลในเวลา
ตอมา 

สาเหตุของความวิตกกังวล 
เอปสไตน (Epstein, 1972) ไดสรุปสาเหตุของความวิตกกังวลวาเกิดจากสาเหตุ 3 ประการ 

คือ  
 1. สาเหตุจากการมีส่ิงเราทางกายภาพมากระตุนเราบุคคล จนเกิดขีดระดับความสามารถ
ของบุคคลที่จะทนได ดังนั้นการตอบสนองตอความวิตกกังวลที่มาจากสาเหตุนี้จะแสดงออกมาเปน
ความเจ็บปวด แลวมีผลทําใหเกิดความกลัวและวิตกกังวล นอกจากนี้แลวขีดระดับความสามารถ
ของบุคคลที่จะทนตอส่ิงเราที่มากระตุนนั้น จะมีความแตกตางระหวางบุคคล 

2. สาเหตุจากความไมสอดคลองกันของความคิด คือ ความไมสอดคลองกันระหวาง
ประสบการณของตนและความคาดหวัง นั้นหมายความวาเกิดความไมสอดคลองกันระหวางความ
จริงและความคาดหวัง ซึ่งจะเปนภาวะที่รูสึกถูกคุกคามและนําไปสูการเกิดอาการวิตกกังวล 

3. สาเหตุจากความไมสามารถตอบสนองตอส่ิงเราที่เกิดข้ึนได ซึ่งอาจเกิดจากการไมรูส่ิง
เราใดเปนตัวกระตุนใหเกิดความวิตกกังวล และเกิดจากการขัดแยงระหวางการที่จะตองเลือกการ
ตอบสนอง ซึ่งภาวะเชนนี้จะนําไปสูการใหการเกิดความวิตกกังวล 

สรุปไดวาสาเหตุของความวิตกกังวลเกิดจากสาเหตุ คือ มีส่ิงเรามากระตุนบุคคลจนเกิน
ขีดความสามารถที่จะทนได ความไมสอดคลองกันทางความคิด และความไมตอบสนองตอส่ิงเราที่
เกิดข้ึนได 

ผลของความวิตกกังวล  
โกลดเบอรเกอร (Goldberger, 1982) ไดกลาวถึงผลกระทบของความวิตกกังวล คือ 

ความวิตกกังวลจะทําใหเกิดผลกระทบตอบุคคลในดานสรีระ อารมณ ความคิด และพฤติกรรมซ่ึงมี
รายละเอียดดังนี้ 

1. ดานชีวเคมี  ในขณะที่เกิดความวิตกกังวล จะทําใหระบบประสาทอัตโนมัติถูกกระตุน
แลวมีผลตอการทํางานของสมองและตอมไรทอ คือในขณะที่เกิดความวิตกกังวลตอมอดรีนาล 
(Adrenal medulla) จะหล่ังสารอดรีนาลิน (Adrenaline) และทําใหระดับของฮอรโมนบางชนิดใน
เลือดเพิ่มสูงข้ึน เชน อิพิเนฟริน (Epinephrene) และคอรติโคสเตรียรอยด (Corticceteriods) 

2. ดานสรีระ การเปล่ียนแปลงทางดานสรีระนั้นสวนมากจะเกิดข้ึนกับระบบประสาท
อัตโนมัติ ระบบกลามเนื้อ และระบบขับถาย การเปล่ียนแปลงทางระบบประสาทอัตโนมัติมักจะ
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เปนผลสืบเนื่องมาจากการเปล่ียนแปลงทางดานเคมี เชน สารอดรีนาลินจะมีผลทําใหอัตราการ
ไหลเวียนของเลือดมีมากข้ึน รางกายขับน้ํายอยมากกวาปกติ สารอิพิเนฟริน จะมีผลทําใหหัว
ใจเตนเร็วและเตนแรง ใจส่ัน ขนลุก เหงื่อออกงาย เพิ่มอัตราการเผาผลาญอาหาร สารคอรติโคส เต
รียรอยด จะมีผลตอระบบประสาทสวนกลาง เชน ทําใหนอนไมหลับ กระวนกระวาย รางกายขาด
ภูมิตานทานโรค การเปล่ียนแปลงเก่ียวกับระบบกลามเนื้อไดแกการเกิดอาการเกร็งของกลามเนื้อ 
ทําใหรูสึกปวดเมื่อยตามรางกาย การเปล่ียนแปลงเกี่ยวกับระบบขับถาย ไดแก อาการคล่ืนไส 
อาเจียน ทองอืดทองเฟอ ทองผูกหรือทองเสีย ปสสาวะบอย 

3. ดานอารมณ ผลของความวิตกกังวลที่มีตออารมณนั้น จะทําใหเกิดอาการต่ืนเตน 
หวาดหวั่น หงุดหงิด ตกใจงาย โกรธงาย กระสับกระสาย ขาดสมาธิ เหนื่อยหนาย ทอแท โศกเศรา 
เสียใจ รองไหบอย เปนตน 

4. ดานความคิด ความจําและการรับรู ผลของความวิตกกังวลจะทําใหเกิดความผิดปกติ
เกี่ยวกับความคิดไดแก การเกิดความคิดในทางลบ ระบบความคิดถูกรบกวน สับสน หมกมุน ย้ํา
คิด การตัดสินใจชา ไมยืดหยุนในการแกปญหา ความสนใจลดลง ขาดสมาธิ ฯลฯ ความผิดปกติ
เกี่ยวกับความจําไดแก มีอาการหลงลืม ความสามารถเกี่ยวกับจําลดลง และมีความผิดปกติ
เกี่ยวกับการเรียนรู 

สรุปไดวาผลของความวิตกกังวลจะสงกระทบใหเกิดกับบุคคล 4 ดาน ไดแก ดานชีวเคมี 
ดานสรีระ ดานอารมณและดานความคิด 

 

การประเมินความวิตกกังวล  
 เบราทีน (Beratein, 1973) ไดเสนอวาการประเมินความวิตกกังวลนั้นกระทําได 3 วิธี คือ 

1. การประเมินจากการรายงานตนเอง คือ ใหบุคคลรายงานความรูสึกวิตกกังวลดวย
ตนเอง ซึ่งอาจกระทําโดยการสัมภาษณ การจินตนาการ และการตอบแบบสอบถาม โดยเฉพาะ
การใชแบบสอบถามนั้นมักจะนํามาใชบอย เนื่องจากเปนวิธีที่สะดวกและใชไดผลดี 
 2. การประเมินจากการเปล่ียนแปลงทางสรีระ คือ เปนการประเมินจากการเปล่ียนแปลง
ทางสรีระที่เปนผลมาจากการทํางานของระบบประสาทอัตโนมัติ ไดแก การวัดความดันโลหิต การ
วัดอัตราการหายใจ การวัดการเตนของหัวใจ การวัดอาการเกร็งของกลามเนื้อ การวัดความ
ตานทานไฟฟาที่ฝามือ ฯลฯ 

3. การประเมินจากการสังเกตพฤติกรรม โดยการสังเกตพฤติกรรมโดยตรงหรือโดย
ทางออม การสังเกตโดยตรงจะเปนการสังเกตอาการที่แสดงออกถึงความเครียดโดยตรง เชน การ
หายใจ มือส่ัน กัดริมฝปาก ถอนหายใจ สวนการสังเกตพฤติกรรมทางออม กระทําไดโดยการให
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แสดงบทบาทสมมติแลวสังเกตพฤติกรรมความวิตกกังวลหรืออาจจะใหบุคคลอยูในสถานการณที่
ทําใหเกิดความวิตกกังวล แลวสังเกตพฤติกรรมความวิตกกังวล 
 สรุปไดวาการประเมินความวิตกกังวลสามารถประเมินได คือ การประเมินจากการรายงาน
ตนเอง จากการเปล่ียนแปลงทางสรีระและจากการสังเกตพฤติกรรม 

ระดับของความวิตกกังวล 
จอหนสัน (Johnson, 1986) ไดแบงระดับความรุนแรงของความวิตกกังวลออกเปน 4 

ระดับ ดังนี้ 
1. ความวิตกกังวลระดับเล็กนอย (Mild anxiety)  เปนความวิตกกังวลในระดับที่กระตุนให

บุคคลเกิดความต่ืนตัว กระตุนประสาทรับสัมผัสทั้ง 5 ใหรับรูไดอยางมีประสิทธิภาพมากข้ึน ทําให
เรียนรูและแกปญหาไดดีข้ึน และทําใหเกิดความคิดสรางสรรค 

2. ความวิตกกังวลระดับปานกลาง (Moderate anxiety) เปนความวิตกกังวลในระดับที่ทํา
ใหบุคคลสนใจตอความวิตกกังวลที่ เกิดข้ึน มีผลทําใหการรับรูประสาทสัมผัสทั้ง 5 ลดลง 
ความสามารถเกี่ยวกับการเรียนรูลดลง รางกายมีปฏิกิริยาตอบสนองตอความวิตกกังวลในการ
สอบ เชน มีอาการเกร็งของกลามเนื้อ มีอาการปนปวนภายในทอง มีอาการหอบหายใจเขาออกแรง 
ปวดศีรษะ เปนตน 

3. ความวิตกกังวลระดับสูง (Serve anxiety) เปนความวิตกกังวลในระดับที่ทําใหการรับรู
ประสาทสัมผัสทั้ง 5 ลดลงอยางมาก จนอาจทําใหรับรูสภาพแวดลอมบิดเบือนไปจากความเปน
จริง รับรูรายละเอียดของเหตุการณที่เกิดข้ึนเพียงบางสวน ทําใหไมสามารถเช่ือมโยงรายละเอียด
ของเหตุการณทั้งหมดที่เกิดข้ึนได และบุคคลมีปฏิกิริยาตอบสนองตอความวิตกกังวลทั้งทาง
รางกาย อารมณ และพฤติกรรม 

4. ความวิตกกังวลระดับรุนแรงที่สุด (Panic anxiety) เปนความวิตกกังวลในระดับที่ทําให
บุคคลรับรูสภาพแวดลอมผิดไปจากความเปนจริงจนอาจมีอาการของประสาทหลอน บุคคล
สูญเสียการควบคุมตนเอง บุคลิกภาพและความคิดผิดปกติจนอาจมีอาการหลงผิด ความสามารถ
เกี่ยวกับการเรียนรูเสียไป รางกายมีการตอบสนองตอความวิตกกังวลอยางรุนแรง 

ความวิตกกังวลไมใชสภาวะอารมณที่มีผลในทางลบเพียงอยางเดียว ความวิตกกังวลใน
ระดับเล็กนอยและปานกลาง จะมีประโยชนเปนตัวกระตุนใหเกิดการต่ืนตัวใหเกิดการเรียนรู
แกปญหา ทํากิจกรรมตางๆใหดีข้ึน และเกิดความคิดสรางสรรค แตความวิตกกังวลในระดับสูงและ
รุนแรงที่ สุด จะมีผลในทางลบ  ทําให เกิดพยาธิสภาพทางจิตใจจนอาจทําใหเกิดโรคจิต                         
โรคประสาทได 
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 สรุปไดวาความวิตกกังวล ไดแบงออกเปน 4 ระดับ คือ ระดับเล็กนอย ปานกลาง สูงและ
รุนแรงที่สุด ซึ่งแตละระดับก็จะมีผลความรุนแรงที่แตกตางกันออกไป 

 

ความวิตกกังวลในการใชคอมพิวเตอร 
นักวิจัยไดใหความหมายของคําวา ความวิตกเกี่ยวกับคอมพิวเตอร (Computer Anxiety) 

คืออาการทางจิตวิทยาที่บุคคลมีปฏิกริยาทางลบตอการใชคอมพิวเตอร อาการที่แสดงออก เชน 
ครุนคิดตลอดเวลาถึงความอันตราย กลัววาตนเองจะตกเปนทาสของเทคโนโลยี ไมสามารถ
ควบคุมสถานการณไดดวยตนเอง กลัววาคอมพิวเตอรจะเขามาแทนที่มนุษย อับอาย ทอแท ต่ืน
กลัววาจะแสดงความไมรูของตนเองออกไป 

การศึกษาในดานความวิตกกังวลเมื่อใชคอมพิวเตอรแสดงใหเห็นปรากฎการณของความ
วิตกและไดต้ังช่ือผูที่มีอาการตาง ๆ ไวคือ ซีเอ (CA) ที่รูจักกันดีวาเปนชื่อเรียกผูที่กลัวคอมพิวเตอร
(Computerphobia) ผูที่กลัวเทคโนโลยี (Technophobia) ฯลฯ บุคคลที่มีอาการซีเอ มักถูกจัดอยู
ในกลุมที่มีอาการกลัวคอมพิวเตอร และเทคโนโลยี หรือบางคร้ังก็ถูกเรียกวาเปนผูไมมีการศึกษา
ดานคอมพิวเตอร (computer illiterate) ความกลัวเทคโนโลยีเกิดข้ึนไดในหลากหลายลักษณะและ
มีอาการแตกตางกันดังนี้ 

1. ผูใชที่อึดอัดขัดของ (The uncomfortable user) เปนกลุมที่จัดไดวามีความกังวลตํ่า 
และไมจําเปนตองมีการใหความชวยเหลือเปนพิเศษ หรือชวยเหลือเปนรายบุคคล กลุมนี้ขาดเพียง
การสนับสนุนทางเทคนิควิธี หรือขอมูล เพื่อที่จะขับไลความไมรู หรือเรียนรูถึงความเปนจริงของ
คอมพิวเตอรเทคโนโลยี 

2. พวกกลัวคอมพิวเตอรที่มีความวิตก (The anxious computerphobic) เปนกลุมที่แสดง
อาการอยางชัดเจนวาวิตกกังวล เชนเหงื่อออกตามมือ ส่ัน ปวดศรีษะ ฯลฯ 

3. พวกกลัวคอมพิวเตอรแตภายนอกสงบนิ่ง (The outwardly calm computerphobic)    
คนกลุมนี้มีอาการสงบถาสังเกตจากภายนอก แตภายในใจจะเต็มไปดวยความวาวุน และถอยคําที่
ตอตานคอมพิวเตอร เชน “ใคร ๆก็รูวิธีทํา (งานกับคอมพิวเตอร) ยกเวนฉัน” หรือ “ฉันกําลังจะกด
ปุมผิดแน ๆ แลวเจาเคร่ืองนี่จะพัง” โรเซน(Rosen, 1993) 

อยางไรก็ตามเมื่อกลาวถึงความวิตกกังวลในการใชคอมพิวเตอรอาจมีชื่อเรียกอ่ืน ๆ อีกแต
ทายที่สุด อาการตาง ๆ จะเกี่ยวของกับความกลัวเทคโนโลยีคอมพิวเตอรทั้งส้ิน และเปนปจจัยหนึ่ง     
ที่เปนอุปสรรคตอการสรางสังคมคอมพิวเตอร (Computerized society) 
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ดังนั้นความวิตกกังวลในการใชคอมพิวเตอร จึงเปนความรูสึกของสภาวะจิตใจของผูเรียน
ที่มีตอการใชคอมพิวเตอรที่ทําใหผูเรียนเกิดความคิดดานลบตอตนเอง ในเร่ืองของการเรียน และ
การใชงานทางดานคอมพิวเตอร 

 

ตอนท่ี 4 แนวคิดทฤษฎีเกี่ยวกับความสามารถทางคอมพิวเตอรและปจจัยที่สงผลตอ
ความสามารถทางคอมพิวเตอร 

ในตอนนี ้ผู ว ิจ ัยได รวบรวมแนวคิดและทฤษฎีที ่เกี ่ยวข องก ับความสามารถทาง
คอมพิวเตอรและปจจัยที่สงผลตอความสามารถทางคอมพิวเตอร ดังนี้ 

 

สาระและมาตรฐานการเรยีนรูของกลุมการงานอาชีพและเทคโนโลยี  
ผูวิจัยนําสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพและเทคโนโลยีนี้มาเปน

สาระสําคัญในการศึกษาหาตัวแปรสําหรับใชวัดความสามารถทางคอมพิวเตอรของนักเรียนชวงชัน้
ที่ 4 โดยพิจารณาจากเน้ือหาที่มีความเหมาะสมกับระดับชวงช้ันของนักเรียนในรายวิชา
คอมพิวเตอร ตามที่สาระและมาตรฐานการเรียนรูไดกําหนดไว ดังนี้ 

ในบทนําของสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพและเทคโนโลยีกลาวไววา 
การพัฒนาผูเรียนตามหลักสูตรการศึกษาข้ันพื้นฐาน จะมุงพัฒนาใหเปนคนที่สมบูรณและสมดุล
ทั้งดานจิตใจ รางกาย สติปญญา อารมณ และสังคม โดยมุงเนนการพัฒนาใหผูเรียนมีความรู 
ความสามารถ ทั้งดานวิชาการ วิชางาน และวิชาชีวิต เพื่อใหสามารถดํารงชีวิตอยูในสังคมไดอยาง
มีความสุข พึ่งตนเองได อยูรวมกับผูอ่ืนอยางสรางสรรค พัฒนาสังคมและส่ิงแวดลอม  โดยที่สาระ
การเรียนรูกลุมการงานอาชีพและเทคโนโลยี เปนกลุมสาระการเรียนรูที่มุงเนนพัฒนาใหผูเรียนมี
ทักษะในการทํางาน ทํางานเปน รักการทํางาน ทํางานรวมกับผูอ่ืนได มีความสามารถในการ
จัดการ การวางแผนออกแบบการทํางาน สามารถนําเอาความรูเทคโนโลยีและเทคโนโลยี
สารสนเทศมาใช และประยุกตใชในการทํางาน สราง พัฒนางาน ผลิตภัณฑตลอดจนวิธีการใหม
เพื่อพัฒนาคุณภาพของงานและการทํางาน 

กลุมการงานอาชีพและเทคโนโลยีมีวิสัยทัศนที่เนนใหผูเรียนไดฝกกระบวนการทํางานและ
จัดการอยางเปนระบบ พัฒนาความคิดสรางสรรค มีทักษะการออกแบบงานและสามารถทํางานได
อยางมีกลยุทธ โดยใชกระบวนการของเทคโนโลยีสารสนเทศ ตลอดจนนักเรียนสามารถนํา
เทคโนโลยีมาประยุกตใชในการทํางาน สราง พัฒนา ผลิตภัณฑ หรือคิดคนวิธีการใหมที่เนนการใช
ทรัพยากรธรรมชาติ ส่ิงแวดลอมและพลังงานอยางประหยัดและคุมคา ดังนั้นเพื่อใหบรรลุวิสัยทัศน
ดังกลาว กลุมการงานอาชีพและเทคโนโลยี จึงกําหนดการเรียนรูที่ยึดงานกระบวนการจัดการและ
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การแกปญหาเปนสําคัญบนพื้นฐานของการใชหลักการและทฤษฎีเปนหลักในการทํางานและการ
แกปญหา งานท่ีนํามาฝกฝนเพื่อบรรลุวิสัยทัศนของกลุมนั้น เปนงานเพ่ือการดําเนินชีวิตใน
ครอบครัวและสังคมและงานเพื่อการประกอบอาชีพ ซึ่งงานทั้ง 2 ประเภทนี้ เมื่อผูเรียนไดรับการ
ฝกฝนและปฏิบัติตามกระบวนการเรียนรูของกลุมการงานอาชีพและเทคโนโลยีแลว ผูเรียนจะไดรับ
การปลูกฝงและพัฒนาใหมีคุณภาพและคุณธรรม การเรียนรูจากการทํางานและการแกปญหาของ
กลุมการงานอาชีพและเทคโนโลยี จึงเปนการเรียนรูที่เกิดจากการบูรณาการความรู ทักษะ และ
ความดีที่หลอมรวมกันจนกอเกิดเปนคุณลักษณะของผูเรียน ทั้งดานคุณภาพและคุณธรรมตาม
มาตรฐานการเรียนรูที่กําหนด 

ในดานคุณภาพของผูเรียน กลุมการงานอาชีพและเทคโนโลยีมุงพัฒนาผูเรียนแบบองค
รวมเพื่อใหเปนคนดี มีความรู ความสามารถ โดยมีคุณลักษณะที่พึงประสงคดังนี้ มีความรูความ
เขาใจเกี่ยวกับการดํารงชีวิตและครอบครัว การอาชีพ การออกแบบ และเทคโนโลยี เทคโนโลยี
สารสนเทศ เทคโนโลยีเพื่อการทํางาน และอาชีพมีทักษะในการทํางาน การประกอบอาชีพ การ
จัดการ การแสวงหาความรูเลือกใชเทคโนโลยีและเทคโนโลยีสารสนเทศในการทํางาน สามารถ
ทํางานอยางมีกลยุทธ สรางและพัฒนาผลิตภัณฑหรือวิธีการใหมมีความรับผิดชอบ ซื่อสัตย ขยัน 
อดทน รักการทํางาน ประหยัด อดออม ตรงตอเวลา เอ้ือเฟอ เสียสละ และมีวินัยในการทํางาน เหน็
คุณคาความสําคัญของงานและอาชีพสุจริต ตระหนักถึงความสําคัญของสารสนเทศ การอนุรักษ
ทรัพยากรธรรมชาติ ส่ิงแวดลอม และพลังงาน 

โดยสาระการเรียนรูของเทคโนโลยีสารสนเทศ 12 ป มีรายละเอียดดังนี้ 
1. ขอมูลและสารสนเทศ 
แหลงขอมูล ความหมายและประโยชนของขอมูล การรวบรวมขอมูล ประเภทของขอมูล    

การจัดเก็บขอมูลในรูปแบบที่เหมาะสม การประมวลผลขอมูลเปนสารสนเทศ การเก็บและ
บํารุงรักษาขอมูล ซอฟตแวรชวยประมวลผลขอมูล 

2. เทคโนโลยีสารสนเทศ 
องคประกอบของการผลิตสารสนเทศ บทบาทและประโยชนของเทคโนโลยีสารสนเทศ 

สวนประกอบและอุปกรณของเครื่องคอมพิวเตอร หลักการทํางานของเครื่องคอมพิวเตอร 
ซอฟตแวร คอมพิวเตอรระบบมัลติมีเดีย 

3. การสื่อสารขอมูลและเครือขาย 
การสื่อสารขอมูล สวนประกอบของเครือขายคอมพิวเตอร เครือขายอินเทอรเน็ตการคนหา

และการสืบคนขอมูล 



 56
 

4. หลักการแกไขปญหาหรือสรางงาน 
หลักการคิดคํานวณพื้นฐานในการประมวลผลขอมูล หลักการเร่ิมตนในการแกไขปญหา 

ข้ันตอนในการพัฒนาโปรแกรม และภาษาโปรแกรม การใชซอฟตแวรสําเร็จ ตรรกะ ระบบเลขฐาน
และวงจรตรรกะ 

5. โครงสรางงาน 
การนําเสนอขอมูล การวางแผนงาน การสรางงานตามวัตถุประสงคของงาน การจัดทํา

คูมือ การบํารุงรักษาโปรแกรมและขอมูล 
6. หลักการพื้นฐานของคอมพิวเตอร 
กลไกการทํางาน รูปแบบการทํางาน ภาษาคอมพิวเตอรระดับตํ่า 
7. การจัดขอมูล 
การจัดขอมูลเบ้ืองตน โครงสรางขอมูล การจัดการฐานขอมูล 
 

ตัวชี้วัดและสาระการเรียนรูแกนกลาง กลุมสาระการเรียนรูการงานอาชีพและ
เทคโนโลยีตามหลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน 

นอกจากนี้ผูวิจัยจึงไดนําคูมือตัวชี้วัดและสาระการเรียนรูแกนกลางของกลุมสาระการ
เรียนรูการงานอาชีพและเทคโนโลยีตามหลักสูตรการศึกษาข้ันพื้นฐาน พุทธศักราช 2551 มา
พิจารณาในการศึกษาหาตัวแปรสําหรับใชวัดความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน       
ที่ 4 ประกอบเพิ่มเติม คือ ในสาระที่ 3 เทคโนโลยีสารสนเทศและการส่ือสาร (มาตรฐาน ง 3.1) ได
เนนใหผูเรียนเขาใจ เห็นคุณคาและสามารถใชกระบวนการเทคโนโลยีสารสนเทศในการสืบคน
ขอมูล การเรียนรู การสื่อสาร การแกปญหา การทํางาน และอาชีพอยางมีประสิทธิภาพประสิทธผิล
อยางมีคุณธรรม โดยในดานคุณภาพของผูเรียน คือ ใหผูเรียนสามารถเขาใจความสัมพันธระหวาง
เทคโนโลยีกับศาสตรอ่ืนๆ วิเคราะหระบบเทคโนโลยี มีความคิดสรางสรรคในการแกปญหาหรือ
สนองความตองการ สรางและพัฒนาส่ิงของเคร่ืองใชหรือวิธีการตามกระบวนการเทคโนโลยีอยาง
ปลอดภัย โดยใชซอฟตแวรในการออกแบบหรือนําเสนอผลงานวิเคราะหและเลือกใชเทคโนโลยีที่
เหมาะสมกับชีวิตประจําวันอยางสรางสรรคตอชีวิต สังคม ส่ิงแวดลอมและมีการจัดการเทคโนโลยี
ดวยวิธีการของเทคโนโลยีสะอาด ใชคอมพิวเตอรในการประมวลผลขอมูลใหเปนสารสนเทศเพื่อ
การตัดสินใจใชเทคโนโลยีนําเสนอผลงาน 
  

จากการศึกษาสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพและเทคโนโลยี และคูมือ
ตัวชี้วัดและสาระการเรียนรูแกนกลางของกลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี ไดมี
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เนื้อหาที่มุงเนนใหผูเรียนสามารถใชโปรแกรมสําเร็จรูปสําหรับประมวลผลคําและใชออกแบบ
นําเสนอผลงานไดเปนโปรแกรมพื้นฐาน ดังนั้นในงานวิจัยคร้ังนี้เพื่อใหนักเรียนสามารถเลือกใช
เทคโนโลยีซอฟตแวรที่มีความเหมาะสมในการทํางานและเปนพื้นฐานสําหรับการใชงานโปรแกรม
อ่ืนๆ ผูวิจัยจึงเลือกใชความสามารถในการใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอ
ผลงานเปนตัวบงช้ีที่ใชในการวัดความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                
ในกรุงเทพมหานคร โดยที่ความสามารถทางคอมพิวเตอรของนักเรียน จะวัดจากคะแนนทดสอบ
โปรแกรมประมวลผลคํา (Microsoft Word) และคะแนนทดสอบโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) 

 

ความสามารถทางคอมพิวเตอร คะแนนทดสอบโปรแกรมประมวลผลคําและ
โปรแกรมนําเสนอผลงาน 

ความสามารถทางคอมพิวเตอร คือ ความสามารถในการใชคอมพิวเตอรที่ผูเรียนไดจาก
การเรียนในวิชาคอมพิวเตอรซึ่งอางอิงมาจากสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพ
และเทคโนโลยีและคูมือตัวช้ีวัดและสาระการเรียนรูแกนกลางของกลุมสาระการเรียนรูการงาน
อาชีพและเทคโนโลยีตามแตละโรงเรียนที่จัดใหมีการเรียนการสอนในแตละชวงช้ัน ซึ่งวัดไดจาก
คะแนนทดสอบโปรแกรมประมวลผลคํา (Microsoft Word) และคะแนนทดสอบโปรแกรมนําเสนอ
ผลงาน (Microsoft PowerPoint) ซึ่งผูวิจัยจะขอกลาวถึงรายละเอียดของโปรแกรมประมวลผลคํา 
(Microsoft Word) และโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint) ดังนี้ 

 

โปรแกรมประมวลผลคํา (Microsoft Word) 
โปรแกรมประมวลผลคํา (Microsoft Word) เปนโปรแกรมที่มีหนาที่หลักในการตกแตง 

จัดการ สรางงานเอกสารในรูปแบบตางๆ  โปรแกรมนี้เหมาะสมสําหรับการสรางสรรคผลงานใน
รูปแบบตางๆ ไมวาจะเปน หนังสือ คูมือ รายงาน จดหมาย บันทึกการประชุม เอกสารสัญญา ใบ
ปะหนาแฟกซ ปฏิทิน ประวัติสวนตัว ฯลฯ ซึ่งสามารถรองรับการทํางานในทุกๆดาน 

โดยรายละเอียดผลการเรียนรูที่คาดหวังในการใชโปรแกรมประมวลผลคํา ผูเรียนหรือ
ผูใชงานสามารถใชงานคําส่ัง เปดและปดโปรแกรม แถบเคร่ืองมือตางๆ การปดโปรแกรม สรางงาน
เอกสาร ทํางานกับไฟล บันทึกไฟล ปดเปดไฟล ทํางานกับขอความ  ตกแตงขอความใหสวยงาม  
จัดวางขอความบนหนาเอกสาร  ใสสัญลักษณและเลขลําดับ ขอความอิสระดวย Text Box , 
WordArt Shape ฯลฯ 
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แผนภาพที่ 2.6 ภาพแสดงการใชงานโปรแกรมประมวลผลคํา (Microsoft Word) 

 

ความสาํคัญของโปรแกรมประมวลผลคํา  
ปจจุบันสํานักงานทั้งภาครัฐและเอกชน ไดมีการนําโปรแกรมประมวลผลคํามาใชในการ

พิมพเอกสารและรายงานตางๆ แทนเครื่องพิมพดีดมากข้ึน ทั้งนี้เนื่องจากความกาวหนาทาง
เทคโนโลยีคอมพิวเตอร โดยเฉพาะอยางยิ่งการพัฒนา ความสามารถของตัวประมวลผลและ
ประสิทธิภาพการเก็บขอมูลของหนวยเก็บขอมูลสํารองตางๆ เชน ฮารดดิสก ดิสกเกตต ที่มี
ความจําสูงข้ึนรวมถึงการผลิตเคร่ืองพิมพ (Printer) ความเร็วสูง ประกอบกับราคาเคร่ือง
คอมพิวเตอรมีราคาถูกลงแตมีประสิทธิภาพสูงข้ึน ทําใหสํานักงานตางๆ หันมาใชคอมพิวเตอรเขา
มาชวยในการประมวลขอมูล ซึ่งสามารถจัดทําเอกสาร บทความ ตลอดจนรายงานไดอยางรวดเร็ว 
โดยสามารถจัดขอความและ เลือกแบบอักษร แกไข เพิ่มเติม ปรับปรุง แทรกขอความ รวมขอความ
หรือเอกสาร จัดขอบกระดาษและตรวจดูเอกสารกอนที่จะพิมพเอกสารจริงออกมา นอกจากนี้ยัง
สามารถบันทึกเอกสารตางๆ ตลอดจนเรียกใชงานแฟมขอมูลที่ไดเก็บบันทึกไว ข้ึนมาใชงานใน
ภายหลังได 

 

ประโยชนของโปรแกรมประมวลผลคํา 
1. ชวยใหการจัดเก็บและคนหาเอกสารมีความรวดเร็วมากข้ึน เพราะงานเอกสารตางๆ            

จะถูกจัดเก็บเปนแฟมขอมูลลงใน ส่ือบันทึกขอมูลตางๆ สาารถคนหาและเรียกใชงานดสะดวกและ
รวดเร็ว 

2. ชวยลดปริมาณกระดาษที่จัดเก็บทําใหประหยัดพื้นที่ในการเก็บเอกสารเพราะเอกสาร
จะถูกจัดเก็บอยูในส่ือบันทึกขอมูลตางๆ ที่มีขนาดเล็กแตมีความจุในการเก็บขอมูลไดเปนจํานวน
มาก 
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3. ชวยลดข้ันตอนในการจัดทําเอกสาร เชน ถาตองการสงจดหมายที่มีขอความเหมือนกัน
ไปใหผูรับจดหมายเปนจํานวนมากอาจทําไดโดยการจัดทําจดหมายเวียน ซึ่งมีข้ันตอนการทํา              
ที่สะดวกและรวดเร็ว ซึ่งถาหากใชเคร่ืองพิมพดีดก็อาจจะตองเสียเวลาในการจัดทํามาก 

4. ชวยประหยัดเวลาและคาใชจายในการจัดพิมพเอกสาร 
5. ชวยสรางเอกสารใหมีความสวยงาม ทั้งนี้เพราะผูใชสามารถนํารูปภาพ รูปวาด 

ภาพกราฟกตาง ๆ มาแทรกลงในเอกสารไดโดยตรง 
6. ชวยใหการทํางานกับเอกสารถูกตองและมีขอผิดพลาดลดนอยลง เพราะผูใชงาน

สามารถตรวจสอบความถูกตองของเอกสารไดโดยตรงบนหนาจอจนพอใจจึงจะสั่งพิมพเอกสาร
ออกทางเคร่ืองพิมพได หรือาจใชระบบการตรวจสอบคําผิดแบบอัตโนมัติ ในการตรวจสอบการ
สะกดคําหรือไวยากรณของภาษาได 

 

โปรแกรมนําเสนอผลงาน (Microsoft Powerpoint) 
โปรแกรมนําเสนอผลงาน (Microsoft Powerpoint) เปนโปรแกรมที่รูจักกันดีวาใชในการ

สรางสไลดสําหรับการนําเสนองาน(Presentation) ไมวาจะเปนการแสดงบนจอภาพ ฉายโปรเจ็ค
เตอรที่ตอกับเคร่ืองคอมพิวเตอร เปนโปรแกรมที่มีเคร่ืองมือคอยอํานวยความสะดวกแกผูใชทําให
งานเกิดความนาสนใจยิ่งข้ึนโดยการใสรูปภาพตาง เชน ภาพนิ่ง ภาพเคล่ือนไหว เสียง และวิดีโอ
คลิป ฯลฯ 

โดยรายละเอียดผลการเรียนรูที่คาดหวังในการใชโปรแกรมนําเสนอผลงาน ผูเรียนหรือ
ผูใชงานสามารถ วิธีเรียกใชและปดโปรแกรม แถบเคร่ืองมือตางๆ การปดโปรแกรม   สรางและ
จัดการสไลดกับสไลดได จัดการกับขอความโดยใชรูปแบบตางๆ การตกแตงแผนโดยใชแมแบบ 
แทรกและปรับแตงรูปภาพ รูปวาดหรืออักษรประดิษฐ ใสลูกเลนใหเนื้อหาทั้งในสไลดและขณะ
เปล่ียนสไลด หรือจะกําหนดการเคลื่อนไหวในการนําเสนอเองได   

 
แผนภาพที่ 2.7 ภาพแสดงการใชงานโปรแกรมนําเสนองาน (Microsoft PowerPoint) 
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ความสาํคัญของโปรแกรมนําเสนอผลงาน 
ในปจจุบันนี้การนําเสนอเขามามีบทบาทสําคัญในองคกรทางธุรกิจ ทางการเมือง                  

ทางการศึกษา หรือแมแตหนวยงานของรัฐทุกแหงก็ตองอาศัยวิธีการนําเสนอเพื่อส่ือสารขอมูล 
เสนอความเห็นเสนอขออนุมัติหรือเสนอขอสรุปผลการดําเนินงานตางๆ ผูมีหนาที่เกี่ยวกับการ
ประชาสัมพันธ การแนะนําเพื่อการเยี่ยมชม การฝกอบรม การประชุม หรือผูที่เปนหัวหนางานทุก
ระดับจะตองรูจักวิธีการนําเสนอ เพื่อนําไปใชใหเหมาะสมกับงานตางๆ และเพื่อผลสําเร็จของการ
พัฒนางานของตน หรือขององคกรและหนวยงานตางๆ กลาวโดยสรุปการนําเสนอมีความสําคัญ  
ตอการปฏิบัติงานทุกประเภท เพราะชวยในการตัดสินใจในการดําเนินงาน ใชในการพัฒนางาน 
ตลอดจนเผยแพรความกาวหนาของงานตอผูบังคับบัญชาและบุคคลผูที่สนใจ    

 

การรับรูความสามารถดานคอมพิวเตอรของตนเอง  
คอมโปและฮิกกินส (Compeau & Higgins, 1995) ไดพบวาการรับรูความสามารถตนเอง

ในการใชคอมพิวเตอร มีผลตอความคาดหวังเกี่ยวกับผลสําเร็จในอนาคตจากการใชคอมพิวเตอร 
เชน ในอาชีพการงานและการประสบผลสําเร็จของบุคคล  ซึ่งความคาดหวังเกี่ยวกับผลสําเร็จใน
การทํางานในอนาคตขางหนาสําหรับนักเรียนก็จะหมายถึงความสามารถทางคอมพิวเตอร 

รอส,โฮกาโบม เกรยและฮานเนย (Ross, Hogaboam-Gray and Hannay, 2001) ทําการ
ทดสอบโดยใหนักเรียนยายหองเรียนโดยเปล่ียนครูผูสอนคอมพิวเตอรที่มีการรับรูความสามารถ
ตนเองตางกัน ปรากฎวานักเรียนเรียนดีข้ึนและมีการรับรูความสามารถตนเองสูงข้ึนเมื่อไดเรียนกับ
ครูที่มีความมั่นใจในทักษะการใชคอมพิวเตอรของตัวเองจึงทําใหนักเรียนไดมีความสามารถทาง
คอมพิวเตอรสูงข้ึน 

ดังนั้นการรับรูความสามารถดานคอมพิวเตอรของตนเองจึงเปนปจจัยหนึ่งที่มีผลตอ
ความสามารถทางคอมพิวเตอร ซึ่งนอกจากนี้แลวการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองยังจะเปนเหตุใหเกิดการต้ังเปาหมายและความผูกพันตอเปาหมายอีกดวย 

 

การต้ังเปาหมาย 
จากทฤษฎีการตั้งเปาหมายของล็อค ไดสรุปวาการต้ังเปาหมายของบุคคลสามารถ                

ทําใหเกิดพฤติกรรมที่สงผลตอการทํางาน ตามที่ไดกลาวไวแลวในตอนที่สอง อันจะทําใหผลการ
ปฏิบัติงานดีข้ึนตามไปดวย ซึ่งอาจจะกลาวในทางการวิจัยผูวิจัยจึงสรุปวาการต้ังเปาหมายในเร่ือง
คอมพิวเตอรจะสงผลตอความสามารถทางคอมพิวเตอร 
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ความผูกพันตอเปาหมาย  
ความผูกพันตอเปาหมาย คือ ความพยายามของคนท่ีจะบรรลุเปาหมายเมื่อบรรลุ

เปาหมายแลวจะเกิดความคงอยูของพฤติกรรม   ความผูกพันตอเปาหมายมักจะถูกนําไปศึกษา
รวมกับการต้ังเปาหมายในการทํางาน ในแงที่วา ความผูกพันตอเปาหมายเปนตัวสําคัญทีท่าํใหคน
บรรลุเปาหมายหรือเปนที่มาของเปาหมายไมวาจะเปนเปาหมายที่เรากําหนดเอง, เปาหมายที่มี
สวนรวมหรือเปาหมายที่ถูกกําหนดให  ความสัมพันธระหวางการต้ังเปาหมายในการทํางานกับ
ความผูกพันตอเปาหมายจะสงผลตอผลิตภาพการทํางาน 2 ลักษณะ คือ 

1. หากระดับของเปาหมายมีความคงที่ หรือทุกคนมีเปาหมายที่ทาทาย ความผูกพันตอ
เปาหมายจะเพิ่มผลิตภาพการทํางาน โดยไดมีงานวิจัยของ อีเรซและไซดอน (eraz and Zidon, 
1984) พบวา ในทุกระดับของความยากของเปาหมายจะเกิดผลทางบวกกับความผูกพันตอ
เปาหมายและผลิตภาพการทํางาน และขอเสนอนสนับสนุนจากงานวิจัยของไรท (Wright, 1989) 
ที่พบวาเปาหมายยากจะมีความผูกพันตอเปาหมายทางบวกับผลิตภาพการทํางาน 

2. ความผูกพันตอเปาหมายนาจะเปนส่ือกลางระหวางการตั้งเปาหมายในการทํางานกับ
ผลิตภาพการทํางานตามระดับความยากงายของเปาหมาย 

ดังนั้นระดับความยากงายของเปาหมายมีผลกระทบตอความผูกพันตอเปาหมาย 
เปาหมายยากที่คนสามารถบรรลุเปาหมายไดจะเกิดความผูกพันตอเปาหมายที่สูงสงผลตอการ
เพิ่มผลิตภาพการทํางานที่สูงข้ึน เชน งานวิจัยของไรท (Wright, 1989) ซึ่งศึกษาระดับความยาก
งายของเปาหมายในการทํางานกับความผูกพันตอเปาหมาย พบวาเปาหมายที่งายจะไมเกิดความ
ผูกพันตอเปาหมาย แชมเปญและแมคอาฟ (Champagne & Mc Afee, 1989) ไดเสนอวา
นอกจากความยากงายของเปาหมายแลว ความสามาถในการบรรลุเปาหมายก็เปนส่ิงทีสําคัญที่
จะตองสัมพันธกับผลิตภาพการทํางาน  ในแงของคุณภาพและปริมาณระยะยาว  การที่เราใชการ
ต้ังเปาหมายในการทํางานรวมกับการใหรางวัล มีผลตอความคาดหวังในผลสําเร็จ (Expectancy) 
และคุณคาของผลสําเร็จที่เราจะไดรับ (Valence) ส่ิงเหลานี้มีผลตอความผูกพันตอเปาหมาย 
(Goal Commitment) 

เมเออรและบรุนสเตียน (Maier & Brunstein, 2001) พบวาเปาหมายสวนบุคคล 
(Personal Goal) เปนการแสดงถึงการกําหนดทิศทางในอนาคตของแตละคนในการมุงมั่นเพือ่ชีวติ
และการมองหาความสําเร็จในชีวิตที่หลากหลายโดยมีการตัดสินใจไปตามแตละเปาหมายของ
บุคคล  ตามที่ ไดกลาวไวแลวในตอนที่สอง  ดังนั้นถาผู เ รียนมีความมุงมั่นและผูกพันกับ
ความสามารถทางคอมพิวเตอร มีความตองการจะใหไดความสามารถที่ดี ผูเรียนจึงตองมีความ
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ผูกพันตอเปาหมายทางดานคอมพิวเตอรนั้นดวย ซึ่งผูวิจัยจึงขอสรุปวาความผูกพันตอเปาหมาย
จะสงผลตอความสามารถทางคอมพิวเตอร  

 

ตอนท่ี 5 งานวิจัยที่เกี่ยวของ 
 5.1 งานวิจัยในประเทศ 

วรารัตน บุญณสะ (2550) ไดศึกษาความสัมพันธระหวางการตั้งเปาหมายสวนบุคคลใน
งานพยาบาลและความต้ังใจคงอยูของงานพยาบาลใหม และศึกษาความสัมพันธระหวางความ
ผูกพันตอเปาหมายในฐานะตัวแปรกํากับในความสัมพันธระหวางการตั้งเปาหมายสวนบุคคล และ
ความต้ังใจอยูในงาน และศึกษาผลของตัวแปรดานการตั้งเปาหมายสวนบุคคลและความผูกพันตอ
เปาหมายที่สัมพันธกับความต้ังในอยูในงาน  ผลพบวาการต้ังหมายสวนบุคคลของพยาบาลใหมมี
ความสัมพันธทางบวกกับความต้ังใจคงอยูโดยงานรวม และรายดานไดแก ความมีอิสระในการ
ทํางาน ความตองการรายได ฯลฯ  ความผูกพันตอเปาหมายไมเปนตัวแปรกํากับในความสัมพันธ
ระหวางการต้ังเปาหมายสวนบุคคลกับความตั้งใจคงอยูในงาน แตความผูกพันตอเปาหมายมี
ความสัมพันธทางบวกกับความตั้งใจอยูในงาน ซึ่งเมื่อไดวิเคราะหการถดถอยพหุคูณเขิงช้ันพบวา
ขอมูลสวนบุคคลสามารถอธิบายความแปรปรวนของความต้ังใจคงอยูในงานไดรอยละ 17 ซึ่งเม่ือ
เพิ่มตัวแปรการต้ังเปาหมายสวนบุคคลสามารถอธิบายความแปรปรวนของความต้ังใจคงอยูในงาน
ไดเพิ่มข้ึนรอยละ 23 คือความม่ันคงทางอาชีพ โอกาสในการสรางความกาวหนาในอาชีพ การ
ไดรับการยอมรับจากผูรวมงาน และการไดรับการยอมรับจากหัวหนางาน 

ชูชีพ ออนโคกสูง และอนุสรณ อรรถศิริ (2549) ไดศึกษาความสัมพันธระหวางพลัง
ความสามารถแหงตน เปาหมาย และความเปนไปไดที่จะกระทํากับแรงจูงใจในการเรียน โดยใช
กลุมตัวอยางเปนนิสิตชั้นปที่ 1 หลักสูตรการศึกษาบัณฑิต มหาวิทยาลัยศรีนครินทรวิโรฒ ป
การศึกษา 2548 จํานวน 369 คน ผลการวิจัยพบวานิสิตมีพลังความสามารถแหงตนคอนขางมาก 
จะมีเปาหมายในการเรียนคอนขางชัดเจน มีความเปนไปไดที่จะกระทํากิจกรรมการเรียนคอนขาง
สูง มีแรงจูงใจในการเรียนคอนขางสูงและมีคะแนนเฉลี่ยสะสมอยูในระดับสูง   นิสิตชาย – หญิง มี
เปาหมายในการเรียนและคะแนนเฉล่ียสะสมแตกตางกันอยางมีนัยสําคัญทางสถิติที่ระดับ .05 
และ .01 ตามลําดับ  นิสิตตางคณะกันมีเปาหมายในการเรียนและแรงจูงใจในการเรียนแตกตางกนั
อยางมีนัยสําคัญทางสถิติที่ระดับ .01 และ .05 ตามลําดับ  นิสิตที่มีคะแนนเฉลี่ยสะสมตางกันมี
แรงจูงใจในการเรียนแตกตางกันอยางมีนัยสําคัญทางสถิติที่ระดับ .01  พลังความสามารถแหงตน
มีความสัมพันธทางบวกกับเปาหมายในการเรียนและความเปนไปไดที่จะกระทํากิจกรรมการเรียน
อยางมีนัยสําคัญทางสถิติที่ระดับ .01 และมีความสัมพันธทางบวกกับแรงจูงใจในการเรียนอยางมี
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นัยสําคัญทางสถิติที่ระดับ .05 เปาหมายในการเรียนมีความสัมพันธทางบวกกับความเปนไปไดที่
จะกระทํากิจกรรมการเรียนและแรงจูงใจในการเรียนอยางมีนัยสําคัญทางสถิติที่ระดับ .01  และมี
ความเปนไปไดที่จะกระทํากิจกรรมการเรียนมีความสัมพันธทางบวกกับแรงจูงใจในการเรียนอยาง
มีนัยสําคัญที่ระดับ .01 

ทวีวัฒน วัฒนกุลเจริญ (2547)ไดพัฒนารูปแบบการวัดประเมินตามสภาพจริงจากการ
เรียนอิเล็กทรอนิกสที่ใชวิธีการเรียนตามสถานการณที่สงผลตอการรับรูความสามารถของตนเอง
ของผูเรียนในสถานศึกษา ผลการวิจัยพบวา รูปแบบการวัดประเมินตามสภาพจริงฯ ประกอบดวย 
องคประกอบของการวัดประเมินตามสภาพจริง และข้ันตอนการวัดประเมินตามสภาพจริง  และผล
จากการใชรูปแบบการวัดประเมินตามสภาพจริงฯ ที่พัฒนาข้ึน โดยทดลองใชรูปแบบการวัด
ประเมินตามสภาพจริง พบวา ผูเรียนมีระดับการรับรูความสามารถของตนเองสูงกวากอนการ
ทดลองใชรูปแบบอยางมีนัยสําคัญทางสถิติที่ระดับ .05 
 รจเรข รัตนาจารย (2547) ไดศึกษาผลของการฝกการกํากับตนเองในการเรียนการสอน
วิชาวิทยาศาสตรที่มีตอการรับรูความสามารถของตนเองและความสามารถทางการเรียนวิชา
วิทยาศาสตรของนักเรียนช้ันมัธยมศึกษาปที่ 3 ผลการวิจัยที่เกี่ยวของกับการรับรูความสามารถใน
ตนเอง พบวา ภายหลังการทดลอง นักเรียนกลุมทดลองมีคาเฉลี่ยคะแนนการรับรูความสามารถ
ของตนเองในวิชาวิทยาศาสตรสูงกวากอนทดลอง อยางมีนัยสําคัญทางสถิติที่ระดับ .05  ภายหลัง
การทดลอง นักเรียนกลุมทดลองมีคาเฉลี่ยคะแนนการรับรูความสามารถของตนเองในวิชา
วิทยาศาสตรสูงกวานักเรียนกลุมเปรียบเทียบที่ไมมีการฝกการกํากับตนเองในการเรียนการสอน
วิชาวิทยาศาสตรอยางมีนัยสําคัญทางสถิติที่ระดับ .05  และภายหลังการทดลอง คะแนนการรับรู
ความสามารถของตนเองในวิชาวิทยาศาสตรของนักเรียนกลุมทดลองมีความสัมพันธกับคะแนน
ความสามารถทางการเรียนวิชาวิทยาศาสตรอยางมีนัยสําคัญทางสถิติที่ระดับ .05 โดยมีคา
สัมประสิทธิ์สหสัมพันธเทากับ .61 ซึ่งสูงกวากอนทดลอง ภายหลังการทดลอง นักเรียนกลุมทดลอง
มีคาสัมประสิทธิ์สหสัมพันธระหวางการรับรูความสามารถของตนเองในวิชาวิทยาศาสตรกับ
ความสามารถทางการเรียนวิชาวิทยาศาสตรของนักเรียนกลุมทดลองสูงกวานักเรียนกลุม
เปรียบเทียบ 

เสรี ชัดแชม และคอยจิตร นครราช (2549) ไดศึกษาเกี่ยวกับการรับรูความสามารถดาน
คอมพิวเตอรของนิสิตนักศึกษาสามสาขาวิชา โดยมีวัตถุประสงคเพื่อเปรียบเทียบความตรงเชิง
โครงสรางของโมเดลการรับรูความสามารถดานคอมพิวเตอรของนิสิตนักศึกษาตามแนวคิดการรับรู
ความสามารถของตนดานคอมพิวเตอรของทอรกซาเดทคอฟเทอรรอส และฟลูโกฟท (Torkzadeh, 
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Koufteros, & Pflughoeft, 2003) โดยมีกลุมตัวอยางเปนนิสิตนักศึกษาช้ันปที่ 1 จากมหาวิทยาลัย
ของรัฐ ปการศึกษา 2547 และไดใชเคร่ืองมือการวิจัยเปนแบบสอบถามเร่ืองการรับรูความสามารถ
ของตนดานคอมพิวเตอรของนิสิตนักศึกษา ซึ่งผลการวิจัยปรากฏวา การรับรูความสามารถดาน
คอมพิวเตอรของนิสิตนักศึกษาทั้งสาขาวิชาวิทยาศาสตรและเทคโนโลยีสาขาวิชาวิทยาศาสตร
สุขภาพ และสาขาวิชามนุษยศาสตรและสังคมศาสตร ประกอบดวย 4 องคประกอบเหมือนกัน 
ไดแก ทักษะเบ้ืองตน ทักษะดานแฟมขอมูลและซอฟตแวร ทักษะข้ันสูง และ ทักษะดาน
อินเทอรเน็ต  ความตรงเชิงโครงสรางของโมเดลการรับรูความสามารถดานคอมพิวเตอรของนิสิต
นักศึกษาทั้ง 3 สาขาวิชา มีความสอดคลองกับขอมูลเชิงประจักษ คาไค-สแควรมีต้ังแต 26.33 ถึง 
53.99 คา p(s) เทากับ 1.00 ดัชนี AGFIมีคาต้ังแต .95 ถึง .96 ดัชนี CFIs เทากับ 1.00 คา SRMR 
มีต้ังแต .02 ถึง .03 และคา RMSEAs เทากับ .00 และโครงสรางองคประกอบของโมเดลการรับรู
ความสามารถดานคอมพิวเตอรของนิสิตนักศึกษาทุกสาขาวิชาไมแตกตางกัน แตคาน้ําหนัก
องคประกอบแตกตางกัน 

ดร.เดือนเพ็ญ ทองนวม (2545) ไดทํางานวิจัยและศึกษาการรับรูความสามารถแหงตน 
เปาหมายในการศึกษาและการเรียนรูโดยการกํากับตนเอง ผลการวิจัยพบวานักศึกษาทีม่รีะดับการ
รับรูความสามารถดวยตนเองสูง  มีเปาหมายมุงความรู (Mastery Goal) และมุงผลการเรียนสูง 
(Performance  Goal)  รายงานวาตนใชกลยุทธการเรียนโดยการกํากับตนเองมากกวานักศึกษาที่
มีระดับการรับรูความสามารถดวยตนเองตํ่าและมีเปาหมายมุงความรูและมุงผลการเรียน  
นอกจากนี้ผลการศึกษายังพบวานักศึกษาที่ไดเกรดเฉล่ียสูง รายงานวามีระดับการรับรู
ความสามารถดวยตนเองและเปาหมายมุงความรูสูง และการใชการเรียนโดยการกํากับตนเอง
มากกวานักเรียนที่ไดเกรดเฉล่ียตํ่า  และการวิเคราะหการถดถอยพหุคูณยังแสดงใหเห็นวาใน
บรรดาตัวแปรที่ศึกษาทั้ง 4 ตัว ซึ่งประกอบไปดวยการรับรูความสามารถดวยตนเอง เปาหมายมุง
ความรู เปาหมายมุงผลการเรียน และเกรดเฉล่ีย  โดยการรับรูความสามารถแหงตนเองเปนตัว
ทํานายการเรียนรูโดยการกํากับตนเองไดดีที่สุด ตามดวยเปาหมายมุงความรู ขอเสนอแนะสําหรับ
อาจารยผูสอนในการพัฒนาความเชื่อในความสามารถข้ึนในตัวของผูเรียน ไดแก การใสใจในการ
รับรูความสามารถของผูเรียน การเปนตัวแบบที่ดี และการสรางบรรยากาศแหงความรวมมือในช้ัน
เรียน 

อดิศักด์ิ พงษพูลผลศักด์ิ ไพบูลย เกียรติโกมล และปยะมาศ เจริญพันธุวงศ (2544) ได
ศึกษาปจจัยที่มีผลตอความสามารถทางการเรียนวิชาคอมพิวเตอรของนักเรียนระดับมัธยมศึกษา
ตอนปลายในโรงเรียนของรัฐ : กรณีศึกษาจังหวัดลพบุรี โดยมีกลุมตัวอยางจํานวน 495 คน  ใช
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วิธีการเก็บขอมูลดวยแบบสอบถามและแบบทดสอบ  ผลปรากฏวา ระยะเวลาในการเดินทางมา
ศึกษา อาชีพผูปกครอง ระดับการศึกษาของผูปกครอง อัตราสวนระหวางนักเรียนกับครู วุฒิ
การศึกษาของครู สถิติการขาดเรียน และวิธีการสอนของครูมีผลตอความสามารถทางการเรียนของ
นักเรียน  เจตคติที่มีตอการเรียนสงผลโดยตรงตอความสามารถทางการเรียนของนักเรียน  และมี
ผลทางออมผานการปรับตัวของนักเรียนกับเพื่อน ความสนใจในวิชาชีพ แรงจูงใจใฝสัมฤทธิ์ ความ
รับผิดชอบ และทักษะพื้นฐานทางคอมพิวเตอร การปรับตัวของนักเรียนกับเพื่อนสงผลโดยตรงตอ
ความสามารถทางการเรียน  ความสนใจในวิชาชีพสงผลโดยตรงตอความสามารถทางการเรียน
และมีผลทางออมผานทางแรงจูงใจใฝสัมฤทธิ์  แรงจูงใจใฝสัมฤทธิ์สงผลโดยตรงตอความสามารถ
ทางการเรียนและมีผลทางออมผานความรับผิดชอบและทักษะพื้นฐาน และทักษะพื้นฐานทาง
คอมพิวเตอรจะสงผลโดยตรงตอความสามารถทางการเรียน 

วรกานต เส่ียงอารมณ (2541) ไดทําการศึกษาเร่ืองอิทธิพลของความยากงายของ
เปาหมายและรางวัลที่มีตอผลิตภาพการทํางาน และความผูกพันใจในเปาหมาย โดยกลุมตัวอยาง
เปนพนักงานเย็บกระเปารายวันแบงกลุมตามเงื่อนไขการทดลอง ตามเปาหมายและเงินรางวัล 
พบวาพนักงานที่มีการต้ังเปาหมายและใหส่ิงจูงใจเปนตัวเงินมีผลิตภาพที่สูงข้ึน ความยากงายของ
เปาหมายไมมีผลตอความผูกพันใจในเปาหมาย แตการใหเงินรางวัลมีผลตอความผูกพันใจใน
เปาหมาย สวนพนักงานที่บรรลุเปาหมายจะเกิดความผูกพันใจตอเปาหมายตามผลการวิจัยของ
ล็อค และลาแธม (1990) 
 กรรณิการ จิตตบรรเทา (2539)  ไดศึกษาความสัมพันธระหวางการรับรูความสามารถของ
ตนเองกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ  ความสัมพันธระหวางความ
คาดหวังในผลการเรียนภาษาอังกฤษกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ 
และความสัมพันธระหวางการรับรูความสามารถของตนเองและความคาดหวังในผลการเรียน
ภาษาอังกฤษกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ โดยมีกลุมตัวอยางเปน
นักเรียนช้ันมัธยมศึกษาปที่ 5 ในกรุงเทพมหานคร ใชการวิเคราะหดวยการหาคาความสัมพันธ
แบบเพียรสันและสัมประสิทธิ์สหสัมพันธพหุคูณ โดยผลการวิจัย คือ การรับรูความสามารถของ
ตนเองมีความสัมพันธทางบวกกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ อยางมี
นัยสําคัญทางสถิติที่ระดับ 0.01 ความคาดหวังในผลการเรียนภาษาอังกฤษมีความสัมพันธ
ทางบวกกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ อยางมีนัยสําคัญทางสถิติที่
ระดับ 0.01 และการรับรูความสามารถของตนเอง และความคาดหวังในผลการเรียนภาษาอังกฤษ 
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มีความสัมพันธกันทางบวกกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ อยางมี
นัยสําคัญทางสถิติที่ระดับ 0.01 

สุธีรา นิมิตรนิวัฒน (2537) ไดศึกษาผลของฝกการต้ังเปาหมายที่มีตอความสนใจใน
กิจกรรมและความสามารถในวิชาคณิตศาสตรของนักเรียนชั้นมัธยมศึกษาปที่ 2  ซึ่งผลการวิจัย
พบวา กลุมนักเรียนที่ต้ังเปาหมายระยะส้ันมีคะแนนความสนใจในกิจกรรมสูงกวากลุมนักเรียนที่
ต้ังเปาหมายระยะยาวและกลุมควบคุมอยางมีนัยสําคัญทางสถิติที่ระดับ .01 กลุมนักเรียนที่
ต้ังเปาหมายระยะส้ันมีคะแนนความสามารถในวิชาคณิตศาสตรสูงกวากลุมนักเรียนที่ต้ังเปาหมาย
ระยะยาวและกลุมควบคุม อยางมีนัยสําคัญทางสถิติที่ระดับ .01 

อมรรัตน บุบผโชติ (2546) ไดศึกษาผลของการใชบันทึกการเรียนรูในการเรียนการสอน
วิชาวิทยาศาสตรที่มีตอการรับรูความสามารถของตนเองและความสามารถทางการเรียนวิชา
วิทยาศาสตรของนักเรียนช้ันมัธยมศึกษาปที่ 3 โรงเรียนสาธิต สังกัดมหาวิทยาลัยของรัฐใน
กรุงเทพมหานคร โดยผลการวิจัยที่เกี่ยวของกับการรับรูความสามารถของตนเองพบวา การรับรู
ความสามารถของตนเองมีความสัมพันธกับความสามารถทางการเรียนวิชาวิทยาศาสตร หลังการ
เรียนโดยใชบันทึกการเรียนรูในการเรียนการสอนวิชาวิทยาศาสตรอยางมีนัยสําคัญทางสถิติที่
ระดับ .01 โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ .62 นักเรียนที่เรียนโดยใชบันทึกการเรียนรูมี
คาเฉล่ียคะแนนการรับรูความสามารถของตนเองในวิชาวิทยาศาสตรสูงกวากอนทดลอง อยางมี
นัยสําคัญทางสถิติที่ระดับ .05   นักเรียน  ที่เรียนโดยใชบันทึกการเรียนรูมีคาเฉลี่ยคะแนนการรับรู
ความสามารถของตนเองในวิชาวิทยาศาสตรสูงกวานักเรียนที่เรียนโดยไมใชบันทึกการเรียนรู 
อยางมีนัยสําคัญทางสถิติที่ระดับ .05   

ขนิษฐา สุวรรณนิตย (2533) ไดศึกษาปจจัยที่มีอิทธิพลตอความคาดหวังเกี่ยวกับ
ความสามารถของตนทั้งทางตรงและทางออม โดยการศึกษากับปจจัยระดับการอนุมานสาเหตุผล
ของการทําแบบทดสอบท่ีมาจากความสามารถในการเรียน การพูดชักจูงจากผู อ่ืน การ
ต้ังเปาหมายในการเรียน การเห็นผูอ่ืนเปนตัวแบบ ความวิตกกังวล ประสบการณที่ไดจากการเรียน 
และทักษะในการเรียน โดยมีกลุมตัวอยางเปนนักเรียนช้ันประถมศึกษาปที่ 6 ในจังหวัดนครสวรรค 
ใชวิธีการวิเคราะหขอมูลโดยใชการวิเคราะหเสนทาง ซึ่งผลการวิจัยพบวา  ปจจัยที่มีอิทธิพล
ทางตรงเชิงนิมานตอความคาดหวังเกี่ยวกับความสามารถของตน คือ ทักษะในการเรียน 
(0.43259) และประสบการณที่ไดรับจากการเรียน (0.06083) ปจจัยที่มีอิทธิพลทางตรงเชิงนิเสธ 
คือ ความวิตกกังวล (-0.41445) การเห็นผูอ่ืนเปนตัวแบบ (-0.17814)  สวนปจจัยที่มีอิทธิพล
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ทางออม คือ การต้ังเปาหมายในการเรียน (0.05847) และความวิตกกังวล (-0.07231) ซึ่งความ
วิตกกังวลเปนปจจัยที่มีอิทธิพลทั้งทางตรงและทางออม  

สาขางานวิจัยของสถาบันการสงเสริมการสอนวิทยาศาสตรและเทคโนโลยี (2549) ได
ศึกษาผลของการใชคูมือครูและหนังสือเรียนเทคโนโลยีสารสนเทศ ชวงชั้นที่ 4  โดยผลการวิจัย
พบวายังมีครูที่ใชคูมือครูและหนังสือเรียนสาระการเรียนรูพื้นฐานและเพิ่มเติมเทคโนโลยีสารสนเทศ
ชวงชั้นที่ 4  เพียงรอยละ 67.0 และใชคูมือครูสาระการเรียนรูเพิ่มเติม การโปรแกรมเบ้ืองตน คิดเปน 
รอยละ 53.3 และสาเหตุที่ครูไมไดใชคูมือครูและหนังสือเรียนเทคโนโลยีสารสนเทศของ สสวท. คือ 
ครูไมทราบวามีคูมือครูและหนังสือเรียนจําหนาย ถึงแมวาทราบวามีคูมือครูและหนังสือเรียน
จําหนายแตหาซ้ือไมได และทราบวามีคูมือครูและหนังสือเรียนจําหนายแตไมไดซื้อมาใช  

 

5.2 งานวิจัยตางประเทศ 
จัดจและโบโน (Judge and Bono, 2001) ไดศึกษาความสัมพันธระหวางการประเมิน

ตนเอง (Core Self Evaluation) กับความพึงพอใจในงานและผลการปฏิบัติงาน โดยไดกลาววาการ
ประเมินตนเองเปนการรับรูและเปนความคิดเกี่ยวกับตนเองในแงตางๆ ทั้งในดานบวกและดานลบ
โดยจัดจและโบโนไดแบงการประเมินตนเอง (Core Self Evaluation) ออกเปน 4 ดาน ไดแก ความ
ภาคภูมิใจในตนเอง (Self Esteem) ศูนยการควบคุม (Locus of Control) การรับรูความสามารถ
ของตนเอง (Self Efficacy) ความมั่นคงทางอารมณ (Emotional Stability) 

แวนคูเวอร, ธอมพสัน และวิลเลียม (Vancouver, Thompson & Williams, 2001)                 
ไดทําการศึกษาถึงการเปล่ียนแปลงความสัมพันธระหวางการรับรูถึงความสามารถของตน (Self 
efficacy) , เปาหมายสวนบุคคล (Personal Goal), และผลการปฏิบัติงาน(Performance) พบวา
เมื่อนํามาใชรวมกับทฤษฎีของแบนดูราถึงความเชื่อของตนในการที่จะบรรลุเปาหมายได นํามาหา
คาสหสัมพันธเม่ือใชรวมกับ Control Theory สามารถทํานายไดวา การรับรูถึงความสามารถของ
ตนที่จะบรรลุ เปาหมายสงผลในทางลบตอผลการปฏิบั ติงานที่ผานมา  (Subsequence 
Performance) การทดลองนี้มีผูเขารวมการวิจัย 56 คน  โดยใชวิธีการ within person technique 
พบวาเปาหมายสวนบุคคลมีความสัมพันธในทางบวกเม่ือนํามาใชรวมกับการรับรูความสามารถ
ของตนที่จะบรรลุเปาหมาย  แตมีความสัมพันธในทางลบกับผลการปฏิบัติงานที่ผานมาในการวิจัย
สวนที่สองกับผูรวมการวิจัย 185 คน พบวาการเพิ่มระดับของเปาหมายสามารถทํานาย
ความสัมพันธทางบวกของผลการปฏิบัติงานแมวาการต้ังเปาหมายนั้นจะเปนเปาหมายที่ยาก 

เมเออรและบรุนเสตียน (Maier and brunstein, 2001) ไดทําการวิจัยในเร่ืองการวิเคราะห
ระยะยาว: บทบาทของการตั้งเปาหมายในการทํางานของพนักงานใหม กับความพึงพอใจในงาน 
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และคาวมผูกพันตอองคการ พบวามีตัวแปรสําคัญ 3 อยางในการต้ังเปาหมายในงาน (personal 
work Goals) ไดแก ความผูกพันตอเปาหมาย (Goal Commitment) ความสําเร็จตอเปาหมาย 
(Goal Attainability) และความกาวหนาในการไปสูเปาหมาย (Goal Process) เปนตัวแปรสงผล
ตอทัศนคติของพนักงานใหม (Satisfaction and Organization commitment) ในการวิจัยนี้ได
ศึกษาพนักงานใหมต้ังแตระยะ 1 เดือนแรกที่เขาทํางาน จนถึง 20 สัปดาหของการทํางานโดยแต
ละคนจะไดรับมอบหมายใหต้ังเปาหมายในการทํางานของตน เม่ือถึงสัปดาหที่ 8 พนักงานเหลานี้
จะไดรับการทดสอบความผูกพันตอเปาหมายอันเปนตัวแปรกํากับที่สงผลตอความแตกตางในการ
ดําเนินการตามเปาหมายของพนักงานแตละคน อันนําไปสูการเปล่ียนแปลงความพึงพอใจในงาน 
(Job Satisfaction) และความผูกพันตอองคการ (Organization Commitment) พบวา
ความกาวหนาของเปาหมายเปนตัวแปรสงผานที่สําคัญตอความผูกพันตอเปาหมาย และ
ความสําเร็จตอเปาหมายของพนักงานใหมในดานทัศนคติตองาน 

 

ตอนท่ี 6 หลกัการวิเคราะหโมเดลลิสเรล 
โมเดลลิสเรล (LISREL model) หรือโมเดลสมการโครงสราง (Structural Equation 

Model) หรือโมเดลโครงสรางความแปรปรวนรวม (Covariance Structural Model) เปนโมเดล    
ที่แสดงความสัมพันธเชิงสาเหตุระหวางตัวแปรที่สรางข้ึนโดยวิเคราะหเพื่อตรวจสอบความ
สอดคลองกลมกลืนระหวางโมเดลการวิจัยที่ผูวิจัย สรางข้ึนมาจากทฤษฎีหรือการวิจัยที่ผานมากับ
ขอมูลเชิงประจักษ หัวใจสําคัญของโมเดลลิสเรลอยูที่การเปรียบเทียบความแตกตางระหวาง
เมตริกซความแปรปรวน-ความแปรปรวนรวม (variance-covariance matrix) ที่ไดจากขอมูลเชิง
ประจักษกับเมทริกซที ่ไดจากการประมาณคาพารามิเตอรที่คํานวณจากโมเดลลิสเรลที ่เปน
สมมติฐานการวิจัย เพื่อตรวจสอบความสอดคลองระหวางโมเดลกับขอมูลเชิงประจักษ พรอมทั้ง
รายงานดัชนีความสอดคลองดวย  
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โมเดลใหญในโปรแกรมลิสเรลสามารถเขียนเปนสมการและแสดงตามแผนภาพท่ี 2.8  
ดังนี้ 

 

 
 

แผนภาพที ่2.8 โมเดลใหญในโปรแกรมลิสเรล 
 

ในที่นี้ NX  = จํานวนตัวแปรภายนอกสังเกตได 
 NY  = จํานวนตัวแปรภายในสังเกตได 
 NK  = จํานวนตัวแปรภายนอกแฝง  
 NE  = จํานวนตัวแปรภายในแฝง 

เวคเตอรของตัวแปรในโมเดลมีสัญลักษณอักษรกรีก และความหมายดังตอไปนี้ 
 X     =    Eks      =  เวคเตอรตัวแปรภายนอกสังเกตได X ขนาด (NX x 1) 
 Y     =    Wi =  เวคเตอรตัวแปรภายในสังเกตได Y ขนาด (NY x 1) 
 ξ    =    Xi =  เวคเตอรตัวแปรภายนอกแฝง K ขนาด (NK x 1) 

η    =    Eta =  เวคเตอรตัวแปรภายในแฝง E ขนาด (NE x 1) 
δ    =    Delta =  เวคเตอรความคลาดเคล่ือน d ในการวัดตัวแปร X ขนาด (NX x 1) 
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ε    =    Epsilon =  เวคเตอรความคลาดเคล่ือน e ในการวัดตัวแปร Y ขนาด (NY x 1) 
ζ   =    Zeta = เวคเตอรความคลาดเคล่ือน z ในการวัดตัวแปร E ขนาด (NE x 1) 

 เมทริกซพารามิเตอรอิทธิพลเชิงสาเหตุหรือสัมประสิทธิ์การถดถอย (causal effects or 
regression coefficients) รวม 4 เมทริกซ และเมทริกซพารามิเตอรความแปรปรวน-ความ
แปรปรวนรวม (variance-covariance) รวม 4 เมทริกซ มีสัญลักษณอักษรกรีก คําอาน ตัวยอ
ภาษาอังกฤษและความหมายมีดังนี้ 

ΔX = Lambda-X  = LX  
        = เมทริกซสัมประสิทธิ์การถดถอยของ X บน K ขนาด (NX x NK) 
ΔY = Lambda-Y  = LY  
        = เมทริกซสัมประสิทธิ์การถดถอยของ Y บน E ขนาด (NX x NE) 
Γ   = Gamma  = GA  
       = เมทริกซอิทธิพลเชิงสาเหตุจาก K ไป E ขนาด (NE x NK) 
β   = Beta  = BE  
       = เมทริกซอิทธิพลเชิงสาเหตุระหวาง E ขนาด (NE x NE)  
Φ  = Phi     =  PH  
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางตัวแปรภายนอกแฝง K ขนาด  
           (NK x NK)  
ψ  = Psi     =  Ps 
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางความคลาดเคล่ือน z ขนาด  
           (NE x NE)  
θδ  = Theta-Delta   = TD  
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางความคลาดเคล่ือน d ขนาด  
           (NX x NX) 
θδ  = Theta-epsilon = TE  
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางความคลาดเคล่ือน e ขนาด  
           (NY x NY) 

 ในโปรแกรมลิสเรลโมเดลใหญนั้นจะประกอบไปดวยโมเดลที่สําคัญสองโมเดล ไดแก  
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1.โมเดลการวัด (Measurement model or Confirmatory factor model)   
 โมเดลการวัด เปนโมเดลการวิเคราะหตัวประกอบซ่ึงแสดงความสัมพันธระหวางตัวแปรที่
สังเกตไดกับตัวแปรประกอบหรือตัวแปรแฝง โมเดลการวัดประกอบดวยชุดของตัวแปรสังเกตได 2 
ชุด คือ ตัวแปรอิสระที่สังเกตได x =(x1,x2 และ x3) และตัวแปรตามสังเกตได Y= (Y1,Y2 และ Y3) ซึ่ง
มีลักษณะ ดังสมการ 
   

εη
δξ

+Δ=
+Δ=

))((
))((

YY
xx  

โดยที ่        x    =    เวคเตอรของคาจากการวัดตัวแปรที่สังเกตได (ตัวบงชี้ของตัวแปรแฝงทีเ่ปนตัว 
       แปรอิสระ ξ ) 

    xΔ =   เมตริกซของสัมประสิทธิ์การถดถอยหรือน้าํหนักตัวประกอบซึ่งแสดง 
                               ความสัมพันธ ระหวาง x กับξ  
          δ  =    เวกเตอรแสดงความคลาดเคล่ือนในสมการ x 
        Y =    เวกเตอรของคาจากการวัดตัวแปรตามสังเกตได (ตัวบงชี้ของตัวแปรแฝงท่ี 
                              เปนตัวแปรอิสระ η ) 
                 YΔ  =   เมตริกซของสัมประสิทธ์ิการถดถอยหรือน้ําหนักตัวประกอบซึง่แสดง 
                               ความสัมพันธ ระหวาง Y กับ η  
                   ε  =   เวกเตอรความคลาดเคลื่อนในสมการ Y 

2.โมเดลสมการโครงการ (Structural equation model) 
 โมเดลสมการโครงสรางเปนโมเดลที่แสดงความสัมพันธระหวางตัวแปรภายในโมเดลการวจิยั 
ซึ่งมีลักษณะดังสมการ ดังนี้ 
   ξξηη +Γ+= B  
โดยที่          η   =  เวคเตอรของตัวแปรแฝงที่เปนตัวแปรตาม 
      ξ  =  เวคเตอรของตัวแปรแฝงที่เปนตัวแปรตาม 
       B    =  เมตริกซของสัมประสิทธิ์การถดถอย ซึง่แสดงอิทธพิลโดยตรงของ η   ทีม่ตีอ η   
                             อ่ืนๆ 
       Γ  =  เมตริกซของสัมประสิทธิก์ารถดถอย ซึง่แสดงอิทธพิลโดยตรงของ ξ  ที่มีตอ ξ   
                             อ่ืนๆ 
 จุดประสงคหลักของโมเดลลิสเรล คือ ตองการที่จะวัดคาตัวแปรโมเดลสมการโครงสราง 
แตวาไมสามารถที่จะวัดตัวแปรที่อยูในสมการโครงสรางไดโดยตรง ดังนั้นจึงตองมีโมเดลการวัด
เพื่อที่จะวัดคาตัวแปรที่อยูในโมเดลสมการโครงสราง และจากการที่โมเดลลิสเรลนี้มีโมเดลการวัด
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อยูในโมเดลใหญของลิสเรล ทําใหโมเดลลิสเรลสามารถทําการประมาณคาพารามิเตอรซึ่งสามารถ
ใชในการวิเคราะหการถดถอยได 
 โมเดลลิสเรล เปนผลของการสังเคราะหวิธีการวิเคราะหขอมูลที่สําคัญ 3 วิธี คือ การวิเคราะห
องคประกอบ (factor analysis) การวิเคราะหอิทธิพล (path analysis) และการประมาณคาพารามิเตอร
ซึ่งในการวิเคราะหการถดถอยโดยการวิเคราะหองคประกอบ และการประมาณคาพารามิเตอรใน
การวิเคราะหถดถอยนั้นเปนการวิเคราะหในโมเดลการวัด ซึ่งถือวาเปนจุดเดนที่สําคัญของลิสเรล 
โดยการวิเคราะหองคประกอบเปนการวิเคราะหองคประกอบของตัวแปรแฝงที่ไมสามารถสังเกตได
โดยวัดจากองคประกอบของตัวแปรแฝง ซึ่งเปนตัวแปรสังเกตไดสวนการประมาณคาพารามิเตอร
ในการวิเคราะหการถดถอยนั้นจะเปนคาสถิติที่ชวยทําใหเราทราบคาพารามิเตอรที่แทจริงได เพราะ 
คาตัวแปรที่วัดไดจะบอกคาความคลาดเคล่ือนของการวัดในแตละตัวแปรดวยและในการวิเคราะห 
อิทธิพลนั้นจะอยูในสวนของโมเดลโครงสรางซึ่งเปนโมเดลที่สําคัญในโมเดลลิสเรล โดยเปนการ
วิเคราะหหาความสัมพันธเชิงสาเหตุระหวางตัวแปรภายนอกแฝงและตัวแปรภายในแฝง 
 

ขอตกลงเบื้องตนของโมเดลลิสเรล  ประกอบดวย 
  1. ลักษณะความสัมพันธระหวางตัวแปรทั้งหมดในโมเดลเปนความสัมพันธแบบเสนตรง
เชิงบวกและเปนความสัมพันธเชิงสาเหตุ 
 2. ลักษณะการแจกแจงของตัวแปรทั้งตัวแปรภายในและภายนอกและความคลาดเคล่ือน 
ตองเปนการแจกแจงแบบปกติ ความคลาดเคล่ือนตางๆตองมีคาเฉลี่ยเปนศูนย 
 3. ลักษณะความเปนอิสระตอกันระหวางตัวแปรกับความคลาดเคล่ือนสามารถแยกออก
ไดเปนความคลาดเคล่ือนที่เปนอิสระตอกัน ความคลาดเคล่ือนและตัวแปรแฝงท่ีเปนอิสระตอกัน 
 4. สําหรับการวิเคราะหอนุกรมเวลา ที่มีการวัดขอมูลมากกวา 2 คร้ัง การวัดตัวแปรตอง
ไมไดรับอิทธิพลจากชวงเวลาเหล่ือม (time lay) ระหวางการวัด 
 จะเห็นไดวาขอตกลงของโมเดลลิสเรลนั้นมีการผอนคลายมากกวาขอตกลงของการวิเคราะห 
การถดถอยและการวิเคราะหเสนทางเปนอยางมาก ซึ่งจะทําใหขอมูลสอดคลองกับขอตกลงทาง
สถิติไดดียิ่งข้ึน 
 กระบวนการสรางโมเดลนั้นโดยทั่วไปนั้น ขั้นแรกเปนการสรางโมเดลที่ไดมาจากการ
ทบทวนเอกสารและงานวิจัยตางๆ ข้ันตอมาจึงเปนขั้นของการตรวจสอบโมเดลที่ไดจากการสราง
โมเดลในขั้นตอนแรกกับขอมูลจริง เพื่อที่จะไดดูวาโมเดลที่เราไดจากขั้นตอนแรกนั้นสอดคลอง
กับขอมูลในสภาพการณจริง โดยในข้ันตอนนี้ถาเราจะเลือกใชสถิติวิเคราะหโปรแกรมลิสเรลก็จะ
วิเคราะหข้ันตอนนี้ โดยในการวิเคราะหดวยโปรแกรมลิสเรลจะมีข้ันตอนทั้งหมด 6 ที่สําคัญ ไดแก 
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ข้ันตอนที่ 1 การกําหนดขอมูลจําเพาะของโมเดล (specification of the model) ใน
การวิเคราะหขอมูลโปรแกรมลิสเรลส่ิงที่สําคัญคือ การกําหนดคาเมทริกซทั้ง 8 เมทริกซให
สอดคลองกับโมเดลการวิจัย การกําหนดขอมูลจําเพาะได 3 รูปแบบ ดังนี้ 

1. พารามิเตอรกําหนด (Fixed Parameter: FI) หมายถึง พารามิเตอรในโมเดลการ
วิจัยที่ไมมีเสนแสดงอิทธิพลระหวางตัวแปร ซึ่งสามารถกําหนดคาความสัมพันธในเมทริกซดวย
สัญลักษณ “0” 

 2. พารามิเตอรบังคับ (Constrained Parameter: ST) หมายถึง พารามิเตอรใน
โมเดลการวิจัยที่มีเสนแสดงอิทธิพลระหวางตัวแปร และพารามิเตอรขนาดอิทธิพลนั้นเปนคาที่
จะตองมีการประมาณ แตมีเงื่อนไขกําหนดให พารามิเตอรบางตัวมีคาเฉพาะคงที่ ซึ่งถาบังคับให
เปน 1 ก็สามารถกําหนดคาความสัมพันธในเมทริกซดวยสัญลักษณ “1” 

3. พารามิเตอรอิสระ (Free Parameter: FI) หมายถึง พารามิเตอรในโมเดลการวิจัยที่
ที่ตองการประมาณคา และไมบังคับใหมีคาอยางใดอยางหนึ่งใชสัญลักษณ “*” 

การกําหนดลักษณะพารามิเตอรวาเปนพารามิเตอรกําหนด พารามิเตอรบังคับ และ
พารามิเตอรอิสระในเมทริกซทั้ง 8 มีความสําคัญตอการใชโปรแกรมลิสเรลมาก ในการเขียนคําส่ัง
นักวิจัยตองกําหนดขอมูลจําเพาะของพารามิเตอรที่เขียนในรูปเมทริกซทั้ง 8 ดวยวามีรูปแบบ 
(form) และสถานะ (mode) ของพารามิเตอรเปนแบบใด รูปแบบของเมทริกซที่ใชในโปรแกรมลิส 
เรล มี 8 รูปแบบ ตามเมทริกซทางคณิตศาสตรทั่วไป ดังนี้ 

1. เมทริกซศูนย (Zero Matrix = ZE) 
2. เมทริกซเอกลักษณ (Identity Matrix = ID) 
3. เมทริกซเอกลักษณ,ศูนย (Identity, Zero Matrix = IZ) 
4. เมทริกซศูนย, เอกลักษณ (Zero, Identity Matrix = ZI) 
5. เมทริกซแนวทแยง (Diagonal Matrix = DI) 
6. เมทริกซสมมาตร (Symmetric Matrix = SYI) 
7. เมทริกซใตแนวทแยง (Subdiagonal Matrix = SD) 
8. เมทริกซสมมาตรมาตรฐาน (Standardized Symmetric Matrix = ST) 
9. เมทริกซเต็มรูปแบบ (Full Matrix = FU) 
สถานะ (mode) ของเมทริกซที่ใชในโปรแกรมกําหนดตามสถานะของสมาชิกในเมท

ริกซเปน 2 สถานะ คือ พารามิเตอรกําหนด (Fixed Parameter = FI) และพารามิเตอรอิสระ (Free 
Parameter = FR)  
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ข้ันตอนที่ 2 การระบุความเปนไดคาเดียวของโมเดล (identifications of the model)
การระบุความเปนไปไดคาเดียวทําใหนักวิจัยทราบไดลวงหนาวา โมเดลนั้นจะประมาณ
คาพารามิเตอรไดหรือไม เงื่อนไขที่ทําใหระบุความเปนไปไดคาเดียวพอดีที่ตองพิจารณาอยู 3 
ประเภท (Bollen, 1989 : 103,332; Long, 1983 : 44 อางถึงใน นงลักษณ วิรัชชัย, 2542) คือ 
เงื่อนไขจําเปน (necessary condition) เงื่อนไขพอเพียง (sufficient condition) และเงื่อนไขจําเปน
และพอเพียง (necessary and sufficient conditions) 

ข้ันตอนที่ 3 การประมาณคาพารามิเตอรจากโมเดล (parameter estimation of the 
model) จุดมุงหมายของการประมาณคาพารามิเตอร คือ การหาคาพารามิเตอรที่จะทําใหเมทริกซ
ความแปรปรวน-ความแปรปรวนรวมที่คํานวณไดจากกลุมตัวอยาง (S) และเมทริกซความ
แปรปรวน-ความแปรปรวนรวมที่ถูกสรางข้ึนจากพารามิเตอรที่ประมาณคาไดจากโมเดลสมมติฐาน 
(Σ หรือ sigma) มีคาใกลเคียงกันมากที่สุด  ถาหากเมทริกซทั้งสองมีคาใกลเคียงกันกัน แสดงวา
โมเดลที่เปนสมมติฐานมีความกลมกลืนกับขอมูลเชิงประจักษ ในการกําหนดเงื่อนไขใหเมทริกซทั้ง
สองมีคาใกลเคียงกันใชวิธีการสรางฟงกชั่นความกลมกลืน (fit or fitting function) รูปแบบของ
ฟงกชั่นทุกฟงกชั่นที่สรางข้ึนตองมีคุณสมบัติรวม 4 ประการ คือ (1) ฟงกชั่นความกลมกลืนตอง
เปนสเกลลารหรือเปนตัวเลขจํานวน (2) ฟงกชั่นความกลมกลืนตองมีคามากกวาหรือเทากับศูนย 
(3) ฟงกชั่นความกลมกลืนมีคาเทากับศูนยเม่ือเมทริกซ S และ Σ มีคาเทากันเทานั้น (4) ฟงกชั่น
ความกลมกลืนเปนฟงกชั่นตอเนื่อง (continuous function) วิธีการประมาณคาพารามิเตอรใน
โปรแกรมลิสเรลมี 7 วิธี ในจํานวนนี้เปนการประมาณคาที่ใชความกลมกลืนมี 5 แบบ คือ 

1. วิธีกําลังสองนอยที่สุดไมถวงน้ําหนัก (Unweighted Least Square = ULS) 
2. วิธีกําลังสองนอยที่สุดวางนัยทั่วไป (Generalized Least Square = GLS) 
3. วิธีไลคลิฮูดสูงสุด (Maximum Likelihood = Mi) 
4. วิธีกําลังสองนอยที่สุดถวงน้ําหนักทั่วไป  
(Generally Weight Least Square  = WLS) 
5. วิธีกําลังสองนอยที่สุดถวงน้ําหนักแนวทแยง  
(Diagonal Weighted Least   Square = DWLS) 
ข้ันตอนที่ 4 การตรวจสอบความตรงของโมเดล (validation of the model) ข้ันตอนนี้

เปนการตรวจสอบความตรงของโมเดลที่เปนสมมติฐานการวิจัยหรือการประเมินผลความถูกตอง
ของโมเดลหรือการตรวจสอบความกลมกลืนระหวางขอมูลเชิงประจักษกับโมเดล คาสถิติที่ชวยใน
การตรวจสอบความตรงของโมเดลมี 5 วิธี  
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1. ความคลาดเคล่ือนมาตรฐานและสหสัมพันธของคาประมาณพารามิเตอร 
(standard errors and correlations of estimates) ถาสหสัมพันธระหวางคาประมาณมีคาสูงมาก
เปนสัญญาณแสดงวาโมเดลการวิจัยใกลจะไมเปนบวกแนนอน (non-positive definite) เปน
โมเดลที่ไมดีพอ 

2. สหสัมพันธพหุคูณและสัมประสิทธิ์การพยากรณ (multiple correlations and 
coefficients of determination) คาสถิติเหลานี้ควรมีคาสูงสุดไมเกินหนึ่งและคาที่สูงแสดงวา
โมเดลมีความตรง 

3. คาสถิติวัดระดับความกลมกลืน (goodness of fit measures) คาสถิติในกลุมนี้ใช
ตรวจสอบความตรงของโมเดลเปนภาพรวมทั้งโมเดล สําหรับโปรแกรมลิสเรลมี 7 ประเภท 
ดังตอไปนี้ 

 3.1 คาไคสแควร (chi-square statistics) ถาคาไคสแควรมีคาตํ่ามาก ยิ่งมีคาใกล
ศูนยมากเทาไรแสดงวาโมเดลลิสเรลมีความสอดคลองกับขอมูลเชิงประจักษ Saris และt 
Stronkhorst (1984 : 200 อางถึงใน นงลักษณ วิรัชชัย, 2542) เสนอวาคาไคแสควรควรมีคา
เทากับองศาอิสระสําหรับโมเดลที่มีความกลมกลืนกับขอมูลเชิงประจักษ 

 3.2 ดัชนีวัดระดับความกลมกลืน (Goodness of fit Index = GFI) ดัชนี GFI จะมี
คาอยูระหวาง 0 ถึง 1 เม่ือขนาดของกลุมตัวอยางมีคาสูงข้ึน ดัชนี GFI ที่เขาใกล 1 แสดงวาโมเดล
มีความกลมกลืนกับขอมูลเชิงประจักษ 

 3.3 ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (Adjusted Goodness of fit 
Index = AGFI) มีคุณสมบัติเชนเดียวกับ GFI 

 3.4 ดัชนีรากของคาเฉล่ียกําลังสองของสวนที่เหลือ (Root Mean Squared 
Residual = RMR) คาของดัชนี RMR ยิ่งเขาใกลศูนยแสดงวาโมเดลมีความกลมกลืนกับขอมูลเชิง
ประจักษ 

4. การวิเคราะหเศษเหลือหรือความคลาดเคล่ือน (analysis of residuals) ในการใช
โปรแกรมลิสเรลนักวิจัยควรวิเคราะหเศษเหลือควบคูกันไปกับดัชนีตัวอ่ืน ๆ ผลจากการวิเคราะห
ขอมูลดวยโปรแกรมลิสเรลในสวนที่เกี่ยวของกับความคลาดเคล่ือนมีหลายแบบ แตละแบบให
ประโยชนในการตรวจสอบความกลมกลืนของโมเดลกับขอมูลเชิงประจักษดังนี้ 

 4.1 เมทริกซเศษเหลือหรือความคลาดเคลื่อนในการเทียบความกลมกลืน (fitted 
residuals matrix) ถาโมเดลมีความสอดคลองกลมกลืนกับขอมูล คาความคลาดเคล่ือนในรูป
คะแนนมาตรฐานไมควรมีคาเกิน 2 ถายังมีคาเกิน 2 ตองปรับโมเดล 
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 4.2 คิวพล็อต  (Q-plot)  เปนกราฟแสดงความสัมพันธ ระหวางคาความ
คลาดเคล่ือนกับ ควอนไทลปกติ (normal quantiles) ถาไดเสนกราฟมีความชันมากกวาเสนทแยง
มุมเปนเกณฑในการเปรียบเทียบแสดงวาโมเดลมีความสอดคลองกลมกลืนกับขอมูลเชิงประจักษ 

5. ดัชนีดัดแปรโมเดล (mode; modification indices) เปนคาสถิติเฉพาะสําหรับ
พารามิเตอรแตละตัวมีคาเทากับคาไค-สแควรที่จะลดลงเมื่อกําหนดใหพารามิเตอรตัวนั้นเปน
พารามิเตอรอิสระหรือมีการผอนคลายขอกําหนดเงื่อนไขบังคับของพารามิเตอรนั้น 

ข้ันตอนที่ 5 การปรับโมเดล (model adjustment) ในกรณีที่ผลการตรวจสอบความ
ตรงของโมเดลพบวาโมเดลไมสอดคลองกับขอมูลเชิงประจักษ ผูวิจัยตองทําการปรับโมเดลโดย
อาศัยดัชนีดัดแปรโมเดล เปนแนวทางในการปรับโมเดลจนกวาจะไดโมเดลที่สอดคลองกับขอมูล
เชิงประจักษ 

ข้ันตอนที่ 6 การแปลผลการวิเคราะหขอมูล เปนข้ันตอนสุดทายที่ผูวิจัยตองทํา
หลังจากที่ไดโมเดลที่สอดคลองกับขอมูลเชิงประจักษเรียบรอยแลว 

การดําเนินการทั้ง 6 ข้ันตอนนี้ตอเนื่องกัน  ดังแผนภาพท่ี 2.9 และเมื่อตรวจสอบ
ความสอดคลองระหวางขอมูลเชิงประจักษกับโมเดลลิสเรล ถาผลการวิเคราะหพบวาไมสอดคลอง
นักวิจัยอาจปรับโมเดลลิสเรลและดําเนินการวิเคราะหใหมอีกรอบหนึ่ง ถาพบวามีความสอดคลอง
ระหวางขอมูลเชิงประจักษและโมเดลลิสเรล จึงจะแปลความหมายผลการวิเคราะหขอมูลได 
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แผนภาพที่ 2.9 ข้ันตอนการวิเคราะหโมเดลลิสเรล 
ที่มา : นงลักษณ วิรัชชัย, 2542 

ลักษณะเดน ของการวิเคราะหโมเดลลิสเรลที่ทําใหผลการวิจัยมีความถูกตองและมีความ
นาเช่ือถือ แบงออกเปน 4 ประเด็น คือ (นงลักษณ  วิรัชชัย, 2542) 
 1. หลักการวิเคราะหโมเดลเปนหลักการที่ตรงตามวิธีวิทยาการวิจัย คือ นักวิจัยไดสราง
สมมติฐานในการวิจัยในรูปของความสัมพันธโครงสรางเชิงเสนระหวางตัวแปร โดยมีพื้นฐานมา
จากทฤษฎีและงานวิจัยที่เกี่ยวของแลวจึงนํามาวิเคราะหโมเดลลิสเรลโดยการตรวจสอบขอมูลเชิง
ประจักษกลมกลืนสอดคลองกับโมเดลลิสเรลที่พัฒนาข้ึน 
 2. โปรแกรมลิสเรล เปนวิธีการวิเคราะหขอมูลทางสถิติใชศึกษาความสัมพันธเชิงสาเหตุ
ไดทั้งการวิจัยที่เปนการวิจัยเชิงทดลองและไมใชการวิจัยเชิงทดลอง โดยผลการวิเคราะหขอมลูจะมี
ความถูกตองมากขึ้นจากการวิเคราะหแบบด้ังเดิม เนื่องจากในโมเดลมีการรวมตัวแปรแฝงและมี
การผอนคลายขอตกลงเบื้องตนหลายประการ ซึ่งทําใหขอมุลซ่ึงทําใหขอมูลสอดคลองกับขอตกลง

การระบุความเปนไปไดคาเดียว

การแปลความหมายโมเดล

การตรวจสอบความกลมกลืน

เมตริกซความแปรปรวน-ความแปรปรวนรวม

การกําหนดขอมูลจําเพาะ

โมเดลลิสเรล

การปรับโมเดล

ขอมูลเชิงประจักษ   การประมาณคาพารามิเตอร

ไมกลมกลืน

กลมกลืน
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ทางสถิติไดดีข้ึน เชน การที่โมเดลลิสเรลยอมใหตัวแปรมีความคลาดเคล่ือนในการวัดและความ
คลาดเคล่ือนอาจสัมพันธกันได แตถาเปนการวิเคราะหแบบสหสัมพันธพหุคูณซ่ึงเปนการวิเคราะห
แบบด้ังเดิมนั้น จะกําหนดวาตองไมมีความสัมพันธกันของความคลาดเคล่ือน และตัวแปรวัดได
โดยไมมีความคลาดเคล่ือน ดังนั้นหากผูวิจัยสรางเคร่ืองมือวัดตัวแปรอยางไมมีคุณภาพยอมทําให
ตัวแปรผลการวิจัยไมถูกตอง 
 3. เทคนิคการวิเคราะหขอมูลโมเดลลิสเรลนั้นจะครอบคลุมเทคนิคการวิเคราะหขอมูลทาง 
สถิติข้ันสูงเกือบทุกประเภทไมวาจะเปน การวิเคราะหความแปรปรวน การวิเคราะหหลายระดับ 
การวิเคราะหองคประกอบ การวิเคราะหอิทธิพล รวมทั้งการวิเคราะหโมเดลเกี่ยวกับการวัดแบบ
ตางๆ 
 4. การวิเคราะหโมเดลลิสเรล สามารถใชเปนเครื่องมือในการตรวจสอบทฤษฎีที่ผูวิจัย
ตองการศึกษา ทั้งในดานการตรวจสอบความตรงเชิงโครงสรางและการตรวจสอบความตรงของ
โมเดล โดยสามารถพิจารณาไดจากดัชนีที่โปรแกรมเสนอไวในผลการวิเคราะห เชน ไค-สแควร 
ดัชนีความสอดคลอง (GFI) ดัชนีความสอดคลองเชิงเปรียบเทียบ (CFI) และดัชนีรากกําลังสอง
เฉลี่ยของเศษที่เหลือ (RMR) ดัชนีเหลานี้จะบงบอกวาโมเดลที่ผูวิจัยพัฒนาขึ้นหรือโครงสรางที่
ตองการตรวจสอบนั้นมีความสอดคลองกับขอมูลเชิงประจักษหรือไม ถายังไมสอดคลองกับขอมูล
เชิงประจักษ ผูวิจัยยังสามารถปรับโมเดลโดยพิจารณาจากดัชนีปรับโมเดล (MI) และดัชนีการ
เปล่ียนแปลงที่คาดหวัง(EPC) 
 
ตอนท่ี 7 กรอบแนวคิดและสมมติฐานการวิจัย 

ริชารดดี จอหนสัน (Richard D. Johnson, 2005) ไดนําทฤษฎีการรับรูความสามารถของ
ตนเองกับทฤษฎีการตั้งเปาหมายมาสังเคราะหกันเพื่อศึกษาความสัมพันธระหวางตัวแปรหลัก              
2 ตัวแปร คือ การรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทาง
คอมพิวเตอร โดยเก็บนักศึกษาจํานวน 313 คน  ที่มีประสบการณการใชคอมพิวเตอร  และใน
งานวิจัยไดมีตัวแปรที่เกี่ยวของกัน 9 ตัวแปร ไดแก ระดับประสบการณเดิม บุคลิกภาพภายในของ
ผูเรียน ความมุงมั่นในการทํางาน ความวิตกกังวลในการใชคอมพิวเตอร การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง การต้ังเปาหมาย  ความผูกพันตอเปาหมาย เจตคติในการทํางาน 
และความสามารถทางคอมพิวเตอร   แตในงานวิจัยนี้ผูวิจัยไดตัดตัวแปรเจตคติในการทํางาน
ออกไป เพราะจากการศึกษาเอกสารและงานวิจัยที่เกี่ยวของทําใหทราบวาตัวแปรนี้ไมไดเปนผลมา
จากการเกิดการรับรูความสามารถดานคอมพิวเตอรของตนเอง ดังนั้นผูวิจัยจึงเลือกศึกษาตัวแปร
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ทั้งหมด 8 ตัว ไดแก ประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน 
ความวิตกกังวลในการใชคอมพิวเตอร การรับรูความสามารถดานคอมพิวเตอรของตนเอง การ
ต้ังเปาหมาย  ความผูกพันตอเปาหมาย และความสามารถทางคอมพิวเตอร 

โดยจากการศึกษาเอกสารและงานวิจัยของริชารดดี จอหนสัน (Richard D. Johnson, 
2005) ที่เกี่ยวของกับตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร ผูวิจัยจึงได
สังเคราะหตัวแปรโดยไดตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองได 
4 ตัวแปร ไดแก ระดับประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน
และความวิตกกังวลในการใชคอมพิวเตอร โดยมีรายละเอียด ดังตารางที่ 2.2 
 

ตารางที ่2.2 สรุปผลการสังเคราะหตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร 
                    ของตนเอง 
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ตัวแปรทีส่งผลตอ 
การรับรูความสามารถ 

ดานคอมพิวเตอรของตนเอง 

1997 2000 2004 1989 2001 1992 2000
ระดับประสบการณเดิม / /      
บุคลิกภาพภายในของผูเรียน   /     
ความมุงมัน่ในการทํางาน    / /   
ความวิตกกงัวลในการใชคอมพิวเตอร      / / 
 นอกจากนี้แลวยังมีเอกสารและงานวิจยั ริชารดดี จอหนสัน (Richard D. Johnson, 
2005)ที่ไดกลาวถงึตัวแปรทีส่งผลตอความสามารถทางคอมพิวเตอร ซึ่งผูวิจยัไดสังเคราะหตัวแปร
โดยไดตัวแปรที่สงผลตอความสามารถทางคอมพวิเตอรได 3 ตัวแปร ไดแก การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง การตั้งเปาหมายและความผูกพันตอเปาหมาย โดยมีรายละเอียด ดังตาราง
ที่ 2.3 
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ตารางที ่2.3 สรุปผลการสังเคราะหตัวแปรที่สงผลตอความสามารถทางคอมพวิเตอร 
นักจิตวทิยา/นักวิจยั 
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ตัวแปรทีส่งผลตอ 
ความสามารถทางคอมพิวเตอร 

1984 1989 1995 2004 1986 1997 

การรับรูความสามารถดานคอมพวิเตอรของตนเอง / / /    
การต้ังเปาหมาย    / /  
ความผูกพนัตอเปาหมาย    / / / 
 

ดังนั้นจากการศึกษาแนวคิด ทฤษฎี เอกสารและงานวิจัยที่เกี่ยวของทั้งหมดทําใหผูวิจัย
สนใจที่จะศึกษาปจจัยจาก 2 ตัวแปร คือ การรับรูความสามารถดานคอมพิวเตอรของตนเองและ
ความสามารถทางคอมพิวเตอร โดยผูวิจัยขออธิบายเปน 3 สวนไดแก สวนที่ 1 ปจจัยที่ทําใหเกิด
การรับรูความสามารถดานคอมพิวเตอรของตนเอง สวนที่ 2 ผลของการรับรูความสามารถของ
ตนเองดานคอมพิวเตอร  และสวนที่ 3 ปจจัยที่มีผลทําใหเกิดความสามารถทางคอมพิวเตอร  

สวนที่ 1 ปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก 
ประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน และความวิตกกังวลใน
การใชคอมพิวเตอร   แบนดูรา (Bandura, 1997) ไดกลาววาประสบการณเดิม คือ การที่บุคคล
ไดรับขาวสารจากแหลงขอมูลตางๆซึ่งจะทําใหบุคคลนั้นไดรับรู เกิดการเรียนรูที่หลากหลาย เมื่อ
บุคคลใดไดรับประสบการณเดิมที่ประสบความสําเร็จมากอนก็จะเปนเหตุใหเกิดทักษะและมี
ความสามารถทางดานนั้นดวย ซึ่งสอดคลองกับ ซาราโนวา (Salanova, 2000) ที่กลาวเอาไววา
การไดใชคอมพิวเตอรหรือประสบการณการใชงานมากอนก็สามารถทํานายหรือประมาณคาการ
รับรูความสามารถดานคอมพิวเตอรของตนเองได  ดังนั้นประสบการณเดิมนาจะสงผลตอตอการ
รับรูความสามารถดานคอมพิวเตอรของตนเอง   ล็อคและลาแธม (Locke & Latham, 2004) ได
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กลาววาการรับรูความสามารถของตนเองเปนส่ือกลางความสัมพันธระหวางบุคลิกภาพภายในของ
บุคคลนั้น กระบวนการตั้งเปาหมาย และความสามารถทางคอมพิวเตอร ผูวิจัยจึงเห็นวา
บุคลิกภาพภายในของผูเรียน นาจะสงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง  
วูดและแบนดูรา (Wood and Bandura, 1989) ไดกลาวถึงความมุงมั่นในการทํางานวาเปนการ
กําหนดเปาหมายสําหรับการเรียนรูซึ่งจะสามารถประมาณคาการรับรูความสามารถของตนเองได 
เพราะวาการมีความมุงมั่นในการทํางาน จะเปนกระบวนการหนึ่งในการประมาณคาการรับรู
ความสามารถ เชน การศึกษาจากส่ิงรอบขาง การไดมาซึ่งทักษะ การพัฒนาตางๆ  และ แวนเดอวาล 
(Vandewalle, 2001) ไดศึกษาเกี่ยวกับความสัมพันธที่เกี่ยวกับความสนใจในการเขาศึกษาและ
แรงจูงใจ ซึ่งงานวิจัยเหลานี้ไดสอดคลองกับความสัมพันธระหวางการมีความมุงมั่นในการทํางาน 
และการรับรูความสามารถของตนเอง ฉะนั้นผูวิจัยจึงเห็นวาความมุงมั่นในการทํางานนาจะสงผลตอ
การรับรูความสามารถดานคอมพิวเตอรของตนเอง     ความวิตกกังวลในการใชคอมพิวเตอร คือ 
ความกลัว ความหวาดหวั่นความเกรงกลัวในการใชคอมพิวเตอร อันจะสงผลตอการสูญเสียในดาน
ตางๆ เชน การทํางาน การสื่อสารดานตางๆ กลัววาใชแลวจะกอใหเกิดขอผิดพลาดอะไรบางอยาง 
มาโตะชิคโค (Martocchio, 1992) และ จอหนสันและมาราสกา (Johnson and Marakas, 2000) 
ไดกลาววาความวิตกกังวลในการใชคอมพิวเตอรมีความสัมพันธตอการการรับรูความสามารถของ
ตนเองดานคอมพิวเตอร  ดังนั้นผูวิจัยจึงเห็นวาความวิตกกังวลในการใชคอมพิวเตอรนาจะสงผลทาง
ลบกับการรับรูความสามารถดานคอมพิวเตอรของตนเอง 

สวนที่ 2 ผลของการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก การต้ังเปาหมาย
ความผูกพันตอเปาหมาย ล็อคและลาแธม (Locke & Latham, 1990) ไดกลาววาความสําเร็จของ
เปาหมายสามารถทําใหบุคคลนั้นมีความสามารถเกิดข้ึน แตในทางตรงกันขามการรับรูความสามารถ
ของตนเองก็สามารถทําใหบุคคลนั้นมีความเชื่อในเปาหมาย ความผูกพันตอเปาหมายและเกิดการ
ต้ังเปาหมายดวยตนเอง  ดังนั้นผูวิจัยจึงเห็นวาการรับรูความสามารถดานคอมพิวเตอรของตนเอง
นาจะสงผลใหเกิดการต้ังเปาหมายและความผูกพันตอเปาหมาย  

สวนที่ 3 ปจจัยที่สงผลทําใหเกิดความสามารถทางคอมพิวเตอร   ไดแก  การรับรู
ความสามารถดานคอมพิวเตอรของตนเอง การต้ังเปาหมาย และความผูกพันตอเปาหมายล็อค 
(Lock , 1984) วูดและแบนดูรา (Wood and Bandura, 1989) คอมโบและฮิกกิ้น (Compeau and 
Higgins, 1995) ไดศึกษาการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีผลตอการเกิด
ความสามารถทางคอมพิวเตอร ซึ่งเปนผลที่นําไปสูความสําเร็จ    ในทางเดียวกัน ยีและอิม (Yi and 
Im, 2004) ก็ไดนําหลักการของ ล็อคและลาแธม(Locke & Latham, 1990) นี้ไปศึกษาตอในเร่ือง ผล
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ของการต้ังเปาหมาย ความผูกพันตอเปาหมายที่มีตอความสามารถทางคอมพิวเตอร  ดังนั้นผูวิจัยจึง
เห็นวา การรับรูความสามารถดานคอมพิวเตอรของตนเองการตั้งเปาหมาย และความผูกพันตอ
เปาหมายนาจะสงผลตอความสามารถทางคอมพิวเตอรเชนกัน 

จากที่กลาวมาทั้งหมดนี้ ผูวิจัยจึงขอนําเสนอกรอบแนวคิดโมเดลเชิงสาเหตุและผลของ
การรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถดานคอมพิวเตอรของ
นักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร โดยสรุปดังแผนภาพที่ 2.10 

 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ระดับประสบการณ 
ในการใชโปรแกรม
ประมวลผลคํา 

ระดับประสบการณใน
การใชโปรแกรม
นําเสนอผลงาน

การเห็นคุณคา 
ในตนเอง 

ความออนไหว 
ทางอารมณ 

ระดับความมุงมั่น
ในการทํางาน 

ระดับความวิตกกังวล 
ในการใชคอมพิวเตอร 

ระดับประสบการณเดิม 

บุคลิกภาพภายในของผูเรียน 

ความมุงมั่นในการทํางาน 

ความวิตกกังวล 
ในการใชคอมพิวเตอร 

การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง

การรับรูความสามารถ
ในการใชโปรแกรม
ประมวลผลคํา

การรับรูความสามารถ
ในการใชโปรแกรม
นําเสนอผลงาน

     การตั้งเปาหมาย 

ความผูกพันตอเปาหมาย

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมประมวลผลคํา

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมนําเสนอผลงาน

คะแนนทดสอบ 
โปรแกรมประมวลผลคํา 

คะแนนทดสอบ 
โปรแกรมนําเสนอผลงาน 

ความสามารถ
ทางคอมพิวเตอร

ระดับความผูกพันตอเปาหมาย

แผนภาพที่ 2.10 กรอบแนวคิดโมเดลความสัมพันธเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเอง
                        ที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 83



บทที่ 3 
 

วิธีดําเนินการวิจัย 
 

การวิจัยในคร้ังนี้เปนการศึกษาความสัมพันธเชิงสาเหตุ (causal relationships) โดยมี
วัตถุประสงคหลักเพื่อพัฒนาและตรวจสอบความตรง (validation) ของโมเดลเชิงสาเหตุระหวาง
การรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของ
นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย (ชวงช้ันที่ 4) ในเขตกรุงเทพมหานคร ดังมีรายละเอียด
และข้ันตอนการดําเนินการวิจัยดังตอไปนี้ 

 

ประชากรและกลุมตัวอยางที่ใชในการวิจัย 
 ประชากร 
 ประชากรที่ใชในการศึกษาคร้ังนี้  คือ นักเรียนระดับช้ันมัธยมศึกษาตอนปลาย (ชวงช้ันที่ 
4) ในกรุงเทพมหานคร จํานวน 161,763 คน ซึ่งผูวิจัยใชเปนกรอบประชากรในการกําหนดขนาด
ของกลุมตัวอยางในการวิจัยคร้ังนี้ 

กลุมตัวอยาง 
 กลุมตัวอยางที่ใชในการศึกษาคร้ังนี้ คือ นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย (ชวงชัน้ที ่4)
ในกรุงเทพมหานคร ประจําภาคเรียนที่ 2 ปการศึกษา 2551 จํานวน 720 คน ซึ่งไดจากการกาํหนด
ขนาดของกลุมตัวอยางโดยใชแนวคิดของลินดแมน (Lindman, 1980 อางถึงในนงลักษณ วิรัชชัย , 
2542) เนื่องจากการวิจัยในคร้ังนี้เปนการวิเคราะหดวยโปรแกรมลิสเรล ซึ่งลินดแมน เสนอวาขนาด
กลุมตัวอยางตองมีอยางนอย 20 คน ตอ 1 พารามิเตอร โดยการวิจัยคร้ังนี้ไดกําหนดจํานวน
พารามิเตอรที่ตองประมาณคาในโมเดล จํานวน 36 พารามิเตอร จึงไดขนาดกลุมตัวอยาง จํานวน 
720 คน  
 การสุมตัวอยาง 

กลุมตัวอยางที่ใชในการศึกษาคร้ังนี้ คือ  นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย                    
(ชวงช้ันที่ 4) ในเขตกรุงเทพมหานคร จํานวน 720 คน โดยผูวิจัยใชวิธีการสุมตัวอยางแบบหลาย
ข้ันตอน (Multi-State Sampling) โดยมีรายละเอียด ดังนี้ 

ข้ันที่ 1 แบงโรงเรียนตามสังกัด โดยผูวิจัยสนใจที่จะศึกษาในโรงเรียน 2 สังกัด คือ โรงเรียน
รัฐบาลสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) กระทรวงศึกษาธิการและ 
โรงเรียนเอกชนสังกัดสํานักบริหารงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) สํานักงาน
ปลัดกระทรวง กระทรวงศึกษาธิการ ซึ่งเหตุผลที่ไมไดวิจัยโรงเรียนในสังกัดกรุงเทพมหานคร
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เนื่องจากโรงเรียนสังกัดกรุงเทพมหานครไมไดมีเปาหมายในการผลิตนักเรียนในระดับมัธยมศึกษา
ตอนปลายแลวแบงขนาดของโรงเรียนทั้ง 2 กลุม เปนโรงเรียนขนาดกลาง และโรงเรียนขนาดใหญ 
โดยใชเกณฑของกรมสามัญศึกษา  (กรมสามัญศึกษา 2542: 5)  ดังนี้ 

โรงเรียนขนาดกลาง จํานวนนักเรียน  500 – 1,499 คน 
โรงเรียนขนาดใหญ จํานวนนักเรียนต้ังแต  1,500 คน ข้ึนไป 

 โดยผูวิจัยสนใจที่จะศึกษาในโรงเรียนขนาดกลางและขนาดใหญเนื่องจาก โรงเรียนในกลุม
นี้จะมีการสนับสนุนอุปกรณส่ือการเรียนการสอนทางโสตทัศนศึกษาอีกทั้งโรงเรียนยังไดมีการจัด
เนื้อหาสาระการเรียนรู (โปรแกรมท่ีใชสอน) ไดสอดคลองกับการรับรูความสามารถดาน
คอมพิวเตอรของผูเรียนซ่ึงจะมีผลตอความสามารถทางคอมพิวเตอร    

ข้ันที่ 2 เลือกโรงเรียนที่จะศึกษาโดยการสุมตัวอยางแบบแบงชั้น (stratified random 
sampling) ตามขนาดโรงเรียน และสุมโรงเรียนในแตละขนาด โดยใชวิธีการสุมอยางงาย (simple 
random sampling) ไดจํานวนโรงเรียนที่เปนกลุมตัวอยาง สังกัดละ 10 โรงเรียน โดยแตละสังกัด             
มีโรงเรียนทั้งขนาดกลางและขนาดใหญ อยางละ 5 โรงเรียน 

ข้ันที่ 3 ทําการสุมนักเรียนที่กําลังศึกษาอยูในระดับช้ันมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4)
ซึ่งผูวิจัยกําหนดใหทางโรงเรียนเปนผูสุมนักเรียนเองโดยสุมนักเรียน โรงเรียนละ 40 คน เนื่องจาก
ผูวิจัยใชวิธีการเก็บรวบรวมขอมูลโดยวิธีการสงแบบสอบถามทางไปรษณีย ดังนั้นจึงปองกันอัตรา
การตอบกลับในระดับตํ่าดวยการเพิ่มจํานวนแบบสอบถามที่สงเปนโรงเรียนละ 50 ฉบับ ดังนั้น
จํานวนแบบสอบถามที่สงจึงมีจํานวนทั้งส้ิน 1,000 ฉบับ รายละเอียดแสดงดังตารางที่ 3.1  

 

ตารางที ่3.1 จํานวนประชากรและกลุมตัวอยางนกัเรียนที่ใชในการวจิัย จําแนกตามขนาดโรงเรียน 
 

จํานวน
ประชากร 

(คน) 
สังกัด ขนาด

โรงเรียน 
จํานวนโรงเรียน
กลุมตัวอยาง 

จํานวนนักเรยีน
กลุมตัวอยาง 

จํานวน
แบบสอบถามที่สง

ใหญ 5 200 250 สพฐ. 
กลาง 5 200 250 
ใหญ 5 200 250 

161,763 
สช. 

กลาง 5 200 250 
รวม 20 800 1,000 
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ตัวแปรที่ใชในการวิจัย 
ตัวแปรที่ศึกษาในการวิจัยคร้ังนี้ ประกอบดวยตัวแปรแฝง 8  ตัวแปร ไดแก ระดับ

ประสบการณเดิม  บุคลิกภาพภายในของผูเรียน  ความมุงมั่นในการทํางาน  ความวิตกกังวลใน
การใชคอมพิวเตอร  การรับรูความสามารถดานคอมพิวเตอรของตนเอง  การต้ังเปาหมาย  ความ
ผูกพันตอเปาหมาย และความสามารถทางคอมพิวเตอร  ซึ่งวัดไดจากตัวแปรสังเกตไดรวม 13 ตัว
แปร ดังมีรายละเอียดของตัวแปรแฝงแตละตัว ดังตอไปนี้ 

1. ตัวแปรภายในแฝง (endogenous latent) ไดแก การรับรูความสามารถดาน
คอมพิวเตอรของตนเอง การต้ังเปาหมาย ความผูกพันตอเปาหมายและความสามารถทาง
คอมพิวเตอร โดยมีรายละเอียดแตละตัวแปร ดังตอไปนี้ 

1.1 การรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF) หมายถึง 
การที่ผูเรียนตัดสินความสามารถของตนเองดานคอมพิวเตอรในการจัดการใหบรรลุเปาหมาย ที่
กําหนดไว ซึ่งวัดจากการรับรูความสามารถในการใชโปรแกรมประมวลผลคํา (Microsoft Word) 
และโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint) โดยวัดดวยแบบสอบถามแบบมาตร
ประมาณคา (rating scale) 5 ระดับ ที่ผูวิจัยไดสรางข้ึนเอง จํานวน 33 ขอ  

1.2 การตั้งเปาหมาย (GOALLEVEL) หมายถึง การที่ผูเรียนคาดหวังและกําหนด
รอยละของผลสําเร็จในการใชโปรแกรมประมวลผลคํา (Microsoft Word) และโปรแกรมนําเสนอ
ผลงาน (Microsoft PowerPoint) เปนเปาหมายตามทักษะของตนเอง ซึ่งวัดไดจากแบบตรวจสอบ
รายการ (check list) ที่ผูวิจัยสรางข้ึน จํานวน 2 ขอ โดยผูวิจัยทําการลงรหัสคะแนนของตัวแปรการ
ตั้งเปาหมาย โดยกําหนดให 1 = รอยละ 0 – 20 2 = รอยละ 21 – 40 3 =  รอยละ 41 – 60             
4 = รอยละ 61 – 80 5 = รอยละ 81 – 100 

1.3 ความผูกพันตอเปาหมาย (GOALCOMM) หมายถึง การที่ผูเรียนมีความรูสึก
รับผิดชอบตอเปาหมายซึ่งเนนผลสําเร็จของงานที่ผูเรียนกําหนดไว ซึ่งวัดไดจากแบบสอบถามแบบ
มาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Hollenback 
(1987) จํานวน 6 ขอ  

1.4 ความสามารถทางคอมพิวเตอร (COMPER) หมายถึง คะแนนที่ไดจากการ
ทดสอบผูเรียนเก่ียวกับการใชโปรแกรมคอมพิวเตอร ประกอบดวย คะแนนจากการทดสอบ
โปรแกรมประมวลผลคํา (Microsoft Word) และโปรแกรมนําเสนอผลงาน (Microsoft 
PowerPoint) ซึ่งวัดไดจากแบบทดสอบปรนัย 4 ตัวเลือกจํานวน 35 ขอ 
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2. ตัวแปรภายนอกแฝง (exogenous latent) ไดแก ระดับประสบการณเดิม บุคลิกภาพ
ภายในของผูเรียน ความมุงม่ันในการทํางานและความวิตกกังวลในการใชคอมพิวเตอร 

2.1 ระดับประสบการณเดิม (PREVEXP) หมายถึง ภูมิหลังในการใชโปรแกรม
ประมวลผลคําและโปรแกรมนําเสนอผลงาน ประกอบดวย จํานวนปของประสบการณในการใช
โปรแกรมและจํานวนชั่วโมงเฉล่ียตอวันในการใชโปรแกรม ซึ่งวัดเปนระดับความมากนอยของ
ประสบการณจากแบบตรวจสอบรายการ (check list) ที่ผูวิจัยสรางข้ึน จํานวน 4 ขอ โดย ผูวิจัยทํา
การลงรหัสคะแนนของตัวแปรระดับประสบการณเดิม ดังนี้ 

ประสบการณในการใชโปรแกรม  
 นอยกวา 1 ป ใหคะแนนเทากับ 1   
 1 – 2 ป ใหคะแนนเทากับ 2  
 3 – 4 ป  ใหคะแนนเทากับ 3 
 5 – 6 ป  ใหคะแนนเทากับ 4 
 มากกวา 6 ป ใหคะแนนเทากับ 5 

จํานวนช่ัวโมงในการใชโปรแกรมโดยเฉล่ียตอวัน 
 นอยกวา 1 ชัว่โมง / วัน ใหคะแนนเทากับ 1 
 1 – 2 ชั่วโมง / วนั ใหคะแนนเทากับ 2 
 3 – 4  ชัว่โมง / วนั ใหคะแนนเทากับ 3   
 5 – 6  ชัว่โมง / วนั ใหคะแนนเทากับ     4                          
 มากกวา 6  ชั่วโมง / วัน ใหคะแนนเทากับ  5                

2.2 บุคลิกภาพภายในของผูเรียน  (TRAINPER)   หมายถึง การรับรูของผูเรียนใน
การประเมินตนเองเกี่ยวกับความสามารถในการกระทําส่ิงตางๆทั้งเชิงบวกและเชิงลบ  ซึ่งวัดจาก
การเห็นคุณคาในตนเองและความออนไหวทางอารมณ  โดยวัดดวยแบบสอบถามแบบมาตร
ประมาณคา (rating scale) 5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Judge (2003)  จํานวน 
16 ขอ  

2.3 ความมุงมั่นในการทํางาน (LEARNGOA)  หมายถึง  ลักษณะการแสดงออก
ของผูเรียนที่มีเปาหมายในการเรียนรูและมุงเนนในการทํางานใหบรรลุผลสําเร็จ ซึ่งวัดไดจาก
แบบสอบถามแบบมาตรประมาณคา  (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ 
Button (1996) จํานวน 8 ขอ  
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2.4 ความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE) หมายถึง สภาวะที่
ผูเรียนรูสึกหวั่นไหวตอการใชคอมพิวเตอรอันสงผลใหผูเรียนเกิดความรูสึกในทางลบที่มีตอ
คอมพิวเตอร    ซึ่งวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัยได
พัฒนามาจากแบบวัดของ Heinssen (1987) จํานวน 4 ขอ  

 
 
 

เครื่องมือที่ใชในการวิจัย 
 การวิจัยในคร้ังนี้ ใชแบบสอบถามและแบบทดสอบเปนเคร่ืองมือในการเก็บรวบรวม
ขอมูล ประกอบดวย 4 ตอน ดังนี้ 

 ตอนที่ 1 ขอมูลทั่วไปของนักเรียน เปนขอคําถามเกี่ยวกับลักษณะทางประชากรของกลุม
ตัวอยาง เปนแบบเติมคําตอบในชองวางและแบบตรวจสอบรายการ (check list) จํานวน 12 ขอ 

 ตอนที่ 2 แบบสอบถามเกี่ยวกับปจจัยที่สงผลตอการรับรูความสามารถดาน
คอมพิวเตอร  ประกอบไปดวยขอคําถาม 3 ดาน คือ 1)ดานบุคลิกภาพภายในของผูเรียน ซึ่ง
ผูวิจัยพัฒนามาจากแบบวัดของ Judge (2003)  2) ดานความมุงมั่นในการทาํงาน ซึง่ผูวจิยัพฒันา
มาจากแบบวัดของ Button (1996)  และ 3) ดานความวิตกกังวลในการใชคอมพิวเตอร  ซึ่ง
ผูวิจัยพัฒนามาจากแบบวัดของ Heinssen (1987) โดยเปนแบบมาตรประมาณคา (rating scale)  
5 ระดับ  จํานวน 28 ขอ                    
 โดยมีความหมายของแตละระดับ ดังนี ้
  5 หมายถงึ   เห็นดวยอยางยิ่งกับขอความนั้น  
  4 หมายถงึ   เห็นดวยกับขอความนั้น     
  3 หมายถงึ   ไมแนใจกับขอความนั้น    
  2 หมายถงึ   ไมเห็นดวยกับขอความนัน้          
  1 หมายถงึ   ไมเห็นดวยอยางยิง่กับขอความนัน้ 
  ขอคําถามในสวนนี้  แยกเปน 2 กรณี ไดแก ขอคําถามเชิงบวก และขอคําถามเชิงลบซึ่ง
เกณฑการใหคะแนนแยกเปน 2 กรณี ดังตารางที่ 3.2 
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ตารางที ่3.2 เกณฑการใหคะแนนขอความเกีย่วกบับุคลิกภาพภายในของผูเรียน 
 

เกณฑการใหคะแนน ระดับความคิดเห็น 
คําถามเชิงบวก คําถามเชิงลบ 

เห็นดวยอยางยิ่งกับขอความนั้น  5 1 
เห็นดวยกับขอความนั้น  4 2 
ไมแนใจกับขอความนั้น  3 3 
ไมเห็นดวยกับขอความนัน้  2 4 
ไมเห็นดวยอยางยิง่กับขอความนัน้  1 5 

  

 
ตัวอยางเคร่ืองมือแบบวัดบุคลิกภาพภายในของผูเรียนมีดังนี้ 
 

ระดับความคิดเห็น 

ขอความ 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

   1. ฉันเปนทีรั่กใครของผูอ่ืน      
   2. ฉันไมสามารถเปนทีพ่ึ่งของใครไดเลย      

  
ตอนที่ 3  แบบสอบถามปจจัยที่สงผลตอความสามารถทางคอมพิวเตอร  ประกอบไปดวย

ขอคําถาม 2 ดาน คือ 1) ดานการรับรูความสามารถดานคอมพิวเตอรของตนเอง  และ 2) ดาน
ความผูกพันตอเปาหมาย  โดยขอคําถามดานการรับรูความสามารถดานคอมพิวเตอรของตนเอง
แบงเปน 2 สวน คือ การรับรูความสามารถในการใชโปรแกรมประมวลผลคําและการรับรู
ความสามารถในการใชโปรแกรมนําเสนอผลงาน ซึ่งผูวิจัยไดสรางข้ึนมาเองโดยเปนแบบมาตร
ประเมินคา (rating scale)   5 ระดับ   สวนขอคําถามดานความผูกพันตอเปาหมาย สามารถวัด
จากขอคําถามซ่ึงผูวิจัยไดพัฒนาแบบวัดและอางอิงมาจาก  Hollenbeck (1989) เปนแบบมาตร
ประเมินคา (rating scale) 5 ระดับ จํานวน 39 ขอ โดยมีความหมายและเกณฑการใหคะแนน
เชนเดียวกับแบบวัดบุคลิกภาพภายในของผูเรียน 
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ตัวอยางแบบสอบถามเกี่ยวกับแบบวัดความผูกพันตอเปาหมาย 
  

ระดับความคิดเห็น 

 ขอความ 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

  1.ฉันคิดวาเปาหมายนี้เปนเปาหมายทีดี่ 
     ในการเริ่มดําเนนิการ 

     

 

 ตอนที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร วัดจากคะแนนความสามารถทาง
คอมพิวเตอรในการใชโปรแกรมประมวลผลคํา (Microsoft Word) และโปรแกรมนําเสนอผลงาน 
(Microsoft Powerpoint) ที่ผูวิจัยสรางข้ึนเองและมีความสอดคลองกับหลักสูตรการศึกษาข้ัน
พื้นฐานในชวงชั้นที่ 3 - 4 พ.ศ. 2551 เปนแบบทดสอบปรนัยแบบ 4 ตัวเลือก จํานวน 35 ขอ 
 

ตัวอยางแบบทดสอบความสามารถทางคอมพิวเตอร 
 

 1.  การเรียกดูเอกสารกอนพมิพคร้ังละหลายๆหนา  ตองคลิกที่ปุมใด 
 1.  2.  
 3.  4.  

 

การสรางและการตรวจสอบคุณภาพของเครื่องมือ 
 เคร่ืองมือที่ใชในการเก็บรวบรวมขอมูล คือ แบบสอบถามและแบบทดสอบ โดยในข้ันแรก
ผูวิจัยขอเสนอข้ันตอนการสรางและตรวจสอบคุณภาพของแบบสอบถาม ดังนี้ 
 ข้ันตอนที่ 1 ศึกษาเอกสาร ตํารา งานวิจัย และทฤษฎีที่เกี่ยวของกับการรับรูความสามารถ 
ดานคอมพิวเตอรของตนเอง กําหนดนิยามของตัวแปรและโครงสรางของตัวแปรที่ตองการวัด  
 ข้ันตอนที่ 2  นํานิยามตัวแปรที่ผูวิจัยกําหนดข้ึนในข้ันตอนที่ 1 มาสรางตารางวิเคราะห
โครงสรางตัวแปรที่ตองการศึกษา 
 ข้ันตอนที่ 3 สรางขอคําถามตามโครงสรางของตัวแปร ดังตารางที่ 3.3  

ข้ันตอนที่ 4 นําแบบสอบถามที่สรางข้ึน ไปใหอาจารยที่ปรึกษาตรวจแกไขและให
คําแนะนําเพื่อปรับปรุงแบบสอบถามใหเหมาะสม แลวนําแบบสอบถามไปใหผูเชี่ยวชาญทางดาน
การวัดและประเมินผลทางการศึกษา ผูเช่ียวชาญทางดานจิตวิทยาและผูเช่ียวชาญทางดานการ
สอนคอมพิวเตอร จํานวน 5 ทาน ตรวจสอบคุณภาพของเคร่ืองมือในดานความตรงเชิงเนื้อหา 
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(content validity)  การใชภาษา และความถูกตองของภาษา แลวนํามาปรับปรุงแกไข โดยมี
เกณฑในการคัดเลือกผูเชี่ยวชาญในการตรวจสอบคุณภาพของเคร่ืองมือ ดังนี้ 
 1. นักวิชาการที่มีประสบการณสาขาการวัดและประเมินผลทางการศึกษาที่มี
ประสบการณทํางานมากกวา 5 ป จํานวน 1 ทาน 
 2. ครูที่มีความเช่ียวชาญทางดานจิตวิทยาและมีประสบการณทํางานมากกวา 10 ป 
จํานวน 2 ทาน  
 3. ครูที่มีความเช่ียวชาญทางดานการสอนคอมพวิเตอรและมีประสบการณทาํงาน
มากกวา 10 ป จาํนวน 2 ทาน  

โดยการตรวจสอบความตรงเชิงเนื้อหา ใชดัชนี IOC (index of consistency) โดยมี
เงื่อนไขใหผูเชี่ยวชาญตัดสินอยางเปนระบบ ซึ่งมีลักษณะการใหคะแนน คือ 

 1    เมื่อแนใจวา       รายการหรือขอคําถามนั้นสอดคลองกับคํานยิาม 
 0    เมื่อไมแนใจวา   รายการหรือขอคําถามนั้นสอดคลองกับคํานิยาม  
           -1    เมื่อแนใจวา       รายการหรือขอคําถามนั้นไมสอดคลองกับคํานิยาม 

 โดยผูวิจัยไดกําหนดเกณฑที่ใชในการตัดสินความตรงเชิงเนื้อหา คือ คาดัชนี IOC (index 
of consistency) ตองมากกวา 0.5 (IOC >0.5) จึงถือวาขอคําถามนั้นสอดคลองกับโครงสราง
และนิยามที่ตองการวัด (ศิริชัย กาญจนวาสี, 2544)  ผลการตรวจสอบพบวา ขอคําถามทั้งหมดมี
คาดัชนี IOC มากกวา 0.5 (IOC >0.5)  และมีการปรับภาษาเล็กนอย ผูวิจัยจึงปรับปรุง
แบบสอบถามใหสมบูรณตามขอเสนอแนะของผูเชี่ยวชาญ โดยผานความเห็นชอบจากอาจารยที่
ปรึกษา โดยรายละเอียดของผลการตรวจสอบคุณภาพและการปรับปรุงแบบสอบถาม ดังแสดง
ในภาคผนวก ง และ จ 
 

ตารางที่ 3.3 โครงสรางตัวแปรที่ตองการวดัและจํานวนขอในแบบสอบถาม 
 

ประเดน็หลัก จํานวนขอ ประเดน็ยอย จํานวนขอ ตอนที ่ ขอที่ 
ภูมิหลัง 6 สถานภาพทั่วไป 6 ตอนที่ 1 1 – 6 

ระดับประสบการณในการใช
โปรแกรมประมวลผลคํา 

2 ตอนที่ 1 7 – 8 
ระดับประสบการณ
เดิม 4 

ระดับประสบการณในการใช
โปรแกรมนําเสนอผลงาน 

2 ตอนที่ 1 10 – 11 

การเห็นคุณคาในตนเอง 8 ตอนที่ 2 1 – 8 บุคลิกภาพภาย          
ในของผูเรียน 

16 
ความออนไหวทางอารมณ 8 ตอนที่ 2 9 – 16 
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ตารางที่ 3.3 โครงสรางตัวแปรที่ตองการวดัและจํานวนขอในแบบสอบถาม (ตอ) 
 

ประเดน็หลัก จํานวนขอ ประเดน็ยอย จํานวนขอ ตอนที ่ ขอที่ 
ความมุงม่ันในการ
ทํางาน 8 

ระดับความมุงม่ันในการ
ทํางาน 

8 ตอนที่ 2  17 – 24 

ความวิตกกังวลใน
การใชคอมพิวเตอร 

4 
ระดับความวิตกกังวลในการ
ใชคอมพิวเตอร 

4 ตอนที่ 2 25 – 28 

การรับรูความสามารถในการ
ใชโปรแกรมประมวลผลคํา 

17 ตอนที่ 3 1 – 17  การรับรู
ความสามารถดาน
คอมพิวเตอรของ
ตนเอง 

33 
การรับรูความสามารถในการ
ใชโปรแกรมนําเสนอผลงาน 

16 ตอนที่ 3 18 – 33 

ความผูกพันตอ
เปาหมาย 
 
 

6 

ระดับความผูกพันตอ
เปาหมาย 

6 ตอนที่ 3 34 – 39 

ระดับเปาหมายของผลสําเร็จ
ในการใชโปรแกรม
ประมวลผลคํา 

1 ตอนที่ 1 9 การต้ังเปาหมาย 

2 
ระดับเปาหมายของผลสําเร็จ
ในการใชโปรแกรมนําเสนอ
ผลงาน 

1 ตอนที่ 1 12 

 

ข้ันตอนที่ 5 นําแบบสอบถามที่ปรับปรุงแลวไปทดลองใช (Try Out) กับนักเรียนจํานวน 
30 คน ที่ไมใชกลุมตัวอยาง แลวนํามาวิเคราะหหาคาความเที่ยงแบบความสอดคลองภายใน 
(internal consistency reliability) โดยวิธีหาสัมประสิทธิ์แอลฟาของครอนบาค (Cronbach’s 
Alpha coefficient) โดยมีรายละเอียดผลการตรวจสอบความเที่ยงของแบบสอบถาม ดังตารางที่ 3.4 
 ผลการวิเคราะหพบวา ขอคําถามในแตละดานมีคาความเท่ียงอยูระหวาง 0.6081 ถึง 
0.9507 และคาความเที่ยงทั้งฉบับ คือ 0.8999 แสดงวาแบบสอบถามที่ผูวิจัยสรางข้ึนมีคุณภาพ            
ในระดับคอนขางสูง สําหรับคาความเท่ียงของแบบวัดในแตละดานและทั้งฉบับ มีรายละเอียด          
ดังตารางที่ 3.4  
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ตารางที่ 3.4  คาความเที่ยงของแบบวัด จาํแนกตามตัวแปร 
 

ตัวแปร คาความเที่ยง 
ระดับประสบการณในการใชโปรแกรมประมวลผลคํา 0.6706 
ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 0.6855 
การเหน็คุณคาในตนเอง 0.7724 
ความออนไหวทางอารมณ 0.7198 
ความมุงมัน่ในการทํางาน 0.8119 
ความวิตกกงัวลในการใชคอมพิวเตอร 0.7703 
การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 0.9294 
การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 0.9507 
ความผูกพนัตอเปาหมาย 0.6081 

คาความเที่ยงทั้งฉบับ 0.8999 
 ลําดับตอมาผูวิจัยขอเสนอข้ันตอนการสรางและตรวจสอบคุณภาพของแบบทดสอบ ดังนี้ 
 ข้ันตอนที่ 1 ศึกษาหลักสูตรการศึกษาข้ันพื้นฐาน พุทธศักราช 2544 เอกสาร ตําราทีเ่กีย่วของ
กับสาระการเรียนรูในกลุมการงานอาชีพและเทคโนโลยีดานความสามารถทางคอมพิวเตอรของ
ตนเองของชวงช้ันที่ 4 ที่มีความมุงเนนปลูกฝงความรู ความสามารถและทักษะในวิทยาการและ
เทคโนโลยีเพื่อนําไปใชประโยชนทางการศึกษาอยางมีประสิทธิภาพ 
 ข้ันตอนท่ี 2 ศึกษาผลการเรียนรูที่คาดหวังจากหนังสือเรียนรายวิชาเทคโนโลยีสารสนเทศ
ระดับชวงชั้นที่ 4 ที่เกี่ยวของกับการใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงาน 
 ข้ันตอนที่ 3 สรางแบบทดสอบความสามารถทางคอมพิวเตอรใหสอดคลองกับผลการ
เรียนรูที่คาดหวังเพื่อวัดความสามารถทางคอมพิวเตอรในการใชงานโปรแกรมประมวลผลคําและ
โปรแกรมนําเสนอผลงาน โดยผูวิจัยกําหนดโครงสรางเนื้อหาและผลการเรียนรูที่คาดหวังในการ
สรางขอสอบ ซึ่งประกอบไปดวย ขอสอบวัดความสามารถทางคอมพิวเตอรในการใชโปรแกรม
ประมวลผลคําและโปรแกรมนําเสนอผลงานเปนแบบทดสอบปรนัยชนิดเลือกตอบ 4 ตัวเลือก 
จํานวน 35 ขอ  ดังแสดงในตารางที่ 3.5  
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ตารางที่ 3.5 โครงสรางเนื้อหา ผลการเรียนรูที่คาดหวงั และจํานวนขอสอบวัดความสามารถ 
 ทางคอมพวิเตอร 
 

ความสามารถทาง
คอมพิวเตอร 

ผลการเรียนรูที่คาดหวัง ขอสอบขอที่

สามารถอธิบายหนาที่และสวนประกอบในแถบเครื่องมือใน
โปรแกรมประมวลผลคํา 

1 

สามารถสราง บันทึก เปด และแทรกขอความลงในเอกสารนั้นๆ 2 
สามารถต้ังคาหนากระดาษ ต้ังก้ันหนา ก้ันหลังขอความ 3 
สามารถกําหนดตําแหนงของแท็บและเลือกใชแท็บใหเหมาะสม
กับงาน 

4 

ความสามารถทาง 
คอมพิวเตอรในการใช 
โปรแกรมประมวลผลคํา 

สามารถเลือกขอความ ยายขอความ คัดลอกและลบขอความ 5 
 สามารถจัดรูปแบบขอความ รวมไปถึงการกําหนดหมายเลข

ลําดับ และเคร่ืองหมายหนาขอความ 
6 – 7 

 สามารถปรับเปล่ียนลักษณะของตัวอักษร เปล่ียนสีใหตัวอักษร
และใสสีพื้นหลังใหกับขอความ 

8 

 สามารถปรับระยะหางระหวางตัวอักษร บรรทัดและยอหนา 9 
 สามารถแทรกสัญลักษณพิเศษและอักขระพิเศษลงในเอกสาร 10 
 สามารถใสกรอบใหกับขอความ เอกสารและแบงคอลัมน 11 
 สามารถเรียกดูเอกสารกอนพิมพและส่ังพิมพเอกสารได 12 – 13 
 สามารถสรางตาราง แทรกแถว คอลัมน 14 – 15 
 สามารถสรางวัตถุรูปวาด ตัวอักษรศิลปและสามารถแทรก

รูปภาพ 
16 

 สามารถใสขอความในหัวกระดาษ ทายกระดาษและหมายเลข
หนา 

17 

สามารถอธิบายถึงความสามารถของโปรแกรมนําเสนอผลงาน 18 
สามารถสราง บันทึก เปดและปดงานนําเสนอผลงานได 19 

ความสามารถทาง 
คอมพิวเตอรในการใช 
โปรแกรมนําเสนอผลงาน สามารถบอกความแตกตางของมุมมองในการทํางานของ

โปรแกรม 
20 – 21 

 สามารถเปล่ียนลําดับสไลด ลบสไลด และเพิ่มสไลด 22 
 สามารถกําหนดขนาด ตัวหนา ตัวเอน ตัวขีดเสนใตและใสเงา

ใหกับขอความ 
23 – 24 

 สามารถใสตัวเลขและสัญลักษณแสดงลําดับหัวขอได 25 
 สามารถใชเคร่ืองมือวาดภาพและทํางานกับวัตถุตางๆ 26 
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ตารางที่ 3.5 โครงสรางเนื้อหา ผลการเรียนรูที่คาดหวงั และจํานวนขอสอบวัดความสามารถ 
                    ทางคอมพวิเตอร (ตอ) 
ความสามารถทาง
คอมพิวเตอร 

ผลการเรียนรูที่คาดหวัง ขอสอบขอที่

 สามารถบอกความแตกตางของภาพแบบเวคเตอร (Vector) กับ
ภาพแบบราสเตอร (Raster) 

27 

 สามารถปรับแตงภาพจากไฟลได 28 
 สามารถสรางกราฟและแผนผังลงในสไลด 29 
 สามารถตกแตงพื้นหลัง และสรางแมแบบ (Template) ได 30 – 31 
 สามารถกําหนดเอฟเฟคใหกับวัตถุตางๆตลอดจนเอฟเฟคพิเศษ 

(Transition) 
32 

 สามารถเพ่ิมเสียงประกอบทั้งภายในและภายนอกโปรแกรมเพ่ือ
ทําเอฟเฟคใหกับขอความ 

33 

 สามารถกําหนดรูปแบบการเชื่อมโยงสไลด 34 
 สามารถกําหนดคุณสมบัติของเอกสารกอนพิมพและใชคําส่ัง

พิมพไดอยางถูกวิธี 
35 

 

ข้ันตอนที่ 4 นําแบบทดสอบที่สรางข้ึน ไปใหอาจารยที่ปรึกษาตรวจแกไขและใหคําแนะนํา
แลวนําแบบทดสอบไปใหผูเช่ียวชาญทางดานการวัดและประเมินผลทางการศึกษา ผูเช่ียวชาญ
ทางดานจิตวิทยาและผูเชี่ยวชาญทางดานการสอนคอมพิวเตอร จํานวน 5 ทาน ตรวจสอบคุณภาพ
ของเคร่ืองมือในดานความตรงเชิงเนื้อหา (content validity)  การใชภาษา และความถูกตองของ
ภาษา แลวนํามาปรับปรุงแกไข โดยมีเกณฑในการคัดเลือกผูเชี่ยวชาญในการตรวจสอบคุณภาพ
ของเครื่องมือ ดังนี้ 
 1. นักวิชาการที่มีประสบการณสาขาการวัดและประเมินผลทางการศึกษาที่มีประสบการณ
ทํางานมากกวา 5 ป จํานวน 1 ทาน 
 2. ครูที่มีความเช่ียวชาญทางดานจิตวิทยาและมีประสบการณทํางานมากกวา 10 ป 
จํานวน 2 ทาน  
 3. ครูที่มีความเช่ียวชาญทางดานการสอนคอมพวิเตอรและมีประสบการณทาํงาน
มากกวา 10 ป จาํนวน 2 ทาน  

โดยการตรวจสอบความตรงเชิงเนื้อหา ใชดัชนีความสอดคลอง IOC (item objective 
congruence) โดยมีเงื่อนไขใหผูเชี่ยวชาญตัดสินอยางเปนระบบ ซึ่งมีลักษณะการใหคะแนน คือ 
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 1    เมื่อแนใจวา      รายการหรือขอคําถามนัน้วัดไดสอดคลองกับผลการเรียนรูที่
คาดหวงั 
 0    เมื่อไมแนใจวา  รายการหรือขอคําถามนั้นวัดไดสอดคลองกับผลการเรียนรูที่
คาดหวงั 
           -1    เมื่อแนใจวา  รายการหรือขอคําถามนัน้วดัไดไมสอดคลองกับผลการเรียนรูที่
คาดหวงั 

 โดยผูวิจัยไดกําหนดเกณฑที่ใชในการตัดสินความตรงเชิงเน้ือหา คือ คาดัชนีความ
สอดคลอง IOC (item objective congruence) ตองมากกวา 0.5 (IOC >0.5) จึงถือวาขอ
คําถามนั้นสอดคลองกับผลการเรียนรูที่คาดหวังที่ตองการวัด (ลวน สายยศ และอังคณา สายยศ 
2539)  ผลการตรวจสอบพบวา ขอคําถามทั้งหมดมีคาดัชนี IOC มากกวา 0.5 (IOC >0.5)  และ
มีการปรับภาษาเล็กนอย ผู ว ิจ ัยจึงปรับปรุงแบบทดสอบใหสมบูรณตามขอเสนอแนะของ
ผูเชี่ยวชาญ โดยผานความเห็นชอบจากอาจารยที่ปรึกษา โดยรายละเอียดของผลการตรวจสอบ
คุณภาพและการปรับปรุงแบบทดสอบ ดังแสดงในภาคผนวก ง และ จ 

ข้ันตอนที่ 5 นําแบบทดสอบท่ีไดจากการ (Tryout) กับนักเรียนจํานวน 30 คน ที่ไมใชกลุม
ตัวอยาง แลวนํามาวิเคราะหหาคาความยากและอํานาจจําแนก โดยใชโปรแกรม EVANA 401 
(ภคนันท ทองคํา, 2544) โดยใชเทคนิค  25 % (ประคอง  กรรณสูต, 2535)  โดยกําหนดเกณฑ
มาตรฐานในความยากงายมีคาระหวาง 0.20 – 0.80 คาอํานาจจําแนกมีคาต้ังแต 0.20 ข้ึนไป และคา
ความเที่ยงของแบบทดสอบทั้งฉบับกําหนดใหมีคาต้ังแต 0.60 ข้ึนไป โดยแบบทดสอบมคีาความเทีย่ง
เทากับ 0.7073 ดังที่ไดแสดงใน ภาคผนวก ง 
 ข้ันตอนที่ 6 นําผลการวิเคราะหคุณภาพของขอสอบ ไดแก ขอที่มีคาอํานาจจําแนกไมดี
และอํานาจจําแนกเปน 0 ดังตารางที่ 3.6 มาปรับปรุงขอคําถามโดยผูวิจัยไดไปขอคําแนะนําจาก
ผูเช่ียวชาญและปรับขอคําถามพรอมทั้งตัวเลือกตามขอเสนอแนะของผูเชี่ยวชาญอีกคร้ังหนี่ง
เพื่อใหเหมาะสมกอนที่จะนําไปเก็บขอมูล 
 

ผลการวิเคราะหคุณภาพของขอสอบดวยโปรแกรม EVANA 401 
 

จํานวนขอสอบที่วิเคราะห  (ขอ)            35  
จํานวนกระดาษคําตอบ (ชุด)                30  
คะแนนเฉลีย่                                       23.57  
สวนเบ่ียงเบนมาตรฐาน                       4.4248 
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คาความเที่ยง  KR-20                          .7073 
ความคลาดเคล่ือนมาตรฐาน                2.3937 

 
ตารางที่ 3.6 สรุปคุณภาพ คาความยากและอํานาจจาํแนกของขอสอบ 
 

คาอํานาจจาํแนก คาความยาก 
จําแนกดี จําแนกไมดี อํานาจจําแนกเปน 0 

ขอที่งายมาก 3 11 13 14 19 20 1 
ขอที่คอนขางงาย 9 15 22 23 26 31 - 
ขอที่ยากงายปานกลาง 7 10 12 21 25 28 29 17 27 33 
ขอที่คอนขางยาก 4 30 32 34 35 - 

2 5 6 8 16 18 24 

 

 
การเก็บรวบรวมขอมูล 
 

 ผูวิจัยดําเนินการเก็บรวบรวมขอมูลเกี่ยวกับสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที ่ม ีต อความสามารถทางคอมพิวเตอรของนักเรียนระดับชั้น
มัธยมศึกษา ตอนปลาย (ชวงช้ันที่ 4) ในกรุงเทพมหานคร โดยการใชแบบสอบถามและ
แบบทดสอบเพื่อเก็บขอมูลระหวางวันที่ 10 กุมภาพันธ ถึง 13 มีนาคม 2552 โดยมีรายละเอียดใน
การเก็บรวบรวมขอมูลดังตอไปนี้ 
 1. ผูวิจัยทําหนังสือขอความรวมมือในการทําวิจัยจากคณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย 
ถึงผูบริหารของโรงเรียนแตละโรงเรียนในเขตกรุงเทพมหานครที่เลือกใชเปนกลุมตัวอยาง เพื่อขอ
อนุญาตในการเก็บรวบรวมขอมูลจากนักเรียนระดับช้ันมัธยมศึกษาตอนปลาย 
 2. ติดตอโรงเรียนที่เปนกลุมตัวอยาง เพื่อกําหนดวนัและเวลา ในการเก็บรวบรวมขอมูล 

3. นําแบบสอบถามและแบบทดสอบสงทางไปรษณีย จํานวน 1,000 ฉบับ โดยแนบซอง
เปลาติดแสตมปไปพรอมกับแบบสอบถามและแบบทดสอบ โดยขอความอนุเคราะหทางโรงเรียน
ใหสงแบบสอบถามและแบบทดสอบใหนักเรียนที่ไดรับการคัดเลือกซ่ึงทางผูวิจัยกําหนดใหทาง
โรงเรียนเปนผูสุมนักเรียนเองและรวบรวมแบบสอบถามและแบบทดสอบกลับคืนมายังผูวิจัย 

4. ผูวิจัยไดขอความรวมมือใหทางฝายวิชาการของโรงเรียนกําหนดครูเปนผูดําเนินการโดย
ทําหนาที่แจกแบบสอบถามและแบบทดสอบใหกับนักเรียนทําโดยใหมีการจัดการดําเนินการสอบ
ในหองที่มีสภาพแวดลอมที่เหมาะสม มีที่นั่งสามารถเขียนไดสะดวก  โดยการดําเนินการตอบ
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แบบสอบถามและแบบทดสอบแบงเปน 3 ระยะ คือ การเตรียมตัวกอนทําแบบสอบถามและ
แบบทดสอบ วิธีปฏิบัติขณะทําแบบสอบถามและแบบทดสอบ และเมื่อหมดเวลาทําแบบสอบถาม
และแบบทดสอบ ซึ่งมีข้ันตอนดังนี้ 

4.1 การเตรียมตัวกอนตอบแบบสอบถามและแบบทดสอบ 
  4.1.1 เตรียมแบบสอบถามและแบบทดสอบใหเรียบรอย มีผูดําเนินการ

สอบ 1 คน หรือมากกวา และจัดที่นั่งใหเพียงพอแกผูเขาสอบ 
  4.1.2 การเตรียมตัวสําหรับผูดําเนินการสอบ ผูดําเนินการสอบจะตอง

ศึกษาคําชี้แจงในการทําแบบสอบถามและแบบทดสอบลวงหนา เพื่อใหสามารถดําเนินการได
อยางถูกตอง 

 4.2 วิธีดําเนินการ 
  4.2.1 ผูดําเนินการแจกแบบสอบถามเกี่ยวกับการรับรูความสามารถดาน

คอมพิวเตอรใหแกผูตอบคนละ 1 ชุด  
  4.2.2 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบสอบถาม 

   4.2.3 จากนั้นใหผูตอบลงมือทําแบบสอบถามโดยใชเวลา 15 นาที โดย
ผูดําเนินการสอบใหสัญญาณแกผูตอบไดลงมือทําพรอมกัน 

4.2.4 เม่ือหมดเวลาผูดําเนินการเก็บแบบสอบถามและแจกแบบทดสอบ
ความสามารถทางคอมพิวเตอรใหแกผูตอบคนละ 1 ชุด  

  4.2.5 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบทดสอบ 
  4.2.6 จากนั้นใหผูตอบลงมือทําแบบทดสอบ โดยใชเวลา 30 นาที โดย

ผูดําเนินการสอบใหสัญญาณแกผูตอบไดลงมือทําพรอมกัน 
 4.3 วิธีปฏิบัติเมื่อหมดเวลา 
  4.3.1 ผู ดําเนินการสอบแจงเวลาที่ เหลือในการทําแบบทดสอบ 

เปน 3 ระยะ คือ 
   4.3.1.1 เมื่อเวลาในการสอบผานไป 15 นาที 
   4.3.1.2 เมื่อเหลือเวลาอีก 5 นาที จะหมดเวลาในการทํา 
   4.3.1.3 เมื่อหมดเวลาในการทํา 
  4.3.2 เม่ือหมดเวลาในการทําแบบทดสอบแลว ผูดําเนินการสอบให

ผูตอบวางดินสอหรือปากกาและหยุดทําแบบทดสอบทันที 
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  4.3.3 ในกรณีที่ผูตอบทําแบบทดสอบเสร็จกอนเวลาที่กําหนดใหผูตอบผู
นั้นออกไปนอกหองสอบกอน เพื่อไมใหรบกวนสมาธิในการทําแบบทดสอบของผูตอบคนอ่ืนๆ 
หลังจากนั้น เมื่อผูตอบทําแบบทดสอบเสร็จทั้งหองสอบแลว ผูดําเนินการสอบจึงเก็บแบบทดสอบ
ตามลําดับเลขที่ผูตอบ แลวรวบรวมแบบสอบถามและแบบทดสอบสงกลับคืนฝายวิชาการของ
โรงเรียน 

5. ผูวิจัยดําเนินการติดตามแบบสอบถามและแบบทดสอบโดยโทรศัพทติดตอกับโรงเรียน        
ที่เปนกลุมตัวอยาง โดยแบบสอบถามที่ไดรับกลับคืนมา มีจํานวนทั้งส้ิน 813 ฉบับ คิดเปนรอยละ 
81.30 จากจํานวนแบบสอบถามทั้งส้ิน 1,000 ฉบับ ดังนั้นผูวิจัยจึงไดจํานวนกลุมตัวอยางทั้งหมด 
813 คน รายละเอียด ดังตารางที่ 3.7 

ผลการตอบกลับแบบสอบถามจากกลุมตัวอยาง พบวา โรงเรียนในสังกัดสํานักงาน
คณะกรรมการสงเสริมการศึกษาเอกชน (สช.) ขนาดใหญ มีอัตราการตอบกลับสูงสุด จํานวน 213 
ฉบับ คิดเปนรอยละ 85.20 รองลงมาเปนโรงเรียนขนาดกลาง จํานวน 206 ฉบับ คิดเปนรอยละ 
82.40  โรงเรียนในสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) ขนาดกลาง จํานวน 
199 ฉบับ คิดเปนรอยละ 79.60 และขนาดใหญ จํานวน 195 คิดเปนรอยละ 78.00 ตามลําดับ 
 

ตารางที ่3.7 อัตราการตอบกลับแบบสอบถามคืนจากกลุมตัวอยาง 
 

สังกัด ขนาด
โรงเรียน จํานวนท่ีสง จํานวน 

ไดรับคืน อัตราการตอบกลับ 

ใหญ 250 213 85.20 สช. 
กลาง 250 206 82.40 
ใหญ 250 195 78.00 สพฐ. 
กลาง 250 199 79.60 

รวม 1,000 813 81.30 
 

การวิเคราะหขอมูล 
 

 การวิจยัคร้ังนี ้มีการวิเคราะหขอมูล ดังรายละเอียดตอไปนี ้
ตอนท่ี 1 การวิเคราะหขอมูลเบ้ืองตน โดยใชสถิติบรรยาย เพื่อบรรยายลักษณะของผูตอบ

แบบสอบถามและลักษณะตัวแปรที่ใชในการวิจัย โดยใชโปรแกรมสําเร็จรูป SPSS ดังนี้ 
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  1.1 วิเคราะหคาสถิติพืน้ฐานของกลุมตัวอยาง ดวยสถิติบรรยาย ไดแก คาความถี ่ 
รอยละ เพือ่บรรยายลักษณะของกลุมตัวอยาง 
  1.2 วิเคราะหคาสถิติพื้นฐาน ไดแก คามัชฌิมเลขคณิตหรือคาเฉล่ียเลขคณิต ( x )   
คาสวนเบ่ียงเบนมาตรฐาน (S.D.) คาความเบ (skewness) คาความโดง (kurtosis) และคา
สัมประสิทธิ์การกระจาย (coefficient of variation) ของตัวแปรสังเกตไดที่ใชในการพัฒนาโมเดลเพื่อ
ทราบลักษณะการแจกแจงของตัวแปร 

ตอนท่ี 2 การวิเคราะหความสามารถทางคอมพิวเตอรของนักเรียน ดวยการวิเคราะห
คาเฉลี่ยเลขคณิต ( x ) คาสวนเบี่ยงเบนมาตรฐาน (S.D.) และเปรียบเทียบความสามารถทาง
คอมพิวเตอรของนักเรียน โดยจําแนกตามสังกัดและขนาดของโรงเรียน ดวยสถิติทดสอบที (t-test)  
  ตอนท่ี 3 การวิเคราะหความสัมพันธระหวางตัวแปรสังเกตไดที่ใชในโมเดลเชิงสาเหตุและ
ผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอร
ของนักเรียนระดับช้ันมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4) ในกรุงเทพมหานคร โดยการวเิคราะหคา
สัมประสิทธิ์สหสัมพันธแบบเพียรสัน (Pearson’s product-moment correlation coefficient) โดย
ใชโปรแกรมสําเร็จรูป SPSS  
 ตอนที่ 4 การวิเคราะหตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรที่ผูวิจัยสรางข้ึน
จากทฤษฎีและงานวิจัยที่เกี่ยวของกับขอมูลเชิงประจักษ พรอมทั้งคํานวณขนาดอทิธิพลทัง้ทางตรง
และทางออมของปจจัยที่สงผลตอความสามารถทางคอมพิวเตอรของนักเรียนระดับช้ันมัธยมศึกษา
ตอนปลาย (ชวงชั้นที่ 4) ในกรุงเทพมหานครดวยโปรแกรม LISREL Version 8.72 for WINDOWS 



บทที่ 4 
 

ผลการวิเคราะหขอมูล 
 
 การวิจัยในครั้งนี้ มีวัตถุประสงคเพื่อ 1) ศึกษาและเปรียบเทียบความสามารถทาง
คอมพิวเตอรนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร เมื่อจาํแนกตามสังกัดและขนาดของโรงเรียน 
2) พัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร และ 3) เพื่อตรวจสอบ
ความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร                     
ที่พัฒนาข้ึนกับขอมูลเชิงประจักษ ดังนั้น ผูวิจัยจึงนําเสนอผลการวิเคราะหขอมูลเพื่อตอบ
วัตถุประสงคของการวิจัยดังกลาว โดยแบงออกเปน 4 ตอน โดยตอนที่ 1 และตอนที่ 2 เพื่อตอบ
วัตถุประสงคขอที่ 1 สวนตอนที่ 3 และตอนที่ 4 เพื่อตอบวัตถุประสงคขอที่ 2 และ ขอที่ 3 
 

ตอนท่ี 1 ผลการวิเคราะหคาสถิติพืน้ฐานของตัวแปรทีใ่ชในการวิจัย 
 ผลการวิเคราะหคาสถิติพื้นฐานของสถานภาพโดยทั่วไปของผูตอบแบบสอบถาม 
 ผลการวิเคราะหคามัชฌิมเลขคณิต ( x ) สวนเบี่ยงเบนมาตรฐาน ( S.D.)  ความเบ  
(Skewness) ความโดง (Kurtosis) และคาสัมประสิทธิ์การกระจาย (CV) ของตัวแปรสังเกตไดที่ใชใน 
การวิเคราะหโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร  
 ตอนท่ี 2 การวิเคราะหความแตกตางของระดับความสามารถทางคอมพิวเตอร จําแนก
ตามสังกัดและขนาดของโรงเรียน  
 2.1 การวิเคราะหระดับความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ใน
กรุงเทพมหานคร 
 2.2 การเปรียบเทียบระดับความสามารถทางคอมพิวเตอรจําแนกตามสังกัดและขนาดของ
โรงเรียน 

ตอนท่ี 3 ผลการวิเคราะหสหสัมพันธระหวางตัวแปรสังเกตได ที่ใชในการวิเคราะหโมเดล 
เชิงสาเหตุและผลของการรับรูความสามารถดานคอมพวิเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในเขตกรุงเทพมหานคร  
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ตอนท่ี 4  ผลการวิเคราะหความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในเขตกรุงเทพมหานคร โดยภาพรวมกับขอมูลเชิงประจักษ 
 

  เพื่อใหการนําเสนอผลการวิเคราะหขอมูลและการทําความเขาใจเกี่ยวกับผลการวิเคราะห
ขอมูลมีความสะดวกยิ่งข้ึน ผูวิจัยจึงกําหนดสัญลักษณและความหมายที่ใชแทนคาสถิติและตัวแปร
ตางๆ ในการนําเสนอ ดังนี้ 
 

 สัญลักษณที่ใชแทนคาสถิติ 
 x  หมายถึง  คามัชฌิมเลขคณิต หรือ คาเฉล่ีย (mean) 
 S.D. หมายถึง  สวนเบ่ียงเบนมาตรฐาน (standard  deviation) 
 max หมายถึง  คะแนนสูงสุด (maximum) 
 min หมายถึง  คะแนนตํ่าสุด (minimum) 
 sk หมายถึง  คาความเบ (skewness) 
 ku หมายถึง  คาความโดง (kurtosis) 

2χ   หมายถึง  ดัชนีตรวจสอบความกลมกลืนประเภทคาสถิติไค-สแควร 
df  หมายถึง  องศาอิสระ (degree of freedom) 
TE   หมายถึง  ขนาดอิทธิพลรวม (total effect) 
ID  หมายถึง  ขนาดอิทธิพลทางออม (indirect effect) 
DE  หมายถึง  ขนาดอิทธิพลทางตรง (direct effect) 

 R  หมายถึง   คาสัมประสิทธิ์สหสัมพันธพหุคูณ 
 R2  หมายถึง   สัมประสิทธิ์การทาํนาย (Coefficient of determination)  
 GFI  หมายถึง  ดัชนีวัดระดับความกลมกลืน (goodness of fit index) 
 AGFI หมายถึง  ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (adjusted goodness of  
      fit index) 
 RMR  หมายถึง  ดัชนีรากของคาเฉล่ียกําลังสองของสวนเหลือ (root mean squared 
       residual) 
  p  หมายถึง   ระดับนัยสําคัญทางสถิติ 
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สัญลักษณที่ใชแทนตัวแปรแฝง 
 PREVEXP หมายถึง   ระดับประสบการณเดิม 
 TRAINPER หมายถึง   บุคลิกภาพภายในของผูเรียน 
 LEARNGOA หมายถึง   ความมุงมั่นในการทาํงาน 
 COMANXIE หมายถึง   ความวิตกกังวลในการใชคอมพิวเตอร 
 COMSELF หมายถึง   การรับรูความสามารถดานคอมพิวเตอรของตนเอง 
 GOALLEVEL หมายถึง   การต้ังเปาหมาย 
 GOALCOMM หมายถึง   ความผูกพันตอเปาหมาย 
 COMPER หมายถึง   ความสามารถทางคอมพิวเตอร 
 

สัญลักษณที่ใชแทนตัวแปรสังเกตได 
 WORDEXP หมายถึง   ระดับประสบการณในการใชโปรแกรมประมวลผลคํา 
 PPTEXP หมายถึง   ระดับประสบการณในการใชโปรแกรมนาํเสนอผลงาน 
 SELFEST หมายถึง   การเห็นคุณคาในตนเอง 
 NEUROTIC หมายถึง   ความออนไหวทางอารมณ 
 LEARNGOA หมายถึง   ความมุงมั่นในการทาํงาน 
 COMANXIE หมายถึง   ความวิตกกังวลในการใชคอมพิวเตอร 
 WORDSELF หมายถึง   การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 
 PPTSELF หมายถึง   การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 
 WORDGOAL หมายถึง   ระดับเปาหมายของผลสําเร็จในการใชโปรแกรม 
    ประมวลผลคํา 
 PPTGOAL หมายถึง   ระดับเปาหมายของผลสําเร็จในการใชโปรแกรม 
    นําเสนอผลงาน 
 GOALCOMM หมายถึง   ความผูกพันตอเปาหมาย 
 WORDPER      หมายถึง   คะแนนทดสอบโปรแกรมประมวลผลคํา 
 PPTPER หมายถึง   คะแนนทดสอบโปรแกรมนาํเสนอผลงาน 
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ตอนท่ี 1 ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรที่ใชในการวิจัย 
 

ผลการวิเคราะหขอมูลในตอนนี้ ประกอบดวย 2 สวน สวนแรก เปนผลการวิเคราะหคาสถิติ
พื้นฐานของกลุมตัวอยางที่ใชในการวิจัย โดยการนําเสนอคาสถิติแจกแจงความถี่ รอยละ และสวน 
ที่สอง เปนผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตไดที่ใชในการศึกษา  โมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอร
ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ไดแก คาเฉล่ีย (mean) สวนเบี่ยงเบนมาตรฐาน (S.D.) 
คาคะแนนสูงสุด (maximum) คาคะแนนตํ่าสุด (minimum) คาความเบ (skewness) คาความโดง 
(kurtosis) คาสัมประสิทธิ์การกระจาย (CV) โดยมีวัตถุประสงคเพื่อศึกษาลักษณะการกระจายและ
การแจกแจงของตัวแปรสังเกตไดแตละตัวแปร 
 

1.1 ผลการวิเคราะหคาสถิติพื้นฐานของสถานภาพโดยทั่วไปของผูตอบแบบสอบถาม 
 

ผลการวิเคราะหคาสถิติพื้นฐานของสถานภาพโดยทั่วไปของนักเรียนผูตอบแบบสอบถามมี
รายละเอียด ดังตอไปนี้ 
 

ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน 
        และตัวแปรตางๆ  (N = 813 คน) 

ตัวแปร จํานวน รอยละ 
1. สังกัด   
        สํานักงานคณะกรรมการการศึกษาข้ันพืน้ฐาน (สพฐ.) 394 48.46 
        สํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) 419 51.54 

รวม 813 100.00 
2. ขนาดโรงเรียน   
 ใหญ 408 50.18 
 กลาง 405 49.82 

รวม    813 100.00 
3. เพศ   
 ชาย 442 54.37 
 หญิง 371 45.63 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
4. อายุ (ป)   
 15 109 13.41 
 16 278 34.19 
 17 301 37.02 
 18 119 14.64 
 19 5 0.62 
 20 0 0.00 
 21 1 0.12 
 รวม 813 100.00 
5. ระดับช้ันเรียน   
 ม.4 284 34.93 
 ม.5 369 45.39 
 ม.6 160 19.68 

รวม 813 100.00 
6. แผนการเรียน   
 วิทย – คณิต  596 73.31 
 ศิลป – คํานวณ  88 10.82 
 ศิลป – ภาษา  129 15.87 
 อ่ืนๆ  0 0.00 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
7. ประสบการณในการใชคอมพิวเตอร   
 นอยกวา 1 ป 4 0.49 
 1 – 2 ป 39 4.80 
 3 – 4 ป 121 14.88 
 5 – 6 ป 172 21.16 
 มากกวา 6 ป 477 58.67 

รวม 813 100.00 
8. จํานวนช่ัวโมงทีน่ักเรียนใชคอมพิวเตอรใน 1 วัน   
 นอยกวา 1 ชั่วโมง / วนั 92 11.32 
 1 – 2 ชั่วโมง / วนั 325 39.98 
 3 – 4 ชั่วโมง / วนั 291 35.79 
 5 – 6 ชั่วโมง / วนั 54 6.64 
 มากกวา 6 ชัว่โมง / วนั 51 6.27 

รวม 813 100.00 
9. ประสบการณในการใชโปรแกรมประมวลผลคํา  
    ( Microsoft Word ) 

  

 นอยกวา 1 ป 40 4.92 
 1 – 2 ป 83 10.21 
 3 – 4 ป 196 24.11 
 5 – 6 ป 193 23.74 
 มากกวา 6 ป 301 37.02 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
10. จํานวนช่ัวโมงที่นกัเรียนใชโปรแกรมประมวลผลคํา  
     ( Microsoft Word )ใน 1 วนั 

  

 นอยกวา 1 ชั่วโมง / วนั 363 44.65 
 1 – 2 ชั่วโมง / วนั 358 44.03 
 3 – 4 ชั่วโมง / วนั 76 9.35 
 5 – 6 ชั่วโมง / วนั 6 0.74 
 มากกวา 6 ชัว่โมง / วนั 10 1.23 

รวม 813 100.00 
11. รอยละความคาดหวังถึงผลสําเร็จของผลงานจากการ 
      ใชโปรแกรมประมวลผลคํา (Microsoft Word)      

  

 รอยละ 0 – 20 32 3.94 
 รอยละ 21 – 40 71 8.73 
 รอยละ 41 – 60 146 17.96 
 รอยละ 61 – 80 293 36.04 
 รอยละ 81 – 100 271 33.33 

รวม 813 100.00 
12. ประสบการณในการใชโปรแกรมนาํเสนอผลงาน 
      (Microsoft PowerPoint ) 

  

 นอยกวา 1 ป           96 11.81 
 1 – 2 ป      214 26.32 
 3 – 4 ป 246 30.26 
 5 – 6 ป    139 17.10 
 มากกวา 6 ป 118 14.51 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
13. จํานวนช่ัวโมงที่นกัเรียนใชโปรแกรมนาํเสนอผลงาน  
      (Microsoft PowerPoint) ใน 1 วัน           

  

 นอยกวา 1 ชั่วโมง / วนั 511 62.85 
 1 – 2 ชั่วโมง / วนั 227 27.92 
 3 – 4 ชั่วโมง / วนั 62 7.63 
 5 – 6 ชั่วโมง / วนั 8 0.98 
 มากกวา 6 ชัว่โมง / วนั 5 0.62 

รวม 813 100.00 
14. รอยละความคาดหวังถึงผลสําเร็จของผลงานจากการ 
      ใชโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint)         

  

 รอยละ 0 – 20 38 4.67 
 รอยละ 21 – 40 88 10.82 
 รอยละ 41 – 60 164 20.17 
 รอยละ 61 – 80 322 39.61 
 รอยละ 81 – 100 201 24.72 

รวม 813 100.00 
    

จากตารางที่ 4.1  ผลการวิเคราะหคาสถิติพื้นฐานของผูตอบแบบสอบถามเม่ือจําแนกตาม
สังกัดของโรงเรียน พบวา นักเรียนผูตอบแบบสอบถามสวนใหญเปนนักเรียนในโรงเรียนสังกัด
สํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) คิดเปนรอยละ 51.54 รองลงมา คือ สังกัด
สํานักงานคณะ กรรมการศึกษาข้ันพื้นฐาน (สพฐ.) คิดเปนรอยละ 48.46 และเมื่อจําแนกตาม 
ขนาดของโรงเรียน พบวา นักเรียนผูตอบแบบสอบถามสวนใหญเปนนักเรียนในโรงเรียนขนาดใหญ 
คิดเปนรอยละ 50.18 รองลงมาคือ ขนาดกลาง คิดเปนรอยละ 49.82  คาสถิติพื้นฐาน พบวา 
ผูตอบแบบสอบถามสวนใหญเปนเพศชาย คิดเปนรอยละ 54.37 มีอายุ 17 ป 16 ป และ 18 ป คิด
เปนรอยละ 37.02  34.19 และ 14.64 ตามลําดับ และกําลังศึกษาอยูในระดับชั้นเรียน ม.5  ม.4 
และ  ม.6 คิดเปนรอยละ 45.39  34.93 และ 19.68 ตามลําดับ   และศึกษาแผนการเรียน วิทย – 
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คณิต ศิลป – ภาษาและศิลป – คํานวณ คิดเปนรอยละ 73.31 15.87 และ 10.82 ตามลําดับ  โดย
สวนใหญมีประสบการณในการใชคอมพิวเตอรมามากกวา 6 ป คิดเปนรอยละ 58.67  ใช
คอมพิวเตอรเปนระยะเวลา 1 – 2 ชั่วโมงตอวัน คิดเปนรอยละ 39.98 มีประสบการณในการใช
โปรแกรมประมวลผลคํา (Microsoft Word) มากกวา 6 ป คิดเปนรอยละ 37.02  ใชโปรแกรม
ประมวลผลคํา (Microsoft Word) เปนระยะเวลานอยกวา 1 ชั่วโมงตอวัน คิดเปน รอยละ 44.65  
ความคาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมประมวลผลคํา (Microsoft Word) รอย
ละ 61 – 80 คิดเปนรอยละ 36.04  และสวนใหญมีประสบการณในการใชโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) ระหวาง 3 – 4 ป คิดเปนรอยละ 30.26  ใชโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) เปนระยะเวลานอยกวา 1 ชั่วโมงตอวัน คิดเปนรอยละ 62.85  และความ
คาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint) รอย
ละ 61 – 80 คิดเปนรอยละ 39.61  

 

1.2 ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตได 
 

การวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตได 13 ตัวแปร ที่ใชในการศึกษาโมเดลเชิง
สาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร โดยการวิจัยในคร้ังนี้  แบงเปนตัวแปร
ภายในแฝง จํานวน 4 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
(COMSELF) ตัวแปรการต้ังเปาหมาย   (GOALLEVEL)ตัวแปรความผูกพันตอเปาหมาย  
(GOALCOMM)  และตัวแปรความสามารถทางคอมพิวเตอร (COMPER) ของนักเรียนชวงช้ันที่ 4 
ในกรุงเทพมหานคร  ตัวแปรภายนอกแฝง จํานวน 4 ตัวแปร คือ ตัวแปรระดับประสบการณเดิม  
(PREVEXP)  ตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) ตัวแปรความมุงมั่นในการทํางาน
(LEARNGOA)และตัวแปรความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE)  โดยตัวแปรแฝง
ทั้งหมด วัดไดจากตัวแปรสังเกตได ทั้งหมด 13 ตัวแปร ไดแก ระดับประสบการณในการใชโปรแกรม
ประมวลผลคํา (WORDEXP)   ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน (PPTEXP)   
การเห็นคุณคาในตนเอง (SELFEST)  ความออนไหวทางอารมณ (NEUROTIC)  ความมุงมั่นในการ
ทํางาน (LEARNGOA)  ความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE)  การรับรูความสามารถ
ในการใชโปรแกรมประมวลผลคํา (WORDSELF) การรับรูความสามารถในการใชโปรแกรมนําเสนอ
ผลงาน (PPTSELF)  ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา (WORDGOAL)  
ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน (PPTGOAL)  ความผูกพันตอ
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เปาหมาย (GOALCOMM)  คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) และ คะแนน
ทดสอบโปรแกรมนําเสนอผลงาน (PPTPER)  โดยผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกต
ได มีรายละเอียดดังตอไปนี้ 

ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตไดในโมเดลเชิงสาเหตุและผลของการ
รับรูความสามารถดานคอมพิวเตอรของตนเองที่มีผลตอความสามารถทางคอมพิวเตอรของ
นักเรียนผูตอบแบบสอบถามทั้งหมด เมื่อพิจารณาคาเฉล่ีย ( x ) ของตัวแปรสังเกตได พบวา ตัวแปร
สังเกตไดสวนใหญมีคาเฉล่ียอยูในระดับปานกลางคอนขางสูง ( x = 2.84 – 3.95)  และตัวแปร 
คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) และ คะแนนทดสอบโปรแกรมนําเสนอผลงาน 
(PPTPER)  จะมีคาคะแนนทดสอบเฉลี่ยเทากับ 10.05 และ 7.33 จากคะแนนเต็ม 17 และ 18 
คะแนนตามลําดับ  

เมื่อพิจารณาสัมประสิทธิ์การกระจาย (CV) ของตัวแปรสังเกตได พบวา ตัวแปรคะแนน
ทดสอบโปรแกรมนําเสนอผลงาน (PPTPER)  มีการกระจายของขอมูลมากที่สุด (รอยละ 42.86)  
รองลงมา คือ ตัวแปรระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน (PPTGOAL)  
และ คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER)  รอยละ 29.79 และ 28.97 ตามลําดับ 
สวนตัวแปรการเห็นคุณคาในตนเอง (SELFEST) มีการกระจายของขอมูลนอยที่สุด รอยละ 12.09
สวนตัวแปรที่เหลือมีการกระจายไมแตกตางกันมาก อยูระหวางรอยละ 13.30 – 28.36 แสดงวา
กลุมผูตอบแบบสอบถามทั้งหมดมีคะแนนทดสอบโปรแกรมนําเสนอผลงานแตกตางกันมากที่สุด 
รองลงมา ไดแก ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงานและคะแนนทดสอบ
โปรแกรมประมวลผลคํา  

เมื่อพิจารณาความเบ (SK) ของตัวแปรสังเกตได พบวา ตัวแปรสวนใหญมีการแจกแจงใน
ลักษณะเบซาย (คาความเบเปนลบ) แสดงวา ขอมูลของตัวแปรสูงกวาคาเฉลี่ย ยกเวนตัวแปร
ความผูกพันตอเปาหมาย (GOALCOMM) และตัวแปรคะแนนทดสอบโปรแกรมนําเสนอผลงาน 
(PPTPER)  ที่มีการแจกแจงในลักษณะเบขวา (คาความเบเปนบวก) แสดง วาขอมูลสวนใหญของ
ตัวแปรเหลานี้มีคะแนนตํ่ากวาคาเฉลี่ย 
 เมื่อพิจารณาความโดง (KU) ของตัวแปรสังเกตได พบวามีตัวแปร ความออนไหวทาง
อารมณ (NEUROTIC)  ความวิตกกังวลในการใชคอมพิวเตอร  (COMANXIE) ระดับเปาหมายของ
ผลสํา เ ร็จในการใช โปรแกรมนํ า เสนอผลงาน  (PPTGOAL)ความผูกพันตอ เป าหมาย 
(GOALCOMM)  คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) และคะแนนทดสอบ
โปรแกรมนําเสนอผลงาน (PPTPER)  มีการแจกแจงของขอมูลในลักษณะเตี้ยแบน หรือโคงนอย 



 

 

111

(คาความโดงนอยกวา 0) และมีตัวแปรระดับประสบการณในการใชโปรแกรมประมวลผลคํา 
(WORDEXP) ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน (PPTEXP) การเห็นคุณคา
ในตนเอง (SELFEST)  ความมุงมั่นในการทํางาน (LEARNGOA) การรับรูความสามารถในการ
ใชโปรแกรมประมวลผลคํา (WORDSELF)  การรับรูความสามารถในการใชโปรแกรมนําเสนอ
ผลงาน (PPTSELF) และระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา 
(WORDGOAL)  มีการแจกแจงของขอมูลที่มียอดสูง หรือโคงมาก (คาความโดงมากกวา 0)         
ดังตารางที่ 4.2 
 

ตารางที ่4.2 คาสถิติพืน้ฐานของตัวแปรสังเกตไดที่ใชในการวิจยั (n=813) 
ตัวแปร x  SD CV MIN MAX SK KU 

WORDEXP 3.09 0.62 19.98 1.00 5.00 -0.40 0.22 
PPTEXP 2.84 0.61 21.41 1.00 5.00 -0.06 0.15 
SELFEST 3.84 0.46 12.09 1.50 5.00 -0.09 1.31 
NEUROTIC 3.05 0.73 24.05 1.00 5.00 -0.17 -0.10 
LEARNGOA 3.91 0.52 13.30 1.38 5.00 -0.12 0.44 
COMANXIE 3.95 1.06 26.76 1.00 5.00 -0.91 -0.15 
WORDSELF 3.87 0.60 15.49 1.24 5.00 -0.47 0.44 
PPTSELF 3.68 0.71 19.20 1.00 5.00 -0.44 0.49 
WORDGOAL 3.86 1.09 28.36 1.00 5.00 -0.85 0.04 
PPTGOAL 3.69 1.10 29.79 1.00 5.00 -0.70 -0.17 
GOALCOMM 3.43 0.48 13.88 2.17 5.00 0.55 -0.07 
WORDPER 10.05 2.91 28.97 1.00 17.00 -0.35 -0.17 
PPTPER 7.33 3.14 42.86 0.00 17.00 0.15 -0.40 
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ตอนท่ี 2  การวิเคราะหความแตกตางของระดับความสามารถทางคอมพิวเตอรของ
นักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร จําแนกตามสังกัดและขนาดของ
โรงเรียน  

 

 2.1 การวิเคราะหความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4                 
ในกรุงเทพมหานคร 

ผลการวิเคราะหความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
พบวาความสามารถทางคอมพิวเตอรของนักเรียนที่กําลังศึกษาอยูในโรงเรียนทั้งสังกัดสํานักงาน
คณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) และสังกัดสํานักงานคณะกรรมการการสงเสริม
การศึกษาเอกชน (สช.) ในกรุงเทพมหานคร มีคาระหวาง 16.814 – 17.975 ( x อยูระหวาง 16.814 
– 17.975) สวนเบ่ียงเบนมาตรฐาน มีคาระหวาง 5.323  - 5.352 ( SD อยูระหวาง 5.323 – 5.352) 
และความสามารถทางคอมพิวเตอรของนักเรียนที่กําลังศึกษาอยูในโรงเรียนทั้งโรงเรียนขนาดใหญ
และขนาดกลาง ในกรุงเทพมหานคร อยูในระดับปานกลาง ( x อยูระหวาง 16.939 – 17.817) สวน
เบ่ียงเบนมาตรฐาน  ( SD อยูระหวาง 5.313 – 5.389) ดังตารางที่ 4.3 

 

ตารางท่ี 4.3   คาเฉล่ียและสวนเบ่ียงเบนมาตรฐานแสดงความสามารถทางคอมพวิเตอรของ 
 นักเรียนชวงช้ันที ่4 ในกรุงเทพมหานคร จําแนกตามสังกัดและขนาดของโรงเรียน 
 (n=813) 
ตัวแปร N x  S.D. t p 
สังกัด     สพฐ. 394 17.975 5.323 3.099* 0.002 
              สช. 419 16.814 5.352   
ขนาด     ใหญ 408 17.817 5.389 2.341* 0.019 
             กลาง 405 16.939 5.313   
หมายเหตุ: * p < .05 
 

 2.2   ผลการเปรียบเทยีบความสามารถทางคอมพวิเตอรของนกัเรียนชวงชัน้ที่ 4                
ในกรุงเทพมหานคร เมื่อจําแนกตามสังกัดและขนาดของโรงเรียน  
 ผลการวิเคราะหความแตกตางของความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4                
ในกรุงเทพมหานคร  จําแนกตามสังกัดของโรงเรียน พบวาคะแนนเฉลี่ยของนักเรียนในโรงเรียน
สังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) มีคะแนนความสามารถทาง
คอมพิวเตอรสูงกวาโรงเรียนในสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.)อยาง
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มีนัยสําคัญทางสถิติที่ระดับ .05  และเมื่อจําแนกตามขนาดของโรงเรียน พบวาคะแนนเฉลี่ยของ
นักเร ียนในโรงเร ียนขนาดใหญมีคะแนนความสามารถทางคอมพิวเตอรส ูงกวาโรงเร ียน                
ขนาดกลาง อยางมีนัยสําคัญที่ระดับ .05 
 

ตอนที่ 3  ผลการวิเคราะหสหสัมพันธระหวางตัวแปรสังเกตไดที่ใชในการวิเคราะหโมเดลเชิง
สาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร  

ผลการวิเคราะหสหสัมพันธระหวางตัวแปรสังเกตไดที่ใชในการวิเคราะหโมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 มีรายละเอียดผลการวิเคราะหนําเสนอไว ดังตารางที่  4.4 
 ผลการวิเคราะหความสัมพันธระหวางตัวแปรสังเกตได เกี่ยวกับเหตุของการรับรู
ความสามารถทางคอมพิวเตอรที่มีตอความสามารถทางคอมพิวเตอรที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ของกลุมตัวอยางทั้งหมด พบวา คาสถิติ Bartlett’ test of 
Sphericity ซึ่งเปนคาสถิติทดสอบสมมติฐานวา เมทริกซสหสัมพันธเปนเมทริกซเอกลักษณ 
(identity  matrix) หรือไม มีคาสถิติเทากับ 4151.014 (p<.05) แสดงวาเมทริกซสหสัมพนัธระหวาง
ตัวแปรสังเกตไดทั้งหมดของกลุมตัวอยางแตกตางจากเมทริกซเอกลักษณอยางมีนัยสําคัญที่ระดับ 
.05 ซึ่งสอดคลองกับผลการวิเคราะห คาดัชนีไกเซอร – ไมเยอร - ออลคิน (Kaiser-Meyer-Olkin 
Measure of Sampling Adequacy) มีคาเทากับ  0.720  ซึ่งมีคาเขาใกล  1  แสดงวาตัวแปร
สังเกตไดของขอมูลชุดนี้มีความสัมพันธภายในตอกัน เหมาะสมที่จะนําไปใชในการวิเคราะหโมเดล
ลิสเรลตอไป  

จากตารางที่ 4.4 เมื่อพิจารณาเมทริกซสหสัมพันธระหวางตัวแปรสังเกตได ทั้ง 13 ตัว
แปรพบวา ความสัมพันธระหวางตัวแปรที่มีคาแตกตางจากศูนยอยางมีนัยสําคัญทางสถิติที่ระดับ 
.01 และระดับ .05 จํานวน 72  คู และ 3 คู ตามลําดับ และมีความสัมพันธกันอยางไมมีนัยสําคัญ 
จํานวน 16 คู  จากความสัมพันธระหวางตัวแปรรวม  91  คู 
 เมื่อพิจารณาความสัมพันธระหวางกลุมตัวแปรดานเดียวกัน  พบวา ความสัมพันธระหวาง
ตัวแปรสังเกตไดในกลุมตัวแปรระดับประสบการณเดิม จะมีความสัมพันธที่เปนทิศทางเดียวกันโดย       
มีตัวแปรที ่มีความสัมพันธกันมากที ่สุด คือ ตัวแปรระดับประสบการณในการใชโปรแกรม
ประมวลผลคํา (WORDEXP) กับตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 
(PPTEXP) โดยมีขนาดความสัมพันธเทากับ 0.83 อยางมีนัยสําคัญทางสถิติที่ระดับ .01 แสดงวา 
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หากนักเรียนมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนก็จะสงผลใหประสบการณใน
การใชโปรแกรมนําเสนอผลงานสูงข้ึนดวย ในขณะเดียวกันหากประสบการณในการใชโปรแกรม
นําเสนอผลงานสูงข้ึน ก็จะมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนดวยเชนกัน    

เมื ่อพ ิจารณาความส ัมพ ันธ ระหว างต ัวแปรส ัง เกตได ของกลุ มต ัวแปรการร ับ รู
ความสามารถดานคอมพิวเตอรของตนเองพบวา มีความสัมพันธที่เปนทิศทางเดียวกัน โดยตัว
แปรที่มีความสัมพันธกันมากที่สุด คือ ตัวแปรการรับรูความสามารถในการใชโปรแกรมประมวลผล
คํา  (WORDSELF) กับตัวแปรการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 
(PPTSELF) โดยมีขนาดความสัมพันธเทากับ 0.75 อยางมีนัยสําคัญทางสถิติที่ระดับ .01 แสดงวา 
หากนักเรียนมีการรับรูความสามารถในการใชโปรแกรมประมวลผลคําสูงข้ึน ก็จะสงผลให การรับรู
ความสามารถในการใชโปรแกรมนําเสนอผลงานสูงข้ึนดวย  ในขณะเดียวกันหากการรับรู
ความสามารถในการใชโปรแกรมนําเสนอผลงานสูงข้ึน ก็จะมีการรับรูความสามารถในการใช 
โปรแกรมประมวลผลคําสูงข้ึนดวยเชนกนั
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ตารางที ่4.4 คาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรสังเกตไดของกลุมตัวอยางทั้งหมด (n=813) 

 
              

              **p<.01,*p<.05 

ตัวแปร WORDEXP PPTEXP SELFEST NEUROTIC LEARNGOA COMANXIE WORDSELF PPTSELF WORDGOAL PPTGOAL GOALCOMM WORDPER PPTPER 
WORDEXP 1             
PPTEXP 0.830** 1            
SELFEST 0.126** 0.149* 1           
NEUROTIC 0.045 0.028 0.187** 1          
LEARNGOA 0.125** 0.134** 0.597** 0.082* 1         
COMANXIE 0.219** 0.173** 0.108** 0.462** 0.108** 1        
WORDSELF 0.288** 0.269** 0.454** 0.173** 0.427** 0.342** 1       
PPTSELF 0.290** 0.339** 0.396** 0.127** 0.347** 0.220** 0.752** 1      
WORDGOAL 0.339** 0.258** 0.227** 0.171** 0144** 0.232** 0.332** 0.287** 1     
PPTGOAL 0.294** 0.342** 0.266** 0.154** 0176** 0.228** 0.292** 0.349** 0.633** 1    
GOALCOMM 0.088* 0.032 0.239** 0.354** 0.250** 0.391** 0.266** 0.185** 0.206** 0.219** 1   
WORDPER 0.160** 0.122** 0.093** 0.244** 0.092** 0.370** 0.241** 0.131** 0.231** 0.239** 0.320** 1  
PPTPER 0.141** 0.101** 0.092** 0.188** 0.108** 0.304** 0.276** 0.195** 0.227** 0.240** 0.293** 0.572** 1 
MEAN 3.092 2.835 3.836 3.047 3.912 3.955 3.868 3.676 3.861 3.689 3.432 10.050 7.326 
SD 0.618 0.607 0.464 0.733 0.520 1.058 0.599 0.706 1.095 1.099 0.476 2.912 3.140 

Bartlett’s Test of Sphericity = 4151.014            df=78           P=.000 Kaiser-Meyer-Olkin Measure of Sampling Adequacy= 0.720 
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เมื่อพิจารณาความสัมพันธระหวางตัวแปรสังเกตไดของกลุมตัวแปรการต้ังเปาหมายพบวา 
ตัวแปรมีความสัมพันธไปในทิศทางเดียวกัน โดยตัวแปรที่มีความสัมพันธกันมาก คือตัวแปรระดับ
เปาหมายของผลสําเร็จในการใชโปรแกรม ประมวลผลคํา (WORDGOAL) กับระดับเปาหมายของ
ผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน (PPTGOAL) โดยมีขนาดความสัมพันธเทากับ 0.63 
อยางมีนัยสําคัญทางสถิติที่ระดับ .01 แสดงวาหากนักเรียนไดมีการต้ังเปาหมายของผลสําเร็จใน
การใชโปรแกรมประมวลผลคําสูงข้ึนก็จะทําใหระดับเปาหมายของผลสําเร็จในการใชโปรแกรม
นําเสนอผลงานสูงข้ึนดวย  ในขณะเดียวกันนักเรียนที่ไดมีการต้ังเปาหมายของผลสําเร็จในการใช
โปรแกรมนําเสนอผลงานสูงข้ึนก็จะทําใหการต้ังเปาหมายของผลสําเร็จในการใชโปรแกรม
ประมวลผลคําสูงข้ึนดวยเชนกัน   

เมื่อพิจารณาความสัมพันธระหวางตัวแปรสังเกตไดของกลุมตัวแปรความสามารถทาง
คอมพิวเตอร พบวา ตัวแปรมีความสัมพันธไปในทิศทางเดียวกัน โดยตัวแปรที่มีความสัมพันธกัน
มาก คือ คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) กับคะแนนทดสอบโปรแกรม
นําเสนอผลงาน (PPTPER) โดยมีขนาดความสัมพันธเทากับ 0.57 อยางมีนัยสําคัญทางสถิติ        
ที่ระดับ .01 แสดงวาหากนักเรียนไดมีคะแนนทดสอบโปรแกรมประมวลผลคําสูงข้ึนก็จะทําให
คะแนนทดสอบโปรแกรมนําเสนอผลงานสูงข้ึนดวย  ในขณะเดียวกันนักเรียนที่มีคะแนนทดสอบ
โปรแกรมนําเสนอผลงานสูงข้ึนก็จะทําใหคะแนนทดสอบโปรแกรมประมวลผลคําสูงข้ึนดวยเชนกัน   
 กลาวโดยสรุป ความสัมพันธระหวางตัวแปรสังเกตได 13 ตัวแปร รวม 91 คู ทั้งที่อยูใน        
ตัวแปรปจจัยเดียวกันและตัวแปรทุกปจจัยพบวา ตัวแปรสวนใหญมีความสัมพันธกันอยางมี
นัยสําคัญทางสถิติที่ระดับ .01 ในสวนของเมทริกซสหสัมพันธของตัวแปรสังเกตไดทุกคู พบวา 
แตกตางจากเมทริกซเอกลักษณอยางมีนัยสําคัญทางสถิติ ตัวแปรที่วัดไดมีความสัมพันธภายในตอ
กัน และคาความสัมพันธระหวางตัวแปรสังเกตไดที่เปนตัวแปรอิสระแตละคู สวนใหญมีคาไมเกิน 
0.8 แสดงวา ตัวแปรสังเกตไดสวนใหญแลวจะเปนตัวแปรอิสระของขอมูลชุดนี้ไมมีปญหาภาวะรวม
เสนตรงพหุ (Multicollinearity) (อุทุมพร จามรมาน, 2542) จึงเหมาะสมที่จะนําไปใชในการวิเคราะห
โมเดลลิสเรล (LISREL Model) ที่มีโมเดลการวัด (Measurement Model) ซึ่งอาศัยหลักการ
วิเคราะหองคประกอบที่ตัวแปรควรมีความสัมพันธภายในตอกัน แตไมควรมีขนาดความสัมพันธกัน
สูง ดังนั้น จะเห็นไดวาขอมูลชุดนี้มีความเหมาะสมที่จะนําไปใชในการตรวจสอบความสอดคลอง
ของโมเดลลิสเรลเต็มรูปกับขอมูลเชิงประจักษตอไป 
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ตอนท่ี 4 ผลการวิเคราะหความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ใน
กรุงเทพมหานครกับขอมูลเชิงประจักษ 

 

การวิเคราะหขอมูลในสวนนี้ เปนการวิเคราะหเพื่อตรวจสอบความสอดคลองของโมเดล
เชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ตามสมมติฐานกับขอมูลเชิงประจักษ 
การวิจัยคร้ังนี้มี ตัวแปรภายนอกแฝง จํานวน 4 ตัวแปร ไดแก ตัวแปรระดับประสบการณเดิม 
(PREVEXP) ตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) ตัวแปรความมุงมั่นในการทํางาน
(LEARNGOA) และตัวแปรความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE) ตัวแปรภายใน
แฝง 4 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF)            
ตัวแปรการตั้งเปาหมาย  (GOALLEVEL) ตัวแปรความผูกพันตอเปาหมาย (GOALCOMM) และ
ตัวแปรความสามารถทางคอมพิวเตอร (COMPER) ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
โดยตัวแปรสังเกตไดที่ใชในการวิเคราะหขอมูลทั้งหมดมีจํานวน 13 ตัวแปร  

การทดสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดาน
คอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ใน
กรุงเทพมหานครตามสมมติฐานกับขอมูลเชิงประจักษวิเคราะหโดยกําหนดใหความคลาดเคล่ือนใน 
การวัดไมสัมพันธกัน ผลการวิเคราะหขอมูลปรากฏวา โมเดลตามสมมติฐานไมสอดคลองกับขอมูล
เชิงประจักษโดยพิจารณาจากคาไค–สแควร ( 2χ ) มีคาเทากับ 1030.96 คาองศาอิสระเทากับ 55  
และคาความนาจะเปน (P) เทากับ.000  คาดัชนีวัดระดับความกลมกลืน(GFI)  เทากับ 0.837 และ
ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (AGFI) มีคาเทากับ 0.730  คาดัชนีกําลังสองของสวน 
เหลือ (RMR) เทากับ 0.137 และคาเศษเหลือในรูปคะแนนมาตรฐานระหวางตัวแปรสูงสุด (Largest 
Standardized Residuals) เทากับ 21.440 
 จากผลการวิเคราะหดังกลาว ผูวิจัยทําการปรับโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในกรุงเทพมหานคร โดยยอมใหความคลาดเคล่ือนมีความสัมพันธกันได ซึ่งการปรับโมเดล
ในข้ันตอนนี้ ผูวิจัยพิจารณาจากดัชนีดัดแปรโมเดล (Modification Indices) และผลจากการปรับ
โมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
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ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครที่สอดคลองกับขอมูล
เชิงประจักษ โดยมีรายละเอียดดัง ตารางที่ 4.5 
 จากรายละเอียดผลการวิเคราะหขอมลูในตารางที ่ 4.5 เม่ือพิจารณาผลการวิเคราะหโมเดล
พบวา โมเดลมีความสอดคลองกับขอมูลเชิงประจักษ โดยพิจารณาจากคาสถิติที่ใชตรวจสอบความ
สอดคลองระหวางโมเดลกับขอมูลเชิงประจักษ ไดแก คาไค–สแควร ( 2χ )มีคาเทากับ 9.146 องศา 
อิสระเทากับ 11 ที่ระดับความนาจะเปน (P) เทากบั 0.608 ซึ่งแสดงวาผลการทดสอบคาไค–สแควร
( 2χ ) ไมแตกตางจากศูนยอยางมีนัยสําคัญทางสถิติ คือ ยอมรับสมมติฐานวาโมเดลทีพ่ัฒนาข้ึน
มามีความสอดคลองกับขอมูลเชิงประจกัษ ซึ่งสอดคลองกับผลการวเิคราะหคาดัชนีวัดระดับความ
กลมกลืน (GFI) เทากับ 0.998 ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (AGFI) เทากับ 0.986  
ซึ่งมีคาเขาใกล 1 ดัชนีกําลังสองของสวนเหลือ (RMR ) เทากบั 0.0201  มีคาเขาใกลศูนย และ
กราฟคิวพล็อตของคาเศษเหลือในรูปคะแนนมาตรฐาน (Q-plot of Standardized  Residuals) มี
คาความชันมากกวาแนวทแยงซ่ึงเปนการแสดงวาโมเดลมีความสอดคลองกับขอมลูเชิงประจักษ 

 เมื่อพิจารณาคาความเที่ยงของตัวแปรภายนอกสังเกตได ทั้ง 6 ตัวแปรพบวา ตัวแปรที่มี 
คาความเที่ยงมากที่สุด คือ ตัวแปรระดับระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 
(PPTEXP)  ตัวแปรความมุงมั่นในการทํางาน (LEARNGOA) และตัวแปรความวิตกกังวลในการใช
คอมพิวเตอร (COMANXIE)  ซึ่งทั้งหมดมีคาเทากับ 1.000 รองลงมา ไดแก ตัวแปรระดับ
ประสบการณในการใชโปรแกรมประมวลผลคํา (WORDEXP) ตัวแปรความออนไหวทางอารมณ 
(NEUROTIC)และตัวแปรการเห็นคุณคาในตนเอง (SELFEST) ซึ่งมีคาเทากับ 0.757  0.258 และ 
0.244 ตามลําดับ และเม่ือพิจารณาคาความเที่ยงของตัวแปรภายในสังเกตได 3 อันดับแรก พบวา 
ตัวแปรที่มีคาความเที่ยงมากที่สุด ไดแก ตัวแปรความผูกพันตอเปาหมาย (GOALCOMM) มีคา
เทากับ 1.000 รองลงมาไดแก ตัวแปรการรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 
(WORDSELF) และตัวแปรคะแนนทดสอบโปรแกรมนําเสนอผลงาน (PPTPER) มีคาเทากับ 0.859 
และ 0.812 ตามลําดับ สําหรับคาสัมประสิทธิ์การพยากรณ (R2) ของสมการโครงสรางตัวแปร
ภายในแฝงของตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง ตัวแปรการตั้งเปาหมาย 
ตัวแปรความผูกพันตอเปาหมายและตัวแปรความสามารถทางคอมพิวเตอรพบวา มีคาเทากับ 
1.000 0.176 0.302 และ 0.242 ตามลําดับ แสดงวาตัวแปรในโมเดลสามารถอธิบายความ
แปรปรวนของการรับรูความสามารถดานคอมพิวเตอรของตนเอง การตั้งเปาหมาย ความผูกพันตอ
เปาหมาย และความสามารถทางคอมพิวเตอรไดรอยละ 100.00,17.60, 30.20 และ 24.20 ตามลําดับ 
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 เมื่อพิจารณา คาอิทธิพลทางตรงและอิทธิพลทางออมที่สงผลตอตัวแปรความสามารถ
ทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร (COMPER) พบวา ตัวแปรดังกลาว
ไดรับอิทธิพลทางตรงอยางมีนัยสําคัญทางสถิติที่ระดับ .01 จากตัวแปรความผูกพันตอเปาหมาย 
(GOALCOMM) และตัวแปรการต้ังเปาหมาย (GOALLEVEL) โดยมีขนาดอิทธิพลเทากับ 0.338 และ 
0.309 ตามลําดับ นอกจากนั้นตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ใน
กรุงเทพมหานคร (COMPER) ยังไดรับอิทธิพลทางออมจากตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) โดยมีขนาดอิทธิพลเทากับ 0.201 ตามลําดับ โดยสงผานตัว
แปรปจจัยความผูกพันตอเปาหมาย (GOALCOMM) และตัวแปรการต้ังเปาหมาย (GOALLEVEL)    
ตัวแปรที่มีอิทธิพลรวมอยางมีนัยสําคัญทางสถิติที่ระดับ .01 ตอตัวแปรความสามารถทางคอมพิวเตอร
ของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร (COMPER) คือ ตัวแปรความผูกพันตอเปาหมาย 
(GOALCOMM) และตัวแปรการตั้งเปาหมาย (GOALLEVEL)โดยมีขนาดอิทธิพลทางบวกเทากับ 
0.338 และ 0.309 ตามลําดับ นอกจากนี้ยังมีตัวแปรที่มีอิทธิพลรวมอยางมีนัยสําคัญทางสถิติที่
ระดับ .05 ตอตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร 
(COMPER) คือ ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF)โดยมีขนาด
อิทธิพลทางบวกเทากับ 0.174 แสดงวา ทั้งตัวแปรความผูกพันตอเปาหมาย  ตัวแปรการ
ต้ังเปาหมายและตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเองลวนมีอิทธิพลตอตัว
แปรความสามารถทางคอมพิวเตอรของนักเรียน โดยตัวแปรความผูกพันตอเปาหมายมีขนาด
อิทธิพลสูงกวาตัวแปรการต้ังเปาหมายและและตัวแปรการรับรูความสามารถดานคอมพิวเตอรของ
ตนเอง  ซึ่งเมื่อพิจารณาตัวแปรแลวจะพบวา การรับรูความสามารถในการใชโปรแกรมประมวลผล
คําและโปรแกรมนําเสนอผลงาน ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา
และโปรแกรมนําเสนอผลงาน และความผูกพันตอเปาหมายจะสงผลทางบวกตอความสามารถทาง
คอมพิวเตอรของนักเรียน แสดงใหเห็นวา ถานักเรียนสามารถรับรูความสามารถในการใชโปรแกรม
ประมวลผลคําและโปรแกรมนําเสนอผลงานดวยตนเอง และมีการกําหนดเปาหมายของผลสําเร็จ
ในการใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานตลอดจนมีความรูสึกผูกพันตอ
เปาหมายแลวก็จะทําใหนักเรียนมีความสามารถทางคอมพิวเตอรสูงข้ึน 
  

เมื่อพิจารณาอิทธิพลทางตรงที่สงผลตอตัวแปรการรับรูความสามารถดานคอมพิวเตอร
ของตนเอง (COMSELF) พบวาตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) และ ตัวแปร
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ความมุงม่ันในการทํางาน (LEARNGOA) มีอิทธิพลทางตรงตอการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) โดยมีขนาดอิทธิพลทางบวกเทากับ 0.877 และ 0.408 
ตามลําดับ นอกจากนี้ตัวแปรระดับประสบการณเดิม (PREVEXP) และตัวแปรความวิตกกังวลใน
การใชคอมพิวเตอร (COMANXIE) มีอิทธิพลทางตรงตอตัวแปรการรับรู ความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) โดยมีขนาดอิทธิพลทางลบเทากับ -0.014 และ -0.516 
ตามลําดับ อยางไมมีนัยสําคัญทางสถิติที่ระดับ .05 
 

เมื่อพิจารณาเมทริกซสหสัมพันธระหวางตัวแปรแฝง พบวาคาสัมประสิทธิ์สหสัมพันธระหวาง
ตัวแปรแฝงมีคาอยูระหวาง -0.122 ถึง 0.901 โดยมีตัวแปรคูมีความสัมพันธในทิศทางตรงกันขาม 
(คาสหสัมพันธเปนลบ) ที่มีคาสหสัมพันธติดลบมากที่สุด ไดแก ตัวแปรระดับประสบการณเดิม 
(PREVEXP) กับตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF) โดยมีคา
สัมประสิทธิ์สหสัมพันธเทากับ -0.122 แสดงวาถาตัวแปรระดับประสบการณเดิม (PREVEXP) มีคา
สูงข้ึน ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF) ก็จะมีคาลดลง และ
ตัวแปรที่มีความสัมพันธในทิศทางเดียวกัน (คาสหสัมพันธเปนบวก) มีคามากที่สุด ไดแก ตัวแปร
บุคลิกภาพภายในของผูเรียน (TRAINPER) กับตัวแปรความวิตกกังวลในการใชคอมพิวเตอร 
(COMANXIE)  โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ 0.901  แสดงวาถาตัวแปรบุคลิกภาพ
ภายในของผู เ รียน (TRAINPER) มีคาสูงข้ึนตัวแปรความวิตกกังวลในการใชคอมพิวเตอร 
(COMANXIE) ก ็จะม ีค าส ูง ขึ ้นด วยเช นก ัน  หร ือถ า ตัวแปรบุคลิกภาพภายในของผู เ รียน 
(TRAINPER) ตัวแปรความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE) ก็จะมีคาลดลงดวย
เชนกัน โดยตัวแปรคูที่มีคาสหสัมพันธรองลงมา ไดแก  ตัวแปรการรับรู ความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) และตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) 
โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ 0.891 

 
เมื่อเปรียบเทียบคาสหสัมพันธระหวางตัวแปรความสามารถทางคอมพิวเตอรของนักเรียน

ชวงชั้นที่ 4 ในกรุงเทพมหานคร (COMPER)กับตัวแปรแฝงทั้ง 7 ตัวแปร พบวา คาสัมประสิทธิ์
สหสัมพันธมีคาอยูระหวาง -0.021 – 0.434 โดยตัวแปรคูที่มีคาสัมประสิทธิ์สหสัมพันธมากที่สุด 
ไดแก ตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
(COMPER) กับตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF)  โดยมีคา
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สัมประสิทธิ์สหสัมพันธเทากับ 0.434 แสดงวา ถาตัวแปรการรับรูความสามารถดานคอมพิวเตอร
ของตนเอง (COMSELF) มีคาสูงข้ึนตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 
ในกรุงเทพมหานคร (COMPER) ก็จะมีคาสูงข้ึนดวยหรือถาตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) มีคาลดลงก็จะทําใหตัวแปรความสามารถทางคอมพิวเตอร
ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร (COMPER) มีคาลดลงดวย โดยตัวแปรคูที่มีคา
สัมประสิทธิ์สหสัมพันธรองลงมา ไดแก ตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน
ที่ 4 ในกรุงเทพมหานคร (COMPER) กับตัวแปรความผูกพันตอเปาหมาย(GOALCOMM)และตัว
แปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร (COMPER) กับ
ตัวแปรการตั้งเปาหมาย (GOALLEVEL) โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ 0.388 และ 0.377 
ตามลําดับ 

 
จากผลการพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของ

ตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร พบวา 
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 สามารถวัดดวยคะแนนทดสอบโปรแกรม
นําเสนอผลงานไดดีที่สุด สําหรับการตั้งเปาหมาย พบวา ระดับเปาหมายของผลสําเร็จในการใช
โปรแกรมนําเสนอผลงานจะสงผลตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4            
ในกรุงเทพมหานครมากที่สุด  นอกจากนี้แลวการรับรูความสามารถดานคอมพิวเตอรของตนเองยัง
สงผลทางออมไปยังความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร
โดยตองผานความผูกพันตอเปาหมายและการตั้งเปาหมาย กลาวคือ ถานักเรียนชวงช้ันที่ 4 ไดมี
การรับรูความสามารถดานคอมพิวเตอรของตนเองแลวขณะทํางานมีการตั้งเปาหมายและไดมี
ความผูกพันตอเปาหมายนั้นแลวก็จะสงผลใหนักเรียนมีความสามารถทางคอมพิวเตอรนั้นดวย 
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**p< .01, *p< .05                 

 
 

 
ตารางที่ 4.5  คาสถิติผลการวิเคราะหแยกคาสหสัมพันธระหวางตัวแปรแฝงและการวิเคราะหอิทธิพลของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดาน

คอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 

ตัวแปรผล COMSELF GOALLEVEL GOALCOMM COMPER 
ตัวแปรสาเหตุ TE IE DE TE IE DE TE IE DE TE IE DE 

-0.014 - -0.014 -0.004 -0.004 - -0.005 -0.005 - -0.002 -0.002 - PREVEXP 
(0.336) (0.336) (0.090) (0.090)  (0.117) (0.117) (0.059) (0.059)
0.877 - 0.877 0.654 0.654 - 0.849 0.849 - 0.424 0.424 - TRAINPER 

(0.541) (0.541) (0.473) (0.473)  (0.516) (0.516) (0.288) (0.288)
0.408 - 0.408 0.110* 0.110* - 0.142* 0.142* - 0.071 0.071 - LEARNGOA 

(0.240) (0.240) (0.057) (0.057)  (0.072) (0.072) (0.040) (0.040)
-0.516 - -0.516 -0.321 -0.321 - -0.417 -0.417 - -0.208 -0.208 - COMANXIE 
(0.354) (0.354) (0.508) (0.508)  (0.606) (0.606) (0.312) (0.312)

- - - 0.269** - 0.269** 0.349** - 0.349** 0.174* 0.201** - 0.027 COMSELF 
 (0.080) (0.080) (0.126) (0.126) (0.097) (0.051) (0.072)
- - - - - - - - - 0.309** - 0.309** GOALLEVEL 
  (0.060) (0.060)
- - - - - - - - - 0.338** - 0.338** GOALCOMM

    (0.071) (0.071)
คาสถิต ิ             
ไคว-สแควร = 9.146 p=0.608 df=11 GFI=0.998 AGFI=0.986 RMR=0.0201    
ตัวแปร WORDEXP PPTEXP SELFEST NEUROTIC LEARNGOA COMANXIE WORDSELF PPTSELF     
ความเที่ยง 0.757 1.000 0.244 0.258 1.000 1.000 0.859 0.812     
ตัวแปร WORDGOAL PPTGOAL GOALCOMM WORDPER PPTPER        
ความเที่ยง 0.605 0.654 1.000 0.599 0.540        
สมการโครงสรางตัวแปร COMSELF GOALLEVEL GOALCOMM COMPER        
R SQUARE 1.000 0.176 0.302 0.242        
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ตารางที่ 4.5  คาสถิติผลการวิเคราะหแยกคาสหสัมพันธระหวางตัวแปรแฝงและการวิเคราะหอิทธิพลของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดาน

คอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 (ตอ) 
 

 **p< .01, *p< .05                  
 
 
 
 
 

 
 
 
 
 

เมทริกซสหสัมพันธระหวางตัวแปรแฝง            
ตัวแปรแฝง PREVEXP TRAINPER LEARNGOA COMANXI COMSELF GOALLEVEL GOALCOMM COMPER     
PREVEXP 1            
TRAINPER 0.009 1           
LEARNGOA 0.119 0.156 1          
COMANXI 0.149 0.901 0.100 1         
COMSELF -0.122 0.891 0.667 0.295 1        
GOALLEVEL -0.033 0.382 0.179 0.279 0.670 1       
GOALCOMM -0.043 0.495 0.233 0.362 0.869 0.234 1      
COMPER -0.021 0.248 0.116 0.181 0.434 0.377 0.388 1     
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0.653 

 0 

0.970 

0.966 

-0.014

0.877

0.408

-0.516

ระดับประสบการณ 
ในการใชโปรแกรม
ประมวลผลคํา

ระดับประสบการณใน
การใชโปรแกรม
นําเสนอผลงาน

การเห็นคุณคา 
ในตนเอง 

ความออนไหว 
ทางอารมณ 

ระดับความมุงมั่น
ในการทํางาน 

ระดับความวิตกกังวล 
ในการใชคอมพิวเตอร 

0 

0 

ระดับประสบการณเดิม

บุคลิกภาพภายในของผูเรียน

ความมุงมั่นในการทํางาน

ความวิตกกังวล 
ในการใชคอมพิวเตอร

0.980 

1.000** 

0.494** 

0.508** 

1.000** 

1.000** 

การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง

การรับรูความสามารถ
ในการใชโปรแกรม
ประมวลผลคํา

การรับรูความสามารถ
ในการใชโปรแกรม
นําเสนอผลงาน

0.973** 0.901

0.584 0.796

0

     การตั้งเปาหมาย

ความผูกพันตอเปาหมาย

0.269**

-0.027

0.349**

0.984

0.953

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมประมวลผลคํา

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมนําเสนอผลงาน

คะแนนทดสอบ 
โปรแกรมประมวลผลคํา 

คะแนนทดสอบ 
โปรแกรมนําเสนอผลงาน 

0.756

0.801

0.842

0.512
ความสามารถ
ทางคอมพิวเตอร

0.338**

1.000

0.778

0.809**

0.309**

ระดับความผูกพันตอเปาหมาย

0.735**

0.774

0.970

0

แผนภาพที่ 4.1 ผลการพัฒนาโมเดลความสัมพันธเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียน 
                          ชวงชั้นที่ 4 ที่สอดคลองกับขอมูลเชิงประจักษ 124



บทที่ 5 
 

สรุปผลการวจิัย  อภิปรายผล  และขอเสนอแนะ 
 

การวิจัยครั้งนี้ เปนการศึกษาความสัมพันธเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในเขต
กรุงเทพมหานคร โดยมีวัตถุประสงค 3 ประการ ไดแก ประการแรก เพื่อศึกษาและเปรียบเทียบ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร เม่ือจําแนกตามสังกัด
และขนาดของโรงเรียน ประการที่สอง  เพื่อพัฒนาโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในกรุงเทพมหานคร และประการสุดทาย เพื่อตรวจสอบความสอดคลองโมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครที่พัฒนาข้ึนกับขอมูลเชิงประจักษ 
 การดําเนินการวิจัยคร้ังนี้ ประชากรที่ศึกษา คือ นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย 
(ชวงชั้นที่ 4) ในกรุงเทพมหานคร  2 สังกัด ไดแก โรงเรียนรัฐบาลสังกัดสํานักงานคณะกรรมการ
การศึกษาข้ันพื้นฐาน (สพฐ.) และโรงเรียนเอกชนสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษา
เอกชน (สช.) รวมทั้งส้ิน จํานวน 161,763 คน โดยผูวิจัยไดดําเนินการเก็บรวบรวมขอมูลดวยการสง
แบบสอบถามทางไปรษณีย จํานวน 1,000 ฉบับ และไดรับแบบสอบถามกลับคืน จํานวน 813 
ฉบับ ซึ่งคิดเปนรอยละ 81.30 ของผูตอบแบบสอบถาม 

ตัวแปรที่ใชในการวิจยัคร้ังนี ้ประกอบดวย ตัวแปรแฝง (latent variables) จํานวน 8 ตัวแปร  
และตัวแปรสังเกตได (observed variables) จํานวน 13 ตัวแปร ซึ่งแบงเปนตัวแปรภายในแฝง 
จํานวน 4 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง วัดไดจาก            
ตัวแปรสังเกตได จํานวน 2 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถในการใชโปรแกรม
ประมวลผลคํา และตัวแปรการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน  ตัวแปรการ
ต้ังเปาหมาย  วัดไดจากตัวแปรสังเกตได จํานวน 2 ตัวแปร ไดแก ตัวแปรระดับเปาหมายของ
ผลสําเร็จในการใชโปรแกรมประมวลผลคํา และตัวแปรระดับเปาหมายของผลสําเร็จในการใช
โปรแกรมนําเสนอผลงาน ตัวแปรความผูกพันตอเปาหมาย วัดไดจากตัวแปรสังเกตได  คือ ตัวแปร
ความผูกพันตอเปาหมาย และตัวแปรความสามารถทางคอมพิวเตอร วัดจากตัวแปรสังเกตได 
จํานวน 2 ตัวแปร คือ ตัวแปรคะแนนทดสอบโปรแกรมประมวลผลคํา และตัวแปรคะแนนทดสอบ



 126
 

โปรแกรมนําเสนอผลงาน และตัวแปรภายนอกแฝง จํานวน 4 ตัวแปร ไดแก  ตัวแปรระดับ
ประสบการณเดิม วัดไดจากตัวแปรสังเกตได จํานวน 2 ตัวแปร ไดแก ตัวแปรระดับประสบการณใน
การใชโปรแกรมประมวลผลคําและตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน  ตัว
แปรบุคลิกภาพภายในของผูเรียน วัดไดจากตัวแปรสังเกตได  จํานวน 2 ตัวแปร ไดแก ตัวแปรการ
เห็นคุณคาในตนเองและตัวแปรความออนไหวทางอารมณ   ตัวแปรความมุงมั่นในการทํางาน วัดได
จากตัวแปรสังเกตได คือ ตัวแปรความมุงมั่นในการทํางานและตัวแปรความวิตกกังวลในการใช
คอมพิวเตอร วัดไดจากตัวแปรสังเกตได คือ ตัวแปรความวิตกกังวลในการใชคอมพิวเตอร   
 เคร่ืองมือที่ใชในการวิจัยคร้ังนี้ คือ แบบสอบถามซึ่งผูวิจัยสรางข้ึนเองจากการศึกษาเอกสาร 
และงานวิจัยที่เกี่ยวของ โดยแบงออกเปน 4 ตอน ไดแก ตอนที่ 1 แบบสอบถามขอมูลทั่วไปของ
นักเรียน เปนแบบเติมคําในชองวางและแบบตรวจสอบรายการ (check list) ตอนที่ 2 เปน
แบบสอบถามเกี่ยวกับปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร  ประกอบไปดวย
ขอคําถาม 3 ดาน คือ  ดานบุคลิกภาพภายในของผูเรียน ดานความมุงมั่นในการทํางาน และดาน
ความวิตกกังวลในการใชคอมพิวเตอรโดยมีลักษณะเปนแบบมาตรประมาณคา  (rating scale)      
5 ระดับ  ตอนที่ 3 เปนแบบสอบถามปจจัยที่สงผลตอความสามารถทางคอมพิวเตอร ซึ่งประกอบ
ไปดวยขอคําถาม 2 ดานคือ ดานการรับรูความสามารถดานคอมพิวเตอรของตนเองและดานความ
ผูกพันตอเปาหมาย โดยมีลักษณะเปนแบบมาตรประมาณคา (rating scale) 5 ระดับ  และ 
ตอนที่ 4 เปนแบบทดสอบความสามารถทางคอมพิวเตอรที่ผูวิจัยสรางข้ึนเอง โดยมีลีกษณะเปน
แบบทดสอบปรนัยแบบ 4 ตัวเลือก จํานวน 35 ขอ 

การวิเคราะหขอมูล แบงออกเปน 4 สวน ไดแก สวนทีห่นึ่ง เปนการวเิคราะหขอมูลเบื้องตน 
โดยใชสถิติบรรยาย เพื่อใหทราบลักษณะของกลุมตัวอยางและลักษณะของตัวแปรที่ใชในการวิจัย  
โดยสถิติใชโปรแกรมสําเร็จรูป SPSS ไดแก คาความถี่ รอยละ คาเฉล่ียเลขคณิต ( x ) คาสวน
เบ่ียงเบนมาตรฐาน (S.D.) คาความเบ (skewness) คาความโดง (kurtosis) และคาสัมประสิทธิ์การ
กระจาย (coefficient of variation) สวนที่สอง เปนการวิเคราะหความแตกตางของระดับ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร โดยจําแนกตามสังกัด
และขนาดของโรงเรียน โดยใชการทดสอบความแตกตางของคาเฉลี่ยเลขคณิตคาที (t–test) สวนที่
สาม เปนการวิเคราะหความสัมพันธระหวางตัวแปรสังเกตไดที่ใชในการวิเคราะหโมเดลเชิงสาเหตุ 
โดยใชการวิเคราะหคาสัมประสิทธิ์สหสัมพันธแบบเพียรสัน (Pearson’s product-moment 
correlation coefficient)  และสวนสุดทาย เปนการตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
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คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ที่ผูวิจัยสรางข้ึนจากทฤษฎีและงานวิจัยที่
เกี่ยวของกับขอมูลเชิงประจักษ  พรอมทั้งคํานวณขนาดอิทธิพลทั้งทางตรงและทางออมของปจจัย
ที่สงผลตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร ดวย
โปรแกรม LISREL version 8.72 for WINDOWS 

จากกรอบแนวคิดในการวิจัย ผูวิจัยกําหนดสมมติฐานในการวิจัยคร้ังนี้ไว 3 ประการ ซึ่งมี
รายละเอียดอยูในบทที่ 2 ไดแก ประการแรก ปจจัยที่มีอิทธิพลเชิงสาเหตุโดยทางตรงตอการรับรู
ความสามารถดานคอมพิวเตอรของตนเอง ไดแก ระดับประสบการณเดิม บุคลิกภาพภายในของ
ผูเรียน ความมุงม่ันในการทํางาน และความวิตกกังวลในการใชคอมพิวเตอร   ประการทีส่อง ปจจัย
การรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีอิทธิพลเชิงสาเหตุโดยทางตรงและทางออม
ตอความสามารถทางคอมพิวเตอร โดยผานการตั้งเปาหมายและความผูกพันตอเปาหมาย และ
ประการสุดทายโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเอง                         
ที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ที่ผูวิจัย
พัฒนาข้ึนจากทฤษฎีและงานวิจัยที่เกี่ยวของสอดคลองกับขอมูลเชิงประจักษ 
 
สรุปผลการวจิัย 
 

 สําหรับผลการวิจัย สรุปได ดังนี ้
 1. ผลการวิเคราะหคาสถิติพื้นฐานของกลุมตัวอยางพบวา ผูตอบแบบสอบถามสวนใหญ
เปนนักเรียนช้ันมัธยมศึกษาปที่ 5 ในโรงเรียนขนาดใหญ สังกัดสํานักงานคณะกรรมการสงเสริม
การศึกษาเอกชน (สช.) ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตได เกี่ยวกับการรับรู
ความสามารถดานคอมพิวเตอรของตนเองและความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน
ที่ 4  ในกรุงเทพมหานคร จํานวน 13 ตัวแปร พบวา ตัวแปรสวนใหญมีคาเฉลี่ยอยูในระดับ            
ปานกลางคอนขางสูง  ( x = 2.84 – 3.95)  ยกเวน ตัวแปรคะแนนทดสอบโปรแกรมประมวลผลคํา 
(WORDPER) และ คะแนนทดสอบโปรแกรมนําเสนอผลงาน (PPTPER)  จะมีคาเฉล่ียเทากับ 10.05 
และ 7.33 จากคะแนนเต็ม 17 และ 18 คะแนนตามลําดับ  ซึ่งคิดเปนคะแนนโดยรวมมีคะแนน
เฉล่ียคิดเปนรอยละ 49.66 ของคะแนนเต็มทั้งหมด  โดยนักเรียนที่อยูในโรงเรียนสังกัดสํานักงาน
คณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) มีคะแนนเฉลี่ยความสามารถทางคอมพิวเตอรสูงกวา
โรงเรียนในสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) และนักเรียนที่อยูใน
โรงเรียนขนาดใหญมีคะแนนเฉลี่ยความสามารถทางคอมพิวเตอรสูงกวาโรงเรียนขนาดกลาง 
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ผลการวิเคราะหความสัมพันธระหวางตัวแปรสังเกตได พบวา สวนใหญมีความสัมพันธกัน
อยางมีนัยสําคัญที่ระดับ .01 โดยมีความสัมพันธที่เปนไปในทิศทางเดียวกัน และตัวแปรที่มี
ความสัมพันธกันมากที่สุดอยางมีนัยสําคัญ ไดแก  ตัวแปรระดับประสบการณในการใชโปรแกรม
ประมวลผลคํากับตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน  แสดงวา หาก
นักเรียนมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนก็จะสงผลใหประสบการณในการใช
โปรแกรมนําเสนอผลงานสูงข้ึนดวย ในขณะเดียวกันหากนักเรียนมีประสบการณในการใช
โปรแกรมนําเสนอผลงานสูงข้ึนก็จะมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนดวย
เชนกัน   นอกจากนั้นยังพบวา เมทริกซสหสัมพันธระหวางตัวแปรสังเกตไดมีความแตกตางจากเมท
ริกซเอกลักษณ (identity matrix) อยางมีนัยสําคัญที่ระดับ .01 เชนกัน นอกจากนั้นยังสอดคลอง
กับผลการวิเคราะหคาดัชนีไกเซอร – ไมเยอร - ออลคิน (Kaiser-Meyer-Olkin Measure of 
sampling adequacy) ซึ่งแสดงใหเห็นวาตัวแปรสังเกตไดของกลุมตัวอยางมีความสัมพันธภายใน
ตอกันและเหมาะสมท่ีจะนําไปใชในการพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                        
ในกรุงเทพมหานคร พรอมกับตรวจสอบความสอดคลองของโมเดลที่พัฒนาข้ึนกับขอมูลเชิง
ประจักษตอไป 

2. ผลการวิเคราะหความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                        
ในกรุงเทพมหานครกับขอมูลเชิงประจักษ พบวา โมเดลมีความสอดคลองกับขอมูลเชิงประจักษ 
และเปนไปตามสมมติฐานทั้ง 3 ประการที่ผูวิจัยไดตั้งไว โดยใหคาดัชนีความสอดคลองระหวาง
โมเดลตามกรอบแนวคิดกับขอมูลเชิงประจักษ ในรูปของคาไค-สแควร เทากับ 9.146 องศาอิสระ
เทากับ 11 ที่ระดับความนาจะเปน (p) เทากับ 0.608 ซึ่งสอดคลองกับผลการวเิคราะห คาดัชนีวัด
ระดับความกลมกลืน (GFI)  เทากับ 0.998  ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (AGFI) 
เทากับ 0.986 และดัชนีกําลังสองสวนเหลือ (RMR) เทากับ 0.020 โดยตัวแปรในโมเดลสามารถ
อธิบายความแปรปรวนโดยภาพรวมของการรับรูความสามารถดานคอมพิวเตอรของตนเอง การ
ต้ังเปาหมาย ความผูกพันตอเปาหมาย และความสามารถทางคอมพิวเตอรไดรอยละ 100.00 17.60 
30.20 และ 24.20 ตามลําดับ  

3. เมื่อพิจารณาอิทธิพลทางตรงและทางออม ที่สงผลตอตัวแปรความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร พบวาตัวแปรความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร ไดรับอิทธิพลทางตรงจากตัวแปรความ
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ผูกพันตอเปาหมายมากที่สุด อยางมีนัยสําคัญทางสถิติที่ระดับ.01 โดยมีขนาดอิทธิพลเทากับ 
0.338 รองลงมา คือ ตัวแปรการตั้งเปาหมาย โดยมีขนาดอิทธิพล เทากับ 0.309 นอกจากนี้ยังไดรับ
อิทธิพลทางออมจากตัวแปรการรับรูความสามารถทางดานคอมพิวเตอรของตนเอง โดยมีขนาด
อิทธิพลเทากับ 0.201 ตามลําดับ สําหรับปจจัยที่มีอิทธิพลรวมสูงสุดตอตัวแปรความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร อยางมีนัยสําคัญทางสถิติที่ระดับ .01 
ไดแก ตัวแปรดานความผูกพันตอเปาหมาย โดยมีขนาดอิทธิพลเทากับ 0.338 รองลงมา คือ             
ตัวแปรการต้ังเปาหมาย โดยมีขนาดอิทธิพล เทากับ 0.309 นอกจากนั้นยังพบวาตัวแปรการรับรู
ความสามารถดานคอมพิวเตอรของตนเอง ยังมีขนาดอิทธิพลรวมตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร อยางมีนัยสําคัญทางสถิติที่ระดับ .05
โดยมีขนาดอิทธิพล เทากับ 0.174 นอกจากนี้แลวยังมีตัวแปรที่มี อิทธิพลรวมตอตัวแปร
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครอยางไมมีนัยสําคัญ
ทางสถิติ ไดแก บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน ระดับประสบการณเดิม
และความวิตกกังวลในการใชคอมพิวเตอร   

4. เม่ือพิจารณาอิทธิพลทางตรงที่สงผลตอตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง พบวาตัวแปรบุคลิกภาพภายในของผูเรียนและตัวแปรความมุงมั่นในการ
ทํางานมีอิทธิพลทางตรงตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง โดยมีขนาด
อิทธิพลทางบวกเทากับ 0.877 และ 0.408 ตามลําดับ นอกจากนี้ตัวแปรระดับประสบการณเดิม 
และตัวแปรความวิตกกังวลในการใชคอมพิวเตอรมี อิทธิพลทางตรงตอต ัวแปรการร ับ รู
ความสามารถดานคอมพิวเตอรของตนเอง โดยมีขนาดอิทธิพลทางลบเทากับ -0.014 และ -0.516 
ตามลําดับ อยางไมมีนัยสําคัญทางสถิติที่ระดับ .05 

จากผลการวิเคราะหดังกลาว สามารถสรุปไดวา ความสามารถทางคอมพิวเตอรของ
นักเรียนชวงชั ้นที ่ 4  สามารถวัดดวยคะแนนทดสอบโปรแกรมนําเสนอผลงานไดดีที ่สุด และ
สําหรับการตั้งเปาหมาย พบวา ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน
จะสงผลตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานครมากที่สุด  
นอกจากนี้แลวการรับรูความสามารถดานคอมพิวเตอรของตนเองยังสงผลทางออมไปยัง
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครโดยตองผานความ
ผูกพันตอเปาหมายและการตั ้งเป าหมาย  กลาวคือ  ถานักเรียนชวงชั้นที่ 4 ไดมีการรับรู
ความสามารถดานคอมพิวเตอรของตนเองแลวขณะทํางานมีการต้ังเปาหมายและไดมีความผูกพัน
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ตอเปาหมายนั้นแลวก็จะสงผลใหนักเรียนมีความสามารถทางคอมพิวเตอรนั้นดวย ซึง่กคื็อจะทาํให
นักเรียนชวงชั้นที่ 4 มีระดับความสามารถทางคอมพิวเตอรที่สูงข้ึนนั่นเอง 
อภิปรายผลการวิจัย 
 

 จากสรุปผลการวิจัยที่นําเสนอไปขางตนแลวนั้น  จะเห็นไดวาโดยภาพรวมแลวมีความ
สอดคลองกับกรอบแนวคิดและสมมติฐานการวิจัย อยางไรก็ตาม ผลการวิจัยดังกลาว ยงัมปีระเด็น
ที่นาสนใจ ดังนี้  

1. ความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานครที่ศึกษา
พบวา นักเรียนสวนใหญมีความสามารถทางคอมพิวเตอรในระดับปานกลาง โดยมีคะแนนเฉลี่ย
คิดเปนรอยละ 49.66 ของคะแนนเต็ม  ซึ่งสอดคลองกับผลการทดสอบทางการศึกษาระดับชาติข้ัน
พื้นฐาน (O-NET) ชวงช้ันที่ 4 ปการศึกษา 2549 - 2550  (www.moc.moe.go.th/filedata/ONET_ANET.htm) 
ในวิชาการงานอาชีพและเทคโนโลยี พบวามีคะแนนเฉลี่ยคิดเปนรอยละ 49.53 ที่เปนเชนนี้          
อาจเนื่องมาจากครูผูสอนไมไดสอนตามคูมือครูและหนังสือเรียนวิชาการงานอาชีพและเทคโนโลยี 
ซึ่งจากงานวิจัยของสถาบันการสงเสริมการสอนวิทยาศาสตรและเทคโนโลยี (2549) พบวา ยังมีครู
ที่ไมไดใชคูมือครูและหนังสือเรียนสาระการเรียนรูพื้นฐานและเพิ่มเติมเทคโนโลยีสารสนเทศ                
ชวงชั้นที่ 4  อยูถึงรอยละ 33.0 ทั้งนี้ผูวิจัยสรางแบบทดสอบโดยอางอิงตามคูมือครูและหนังสือเรียน
วิชาการงานอาชีพและเทคโนโลยี  ชวงชั้นที่  4 จึงอาจเปนสาเหตุใหผลการศึกษาคร้ังนี้                      
พบวานักเรียนสวนใหญมีความสามารถทางคอมพิวเตอรอยูในระดับปานกลาง 
 จากผลการวิจัยที่พบวา นักเรียนที่อยูในโรงเรียนที่มีขนาดแตกตางกันจะมีความสามารถ
ทางคอมพิวเตอรแตกตางกัน โดยนักเรียนที ่อยู ในโรงเรียนขนาดใหญมีความสามารถทาง
คอมพิวเตอรมากกวานักเรียนที่อยูในโรงเรียนที่มีขนาดกลาง ทั้งนี้อาจเนื่องมาจากโรงเรียนขนาด
ใหญมีคุณภาพของการจัดการศึกษาดีกวาโรงเรียนที่มีขนาดเล็ก และมีความไดเปรียบในดาน
ความเพียงพอของครุภัณฑอุปกรณเทคโนโลยีสารสนเทศและอุปกรณการเรียนการสอน (กองวิจัย
การศึกษา, 2533) และสอดคลองกับงานวิจัยของมนัส ภาคภูมิ (2527) ที่ศึกษาพบวา ขนาดของ
โรงเรียนมีความสัมพันธตอคุณภาพการศึกษา โดยโรงเรียนขนาดใหญมีคุณภาพการศึกษาดีกวา
โรงเรียนขนาดกลาง ทั้งนี้จึงทําใหโรงเรียนขนาดใหญมีความพรอมในการจัดการเรียนการสอนใน
วิชาคอมพิวเตอรมากกวา มีอัตราสวนจํานวนเคร่ืองคอมพิวเตอรตอจํานวนนักเรียนและ                       
มีอัตราสวนจํานวนครูตอหองเรียนและนักเรียนในปริมาณที่สูง (สุวัฒนา สุวรรณเขตนิคม, 2528) 
ทําใหครูสามารถใกลชิดกับนักเรียนไดมากกวาโรงเรียนขนาดเล็กกวา ทําใหครูมีโอกาสไดมีเวลาให
คําปรึกษากับนักเรียนไดมากกวา  โรงเรียนสามารถจัดหาเคร่ืองคอมพิวเตอร อุปกรณเทคโนโลยี
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สารสนเทศและอุปกรณส่ือการเรียนการสอน ไดหลากหลายรูปแบบและมีปริมาณที่เพียงพอกับ
ความตองการของเด็กนักเรียน และนอกจากนั้นยังมีงบประมาณในการสนับสนุนกิจกรรมตางๆ             
ที่เกี่ยวของกับงานสารสนเทศตางๆของนักเรียนในโรงเรียนมากกวาโรงเรียนที่มีขนาดเล็กกวา 
ดังนั้นจึงทําใหนักเรียนที่เรียนในโรงเรียนขนาดใหญจึงมีความสามารถทางคอมพิวเตอรมากกวา
นักเรียนที่เรียนในโรงเรียนที่มีขนาดเล็กกวา 

นอกจากนี้นักเรียนที่อยูในโรงเรียนสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน 
(สพฐ.) จะมีคะแนนความสามารถทางคอมพิวเตอร ส ูงกว าโรงเร ียนในสังก ัดสํานักงาน
คณะกรรมการสงเสริมการศึกษาเอกชน (สช.) ซึ่งสอดคลองกับผลการทดสอบทางการศึกษา
ระดับชาติข้ันพื้นฐาน (O-NET)  ชวงชั้นที่ 4 ปการศึกษา 2550 ในวิชาการงานอาชีพและเทคโนโลยี 
โดยโรงเรียนในสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) จะมีคะแนนเฉลี่ยคิด
เปนรอยละ 49.65 ซึ่งมีคะแนนทดสอบ O-NET สูงกวาโรงเรียนในสังกัดสํานักงานคณะกรรมการ
สงเสริมการศึกษาเอกชน (สช.) โดยมีคะแนนเฉลี่ยคิดเปนรอยละ 47.90  
 

2. ความสัมพันธเชิงสาเหตุระหวางตัวแปรในโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในกรุงเทพมหานคร ซึ่งจากผลการวิเคราะหอิทธิพลทางตรงและทางออมที่สงผลตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร พบวาความสามารถ
ทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ไดรับอิทธิพลทางตรงจากตัวแปรความ
ผูกพันตอเปาหมายมากที่สุด อยางมีนัยสําคัญ รองลงมา คือ ตัวแปรการตั้งเปาหมาย นอกจากนี้
ยังพบวาความสามารถทางคอมพิวเตอรยังไดรับอิทธิพลทางออมจากการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง สําหรับตัวแปรที่มีอิทธิพลรวมสูงสุดตอตัวแปรความสามารถดาน
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร คือ ตัวแปรความผูกพันตอเปาหมาย  

การอภิปรายในประเด็นนี้ ผูวิจัยอภิปรายตามขนาดอิทธิพลของตัวแปรที่สงผลตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร ดังนี้ 

 2.1 ความผูกพันตอเปาหมาย 
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ไดรับอิทธิพล

รวมและอิทธิพลทางตรงที่เปนบวกอยางมีนัยสําคัญจากความผูกพันตอเปาหมายมากที่สุด ซึ่งวัด
ไดจากตัวแปรสังเกตได คือ ความผูกพันตอเปาหมาย  ซึ่งสอดคลองกับงานวิจัยของเมเออรและ 
บรุนเสตียน (2001) ที่ไดศึกษาเกี่ยวกับตัวแปรสําคัญ 3 อยาง คือ ความผูกพันตอเปาหมาย 
ความสําเร็จตอเปาหมายและความกาวหนาของเปาหมาย ซึ่งผลจากการศึกษาพบวา ตัวแปร
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ความผูกพันตอเปาหมายเปนตัวแปรกํากับที่สามารถสงผลตอความแตกตางในการผลสําเร็จของ
การทํางานของคนแตละคน และยังพบวาความกาวหนาของเปาหมายเปนตัวแปรสงผานที่สําคัญ
ตอความผูกพันตอเปาหมายอีกดวย  ซึ่งแสดงใหเห็นวาความผูกพันตอเปาหมายสงผลตอ
ความสามารถทางการทํางาน  กลาวคือถาคนใดมีความผูกพันตอเปาหมายนั้นๆแลว ก็จะสงผลให
คนนั้นมีประสิทธิภาพในการทํางานใดๆมากยิ่งข้ึน  และสัมพันธกับงานวิจัยของวรกานต  เส่ียง
อารมณ (2541) ที่ศึกษาเกี่ยวกับอิทธิพลความยากงายของเปาหมายและรางวัลมีตอผลงานและ
ความผูกพันตอเปาหมายพบวาคนท่ีทํางานจนบรรลุเปาหมายของตนเองแลวจะเกิดความผูกพัน
ตอเปาหมาย นั่นแสดงวาความผูกพันตอเปาหมายและความสามารถในการทํางานนั้นมี
ความสัมพันธกัน ดังนั้นถานักเรียนมีความผูกพันตอเปาหมายในการที่จะทํางานใหสําเร็จ มีความ
มั่นใจวาจะตองทํางานใหสําเร็จ โดยไมมีความกังวลใจและคิดวาเปาหมายที่นักเรียนไดกําหนดไว
เปนเปาหมายที่ดี ก็จะสามารถทําใหนักเรียนมีความสามารถทางคอมพิวเตอรมากยิ่งข้ึน 

 2.2 การต้ังเปาหมาย 
นอกจากนี้ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร                

ยังไดรับอิทธิพลรวมและอิทธิพลทางตรงที่ เปนบวกอยางมีนัยสําคัญจากการตั้งเปาหมาย                      
ดวยเชนกัน ซึ่งวัดจากตัวแปรสังเกตได ไดแก ระดับเปาหมายของผลสําเร็จในการใชโปรแกรม
ประมวลผลคําและระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน ซึ่งจากผลการ
วิเคราะหความสัมพันธระหวางตัวแปรสังเกตไดของตัวแปรการตั้งเปาหมาย ดังแผนภาพท่ี 4.1 
พบวา ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงานมีความสัมพันธกับการ
ต้ังเปาหมายมากที่สุดในทิศทางเดียวกัน  ซึ่งความสัมพันธระหวางการตั้งเปาหมายและ
ความสามารถทางคอมพิวเตอรไดสัมพันธกับงานวิจัยของภัทรียา มาลาทอง (2545) ที่พบวาการ
ต้ังเปาหมายทางการเรียนมีความสัมพันธทางบวกกับทัศนคติตอวิชาชีพพยาบาลอันจะสงผลใหมี
แนวทางในการกระทําพฤติกรรมตางๆอยางเหมาะสม ซึ่งสามารถกอใหเกิดแรงจูงใจภายในและ
นําไปสูความสําเร็จในการทํางาน และจากงานวิจัยของเพียรสัน (1997) ไดศึกษาเกี่ยวกับการ
ต้ังเปาหมายในคนงานพบวาในการทํางานของคนงานที่มีการต้ังเปาหมายจะมีผลงานปฏิบัติงานที่
ดีกวาคนที่ไมมีการต้ังเปาหมายในการทํางาน นอกจากนั้นยังสัมพันธกับงานของฮินส และเวอรลิน 
บี (1995) ที่ไดศึกษาเกี่ยวกับการเปรียบเทียบระดับของการตั้งเปาหมายในการทํางานกับผลการ
ปฏิบัติงาน พบวาในกลุมที่มีการต้ังเปาหมายจะมีผลการปฏิบัติงานที่ดีกวากลุมที่ไมมีการ
ต้ังเปาหมายในการทํางาน และสอดคลองกับคํากลาวของของ วอลช (1995) ที่กลาววาการ
ต้ังเปาหมายในการทํางานจะเปนส่ิงที่ดี หากไมมีจะเกิดผลเสียและไมไดผลตามเทาที่ควรจะเปน 
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ดังงานวิจัยของ ธนากร ศรีชาพันธ (2538) ที่ไดศึกษาผลของการตั้งเปาหมายที่มีตอความสามารถ
ในการเสิรฟเทนนิส พบวาความสามารถของกลุมคนที่ฝกการเสิรฟเทนนิสควบคูกับการ
ต้ังเปาหมายสูงกวาความสามารถของกลุมคนที่มีการเสริฟเทนนิสเพียงอยางเดียว  และจาก
งานวิจัยของพิสมัย สังขทอง (2539) ที่ไดศึกษาผลของการรวมมือในการอานโดยกลุมต้ังเปาหมาย
รวมกันที่มีตอการอานเขาใจความภาษาไทย พบวานักเรียนในกลุมที่เรียนดวยวิธีการรวมมือในการ
อานโดยกลุมต้ังเปาหมายรวมกัน จะมีคะแนนการอานเขาใจความภาษาไทยสูงกวานักเรียนกลุมที่
เรียนวิธีการสอนตามปกติของครู  ดังนั้นเพื่อชวยใหนักเรียนมีประสิทธิภาพในการทํางานมากข้ึน  
ครูสามารถทําไดโดยการสามารถสอนใหนักเรียนรูจักต้ังเปาหมายในการทํางานเพื่อใหผลงานที่
นักเรียนทําออกมามีประสิทธิภาพมากข้ึน  ในทํานองเดียวกันถาครูสอนวิชาคอมพิวเตอรไดสอนให
นักเรียนไดต้ังเปาหมายในการทํางานก็จะสงผลใหนักเรียนมีความสามารถทางคอมพิวเตอรมาก
ข้ึนได 

 2.3 การรับรูความสามารถดานคอมพิวเตอรของตนเอง 
นอกจากนั้นความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร      

ยังไดรับอิทธิพลรวมที่เปนบวกอยางมีนัยสําคัญจากการรับรูความสามารถดานคอมพิวเตอรของ
ตนเอง ซึ่งวัดไดจากตัวแปรสังเกตได ไดแก การรับรูความสามารถในการใชโปรแกรมประมวลผล
คําและการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน ซึ่งจากผลการวิเคราะห
ความสัมพันธระหวางตัวแปรสังเกตไดของตัวแปรการการรับรูความสามารถดานคอมพิวเตอรของ
ตนเอง ดังแผนภาพท่ี 4.1 พบวา การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา                         
มีความสัมพันธกับการรับรูความสามารถดานคอมพิวเตอรของตนเองมากที่สุดในทิศทางเดียวกัน 
ซึ่งความสัมพันธระหวางการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทาง
คอมพิวเตอรไดสัมพันธกับงานวิจัยของกรรณิการ จิตตบรรเทา (2539) ที่ไดศึกษาเกี่ยวกับ
ความสัมพันธระหวางการรับรูความสามารถของตนเองกับความสามารถในการอานเพื่อความ
เขาใจภาษาอังกฤษพบวาการรับรูความสามารถของตนเองมีความสัมพันธทางบวกกับ
ความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ เชนเดียวกับงานวิจัยของอมรรัตน              
บุบผโชติ (2546) ที่ไดศึกษาผลของการใชบันทึกการเรียนรูในการเรียนการสอนวิชาวิทยาศาสตรที่
มีผลตอการรับรูความสามารถของตนเองและความสามารถทางการเรียนวิชาวิทยาศาสตร          
ผลพบวาการรับรูความสามารถของตนเองมีความสัมพันธกับความสามารถทางการเรียนวิชา
วิทยาศาสตร   และยังสัมพันธกับงานวิจัยของ ดร.เดือนเพ็ญ ทองนวม (2545) ที่ไดศึกษาการรับรู
ความสามารถของตนเอง เปาหมายในการศึกษาและการเรียนรูโดยการกํากับตนเอง ผลพบวา
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นักศึกษาที่มีระดับการรับรูความสามารถของตนเองสูงก็จะสงผลใหนักศึกษาไดเกรดเฉล่ียสูงและ
ยังใชการเรียนโดยการกํากับตนเอง ดังงานวิจัยของรจเรข รัตนาจารย (2547) ที่พบวาการรับรู
ความสามารถของตนเองในวิชาวิทยาศาสตรมีความสัมพันธกับความสามารถทางการเรียนวิชา
วิทยาศาสตร   และยังสัมพันธกับชูชีพ ออนโคกสูง และอนุสรณ อรรถศิริ (2549) เกี่ยวกับตัวแปร 
การรับรูความสามารถของตนเอง การต้ังเปาหมายในการเรียน และความเปนไปไดที่จะกระทํากับ
แรงจูงใจในการเรียน  พบวาการรับรูความสามารถของตนเองมีความสัมพันธทางบวกกับการ
ต้ังเปาหมายในการเรียน  ดังนั้นถานักเรียนสามารถตัดสินความสามารถดานคอมพิวเตอรของ
ตนเองในการจัดการตนเองเพื่อใหไดบรรลุตามเปาหมายท่ีประสงคไวไดมากข้ึนก็จะสงผลให
นักเรียนมีความสามารถทางคอมพิวเตอรมากข้ึน 

3. ตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก บุคลิกภาพ
ภายในของผูเรียน ความมุงมั่นในการทํางาน ระดับประสบการณเดิมและความวิตกกังวลในการใช
คอมพิวเตอร โดยคาอิทธิพลทางตรงของตัวแปรเหลานี้จะสงผลตอการรับรูความสามารถดาน
คอมพิวเตอรของตนเองอยางไมมีนัยสําคัญทางสถิติ ดังนั้นบุคลิกภาพภายในของผูเรียน ความมุงมั่น
ในการทํางาน ระดับประสบการณเดิมและความวิตกกังวลในการใชคอมพิวเตอรจึงไมมี
ความสัมพันธกับการรับรูความสามารถดานคอมพิวเตอรของตนเอง ซึ่งสอดคลองกับงานวิจัยของ
ทวี นําสกุลวงศ (2550) ที่ไดศึกษาเกี่ยวกับปจจัยคัดสรรที่สงผลตอการรับรูความสามารถของ
อาจารยมหาวิทยาลัยเทคโนโลยีราชมงคลอีสาน ผลพบวาตัวแปรประสบการณจากตัวแบบ และ
ความวิตกกังวลไมสงผลตอตัวแปรการรับรูความสามารถของอาจารย และยังมีงานวิจัยของศิริโฉม 
หนูมี (2548) ที่ไดศึกษาเกี่ยวกับความสัมพันธระหวางความฉลาดทางอารมณ ความมุงมั่นสู
ความสําเร็จกับผลสัมฤทธิ์ทางการเรียนวิชาภาษาอังกฤษของนักศึกษามหาวิทยาลัยรัตนบัณฑิต
วิทยาศาสตรและเทคโนโลยี ผลพบวาความมุงมั่นสูความสําเร็จไมมีความสัมพันธกับผลสัมฤทธิ์
ทางการเรียนวิชาภาษาอังกฤษ  นอกจากนี้ยังสัมพันธกับงานวิจัยของสกุณา แตแดงเพชร (2526) ที่
ไดศึกษาเกี่ยวกับความสัมพันธระหวางบุคลิกภาพ ความถนัดทางการเรียนและผลสัมฤทธิ์ทางการ
เรียนของนักเรียนชั้นมัธยมศึกษาปที่ 6 โรงเรียนสาธิตคณะศึกษาศาสตร ผลพบวาบุคลิกภาพไมมี
ความสัมพันธกับผลสัมฤทธ์ิทางการเรียน ทั้งนี้อาจเนื่องมาจากลักษณะขอคําถามที่ใชวัดตัวแปร
บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางานและความวิตกกังวลในการใชคอมพิวเตอร 
เปนขอคําถามที่ผูวิจัยไดพัฒนามาจากแบบวัดของนักวิจัยชาวตางประเทศ ซึ่งขอคําถามจะมี
ลักษณะที่เหมาะสมกับกลุมตัวอยางที่เปนนักศึกษาตางประเทศมากกวา สวนตัวแปรระดับ
ประสบการณเดิมจะมีลักษณะขอคําถามที่ไมเหมาะสม คือ ขอคําถามจํานวนชั่วโมงที่นักเรียนใช



 135
 

โปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานใน 1 วัน ซึ่งตามปกติแลวนักเรียนจะใช
โปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานก็ตอเมื่อตองทํางานกับโปรแกรมนั้นจริงๆ
หรือไดรับมอบหมายงานมาจากรายวิชา ที่กําลังศึกษาอยู ดังนั้นจึงสงผลใหนักเรียนสวนใหญมี
จํานวนช่ัวโมงในการใชโปรแกรมประมวลผลคําและนําเสนอผลงานที่นอย ดังนั้นในการศึกษาคร้ัง
ตอไป จึงควรที่จะปรับขอคําถามใหเหมาะสมกับบริบทของคนไทย 
 
ขอเสนอแนะในการวิจยั 
  

 การนําเสนอในสวนนี้ แบงการนําเสนอเปน 2 สวน คือ สวนแรก เปนการนําเสนอเกี่ยวกับ
ขอเสนอแนะในการนําผลการวิจัยไปใช และสวนที่สอง เปนการนําเสนอขอเสนอแนะในการทําวิจัย
คร้ังตอไป ซึ่งมีรายละเอียด ดังนี้ 
 

 ขอเสนอแนะในการนําผลการวิจัยไปใช 
 จากผลการวิเคราะหโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอร
ของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในเขตกรุงเทพมหานคร 
พบประเด็นตาง  ๆ  ที่นาสนใจ  ซึ่ง ผูวิจัยขอเสนอแนะการนําผลการวิจัยไปใชเพื่อพัฒนา
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร ดังนี้ 
 1. จากขอคนพบของการวิจัยที่ชี้ใหเห็นวา ความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในเขตกรุงเทพมหานคร เปนผลมาจากปจจัยดานความผูกพันตอเปาหมายเปนสําคัญ 
เพราะฉะนั้น ครู ผูปกครอง และผูที่เกี่ยวของจึงควรพึงตระหนักไวเสมอวา การปลูกฝงและ
เสริมสรางความสามารถทางคอมพิวเตอรใหแกเด็กนั้นเปนหนาที่สําคัญอยางหนึ่งของทุกฝาย            
จึงควรพยายามทุกวิถีทางเพื่อใหเด็กเห็นคุณคาและประโยชนจากการใชคอมพิวเตอร สงเสริมให
เด็กรูจักใชเทคโนโลยีในทางที่ดี ทั้งนี้หากพอแมผูปกครอง หรือครูเปดโอกาสใหเด็กไดฝกใช
คอมพิวเตอรและการคนควาหาความรูผานคอมพิวเตอรบอย ๆ รวมทั้งใหการสนับสนุนการ
เสริมสรางทักษะทางคอมพิวเตอรแกเด็ก เชน จัดหาหนังสือคอมพิวเตอรเพิ่มเติม ระบบ
อินเตอรเน็ตที่เหมาะสมและตรงกับความสนใจของเด็ก จัดสถานที่และบรรยากาศใหเหมาะสมกับ
การใชคอมพิวเตอร และไมขัดขวางการใชคอมพิวเตอรและเทคโนโลยีของเด็ก รวมถึงรวมมือกับ
ทางโรงเรียนในการชวยกันสงเสริมการใชคอมพิวเตอรของเด็ก ก็จะสามารถทําใหเด็กมีความ
ผูกพันตอเปาหมายเพิ่มข้ึน ซึ่งเปนการสงเสริมใหเด็กมีความสามารถทางคอมพิวเตอรเพิ่มข้ึนไดอีก
ทาง 
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 2. จากการวิเคราะหโมเดลเชิงสาเหตุความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน   
ที่ 4 ในเขตกรุงเทพมหานครยังไดรับอิทธิพลทางตรงจากตัวแปรการต้ังเปาหมาย ซึ่งผูวิจัยขอ
เสนอแนะในการนําผลวิจัยไปใชในสวนนี้ เพื่อพัฒนาความสามารถทางคอมพิวเตอรของนักเรียน
ชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร โดยการที่ผูเรียนมีการต้ังเปาหมายหรือความคาดหวังในการ
เรียนรูไวนั้นจะสงผลใหเด็กมีแรงขับในการเรียนรู ทําใหมีความต้ังใจใฝรูในการเรียนวิชานั้น ๆ และ
เมื่อเด็กมีความมุงมั่นและต้ังใจแลวจะทําใหผลของการกระทํานั้นสําเร็จลุลวงไปไดดวยดี ดังนั้นใน
การจัดการเรียนการสอนคอมพิวเตอร ครูผูสอนจึงควรใหนักเรียนต้ังเปาหมายหรือความคาดหวังใน
การเรียนไวลวงหนาเพื่อใหนักเรียนมีแรงจูงใจในการเรียน และมีความต้ังใจในการเรียนในวิชา
คอมพิวเตอรเพื่อเปนการเพิ่มความสามารถทางคอมพิวเตอรของนักเรียนไดอีกทางหนึ่ง 

3. นอกจากนี้แลวยังมีตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง ซึ่งแมจะ
ไมมีอิทธิพลโดยตรงตอความสามารถทางคอมพิวเตอรแตก็มีอิทธิพลทางออมตอความสามารถ
ทางคอมพิวเตอร กลาวคือ ถานักเรียนไดมีการรับรูความสามารถดานคอมพิวเตอรของตนเองแลว
และนักเรียนไดต้ังเปาหมายในการทํางานจนเกิดความผูกพันตอเปาหมายนั้นแลวก็จะสงผลให
นักเรียนมีความสามารถทางคอมพิวเตอรเพิ่มข้ึนได ดังนั้นถาครูผูสอนในวิชาคอมพิวเตอรสามารถ
สงเสริมใหนักเรียนเกิดการรับรูความดานคอมพิวเตอรของตนเอง โดยทางโรงเรียนจะตองจัดหา
อุปกรณทางคอมพิวเตอรที่เหมาะสมและเพียงพอกับจํานวนนักเรียนแลวก็จะเปนการเพิ่ม
ความสามารถทางคอมพิวเตอรของนักเรียนได 
 

 ขอเสนอแนะในการวิจยัคร้ังตอไป 
1. การวิจัยในครั้งนี้  ใชการวิจัยเชิงปริมาณเพื่อสํารวจหาปจจัยที่สงผลทั้งทางตรงและ

ทางออมตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร                  
จึงควรทําการศึกษาหาปจจัยที่สงผลตอความสามารถทางคอมพิวเตอรในเชิงลึกโดยใชวิธีการ
วิจัยเชิงคุณภาพเพื่อตรวจสอบความสอดคลองและยืนยันผลการวิจัยซึ่งจะทําใหไดสารสนเทศ
เชิงลึกมากข้ึน 

2. ในการวัดความสามารถทางคอมพิวเตอรในการวิจัยคร้ังนี้วัดจากความสามารถในการ
ใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานเทานั้น ดังนั้นในการวิจัยคร้ังตอไปอาจทํา
การวัดความสามารถทางคอมพิวเตอรของนักเรียนโดยวัดจากตัวแปรสังเกตไดอ่ืนๆ ใหครอบคลุม
มากยิ่งข้ึน เชน ความสามารถในการใชอินเตอรเน็ต ความรูทางดานฮารดแวร ความรูทางดาน
เทคโนโลยีสารสนเทศและการส่ือสาร เปนตน 
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 3. จากการศึกษาพบวา ปจจัยดานบุคลิกภายในของผูเรียน ดานความมุงมั่นในการทํางาน 
ดานระดับประสบการณเดิม และดานความวิตกกังวลในการใชคอมพิวเตอรไมสงผลตอการรับรู
ความสามารถดานคอมพิวเตอรของตนเองและความสามารถทางคอมพิวเตอรของนักเรียน                
ซึ่งปจจัยดานตาง ๆ เหลานี้ เปนปจจัยที่เกี่ยวของกับพฤติกรรมของบุคคล ซึ่งมีความละเอียดและ
ซับซอน ดังนั้น จึงควรมีการศึกษาตัวแปรที่เกิดจากปจจัยภายนอกเพิ่มเติมไมวาจะเปนบุคคล        
ที่เกี่ยวของกับนักเรียน ตลอดจนสิ่งแวดลอมเพื่อใหโมเดลมีความสอดคลองกับขอมูลเชิงประจักษ
มากข้ึน 
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ภาคผนวก ก 

รายนามผูเชีย่วชาญในการตรวจสอบคุณภาพเคร่ืองมือ 
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ภาคผนวก ก 
รายนามผูเชีย่วชาญในการตรวจสอบคุณภาพเคร่ืองมือ 

 
1. ผูชวยศาสตราจารย ดร.ณัฎฐภรณ หลาวทอง อาจารยประจําภาควิชาวิจัยและจิตวทิยา

การศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย 
2. ผูชวยศาสตราจารย  ดร.พาสนา จุลรัตน อาจารยประจําภาควิชาการแนะแนวและ

จิตวิทยาการศึกษา คณะศึกษาศาสตร  มหาวิทยาลัยศรีนครินทรวิโรฒฯ 
  3. อาจารย ดร.สกล วรเจริญศรี อาจารยประจําภาควิชาการแนะแนวและจิตวิทยา
การศึกษา คณะศึกษาศาสตร มหาวิทยาลัยศรีนครินทรวิโรฒฯ 

4. อาจารย ดร. ประกอบ กรณีกิจ อาจารยประจําภาควิชาหลักสูตร การสอนและ
เทคโนโลยีการศึกษา สาขาเทคโนโลยีการศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย 

5. อาจารยชยการ  คีรีรัตน อาจารยประจํากลุมสาระการงานอาชีพและเทคโนโลยี  
โรงเรียนสาธิตจุฬาลงกรณมหาวิทยาลัย 
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ภาคผนวก ข 
หนังสือขอความรวมมือ 
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ภาคผนวก ค 

ตัวอยาง คูมอืการดําเนนิงานเก็บขอมูลสาํหรับคร ู
แบบสอบถามและแบบทดสอบ 
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คูมือการดําเนินการเก็บขอมูลแบบสอบถามและแบบทดสอบสาํหรับคร ู
 
จุดมุงหมาย 

แบบสอบถามและแบบทดสอบฉบับนี้สรางข้ึนเพื่อเปนเครื่องมือสําหรับศึกษาปจจัยที่มี
อิทธิพลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองกับความสามารถทางคอมพิวเตอร
ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร  

 
ลักษณะของแบบสอบถามและแบบทดสอบ 

แบบสอบถามและแบบทดสอบชุดนี้ แบงออกเปน 4 ตอน ดังนี ้ตอนที่ 1 เปนขอมลูทั่วไป
ของนักเรียน ตอนที่ 2 เปนแบบสอบถามปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร
ของตนเอง ตอนที ่ 3 เปนแบบสอบถามปจจัยที่สงผลตอความสามารถทางคอมพิวเตอรและตอน            
ที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร โดยวธิีตอบใหนกัเรียนตอบโดยทาํเคร่ืองหมายลง
ไปในแบบสอบถามและแบบทดสอบ รวมใชเวลาในการทําแบบสอบถามและแบบทดสอบทัง้หมด 
45 นาท ี
 
วิธีดําเนินการเก็บขอมูล 

ในการดําเนนิการสอบควรดําเนนิการในหองที่มีสภาพแวดลอมที่เหมาะสม มทีี่นัง่สามารถ 
เขียนไดสะดวกโดยการดําเนินการตอบแบบสอบถามและแบบทดสอบแบงเปน 3 ระยะ คือ                 
การเตรียมตัวกอนทําแบบสอบถามและแบบทดสอบ วิธีปฏิบัติขณะทําแบบสอบถามและ
แบบทดสอบ และเม่ือหมดเวลาทําแบบสอบถามและแบบทดสอบ ซึ่งมีข้ันตอนดังนี้ 

1. การเตรียมตัวกอนตอบแบบสอบถามและแบบทดสอบ 
  1.1 เตรียมแบบสอบถามและแบบทดสอบใหเรียบรอย มีผูดําเนินการ

สอบ 1 คน หรือมากกวา และจัดที่นั่งใหเพียงพอแกผูเขาสอบ 
  1.2 การเตรียมตัวสําหรับผูดําเนินการสอบ ผูดําเนินการสอบจะตอง

ศึกษาคําชี้แจงในการทําแบบสอบถามและแบบทดสอบลวงหนา เพื่อใหสามารถดําเนินการได
อยางถูกตอง 

 2. วิธีดําเนินการ 
  2.1 ผูดําเนินการแจกแบบสอบถามเก่ียวกับเหตุและผลของการรับรู

ความสามารถดานคอมพิวเตอรใหแกผูตอบคนละ 1 ชุด 
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  2.2 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบสอบถาม 
   2.3 จากนั้นใหผูสอบลงมือทําแบบสอบถามโดยใชเวลา 15 นาที โดย
ผูดําเนินการสอบใหสัญญาณแกผูสอบไดลงมือทําพรอมกัน 

2.4 เมื่อหมดเวลาผูดําเนินการเก็บแบบสอบถามและแจกแบบทดสอบ
ความสามารถทางคอมพิวเตอรใหแกผูสอบคนละ 1 ชุด  

  2.5 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบทดสอบ 
  2.6 จากนั้นใหผูสอบลงมือทําแบบทดสอบ โดยใชเวลา 30 นาที โดย

ผูดําเนินการสอบใหสัญญาณแกผูสอบไดลงมือทําพรอมกัน 
 3. วิธีปฏิบัติเมื่อหมดเวลา 
  3 .1  ผู ดํ า เนินการสอบแจ ง เวลาที่ เห ลือในการทําแบบทดสอบ 

เปน 3 ระยะ คือ 
   3.1.1 เมื่อเวลาในการสอบผานไป 15 นาที 
   3.1.2 เมื่อเหลือเวลาอีก 5 นาที จะหมดเวลาในการทํา 
   3.1.3 เมื่อหมดเวลาในการทํา 
  3.2 เมื่อหมดเวลาในการทําแบบทดสอบแลว ผูดําเนินการสอบใหผูสอบ

วางดินสอหรือปากกาและหยุดทําแบบทดสอบทันที 
  3.3 ในกรณีที่ผูตอบทําแบบทดสอบเสร็จกอนเวลาที่กําหนดใหผูสอบผู

นั้นออกไปนอกหองสอบกอน เพื่อไมใหรบกวนสมาธิในการทําแบบทดสอบของผูสอบคนอ่ืนๆ 
หลังจากนั้น เมื่อผูสอบทําแบบทดสอบเสร็จทั้งหองสอบแลว ผูดําเนินการสอบจึงเก็บแบบทดสอบ
ตามลําดับเลขที่ผูสอบ แลวรวบรวมแบบสอบถามและแบบทดสอบสงกลับคืนฝายวิชาการของ
โรงเรียน 
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แบบสอบถามและแบบทดสอบเพื่อการวิจยั 
เรื่อง  

การพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอร 
ของตนเองท่ีมีตอความสามารถทางคอมพิวเตอร 

 
""""""""""""""" 

 
 
 

        คําชี้แจง 
 1.แบบสอบถามและแบบทดสอบฉบับนี้มีวัตถุประสงคเพ่ือศึกษาปจจัยที่มีอิทธิพลตอการรับรู  
ความสามารถดานคอมพิวเตอรของตนเองกับความสามารถทางคอมพิวเตอรของนักเรียน 
ชวงช้ันที่ 4 ในกรุงเทพมหานคร  ขอใหนักเรียนตอบแบบสอบถามใหตรงกับความเปนจริงมากที่สุด   
 2.ขอมูลจากการตอบแบบสอบถามและแบบทดสอบของนักเรียนมีความสําคัญย่ิงตอความ
สมบูรณในการวิจัยจึงขอความกรุณาจากนักเรียนในการตอบคําถามใหครบทุกขอ 
 3.ขอมูลจากการตอบแบบสอบถามและแบบทดสอบของนักเรียนจะถือเปนความลับและไมมี
ผลกระทบใดๆ ตอนักเรียนท้ังส้ิน 
 4. แบบสอบถามและแบบทดสอบชุดนี้ใชเวลาในการทํา 45 นาที 
 5. แบบสอบถามและแบบทดสอบชุดน้ี แบงออกเปน 4 ตอน ดังนี้ 
   ตอนที่ 1 ขอมูลทั่วไปของนักเรียน 
   ตอนที่ 2 แบบสอบถามปจจัยที่สงผลตอการรับรูความสามารถ 
                ดานคอมพิวเตอรของตนเอง 
   ตอนที่ 3 แบบสอบถามปจจัยที่สงผลตอความสามารถทาง 
                คอมพิวเตอร  
   ตอนที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร 

 
               ขอขอบพระคุณที่ใหความรวมมือดวยดี 
            นายชุติวัฒน  สุวัตถิพงศ 
                            ผูวิจัย 

 
 

3  ขอมูลของทานมีประโยชนอยางยิง่สําหรับผูวิจยั  3 
ขอขอบคุณอยางสูงที่กรุณาตอบแบบสอบถาม 
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 ตอนที่ 1 ขอมูลทั่วไปของนักเรียน 
 คําช้ีแจง  โปรดทําเคร่ืองหมาย   ลงในชองวาง  หนาขอความที่ตรงกับความเปนจริงของนักเรียน   

                  และเติมขอความลงในชองวางตามความเปนจริง 
1. เพศ                               � 1) ชาย � 2) หญิง 
2. อายุ ………………………... ป                    
3. ศึกษาอยูในระดับชั้น                  
 

� 1) มัธยมศึกษาปที่ 4        
� 3) มัธยมศึกษาปที่ 6 

� 2) มัธยมศึกษาปที่ 5 

4. แผนการเรียน                              � 1) วิทย - คณติ                       
� 3) ศิลป – ภาษา         

� 2) ศิลป – คํานวณ 
� 4) อื่นๆระบ.ุ.............................. 

5. ประสบการณในการใชคอมพิวเตอร 
     � 1) นอยกวา 1 ป 
     � 4)  5 – 6 ป               

� 2)  1 – 2  ป 
� 5) มากกวา 6 ป                        

� 3) 3 – 4 ป 

6. โดยปกตินักเรียนใชคอมพิวเตอรบอยเพียงใด ( ระบุจํานวนชั่วโมงโดยเฉล่ียตอวัน ) 
     � 1) นอยกวา 1 ชั่วโมง / วัน 
     � 4) 5 – 6  ชั่วโมง / วัน   

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน    

� 3) 3 – 4  ชั่วโมง / วัน  

7. นกัเรียนมีประสบการณในการใชโปรแกรมประมวลผลคํา ( Microsoft Word )  
     � 1) นอยกวา 1 ป 
     � 4)  5 – 6 ป               

� 2)  1 – 2  ป 
� 5) มากกวา 6 ป                        

� 3) 3 – 4 ป 

8. โดยปกตินักเรียนใชโปรแกรมประมวลผลคํา ( Microsoft Word )  คําบอยเพียงใด  
    ( ระบุจํานวนชัว่โมงโดยเฉล่ียตอวัน )  
     � 1) นอยกวา 1 ชั่วโมง / วัน 
     � 4) 5 – 6  ชั่วโมง / วัน   

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน    

� 3) 3 – 4  ชั่วโมง / วัน  

9. นกัเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมประมวลผลคํา ( Microsoft Word )   
    ไวรอยละเทาใด  
     � 1) รอยละ 0 - 20  
     � 4) รอยละ 61 – 80   

� 2) รอยละ 21 – 40 
� 5) รอยละ 81 – 100    

� 3) รอยละ 41 – 60 

10. นกัเรียนมีประสบการณในการใชโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint )  
     � 1) นอยกวา 1 ป 
     � 4)  5 – 6 ป               

� 2)  1 – 2  ป 
� 5) มากกวา 6 ป                        

� 3) 3 – 4 ป 

11. โดยปกตินักเรียนใชโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint ) บอยเพียงใด  
     ( ระบจุํานวนชั่วโมงโดยเฉลี่ยตอวัน )  
     � 1) นอยกวา 1 ชั่วโมง / วัน 
     � 4) 5 – 6  ชั่วโมง / วัน   

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน    

� 3) 3 – 4  ชั่วโมง / วัน  
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12. นกัเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint ) 
      ไวรอยละเทาใด 
     � 1) รอยละ 0 - 20  
     � 4) รอยละ 61 – 80   

� 2) รอยละ 21 – 40 
� 5) รอยละ 81 – 100    

� 3) รอยละ 41 – 60 

 
 ตอนที่ 2 แบบสอบถามปจจัยทีส่งผลตอการรับรูความสามารถดานคอมพิวเตอร 
            ของตนเอง 
 
คําชี้แจง   ใหนักเรียนพิจารณาขอความตอไปน้ี แลวทําเคร่ืองหมาย  ลงในชองวางท่ีตรงกับ 
 ความคิดเห็นของนักเรียนมากท่ีสุด  ดังตัวอยางตอไปน้ี 

      ตัวอยาง 
ระดับความคิดเห็น 

ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

  ป
าน
กล
าง

 

นอ
ย 

นอ
ยท
ี่สุด

 

00 หากฉันไดพยายามทํางาน ฉันจะมีความสุข       
จากตัวอยาง นักเรียนทําเครื่องหมาย   ลงในชองระดับความคิดเห็น “มาก” หมายถึง ถานักเรียน 

ไดมีความพยายามทํางานอยางใดอยางหน่ึงจะทําใหตนเองมีความสุขมากกวามีความทุกขใจ 
ระดับความคิดเห็น 

ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 
 บุคลิกภาพภายในของผูเรียน  

1 ฉันพึงพอใจในความสําเร็จตามท่ีสมควรจะไดรับ      
2 เม่ือฉันพยายาม ฉันจะประสบความสําเร็จในการทํางาน      
3 ฉันทํางานไดอยางสมบูรณและประสบความสําเร็จอยางดี      
4 ฉันรูสึกภูมิใจกับการทํางานของตนเอง      
5 ฉันตัดสินใจเลือกทําส่ิงตางๆไดอยางม่ันใจ      
6 เม่ือเกิดปญหาขึ้น ฉันสามารถรับมือกับปญหาเหลานั้นได      
7 ฉันเปนที่รักใครของผูอื่น      
8 ฉันจะทําในส่ิงที่ถูกตองและเต็มความสามารถเสมอ      
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ระดับความคิดเห็น 

ขอที่                        ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

9 ในการทํางานบางคร้ัง ฉันรูสึกมีความกดดันตอตนเอง      
10 บางคร้ังเมื่อฉันทํางานลมเหลว ฉันจะรูสึกวาตนเองไรคา      
11 บางคร้ังฉันรูสึกควบคุมการทํางานตางๆของฉันไมไดเลย      
12 ฉันมักจะสงสัยในความสามารถของตนเอง      
13 ฉันรูสึกกังวลท่ีฉันไมสามารถทํางานใหสําเร็จได      
14 บางคร้ังฉันรูสึกทอแทในชีวิต      
15 ฉันไมสามารถเปนที่พึ่งของใครไดเลย      
16 ปกติแลวไมคอยมีคนอื่นมาใสใจกับฉันมากนัก      

 ความมุงม่ันในการทํางาน  
17 โอกาสที่ในการจะไดทํางานที่ทาทายเปนส่ิงสําคัญสําหรับฉัน      
18 เม่ือลมเหลวในการทํางานชิ้นที่ยาก  ฉันวางแผนท่ีจะ 

พยายามใหมากข้ึนในการทํางานครั้งตอไป 
     

19 ฉันเลือกท่ีจะทํางานท่ีทําใหฉันไดเรียนรูส่ิงใหม ๆ      
20 โอกาสที่จะไดทําส่ิงใหม ๆ เปนส่ิงทาทายสําหรับฉัน      
21 ฉันพยายามอยางดีที่สุดเม่ือตองทํางานท่ีคอนขางยาก      
22 ฉันพยายามทุกคร้ังที่จะปรับปรุงการปฏิบัติงานท่ีผานมา 

ใหดีขึ้น 
     

23 โอกาสในการพัฒนาความสามารถเปนส่ิงสําคัญสําหรับฉัน      
24 เม่ือพบความยุงยากในการแกปญหา ฉันชอบลองหลาย ๆ  

ทางเพื่อหาวิธีที่ดีที่สุด 
     

 ความวิตกกังวลในการใชคอมพิวเตอร  
25 ฉันไมกลาใชคอมพิวเตอรเพราะกลัววาจะทําผิดพลาด  

แลวแกไขไมได 
     

26 ฉันรูสึกกลัวการใชคอมพิวเตอร      
27 ฉันหลีกเล่ียงการใชคอมพิวเตอรเพราะรูสึกไมคุนเคย      
28 ฉันรูสึกกลัวการใชคอมพิวเตอร แคคิดวาฉันอาจทําลายขอมูล

มากมายในเคร่ือง  เพียงแคกดปุมผิดคร้ังเดียว 
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ตอนที่ 3 แบบสอบถามปจจัยท่ีสงผลความสามารถทางคอมพิวเตอร  
 

คําชี้แจง    ใหนักเรียนพิจารณาขอความตอไปน้ี แลวทําเคร่ืองหมาย  ลงในชองวางท่ีตรงกับ 
 ความคิดเห็นของนักเรียนมากท่ีสุด  ดังตัวอยางตอไปน้ี 
ตัวอยาง 

ระดับความคิดเห็น 
ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

  ป
าน
กล
าง

 

นอ
ย 

นอ
ยท
ี่สุด

 

00 หากฉันไดพยายามทํางาน ฉันจะมีความสุข       
 

จากตัวอยาง นักเรียนทําเคร่ืองหมาย   ลงในชองระดับความคิดเห็น “มาก” หมายถึง ถานักเรียน
ไดมีความพยายามทํางานอยางใดอยางหน่ึงจะทําใหตนเองมีความสุขมากกวามีความทุกขใจ 
 

ระดับความคิดเห็น 
ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

  ป
าน
กล
าง

 

นอ
ย 

นอ
ยท
ี่สุด

 

การรับรูความสามารถดานคอมพิวเตอรของตนเอง 
 การรับรูความสามารถในการใชโปรแกรม 

ประมวล ผลคํา( Microsoft Word ) 
 

1 ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของ
โปรแกรมประมวลผลคําได 

     

2 ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของแถบ
เคร่ืองมือในโปรแกรมประมวลผลคําได 

     

3 ฉันเชื่อวาฉันสามารถสราง บันทึกและเปดเอกสารรวมถึง
แทรกขอความลงในเอกสารนั้นๆได 

     

4 ฉันเชื่อวาฉันสามารถต้ังคาหนากระดาษ ต้ังก้ันหนาและก้ัน
หลังขอความได 

     

5 ฉันเชื่อวาฉันสามารถกําหนดตําแหนงของแท็บและเลือกใช
แท็บใหเหมาะสมกับงานได 

     

6 ฉันเชื่อวาฉันสามารถเลือกขอความ ยายขอความ คัดลอก
และลบขอความได 

     

7 ฉันเชื่อวาฉันสามารถจัดรูปแบบขอความ รวมไปถึงการ
กําหนดหมายเลขลําดับ และเคร่ืองหมายหนาขอความได 
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ระดับความคิดเห็น 
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8 ฉันเชื่อวาฉันสามารถปรับเปล่ียนลักษณะของตัวอักษร
เปล่ียนสีใหตัวอักษรและใสสีพื้นหลังใหกับขอความได 

     

9 ฉันเชื่อวาฉันสามารถปรับระยะหางระหวางตัวอักษร  
บรรทัดและยอหนาได 

     

10 ฉันเชื่อวาฉันสามารถแทรกสัญลักษณพิเศษและอักขระพิเศษ
ลงในเอกสารได  

     

11 ฉันเชื่อวาฉันสามารถใสกรอบใหกับขอความ เอกสารและ
แบงคอลัมนได 

     

12 ฉันเช่ือวาฉันสามารถเรียกดูเอกสารกอนพิมพและส่ังพิมพได      
13 ฉันเชื่อวาฉันสามารถสรางตาราง แทรกแถวและคอลัมน ได      
14 ฉันเชื่อวาฉันสามารถผสานเซลล และแยกเซลลตางๆ

ตลอดจนตกแตงตารางได 
     

15 ฉันเชื่อวาฉันสามารถสรางวัตถุรูปวาด  
ตัวอักษรศิลปและสามารถแทรกรูปภาพได 

     

16 ฉันเชื่อวาฉันสามารถใสขอความในหัวกระดาษ  
ทายกระดาษและหมายเลขหนาได 

     

17 ฉันเชื่อวาฉันสามารถสรางและบอกประโยชนของ 
จดหมายเวียนได 

     

 การรับรูความสามารถในการใชโปรแกรมนําเสนอ
ผลงาน( Microsoft Powerpoint ) 

 

18 ฉันเชื่อวาฉันสามารถอธิบายเก่ียวกับความสามารถของ
โปรแกรมนําเสนอผลงานได 

     

19 ฉันเชื่อวาฉันสามารถสราง บันทึก เปดและปดงานนําเสนอ
ผลงานได 

     

20 ฉันเชื่อวาฉันสามารถบอกความแตกตางของมุมมองในการ
ทํางานของโปรแกรมนําเสนอผลงานได 

     

21 ฉันเช่ือวาฉันสามารถเปล่ียนลําดับ ลบและเพิ่มสไลดไดถูกตอง      

22 
ฉันเชื่อวาฉันสามารถใสขอความ กําหนดขนาด ตัวหนา     
ตัวเอน ตัวขีดเสนใตและใสเงาใหกับขอความได 
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ระดับความคิดเห็น 
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23 ฉันเชื่อวาฉันสามารถใสตัวเลขและสัญลักษณแสดงลําดับ
หัวขอได 

     

24 ฉันเชื่อวาฉันสามารถใชเคร่ืองมือวาดและทํางานกับวัตถุได      

25 ฉันเชื่อวาฉันสามารถบอกความแตกตางของภาพแบบ
เวคเตอร (Vector) กับภาพแบบราสเตอร (Raster) ได 

     

26 ฉันเชื่อวาฉันสามารถปรับแตงภาพจากภาพได      

27 ฉันเชื่อวาฉันสามารถสรางกราฟและแผนผังลงในสไลดได      

28 ฉันเชื่อวาฉันสามารถตกแตงพื้นหลัง และสรางแมแบบ 
(Template) ได 

     

29 ฉันเชื่อวาฉันสามารถกําหนดเอฟเฟคใหกับวัตถุตางๆ
ตลอดจน Transition ได 

     

30 ฉันเชื่อวาฉันสามารถเพิ่มเสียงประกอบทั้งภายในและ
ภายนอกโปรแกรมเพื่อทําเอฟเฟคใหกับขอความได 

     

31 ฉันเชื่อวาฉันสามารถกําหนดรูปแบบการเชื่อมโยงสไลดได      
32 ฉันเชื่อวาฉันสามารถกําหนดคุณสมบัติของเอกสารกอนพิมพ

และใชคําส่ังพิมพไดอยางถูกวิธี 
     

33 ฉันเชื่อวาฉันสามารถแสดงสไลดงานนําเสนอท่ีสรางเสร็จ 
แลวได 

     

ความผูกพันตอเปาหมาย 
34 ฉันรูสึกม่ันใจวาตองทํางานนี้ใหสําเร็จได      
35 หลังไดรับมอบหมายงาน ฉันไมสนใจวางานที่ฉันทําจะบรรลุ

เปาหมายหรือไม 
     

36 เปนไปไดวา เปาหมายที่ฉันต้ังอาจตองไดรับการทบทวน 
ขึ้นอยูกับวา งานดําเนินไดดีแคไหน 

     

37 ฉันไมกังวลมากนัก หากตองท้ิงเปาหมายที่ฉันต้ังไวไป        
38 เปนการยากสําหรับฉัน ในการที่จะต้ังใจดําเนินตาม

เปาหมายอยางจริงจัง 
     

39 ฉันคิดวาเปาหมายของการทํางานน้ีเปนเปาหมายที่ดี 
ในการเร่ิมดําเนินการ 
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 ตอนที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร 
 
      คําชี้แจง   ใหนักเรียนทําแบบทดสอบ โดยเลือกคําตอบขอท่ีถูกตองท่ีสุดเพียงคําตอบเดียว 
  แลวทําเคร่ืองหมาย 8 บนตัวเลือกน้ัน  ดังตัวอยางตอไปน้ี 
      ตัวอยาง 
 

      0. เมื่อตองการตัดขอความที่ไดเลือกเอาไว ตองคลกิที่ปุมใด 
 1.  2.  
 3.  4.  

 
จากตัวอยาง ถานักเรียนคิดวาตัวเลือกท่ี 1 ถูกตองก็ใหนักเรียนทําเครื่องหมาย 8 บนตัวเลือก  

ท่ี 1 ตามตัวอยาง  
 

     0. เมื่อตองการตัดขอความท่ีไดเลือกเอาไว ตองคลกิที่ปุมใด 
 1.  2.  
 3.  4.  
 

แบบทดสอบมี 2 สวน สวนท่ี 1 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใช
โปรแกรมประมวลผลคํา และสวนท่ี 2 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใชโปรแกรม
นําเสนอผลงาน 
 
สวนที่ 1 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใชโปรแกรมประมวลผลคํา 
1.  
 
 
 จากภาพในแถบวงรีคือแถบที่แสดงขอมูลสวนใดของโปรแกรม 
 1. เมนูบาร (Menu Bar) 2. ทูลบาร  (Tool Bar) 
 3. ออพช่ันบาร (Option Bar) 4. คอมมานดบาร (Command Bar) 
2. เม่ือตองการเปดเอกสารเดิมและบันทึกเอกสารจะตองคลิกที่ปุมสัญลักษณใดตามลําดับ 
 1.    และ   2.   และ   

 3.    และ   4.    และ   

8 
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3. ถานักเรียนตองการกําหนดขนาดกระดาษในการทํางานเปนขนาด Legal นักเรียนตองทําอยางไร 
 1. Edit > Page Setup > Paper > Paper Margin = A4 
 2. Edit > Page Setup > Paper > Paper Size = Legal 
 3. File > Page Setup > Paper > Paper Margin = A4 
 4. File > Page Setup > Paper > Paper Size = Legal 
4. ขอใดกลาวผิดเก่ียวกับสัญลักษณในการกําหนดตําแหนงแท็บ 
  1.   ใชกําหนดใหขอความจัดชิดแท็บทางดานซาย 
  2.    ใชกําหนดใหจุดทศนิยม อยูในแนวเดียวกับตําแหนง  ในไมบรรทัดแนวนอน เหมาะกับการ

เรียงตัวเลขใหจุดทศนิยมตรงกัน 
  3.    ใชกําหนดเสนในแนวนอน ใหอยูในแนวเดียวกับตําแหนงไมบรรทัดในแนวต้ัง 
         4.   ใชกําหนดใหขอความจัดก่ึงกลางแท็บ 
5. เม่ือตองการคัดลอกขอความที่ไดเลือกเอาไว ตองคลิกท่ีปุมใด 
 1.  2.  
 3.  4.  
6. การจัดขอความทั้งยอหนาใหอยูก่ึงกลางหนากระดาษตองคลิกท่ีปุมใด หรือใชคําส่ังใดในการจัดยอหนา 
  1. คลิกท่ีปุม  หรือใชคําส่ัง Format > Paragraph > Alignment = Left 
  2. คลิกท่ีปุม  หรือใชคําส่ัง Format > Paragraph > Alignment = Centered 
  3. คลิกท่ีปุม  หรือใชคําส่ัง Format > Paragraph > Alignment = Right 
  4. คลิกท่ีปุม   หรือใชคําส่ัง Format > Paragraph > Alignment = Jusitified 
7. เม่ือตองการปรับแตงปุมเคร่ืองหมายหนาขอความใหเปนเคร่ืองหมายตางๆสามารถทําไดอยางไร 
  1. Format > Bullet and Numbering หรือคลิกที่ปุม  
  2. Insert > Bullet and Numbering หรือคลิกท่ีปุม  
  3. Format > Bullet and Numbering หรือคลิกที่ปุม   
         4. Insert > Bullet and Numbering หรือคลิกท่ีปุม  
8. เม่ือเลือกขอความ “คอมพิวเตอร” แลวคลิกปุม  และปุม  ขอความจะเปนอยางไร 
  1. คอมพิวเตอร 2. คอมพิวเตอร 
  3. คอมพิวเตอร 4. คอมพิวเตอร 
9. ขอใดกลาวถูกตองเกี่ยวกับการจัดยอหนา 
  ก. การปรับระยะหางระหวางบรรทัดตองเลือกเมนู Edit และเลือกคําส่ัง Ruler 
  ข. การปรับระยะหางระหวางยอหนาทําไดโดยการคลิกเมาสปุมขวาในยอหนาท่ีตองการ  
                     แลวเลือกคําส่ัง   Paragraph 
 1. ขอ ก  ถูกตอง 2. ขอ ข ถูกตอง 
 3. ขอ ก และ ข ถูกตอง 4. ไมมีขอใดถูกตอง 
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10. ขั้นตอนในการแทรกสัญลักษณพิเศษหรืออักขระพิเศษลงในเอกสารสามารถทําไดอยางไร 
  ก. จากกลองโตตอบ Symbol ในชอง Font ใหเลือกรายการของรูปแบบที่ตองการ 
  ข. คลิกปุม Insert  เพ่ือแทรกสัญลักษณที่จุดแทรกขอความในเอกสาร 
  ค. คลิกเลือกสัญลักษณที่ตองการแทรกเขาไปในเอกสาร 
  ง. คลิกเลือกเมนู Insert แลวเลือกคําส่ัง Symbol 
 1. ง – ก – ค – ข  2. ง – ข – ค – ก 
 3. ข – ก – ค –ง 4. ก – ง – ค – ข 
11. ถาตองการกําหนดรูปแบบของกรอบขอความใหเปนเสนประ จะตองกําหนดที่หัวขอใด ในแท็บ Borders  
 ของกลองโตตอบ Borders and Shading  
  1. Setting 2. Style 
  3. Color 4. Width 
12. การเรียกดูเอกสารกอนพิมพคร้ังละหลายๆหนา ตองคลิกท่ีปุมใด 
  1.  2.  
  3.  4.  
13. เม่ือตองการพิมพเอกสารหนา 14 ถึง หนา 20 โดยพิมพเฉพาะหนาคูตองปอนตัวเลขในชอง Pages อยางไร 
  1. 14 – 20 2. 14 – 16 , 18 – 20  
  3.  20 – 14  4. 14, 16 , 18 , 20  
14. ขอใดเปนวิธีการเลือกเซลลทั้งตาราง 
  1. คลิกตัวช้ีเมาสบนคอลัมนที่ตองการ แลวเลือกเมนู Table > Select Column 
  2. คลิกตัวช้ีเมาสบนแถวท่ีตองการ แลวเลือกเมนู Table > Select Row 
  3. คลิกตัวช้ีเมาสบนเซลลที่ตองการ แลวเลือกเมนู Table > Select Cell 
  4. คลิกตัวช้ีเมาสบนเซลลในตาราง แลวเลือกเมนู Table > Select Table 
15. กอนการคลิกเลือกเมนู  Table > Insert Columns เพ่ือแทรกคอลัมน จะตองทํากระบวนการใดกอน 
  1. คลิกเลือกเซลล 2. คลิกเลือกกลุมเซลล 
  3. คลิกเลือกคอลัมน 4. ถูกทุกขอ 
16. หากตองการสรางตัวอักษรศิลป (Word art) ลงในเอกสารจะตองคลิกทีปุมใด 
  1.  2.  
  3.  4.  
17. ปุมใดตอไปน้ี ใชสําหรับการสลับสวนหัวกระดาษ และทายกระดาษของเอกสาร 
  1.   2.   
  3.   4.   
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สวนที่ 2 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใชโปรแกรมนําเสนอผลงาน 
18. ขอใดไมใชความสามารถของโปรแกรม PowerPoint 
 1. ทํางานงานคํานวณขอมูลทางบัญชีโดยเฉพาะ 2. แทรกแผนภูมิและภาพเคล่ือนไหวได 
 3. สามารถแทรกเสียงประกอบได 4. สามารถวาดรูปขณะนําเสนอผลงาน 
19. วิธีการปดงานนําเสนอที่ไดสรางไวอยางถูกตอง คือขอใด 
 1. เล่ือนเมาสไปคลิกท่ีปุม Minimize 2. ใชคําส่ัง File > Close 
 3. เล่ือนเมาสไปคลิกท่ีปุม  4. กดคีย < Ctrl + C >  
20. ลักษณะของการสรางงานนําเสนอ โดยเลือกใช Blank Presentation คือขอใด 
 1. แผนสไลดเปลา 2. แผนสไลดที่มีองคประกอบทางกราฟฟก 
 3. แผนสไลดที่มีการกําหนดหัวขอและโครงเนื้อหา 
 4. แผนสไลดที่มีกลองขอความและองคประกอบทางกราฟฟก 
21. หากนักเรียนตองการดูสไลดทั้งหมด และตองการเรียงลําดับการนําเสนอใหมควรคลิกท่ีปุม  
    หรือเรียกใชมุมมองในโปรแกรมใด 
 1. ปุม   หรือ มุมมอง Normal View 2. ปุม  หรือ มุมมอง Slide Show 
 3. ปุม   หรือ  มุมมอง Slide Sorter View 4. ปุม   หรือ  มุมมอง Slide Sorter View 
22. ถานักเรียนตองการเพิ่มสไลด จะตองคลิกท่ีปุมใดตามลําดับ 
 1. คลิกท่ีเมนู Insert -> New Slide   หรือ กดคีย Ctrl + M 
 2. คลิกท่ีเมนู Slide Show -> New Slide   หรือ กดคีย Ctrl + N 
 3. คลิกท่ีเมนู Insert ->  New Slide    หรือ กดคีย Ctrl + M 
 4. คลิกท่ีเมนู Slide Show -> เ New Slide    หรือ กดคีย Ctrl + N  
23. การเปล่ียนขนาดตัวอักษร  โดยการกดปุม   ผลลัพธจะเปนอยางไร 
 1. ตัวอักษรจะมีขนาดใหญกวาขนาดเดิม  
 2. ตัวอักษรจะมีขนาดเล็กลงกวาเดิม 
 3. ตัวอักษรจะมีตําแหนงตัวยกขึ้นจากตําแหนงเดิม 
 4. ตัวอักษรจะมีตําแหนงตัวหอยจากตําแหนงเดิม 
24. การกําหนดตัวอักษรหรือขอความใหเปนตัวหนาและใสเงาใหกับตัวอักษรและขอความตองใชเคร่ืองมือใด 
    ตามลําดับ 
 1. เคร่ืองมือ   และ   2. เคร่ืองมือ   และ   
 3. เคร่ืองมือ   และ   4. เคร่ืองมือ   และ   
25. ถาเราตองการเปล่ียนสัญลักษณหรือตัวเลขที่ใชเปนหัวขอสามารถเขาปรับไดที่เมนูใด 
 1. Tools > Bullet and Numbering 2. Insert > Bullet and Numbering 
 3. Format > Bullet and Numbering 4. Insert > Numbering and Bullet 
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26. หากเราตองการวาดรูปทรงกระบอก และรูปหัวลูกศรแบบตางๆดวย AutoShape จะตองใชคําส่ังใด 
      ตามลําดับ 
 1. AutoShape > Line , AutoShape > Connector 
 2. AutoShape > Callouts , AutoShape > Star and Banners 
 3. AutoShape > Basic shape , AutoShape > Block Arrows 
 4. AutoShape > Connector , AutoShape > Block Arrows 
 
27. ขอใดกลาวถูกตองเกี่ยวกับภาพแบบเวคเตอร (Vector) และภาพแบบราสเตอร (Raster) 
 ก. ภาพแบบเวคเตอร (Vector) เปนภาพที่เกิดจากการวาดเสนตรง เสนโคง รูปทรงเรขาคณิต  โดยภาพ
ชนิดนี้จะถูกจัดเก็บในลักษณะการประมวลผลเปนสูตรคณิตศาสตร ไดแก ไฟลฟอรแมต .wmf  
 ข. ภาพแบบราสเตอร (Raster) เปนภาพที่เกิดจากการเคร่ืองสแกนหรือภาพถายจากกลองดิจิตอลจน
ประกอบไปดวยจุดเล็กๆ ไดแก ไฟลฟอรแมต .bmp  .cgm  .gif  .png  .jpg 
 1. ขอ ก ถูกตอง 2. ขอ ข ถูกตอง 
 3. ขอ ก และ ข ถูกตอง 4. ไมมีขอใดถูก 
28. ปุมคําส่ังใดท่ีใชปรับแตงโหมดสีของภาพ 
 1.  2.  
 3.  4.   
29. ถาเราตองการสรางผังองคกร จะตองคลิกท่ีปุมคําส่ังใด และโดยปกติการสรางแผนผังขององคกร 
    จะเริ่มตนที่บุคลกรก่ีตําแหนง 
 1. ปุม   ,  เร่ิมตนที่ 1 ตําแหนง 2. ปุม  เร่ิมตนที่ 2 ตําแหนง 
 3. ปุม   ,  เร่ิมตนที่ 3 ตําแหนง 4. ปุม  เร่ิมตนที่ 4 ตําแหนง 
30. หากเราตองการใหพื้นหลังมีลักษณะเปนลาย “หินออน” ตองเลือกรูปแบบใด 

 1. Texture        2. Picture     

 3. Pattern        4. Gradient  
31. ประโยชนของการสราง Slide Master คือขอใด 
 1. ไดรูปแบบของสไลดที่มีความหลากหลาย 
 2. การแกไขขอมูลมนสไลดไมขึ้นอยูกับสไลดอื่น 
 3. ไดสไลดที่ตรงกับความตองการใชงานมากที่สุด 
 4. อํานวยความสะดวกตอการทําสไลดที่มีลักษณะเหมือนๆกัน 
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32. จงพิจารณาขอความตอไปนี้เก่ียวกับการใสเอฟเฟคและการใสทรานซิชัน (Transition) 
 ก. การกําหนดใหขอความวิ่งจากทางขวามาทางซายมือของจอภาพ คือ คําส่ัง Fly From Left 
 ข. การกําหนดเอฟเฟคสามารถกําหนดใหไดกับตัวหนังสือเทานั้นไมสามารถ กําหนดใหกับกราฟและ 
                  รูปภาพได 
 ค. การใสทรานซิชัน (Transition) เปนเทคนิคอยางหนึ่งที่ใชในการเปล่ียนสไลด 
 1. ขอ ก ถูกตองเพียงขอเดียว 2. ขอ ก และ ข ถูกตอง 
 3. ขอ ค ถูกตองเพียงขอเดียว 4. ขอ ก และ ค ถูกตอง 
33. ไฟลเสียงและไฟลวิดีโอนามสกุลใดท่ีนักเรียนสามารถที่เราสามารถแทรกลงในการนําเสนอผลงาน   
      Microsoft PowerPoint ไดตามลําดับ 
 1. ไฟลเสียง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  .mp4  .mov  
 2. ไฟลเสียง ไดแก .mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .wmv   .mov 
 3. ไฟลเสียง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  . wmv    
 4. ไฟลเสียง ไดแก . mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .mp4  . mov 
34. ถาเราตองการกําหนดการเช่ือมโยงสไลดเพื่อความสะดวกในการนําเสนองาน เราสามารถสรางปุม 
      ปฏิบัติการไดโดยขั้นตอนใด 
 1. ที่เมนูคลิกเลือก Slide Show > Setup Show… 
 2. ที่เมนูคลิกเลือก Slide Show > Action Buttons  
 3. ที่เมนูคลิกเลือก Slide Show > Setup Buttons 
 4. ที่เมนูคลิกเลือก Slide Show > Custom Buttons 
35. ในการส่ัง Print What จะมีคําส่ังทั้งหมด 4 ประเภท คือ  Slides,   Handouts , Notepages,  
      Outline View ดังนั้นคําส่ัง Print What หมายถึงอะไร 
 1. การกําหนดลําดับของสไลดที่ตองการจะพิมพออกทางเครื่องพิมพที่ต้ังตาไว 
 2. การกําหนดจํานวนชุดของเอกสารที่ตองการจะพิมพออกทางเครื่องพิมพที่ยังไมไดต้ังคา 
 3. การกําหนดมาตรฐานของการพิมพของเครื่องพิมพชนิดตางๆ ที่ยังไมไดต้ังคา 
 4. การเลือกส่ิงที่ตองการพิมพและกําหนดคุณสมบัติของเอกสารประกอบการบรรยาย 
 

☺  ขอขอบคุณที่กรุณาตอบแบบสอบถาม  ☺ 
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การปรับปรุงแบบสอบถามและแบบทดสอบ 

 

 

 

 

 

 

 

 

 
 



 166
 

การปรับปรุงแบบสอบถาม 
 

ขอ ขอความเดิม ขอความท่ีปรับปรุง 
ตอนท่ี 2  ขอมูลเกี่ยวกับปจจัยที่สงผลตอการรับรูความสามารถดานคอมพวิเตอรของตนเอง 
ดานบุคลิกภาพภายในของผูเรียน 
1 ฉันพงึพอใจในการประสบความสําเร็จ

ตามที่สมควรจรจะไดรับ 
ฉันพงึพอใจในความสาํเร็จตามที่สมควรจะ
ไดรับ 

4 ฉันรูสึกพงึพอใจและภูมิใจกับการทาํงาน
ของตนเอง  

ฉันรูสึกภูมิใจกับการทํางานของตนเอง 

13 ฉันไมรูสึกวาฉันสามารถทําใหเกิด
ความสําเร็จในการทํางานได 

ฉันรูสึกกงัวลทีท่ี่ฉันไมสามารถทํางานให
สําเร็จได 

14 บางคร้ังฉันรูสึกวา ส่ิงตาง ๆ ก็ดูนาทอแท
และส้ินหวัง 

บางคร้ังฉันรูสึกทอแทในชีวติ 

ดานความมุงม่ันในการทํางาน 
21 ฉันพยายามอยางดีที่สุดขณะตองทาํงานที่

คอนขางยาก 
ฉันพยายามอยางดีที่สุดเมื่อตองทํางานที่
คอนขางยาก 

22 ฉันพยายามอยางหนักที่จะปรับปรุงการ
ปฏิบัติงานที่ผานมา 

ฉันพยายามทกุคร้ังที่จะปรับปรุงการ
ปฏิบัติงานที่ผานมาใหดีข้ึน 

23 โอกาสที่จะพฒันาความสามารถเปนส่ิง
สําคัญสําหรับฉัน 

โอกาสในการพัฒนาความสามารถเปนส่ิง
สําคัญสําหรับฉัน 

24 เมื่อพบความยุงยากในการแกปญหา        
ฉันชอบลองหลายๆทางเพื่อหาวิธีที่ดีที่สุด

เมื่อพบความยุงยากในการแกปญหา       
ฉันชอบลองหลายๆแนวทางเพื่อหาวิธีที่ดี
ที่สุด 

ดานความวิตกกังวลในการใชคอมพิวเตอร 
28 ฉันรูสึกกลัวแคคิดวาฉันอาจทําลายขอมลู

มากมายในเคร่ืองเพียงแคกดปุมผิดคร้ัง
เดียว 
 
 

ฉันรูสึกกลัวเมือ่คิดวาฉันอาจทําลายขอมลู
มากมายในเคร่ืองเพียงแคกดปุมผิดคร้ัง
เดียว 
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ขอ ขอความเดิม ขอความท่ีปรับปรุง 
 ตอนท่ี 3  ขอมูลเกี่ยวกับปจจัยทีส่งผลตอความสามารถทางคอมพิวเตอร 
ดานการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
2 ฉันเช่ือวาฉันสามารถอธิบายหนาที่และ

สวนประกอบในแถบเคร่ืองมอืในโปรแกรม
ประมวลผลคําได 

ฉันเช่ือวาฉันสามารถอธิบายหนาที่และ
สวนประกอบของแถบเคร่ืองมือในโปรแกรม
ประมวลผลคําได 

3 ฉันเช่ือวาฉันสามารถสราง บนัทกึ เปด
เอกสารและแทรกขอความลงในเอกสาร
นั้นๆได 

ฉันเช่ือวาฉันสามารถสราง บนัทกึและเปด
เอกสารรวมถงึแทรกขอความลงในเอกสาร
นั้นๆได 

13 ฉันเช่ือวาฉันสามารถสรางตาราง แทรก
แถว คอลัมน ได 

ฉันเช่ือวาฉันสามารถสรางตาราง แทรกแถว 
และคอลัมน ได 

18 ฉันเช่ือวาฉันสามารถอธิบายถึง
ความสามารถของโปรแกรมนําเสนอ
ผลงานได 

ฉันเช่ือวาฉันสามารถอธิบายเกี่ยวกับ
ความสามารถของโปรแกรมนาํเสนอผลงานได 

21 ฉันเช่ือวาฉันสามารถเปล่ียนลําดับสไลด 
ลบสไลด และเพิ่มสไลดไดถูกตอง 

ฉันเช่ือวาฉันสามารถเปล่ียนลําดับ ลบและ
เพิ่มสไลดไดถูกตอง 

ดานความผูกพันตอเปาหมาย 
34 ฉันรูสึกวาตองทํางานนี้ใหสําเร็จอยาง

จริงจัง 
ฉันรูสึกมัน่ใจวาตองทาํงานนีใ้หสําเร็จได 

35 ถาจะพูดกนัอยางจริงใจแลว  ฉันไมสนใจ
วางานนี้จะบรรลุเปาหมายหรือไม 

หลังไดรับมอบหมายงาน ฉันไมสนใจวางาน
ที่ฉันทําจะบรรลุเปาหมายหรือไม 

36 เปนไปไดวา เปาหมายนี้อาจตองไดรับการ
ทบทวน ข้ึนอยูกับวา งานดําเนนิไดดีแค
ไหน 

เปนไปไดวา เปาหมายที่ฉันต้ังอาจตองไดรับ
การทบทวน ข้ึนอยูกับวา งานดําเนินไดดีแค
ไหน 

37 ฉันไมกังวลมากนัก หากตองทิ้งเปาหมาย 
นี้ไป   

ฉันไมกังวลมากนัก หากตองทิ้งเปาหมายที่
ฉันต้ังไวไป   

39 ฉันคิดวาเปาหมายนี้เปนเปาหมายที่ดีใน
การเร่ิมดําเนินการ 
 

ฉันคิดวาเปาหมายของการทาํงานนี้เปน
เปาหมายที่ดีในการเริ่มดําเนนิการ 
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ขอ ขอความเดิม ขอความท่ีปรับปรุง 
ตอนท่ี 4  ขอมูลเกี่ยวกับแบบทดสอบความสามารถทางคอมพวิเตอร 
16 การพิมพขอความลงในตัวอักษรศิลป                   

( Word art ) ลงในเอกสารตองคลิกท่ีปุมใด 
 1.                2.  
 3.                4.  
 

หากตองการสรางตัวอักษรศิลป (Word art) ลงใน
เอกสารจะตองคลิกทีปุมใด 
 1.                2.  
 3.                4.  
 

19 วิธีการปดงานนําเสนอท่ีไดสรางไวอยางถูกตอง 
คือขอใด 
1. เล่ือนเมาสไปคลิกท่ีปุม  
2. ใชคําส่ัง File > Close 
3. เล่ือนเมาสไปคลิกท่ีปุม  
4. กดคีย < Ctrl + C > 

วิธีการปดงานนําเสนอท่ีไดสรางไวอยางถูกตอง 
คือขอใด 
1. เล่ือนเมาสไปคลิกท่ีปุม Minimize 
2. ใชคําส่ัง File > Close 
3. เล่ือนเมาสไปคลิกท่ีปุม  
4. กดคีย < Ctrl + C > 

22 ถานักเรียนตองการเพิ่มสไลด จะตองคลิกที่ปุมใด
ตามลําดับ 

1. คลิกที่เมนู Insert > เลือกคําส่ัง New Slide    
     หรือ กดคีย Ctrl + M 
2. คลิกที่เมนู Slide Show > เลือกคําส่ัง New Slide 

      หรือ กดคีย Ctrl + N 

3. คลิกที่เมนู Insert > เลือกคําส่ัง New Slide     
    หรือ กดคีย Ctrl + M 
4. คลิกที่เมนู Slide Show > เลือกคําส่ัง New Slide  

     หรือ กดคีย Ctrl + N 

ถานักเรียนตองการเพิ่มสไลด จะตองคลิกที่ปุมใด
ตามลําดับ 

1. คลิกที่เมนู Insert -> New Slide   หรือ  
   กดคีย Ctrl + M 

2. คลิกที่เมนู Slide Show -> New Slide   หรือ 
    กดคีย Ctrl + N 

3. คลิกที่เมนู Insert ->  New Slide    หรือ 
    กดคีย Ctrl + M 

4. คลิกที่เมนู Slide Show -> เ New Slide    
    หรือ กดคีย Ctrl + N 

30 หากเราตองการใหพื้นหลังมีลักษณะเปนลาย 
“หินออน” ตองเลือกรูปแบบใด 
     1. Texture   2. Picture 
     3. Pattern   4. Gradient 
 

หากเราตองการใหพื้นหลังมีลักษณะเปนลาย  
“หินออน” ตองเลือกรูปแบบใด 

1. Texture       2. Picture     

3. Pattern       4. Gradient  
 

 
 
 

นนนน 
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การประมาณคาความเท่ียงของแบบสอบถามแบบความสอดคลองภายใน 
จากการนาํไปทดลองใช 

 
คาความเที่ยงของแบบสอบถามทั้งฉบับ 
Reliability Coefficients 
N of Cases =     30.0                    N of Items = 71 
Alpha =    .8999 
 
¾ ระดับประสบการณในการใชโปรแกรมประมวลผลคํา 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 2 
 Alpha =    .6706 
 
¾ ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 2 
 Alpha =    .6855 
 
¾ การเหน็คุณคาในตนเอง 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 8 
 Alpha =    .7724 
 
¾ ความออนไหวทางอารมณ 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 8 
 Alpha =    .7198 
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¾ ระดับความมุงมั่นในการทํางาน  
Reliability Coefficients 

 N of Cases =     60.0                    N of Items = 8 
 Alpha =    .8119 
 
¾ ระดับความวิตกกังวลในการใชคอมพิวเตอร 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 4 
 Alpha =    .7703 
 
¾ การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 
 Reliability Coefficients 

 N of Cases =     30.0                    N of Items = 17 
 Alpha =    .9294 
 
¾ การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 16 
 Alpha =    .9507 

 

¾ ระดับความผูกพนัตอเปาหมาย 
 Reliability Coefficients 

 N of Cases =     30.0                    N of Items = 6 
 Alpha =    .6081 
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ตารางแสดง คาความยาก คาความเที่ยง และคาอํานาจจําแนกของแบบทดสอบ 
ความสามารถทางคอมพวิเตอรในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน คํานวณโดยใชโปรแกรมวิเคราะหขอสอบ EVANA   

ขอที่ คาความยาก (p) คาอํานาจจาํแนก (r)
คาความเทีย่งของ

แบบทดสอบท้ังฉบับ 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

0.81 
1.00 
0.81 
0.38 
0.88 
1.00 
0.50 
1.00 
0.69 
0.56 
0.88 
0.56 
0.88 
0.81 
0.63 
1.00 
0.69 
0.50 
0.81 
0.88 
0.56 
0.75 
0.63 
1.00 

0.13 
0.00 
0.38 
0.50 
0.00 
0.00 
0.50 
0.00 
0.38 
0.88 
0.25 
0.38 
0.25 
0.38 
0.25 
0.00 
0.13 
0.00 
0.38 
0.25 
0.63 
0.25 
0.50 
0.00 

0.71 
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ตารางแสดง คาความยาก คาความเที่ยง และคาอํานาจจําแนกของแบบทดสอบ 
ความสามารถทางคอมพวิเตอรในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน คํานวณโดยใชโปรแกรมวิเคราะหขอสอบ EVANA (ตอ) 

ขอที่ 
คาความยาก 

(p) 
คาอํานาจจาํแนก 

(r) 
คาความเทีย่งของ

แบบทดสอบท้ังฉบับ 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 

0.50 
0.75 
0.69 
0.50 
0.44 
0.38 
0.69 
0.38 
0.44 
0.25 
0.38 

0.50 
0.50 
0.13 
0.50 
0.38 
0.50 
0.38 
0.75 
0.13 
0.25 
0.50 

 

คาเฉลี่ย 0.67 0.34  
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เฉลยแบบทดสอบความสามารถทางคอมพิวเตอร 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

โปรแกรมประมวลผลคํา โปรแกรมนาํเสนอผลงาน 
ขอที่ เฉลย ขอที่ เฉลย 

1 1 18 1 
2 2 19 2 
3 4 20 1 
4 3 21 3 
5 2 22 1 
6 2 23 1 
7 3 24 2 
8 4 25 3 
9 2 26 3 
10 1 27 3 
11 2 28 4 
12 3 29 2 
13 4 30 1 
14 4 31 4 
15 3 32 3 
16 1 33 3 
17 3 34 2 
    35 4 
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ภาคผนวก จ 

ผลการตรวจสอบคุณภาพของเครื่องมือ (IOC) 
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ตอนท่ี 1 ขอคําถามเกีย่วกับขอมูลทั่วไปของนักเรยีน 
 

 
 

ขอคําถาม ผลการพิจารณา 
1. เพศ � 1) ชาย � 2) หญิง เหมาะสม 
2. อายุ ………………………... ป                    เหมาะสม 
3. ศึกษาอยูในระดับชั้น � 1) มัธยมศึกษาปที่ 4 

� 3) มัธยมศึกษาปที่ 6 
� 2) มัธยมศึกษาปที่ 5 เหมาะสม 

4. แผนการเรียน � 1) วิทย – คณิต 
� 3) ศิลป – ภาษา 

� 2) ศิลป – คํานวณ 
� 4) อื่นๆ ระบุ........... เหมาะสม 

5. ประสบการณในการใชคอมพิวเตอร 
   � 1) นอยกวา 1 ป 
   � 4)  5 – 6 ป     

� 2)  1 – 2  ป  
� 5) มากกวา 6 ป 

� 3) 3 – 4 ป เหมาะสม 

6. โดยปกตินักเรียนใชคอมพิวเตอรบอยเพียงใด  
   ( ระบุจํานวนช่ัวโมงโดยเฉล่ียตอวัน )  
� 1) นอยกวา 1 ชั่วโมง / วัน  
� 4) 5 – 6  ชั่วโมง / วัน  

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน

� 3) 3 – 4  ชั่วโมง / วัน  
เหมาะสม 

7. นักเรียนมีประสบการณในการใชโปรแกรมประมวลผลคํา ( Microsoft Word )  
   � 1) นอยกวา 1 ป 
   � 4)  5 – 6 ป     

� 2)  1 – 2  ป  
� 5) มากกวา 6 ป 

� 3) 3 – 4 ป เหมาะสม 

8. โดยปกตินักเรียนใชโปรแกรมประมวลผลคํา ( Microsoft Word )  
    บอยเพียงใด  ( ระบุจํานวนช่ัวโมงโดยเฉล่ียตอวัน )  
� 1) นอยกวา 1 ชั่วโมง / วัน  
� 4) 5 – 6  ชั่วโมง / วัน  

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน

� 3) 3 – 4  ชั่วโมง / วัน  
เหมาะสม 

9. นักเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมประมวลผลคํา  
   ( Microsoft Word ) ไวรอยละเทาใด 
   � 1) รอยละ 0 – 20 
   � 4) รอยละ 61 – 80 

� 2) รอยละ 21 – 40  
� 5)  รอยละ 81 – 100  

� 3) รอยละ 41 – 60  
เหมาะสม 

10. นักเรียนมีประสบการณในการใชโปรแกรมนําเสนอผลงาน  
     ( Microsoft Powerpoint )  
   � 1) นอยกวา 1 ป 
   � 4)  5 – 6 ป     

� 2)  1 – 2  ป  
� 5) มากกวา 6 ป 

� 3) 3 – 4 ป 
เหมาะสม 
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ตอนท่ี 2  ขอคําถามเกีย่วกับปจจัยท่ีสงผลตอการรับรูความสามารถดานคอมพิวเตอร 
            ของตนเอง 

 
 

ขอคําถาม ผลการพิจารณา 
11. โดยปกตินักเรียนใชโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint )  
      บอยเพียงใด   ( ระบุจํานวนช่ัวโมงโดยเฉล่ียตอวัน ) 
� 1) นอยกวา 1 ชั่วโมง / วัน  
� 4) 5 – 6  ชั่วโมง / วัน  

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน

� 3) 3 – 4  ชั่วโมง / วัน  
เหมาะสม 

12. นักเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการโปรแกรมนําเสนอผลงาน  
      ( Microsoft Powerpoint )    ไวรอยละเทาใด 
   � 1) รอยละ 0 – 20 
   � 4) รอยละ 61 – 80 

� 2) รอยละ 21 – 40  
� 5)  รอยละ 81 – 100  

� 3) รอยละ 41 – 60  
เหมาะสม 

ขอที่ ขอคําถาม IOC 
การเห็นคุณคาในตนเอง 

1 ฉันพึงพอใจในความสําเร็จตามท่ีสมควรจะไดรับ 1 
2 เม่ือฉันพยายาม ฉันจะประสบความสําเร็จในการทํางาน 1 
3 ฉันทํางานไดอยางสมบูรณและประสบความสําเร็จอยางดี 1 
4 ฉันรูสึกภูมิใจกับการทํางานของตนเอง 1 
5 ฉันตัดสินใจเลือกทําส่ิงตางๆไดอยางม่ันใจ 1 
6 เม่ือเกิดปญหาขึ้น ฉันสามารถรับมือกับปญหาเหลานั้นได 1 
7 ฉันเปนที่รักใครของผูอื่น 1 
8 ฉันจะทําในส่ิงที่ถูกตองและเต็มความสามารถเสมอ 1 

ความออนไหวทางอารมณ 
9 ในการทํางานบางคร้ัง ฉันรูสึกมีความกดดันตอตนเอง 0.8 

10 บางคร้ังเมื่อฉันทํางานลมเหลว ฉันจะรูสึกวาตนเองไรคา 1 
11 บางคร้ังฉันรูสึกควบคุมการทํางานตางๆของฉันไมไดเลย 0.8 
12 ฉันมักจะสงสัยในความสามารถของตนเอง 0.8 
13 ฉันรูสึกกังวลท่ีฉันไมสามารถทํางานใหสําเร็จได 1 
14 บางคร้ังฉันรูสึกทอแทในชีวิต 1 
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ตอนท่ี 3  ขอคําถามเกีย่วกับปจจัยท่ีสงผลตอความสามารถทางคอมพิวเตอร 
             

 

ขอที่ ขอคําถาม IOC 
15 ฉันไมสามารถเปนที่พึ่งของใครไดเลย 1 
16 ปกติแลวไมคอยมีคนอื่นมาใสใจกับฉันมากนัก 1 

ความมุงม่ันในการทํางาน 
17 โอกาสที่ในการจะไดทํางานที่ทาทายเปนส่ิงสําคัญสําหรับฉัน 0.8 

18 
เม่ือลมเหลวในการทํางานชิ้นที่ยาก  ฉันวางแผนท่ีจะพยายามใหมากขึ้น 
ในการทํางานครั้งตอไป 1 

19 ฉันเลือกท่ีจะทํางานท่ีทําใหฉันไดเรียนรูส่ิงใหม ๆ 0.8 
20 โอกาสที่จะไดทําส่ิงใหม ๆ เปนส่ิงทาทายสําหรับฉัน 0.8 
21 ฉันพยายามอยางดีที่สุดเม่ือตองทํางานท่ีคอนขางยาก 1 
22 ฉันพยายามทุกคร้ังที่จะปรับปรุงการปฏิบัติงานท่ีผานมาใหดีขึ้น 1 
23 โอกาสในการพัฒนาความสามารถเปนส่ิงสําคัญสําหรับฉัน 0.8 
24 เม่ือพบความยุงยากในการแกปญหา ฉันชอบลองหลาย ๆ ทางเพือ่หาวิธีที่ดีที่สุด 1 

ความวิตกกังวลในการใชคอมพิวเตอร 
25 ฉันไมกลาใชคอมพิวเตอรเพราะกลัววาจะทําผิดพลาด แลวแกไขไมได 1 
26 ฉันรูสึกกลัวการใชคอมพิวเตอร 1 
27 ฉันหลีกเล่ียงการใชคอมพิวเตอรเพราะรูสึกไมคุนเคย 0.8 

28 
ฉันรูสึกกลัวการใชคอมพิวเตอร แคคิดวาฉันอาจทําลายขอมูลมากมาย 
ในเคร่ืองเพียงแคกดปุมผิดคร้ังเดียว 0.8 

ขอที่ ขอคําถาม IOC 
การรับรูความสามารถในการใชโปรแกรมประมวล ผลคํา( Microsoft Word ) 

1 
ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของ 
โปรแกรมประมวลผลคําได 1 

2 
ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของแถบเคร่ืองมือ 
ในโปรแกรมประมวลผลคําได 

1 

3 
ฉันเชื่อวาฉันสามารถสราง บันทึกและเปดเอกสารรวมถึงแทรกขอความลง 
ในเอกสารน้ันๆได 

1 

4 ฉันเชื่อวาฉันสามารถต้ังคาหนากระดาษ ต้ังก้ันหนาและก้ันหลังขอความได 1 
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ขอที่ ขอคําถาม IOC 

5 
ฉันเชื่อวาฉันสามารถกําหนดตําแหนงของแท็บและเลือกใชแท็บใหเหมาะสม
กับงานได 1 

6 ฉันเชื่อวาฉันสามารถเลือกขอความ ยายขอความ คัดลอกและลบขอความได 1 

7 
ฉันเชื่อวาฉันสามารถจัดรูปแบบขอความ รวมไปถึงการกําหนดหมายเลขลําดับ 
และเครื่องหมายหนาขอความได 1 

8 
ฉันเชื่อวาฉันสามารถปรับเปล่ียนลักษณะของตัวอักษรเปล่ียนสีใหตัวอักษร
และใสสีพื้นหลังใหกับขอความได 

1 

9 ฉันเชื่อวาฉันสามารถปรับระยะหางระหวางตัวอักษร บรรทัดและยอหนาได 1 
10 ฉันเชื่อวาฉันสามารถแทรกสัญลักษณพิเศษและอักขระพิเศษลงในเอกสารได  1 
11 ฉันเชื่อวาฉันสามารถใสกรอบใหกับขอความ เอกสารและแบงคอลัมนได 1 
12 ฉันเชื่อวาฉันสามารถเรียกดูเอกสารกอนพิมพและส่ังพิมพเอกสารได 1 
13 ฉันเชื่อวาฉันสามารถสรางตาราง แทรกแถวและคอลัมน ได 1 
14 ฉันเชื่อวาฉันสามารถผสานเซลล และแยกเซลลตางๆตลอดจนตกแตงตารางได 1 

15 
ฉันเชื่อวาฉันสามารถสรางวัตถุรูปวาด ตัวอักษรศิลปและสามารถ 
แทรกรูปภาพได 

1 

16 
ฉันเชื่อวาฉันสามารถใสขอความในหัวกระดาษ ทายกระดาษและหมายเลข 
หนาได 

1 

17 ฉันเชื่อวาฉันสามารถสรางและบอกประโยชนของจดหมายเวียนได 1 
การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน( Microsoft Powerpoint ) 

18 
ฉันเชื่อวาฉันสามารถอธิบายเก่ียวกับความสามารถของโปรแกรมนําเสนอ
ผลงานได 1 

19 ฉันเชื่อวาฉันสามารถสราง บันทึก เปดและปดงานนําเสนอผลงานได 1 

20 
ฉันเชื่อวาฉันสามารถบอกความแตกตางของมุมมองในการทํางานของ
โปรแกรมนําเสนอผลงานได 1 

21 ฉันเชื่อวาฉันสามารถเปล่ียนลําดับ ลบและเพิ่มสไลดไดถูกตอง 1 

22 
ฉันเชื่อวาฉันสามารถใสขอความ กําหนดขนาด ตัวหนา ตัวเอน ตัวขีดเสนใต
และใสเงาใหกับขอความได 

1 

23 ฉันเชื่อวาฉันสามารถใสตัวเลขและสัญลักษณแสดงลําดับหัวขอได 1 
24 ฉันเชื่อวาฉันสามารถใชเคร่ืองมือวาดและทํางานกับวัตถุตางๆได 1 
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ขอที่ ขอคําถาม IOC 

25 
ฉันเชื่อวาฉันสามารถบอกความแตกตางของภาพแบบเวคเตอร (Vector)  
กับภาพแบบราสเตอร (Raster) ได 1 

26 ฉันเชื่อวาฉันสามารถปรับแตงภาพจากภาพได 0.8 
27 ฉันเชื่อวาฉันสามารถสรางกราฟและแผนผังลงในสไลดได 1 
28 ฉันเชื่อวาฉันสามารถตกแตงพื้นหลัง และสรางแมแบบ (Template) ได 1 
29 ฉันเชื่อวาฉันสามารถกําหนดเอฟเฟคใหกับวัตถุตางๆตลอดจน Transition ได 1 

30 
ฉันเชื่อวาฉันสามารถเพิ่มเสียงประกอบทั้งภายในและภายนอกโปรแกรมเพ่ือ
ทําเอฟเฟคใหกับขอความได 

1 

31 ฉันเชื่อวาฉันสามารถกําหนดรูปแบบการเชื่อมโยงสไลดได 1 

32 
ฉันเชื่อวาฉันสามารถกําหนดคุณสมบัติของเอกสารกอนพิมพและใชคําส่ังพิมพ
ไดอยางถูกวิธี 

1 

33 
ฉันเชื่อวาฉันสามารถแสดงสไลดงานนําเสนอท่ีสรางเสร็จ 
แลวได 

1 

ความผูกพันตอเปาหมาย 
34 ฉันรูสึกม่ันใจวาตองทํางานนี้ใหสําเร็จได 1 
35 หลังไดรับมอบหมายงาน ฉันไมสนใจวางานที่ฉันทําจะบรรลุเปาหมายหรือไม 1 

36 
เปนไปไดวา เปาหมายที่ฉันต้ังอาจตองไดรับการทบทวน ขึ้นอยูกับวา งาน
ดําเนินไดดีแคไหน 0.8 

37 ฉันไมกังวลมากนัก หากตองท้ิงเปาหมายที่ฉันต้ังไวไป   1 
38 เปนการยากสําหรับฉัน ในการที่จะต้ังใจดําเนินตามเปาหมายอยางจริงจัง 1 
39 ฉันคิดวาเปาหมายของการทํางานนี้เปนเปาหมายที่ดีในการเร่ิมดําเนินการ 0.8 
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ตอนท่ี 4  แบบทดสอบความสามารถทางคอมพวิเตอร 
             

 

ขอที่ ขอคําถาม IOC 
แบบทดสอบความสามารถทางคอมพวิเตอรในการใชโปรแกรมประมวลผลคํา  
( Microsoft Word ) 

1  
 
จากภาพในแถบวงรีคือแถบท่ีแสดงขอมูลสวนใดของโปรแกรม 
1. เมนูบาร (Menu Bar)            2. ทูลบาร  (Tool Bar) 
3. ออพชั่นบาร (Option Bar)     4. คอมมานดบาร (Command Bar) 

0.6 

2 เม่ือตองการเปดเอกสารเดิมและบนัทึกเอกสารจะตองคลิกท่ีปุมสัญลกัษณ 
ใดตามลําดับ 

1.    และ                      2.   และ   

3.    และ                       4.    และ   
 

1 

3 ถานักเรียนตองการกําหนดขนาดกระดาษในการทํางานเปน ขนาด Legal  นักเรียน
ตองทําอยางไร 
1. Edit > Page Setup > Paper > Paper Margin = A4 
2. Edit > Page Setup > Paper > Paper Size = Legal 
3. File > Page Setup > Paper > Paper Margin = A4 
4. File > Page Setup > Paper > Paper Size = Legal 

1 

4 ขอใดกลาวผิดเกี่ยวกับสัญลักษณในการกําหนดตําแหนงแท็บ 
1.   ใชกําหนดใหขอความจัดชิดแท็บทางดานซาย 
2.    ใชกําหนดใหจุดทศนิยม อยูในแนวเดียวกับตําแหนง  ในไมบรรทัด 
     แนวนอน เหมาะกับการเรียงตัวเลขใหจุดทศนิยมตรงกัน 
3.    ใชกําหนดเสนในแนวนอน ใหอยูในแนวเดียวกบัตําแหนงไมบรรทัด 
     ในแนวต้ัง 
4.   ใชกําหนดใหขอความจัดกึ่งกลางแท็บ 

1 

5 เม่ือตองการคัดลอกขอความท่ีไดเลือกเอาไว ตองคลิกท่ีปุมใด 
1.                       2.  
3.                             4.  

1 
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ขอที่ ขอคําถาม IOC 
6 การจัดขอความท้ังยอหนาใหอยูกึ่งกลางหนากระดาษตองคลิกท่ีปุมใด  

หรือใชคําสั่งใดในการจัดยอหนา 
1. คลิกท่ีปุม  หรือใชคําสั่ง Format > Paragraph > Alignment = Left 
2. คลิกท่ีปุม  หรือใชคําสั่ง Format > Paragraph > Alignment = Centered 
3. คลิกท่ีปุม  หรือใชคําสั่ง Format > Paragraph > Alignment = Right 
4. คลิกท่ีปุม   หรือใชคําสั่ง Format > Paragraph > Alignment = Jusitified 

1 

7 เม่ือตองการปรับแตงปุมเคร่ืองหมายหนาขอความใหเปนเคร่ืองหมายตางๆ 
สามารถทําไดอยางไร 
1. Format > Bullet and Numbering หรือคลิกท่ีปุม  
2. Insert > Bullet and Numbering หรือคลิกท่ีปุม  
3. Format > Bullet and Numbering หรือคลิกท่ีปุม   
4. Insert > Bullet and Numbering หรือคลิกท่ีปุม  

1 

8 เม่ือเลอืกขอความ “คอมพิวเตอร” แลวคลิกปุม  และปุม  ขอความ 
จะเปนอยางไร 
1. คอมพิวเตอร                 2. คอมพิวเตอร 
3. คอมพิวเตอร               4. คอมพิวเตอร 

1 

9 ขอใดกลาวถกูตองเกี่ยวกบัการจัดยอหนา 
ก. การปรับระยะหางระหวางบรรทัดตองเลือกเมนู Edit และเลอืกคําสัง่ Ruler 
ข. การปรับระยะหางระหวางยอหนาทําไดโดยการคลิกเมาสปุมขวา 
    ในยอหนาท่ีตองการแลวเลือกคําส่ัง   Paragraph 
1. ขอ ก  ถูกตอง                2. ขอ ข ถกูตอง 
3. ขอ ก และ ข ถกูตอง       4. ไมมีขอใดถูกตอง 

1 

10 ขั้นตอนในการแทรกสัญลักษณพิเศษหรืออกัขระพิเศษลงในเอกสารสามารถทําได
อยางไร 
ก. จากกลองโตตอบ Symbol ในชอง Font ใหเลือกรายการของรูปแบบ 
    ที่ตองการ 
ข. คลิกปุม Insert  เพ่ือแทรกสัญลกัษณที่จุดแทรกขอความในเอกสาร 
ค. คลิกเลือกสัญลักษณที่ตองการแทรกเขาไปในเอกสาร 
ง. คลกิเลือกเมนู Insert แลวเลือกคําสั่ง Symbol 
1. ง – ก – ค – ข                   2. ง – ข – ค – ก 
3. ข – ก – ค –ง                    4. ก – ง – ค – ข 

1 
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ขอที่ ขอคําถาม IOC 
11 ถาตองการกําหนดรูปแบบของกรอบขอความใหเปนเสนประ จะตองกาํหนด 

ที่หัวขอใด ในแทบ็ Borders ของกลองโตตอบ Borders and Shading  
1. Setting                   2. Style 
3. Color                   4. Width 

1 

12 การเรียกดูเอกสารกอนพิมพคร้ังละหลายๆหนา ตองคลิกที่ปุมใด 
1.                   2.  
3.                   4.  

1 

13 เม่ือตองการพิมพเอกสารหนา 14 ถึง หนา 20 โดยพิมพเฉพาะหนาคูตองปอนตัวเลข
ในชอง Pages อยางไร 
1. 14 – 20                  2. 14 – 16 , 18 – 20  
3.  20 – 14                   4. 14, 16 , 18 , 20  

1 

14 ขอใดเปนวิธกีารเลือกเซลลทั้งตาราง 
1. คลิกตัวชี้เมาสบนคอลัมนที่ตองการ แลวเลือกเมนู Table > Select Column 
2. คลิกตัวชี้เมาสบนแถวที่ตองการ แลวเลือกเมนู Table > Select Row 
3. คลิกตัวชี้เมาสบนเซลลที่ตองการ แลวเลือกเมนู Table > Select Cell 
4. คลิกตัวชี้เมาสบนเซลลในตาราง แลวเลือกเมนู Table > Select Table 

1 

15 กอนการคลิกเลือกเมนู  Table > Insert Columns เพ่ือแทรกคอลัมน  
จะตองทํากระบวนการใดกอน 
1. คลิกเลือกเซลล          2. คลิกเลือกกลุมเซลล 
3. คลิกเลือกคอลัมน      4. ถูกทุกขอ 

1 

16 หากตองการสรางตัวอักษรศิลป (Word art) ลงในเอกสารจะตองคลิกทีปุมใด 
1.                     2.  
3.                     4.  

1 

17 ปุมใดตอไปน้ี ใชสําหรับการสลับสวนหัวกระดาษ และทายกระดาษ 
ของเอกสาร 
1.                      2.   
3.                      4.   

1 
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ขอที่ ขอคําถาม IOC 
แบบทดสอบความสามารถทางคอมพวิเตอรในการใชโปรแกรมนําเสนอผลงาน 
( Microsoft Powerpoint ) 

18 ขอใดไมใชความสามารถของโปรแกรม PowerPoint 
1. ทํางานงานคํานวณขอมูลทางบญัชีโดยเฉพาะ  
2. แทรกแผนภูมิและภาพเคลื่อนไหวได 
3. สามารถแทรกเสียงประกอบได 
4. สามารถวาดรูปขณะนําเสนอผลงาน 

0.6 

19 วิธีการปดงานนําเสนอท่ีไดสรางไวอยางถูกตอง คือขอใด 
1. เลื่อนเมาสไปคลิกท่ีปุม Minimize    2. ใชคําสั่ง File > Close 
3. เลื่อนเมาสไปคลิกท่ีปุม             4. กดคีย < Ctrl + C > 

1 

20 ลักษณะของการสรางงานนําเสนอ โดยเลอืกใช Blank Presentation คือขอใด 
1. แผนสไลดเปลา 
2. แผนสไลดที่มีองคประกอบทางกราฟฟก 
3. แผนสไลดที่มีการกําหนดหัวขอและโครงเน้ือหา 
4. แผนสไลดที่มีกลองขอความและองคประกอบทางกราฟฟก 

0.8 

21 หากนักเรียนตองการดูสไลดทั้งหมด และตองการเรียงลําดับการนําเสนอใหมควร
คลิกท่ีปุมหรือเรียกใชมุมมองในโปรแกรมใด 
1. ปุม   หรือ มุมมอง Normal View  
2. ปุม  หรือ มุมมอง Slide Show 
3. ปุม   หรือ  มุมมอง Slide Sorter View  
4. ปุม   หรือ  มุมมอง Slide Sorter View 

1 

22 ถานักเรียนตองการเพ่ิมสไลด จะตองคลิกท่ีปุมใดตามลําดับ 
1. คลิกท่ีเมนู Insert -> New Slide   หรือ   กดคีย Ctrl + M 
2. คลิกท่ีเมนู Slide Show -> New Slide   หรือ   กดคีย Ctrl + N 
3. คลิกท่ีเมนู Insert ->  New Slide    หรือ    กดคีย Ctrl + M 
4. คลิกท่ีเมนู Slide Show -> เ New Slide    หรือ กดคีย Ctrl + N  

1 

23 การเปล่ียนขนาดตัวอักษร  โดยการกดปุม   ผลลัพธจะเปนอยางไร 
1. ตัวอกัษรจะมีขนาดใหญกวาขนาดเดิม 
2. ตัวอกัษรจะมีขนาดเล็กลงกวาเดิม 
3. ตัวอกัษรจะมีตําแหนงตัวยกขึน้จากตําแหนงเดิม 
4. ตัวอกัษรจะมีตําแหนงตัวหอยจากตําแหนงเดิม 

1 
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ขอที่ ขอคําถาม IOC 
24 การกําหนดตัวอักษรหรือขอความใหเปนตัวหนาและใสเงาใหกับตัวอักษรและขอความ

ตองใชเคร่ืองมือใดตามลําดับ 
1. เคร่ืองมือ   และ           2. เคร่ืองมือ   และ   
3. เคร่ืองมือ   และ           4. เคร่ืองมือ   และ   

1 

25 ถาเราตองการเปลี่ยนสัญลกัษณหรือตัวเลขท่ีใชเปนหัวขอสามารถ 
เขาปรับไดที่เมนูใด 
1. Tools > Bullet and Numbering  
2. Insert > Bullet and Numbering 
3. Format > Bullet and Numbering  
4. Insert > Numbering and Bullet 

1 

26 หากเราตองการวาดรูปทรงกระบอก และรูปหัวลกูศรแบบตางๆดวย AutoShape 
จะตองใชคําสั่งใดตามลําดับ 
1. AutoShape > Line , AutoShape > Connector 
2. AutoShape > Callouts , AutoShape > Star and Banners 
3. AutoShape > Basic shape , AutoShape > Block Arrows 
4. AutoShape > Connector , AutoShape > Block Arrows 

1 

27 ขอใดกลาวถกูตองเกี่ยวกบัภาพแบบเวคเตอร (Vector) และภาพแบบราสเตอร 
(Raster) 
 ก. ภาพแบบเวคเตอร (Vector) เปนภาพท่ีเกิดจากการวาดเสนตรง เสนโคง 
รูปทรงเรขาคณิต  โดยภาพชนิดน้ีจะถูกจัดเกบ็ในลักษณะ 
การประมวลผลเปนสูตรคณิตศาสตร ไดแก ไฟลฟอรแมต .wmf  
 ข. ภาพแบบราสเตอร (Raster) เปนภาพท่ีเกิดจากการเคร่ืองสแกนหรือ
ภาพถายจากกลองดิจิตอลจนประกอบไปดวยจุดเลก็ๆ ไดแก ไฟลฟอรแมต .bmp  
.cgm  .gif  .png  .jpg 
1. ขอ ก ถูกตอง                     2. ขอ ข ถูกตอง 
3. ขอ ก และ ข ถกูตอง           4. ไมมีขอใดถูก 

1 

28 ปุมคําสั่งใดที่ใชปรับแตงโหมดสีของภาพ 
1.                                2.  
3.                                4.   

1 

29 ถาเราตองการสรางผังองคกร จะตองคลิกท่ีปุมคําสั่งใด และโดยปกติการสราง
แผนผังขององคกรจะเร่ิมตนท่ีบุคลากรกี่ตําแหนง 
1. ปุม   ,  เร่ิมตนท่ี 1 ตําแหนง           2. ปุม  เร่ิมตนท่ี 2 ตําแหนง 
3. ปุม   ,  เร่ิมตนท่ี 3 ตําแหนง           4. ปุม  เร่ิมตนท่ี 4 ตําแหนง 

1 
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ขอที่ ขอคําถาม IOC 
30 หากเราตองการใหพ้ืนหลังมีลักษณะเปนลาย “หินออน” ตองเลือกรูปแบบใด 

1. Texture                        2. Picture     

3. Pattern                        4. Gradient  

1 

31 ประโยชนของการสราง Slide Master คือขอใด 
1. ไดรูปแบบของสไลดที่มีความหลากหลาย 
2. การแกไขขอมูลมนสไลดไมขึ้นอยูกับสไลดอื่น 
3. ไดสไลดที่ตรงกับความตองการใชงานมากท่ีสุด 
4. อํานวยความสะดวกตอการทําสไลดที่มีลักษณะเหมือนๆกัน 

0.8 

32 จงพิจารณาขอความตอไปน้ีเกี่ยวกบัการใสเอฟเฟคและการใสทรานซิชัน 
(Transition) 
ก. การกําหนดใหขอความว่ิงจากทางขวามาทางซายมือของจอภาพ คือ  
    คําสั่ง Fly From Left 
ข. การกําหนดเอฟเฟคสามารถกําหนดใหไดกับตัวหนังสือเทาน้ันไมสามารถ  
    กําหนดใหกับกราฟและ รูปภาพได 
ค. การใสทรานซชิัน (Transition) เปนเทคนิคอยางหนึ่งท่ีใชในการเปล่ียนสไลด 
1. ขอ ก ถูกตองเพียงขอเดียว          2. ขอ ก และ ข ถูกตอง 
3. ขอ ค ถกูตองเพียงขอเดียว          4. ขอ ก และ ค ถูกตอง 

1 

33 ไฟลเสียงและไฟลวิดีโอนามสกุลใดท่ีนักเรียนสามารถท่ีเราสามารถแทรกลงในการ
นําเสนอผลงาน  Microsoft PowerPoint ไดตามลําดับ 
1. ไฟลเสยีง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  .mp4  .mov  
2. ไฟลเสยีง ไดแก .mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .wmv   .mov 
3. ไฟลเสยีง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  . wmv    
4. ไฟลเสยีง ไดแก . mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .mp4  . mov 

1 

34 ถาเราตองการกําหนดการเชื่อมโยงสไลดเพ่ือความสะดวกในการนําเสนองาน เรา
สามารถสรางปุมปฏิบัติการไดโดยขั้นตอนใด 
1. ที่เมนูคลิกเลือก Slide Show > Setup Show… 
2. ที่เมนูคลิกเลือก Slide Show > Action Buttons  
3. ที่เมนูคลิกเลือก Slide Show > Setup Buttons 
4. ที่เมนูคลิกเลือก Slide Show > Custom Buttons 
 

1 
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ขอที่ ขอคําถาม IOC 
35 ในการสั่ง Print What จะมีคําสั่งท้ังหมด 4 ประเภท คือ  Slides,   Handouts , 

Notepages,  Outline View ดังน้ันคําสั่ง Print What หมายถึงอะไร 
1. การกําหนดลําดับของสไลดที่ตองการจะพิมพออกทางเคร่ืองพิมพที่ต้ังตาไว 
2. การกําหนดจํานวนชุดของเอกสารที่ตองการจะพิมพออกทางเคร่ืองพิมพ 
    ทีย่ังไมไดต้ังคา 
3. การกําหนดมาตรฐานของการพิมพของเครื่องพิมพชนิดตางๆ  
    ทีย่ังไมไดต้ังคา 
4. การเลือกสิ่งท่ีตองการพิมพและกําหนดคุณสมบัติของเอกสารประกอบ 
    การบรรยาย 

1 
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ภาคผนวก ฉ 

ผลการวิเคราะหโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพวิเตอร 
ของตนเองที่มตีอความสามารถทางคอมพิวเตอร ดวยโปรแกรมลิสเรล 8.72 
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     DATE:  4/30/2009 
TIME: 22:13 

 
 
                                L I S R E L  8.72 
 
                                       BY 
 
                         Karl G. J”reskog & Dag S”rbom 
 
 
 
                    This program is published exclusively by 
                    Scientific Software International, Inc. 
                       7383 N. Lincoln Avenue, Suite 100 
                        Lincolnwood, IL 60712, U.S.A.  
            Phone: (800)247-6113, (847)675-0720, Fax: (847)675-2140 
        Copyright by Scientific Software International, Inc., 1981-2005  
          Use of this program is subject to the terms specified in the 
                        Universal Copyright Convention. 
                          Website: www.ssicentral.com 
 
 
 The following lines were read from file   
 C:\Users\chang\Desktop\comself_sem\sem59.LPJ: 
 
 TI 
 !DA NI=106 NO=813 MA=CM 
 SY='C:\Users\chang\Desktop\comself_sem\sem39.DSF' 
 SE 
 1 2 3 4 5 6 7 8 9 10 11 12 13 / 
 MO NX=6 NY=7 NK=4 NE=4 BE=FU GA=FI PS=SY TE=SY TD=SY 
 LE 
 comself goallevel goalcomm comper 
 LK 
 prevexp trainper learngoa comanxi 
 FI PS(1,1) TE(7,7) TD(2,2) TD(5,5) TD(6,6) TD(4,2) TD(6,5) TD(6,2) TD(5,2) 
 FI TD(6,4) TD(5,4) 
 FR LY(1,1) LY(4,2) LY(6,4) LX(2,1) LX(3,2) LX(4,2) LX(5,3) LX(6,4) BE(2,1) 
 FR BE(3,1) BE(4,1) BE(4,2) BE(4,3) GA(1,1) GA(1,2) GA(1,3) GA(1,4) TH(1,1) 
 FR TH(1,2) TH(1,3) TH(1,4) TH(2,1) TH(2,2) TH(2,3) TH(2,4) TH(4,1) TH(4,2) 
 FR TH(4,7) TH(6,2) TH(6,5) TH(6,6) TH(6,7) TE(2,1) TE(3,2) TE(4,1) TE(4,2) 
 FR TE(5,1) TE(5,2) TE(6,1) TE(7,1) TE(7,2) TD(2,1) TD(3,2) TD(4,1) TD(5,3) 
 FR TD(6,1) TD(2,1) TD(4,1) TH(6,1) TH(3,4) TH(3,3) TD(3,6) TH(3,2) TH(5,2) 
 FR TH(4,5) TH(4,6) TD(1,5) TD(3,1) TH(5,4) TD(4,3) TH(1,5) TH(2,5) TH(1,6) 
 FR TH(2,6) 
 VA 0.401 LY(2,1) 
 VA 0.838 LY(3,2) 
 VA 2.273 LY(5,4) 
 VA 0.476 LY(7,3) 
 PD 
 OU SL=0 PC RS EF FS SS SC PT ND=3 IT=5000 MI AD=OFF 
 
 TI                                                                              
 
                           Number of Input Variables106 
                           Number of Y - Variables    7 
                           Number of X - Variables    6 
                           Number of ETA - Variables  4 
                           Number of KSI - Variables  4 
                           Number of Observations   813 
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TI 
         Covariance Matrix  
       

     wordself    pptself   wordgoal   pptgoal    wordper    pptper    
     --------   --------   --------   --------   --------   -------- 

wordself     0.359 
pptself      0.318      0.498 
wordgoal     0.218      0.222      1.199 
pptgoal       0.192      0.271      0.761      1.207 
wordper       0.420      0.269      0.736      0.766      8.479 
pptper       0.519      0.432      0.781      0.829      5.227      9.858 
goalcomm      0.076      0.062      0.108      0.115      0.445      0.438 
wordexp       0.107      0.127      0.229      0.199      0.289      0.274 
pptexp       0.098      0.145      0.171      0.228      0.216      0.193 
selfest       0.126      0.129      0.115      0.136      0.125      0.133 
neurotic      0.076      0.066      0.137      0.124      0.520      0.434 
learngoa      0.133      0.127      0.082      0.100      0.139      0.177 
comanxie      0.217      0.164      0.268      0.265      1.139      1.009 
 
         Covariance Matrix        
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
goalcomm      0.227 
wordexp       0.026      0.382 
pptexp        0.009      0.311      0.368 
selfest       0.053      0.036      0.042      0.215 
neurotic      0.123      0.020      0.013      0.063      0.537 
learngoa      0.062      0.040      0.042      0.144      0.032      0.270 
comanxie      0.197      0.143      0.111      0.053      0.358      0.059 
 
         Covariance Matrix        
 
            comanxie    
            -------- 
 comanxie      1.120 
 
          BEHAVIOR UNDER STEEPEST DESCENT ITERATIONS 
 
 
 
           ITER  TRY    ABSCISSA          SLOPE             FUNCTION 
 
              1    0    0.00000000D+00   -0.24485365D+06    0.13433282D+03 
                   1    0.10000000D+01    0.12974628D+38    0.70616940D+36 
                   2    0.18871729D-31   -0.24485365D+06    0.13433282D+03 
                   3    0.37743457D-31   -0.24485365D+06    0.13433282D+03 
                   4    0.56615186D-31   -0.24485365D+06    0.13433282D+03 
                   5    0.75486915D-31   -0.24485365D+06    0.13433282D+03 
                   6    0.94358644D-31   -0.24485365D+06    0.13433282D+03 
                   7    0.11323037D-30   -0.24485365D+06    0.13433282D+03 
                   8    0.13210210D-30   -0.24485365D+06    0.13433282D+03 
                   9    0.15097383D-30   -0.24485365D+06    0.13433282D+03 
                  10    0.16984556D-30   -0.24485365D+06    0.13433282D+03 
                  11    0.18871729D-30   -0.24485365D+06    0.13433282D+03 
                  12    0.20758902D-30   -0.24485365D+06    0.13433282D+03 
                  13    0.22646074D-30   -0.24485365D+06    0.13433282D+03 
                  14    0.24533247D-30   -0.24485365D+06    0.13433282D+03 
                  15    0.26420420D-30   -0.24485365D+06    0.13433282D+03 
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                  16    0.28307593D-30   -0.24485365D+06    0.13433282D+03 
                  17    0.30194766D-30   -0.24485365D+06    0.13433282D+03 
                  18    0.32081939D-30   -0.24485365D+06    0.13433282D+03 
                  19    0.33969112D-30   -0.24485365D+06    0.13433282D+03 
                  20    0.35856285D-30   -0.24485365D+06    0.13433282D+03 
 
              2    0    0.00000000D+00   -0.24485365D+06    0.13433282D+03 
                   1    0.10000000D+01    0.12974628D+38    0.70616940D+36 
                   2    0.18871729D-31   -0.24485365D+06    0.13433282D+03 
                   3    0.37743457D-31   -0.24485365D+06    0.13433282D+03 
                   4    0.56615186D-31   -0.24485365D+06    0.13433282D+03 
                   5    0.75486915D-31   -0.24485365D+06    0.13433282D+03 
                   6    0.94358644D-31   -0.24485365D+06    0.13433282D+03 
                   7    0.11323037D-30   -0.24485365D+06    0.13433282D+03 
                   8    0.13210210D-30   -0.24485365D+06    0.13433282D+03 
                   9    0.15097383D-30   -0.24485365D+06    0.13433282D+03 
                  10    0.16984556D-30   -0.24485365D+06    0.13433282D+03 
                  11    0.18871729D-30   -0.24485365D+06    0.13433282D+03 
                  12    0.20758902D-30   -0.24485365D+06    0.13433282D+03 
                  13    0.22646074D-30   -0.24485365D+06    0.13433282D+03 
                  14    0.24533247D-30   -0.24485365D+06    0.13433282D+03 
                  15    0.26420420D-30   -0.24485365D+06    0.13433282D+03 
                  16    0.28307593D-30   -0.24485365D+06    0.13433282D+03 
                  17    0.30194766D-30   -0.24485365D+06    0.13433282D+03 
                  18    0.32081939D-30   -0.24485365D+06    0.13433282D+03 
                  19    0.33969112D-30   -0.24485365D+06    0.13433282D+03 
                  20    0.35856285D-30   -0.24485365D+06    0.13433282D+03 
 
 
 TI                                                                              
 
 Parameter Specifications 
 
         LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper 
              --------   --------   --------   -------- 
 wordself        1          0          0          0 
 pptself         0          0          0          0 
 wordgoal        0          0          0          0 
 pptgoal         0          2          0          0 
 wordper         0          0          0          0 
 pptper          0          0          0          3 
 goalcomm        0          0          0          0 
 
         LAMBDA-X     
 
              prevexp     trainper   learngoa    comanxi 
              --------   --------   --------   -------- 
wordexp          0          0          0          0 
pptexp           4          0          0          0 
selfest          0          5          0          0 
neurotic         0          6          0          0 
learngoa         0          0          7          0 
comanxie         0          0          0          8 
 
         BETA         
 
              comself    goallevel   goalcomm     comper 
            --------   --------   --------   -------- 
comself          0          0          0          0 
goallevel        9          0          0          0 
goalcomm         10         0          0          0 
comper           11         12         13         0 
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         GAMMA        
 
              prevexp     trainper   learngoa    comanxi 
            --------   --------   --------   -------- 
 comself         14         15         16         17 
 goallevel        0          0          0          0 
 goalcomm         0          0          0          0 
 comper           0          0          0          0 
 
         PHI          
 
              prevexp     trainper   learngoa    comanxi 
            --------   --------   --------   -------- 
 prevexp          0 
 trainper        18          0 
 learngoa        19         20          0 
 comanxi         21         22         23          0 
 
         PSI          
 
            comself    goallevel   goalcomm     comper 
            --------   --------   --------   -------- 
                0         24         25         26 
 
         THETA-EPS    
 
        wordself     pptself   wordgoal   pptgoal    wordper    pptper 
            --------    --------   --------   --------   --------   -------- 
wordself        27 
pptself         28         29 
wordgoal         0         30         31 
pptgoal         32         33          0         34 
wordper         35         36          0          0         37 
pptper          38          0          0          0          0         39 
goalcomm        40         41          0          0          0          0 
 
         THETA-EPS    
 
             goalcomm 
            -------- 
  goalcomm          0 
 
         THETA-DELTA-EPS  
 
            wordself       pptself   wordgoal   pptgoal    wordper    pptper 
            --------   --------   --------   --------   --------   -------- 
  wordexp        42         43         44         45         46         47 
  pptexp         49         50         51         52         53         54 
  selfest         0         56         57         58          0          0 
  neurotic       62         63          0          0         64         65 
  learngoa        0         70          0         71          0          0 
 comanxie        74         75          0          0         76         77 
 
         THETA-DELTA-EPS  
 
             goalcomm 
            -------- 
  wordexp         0 
  pptexp          0 
  selfest         0 
  neurotic       66 
  learngoa        0 
 comanxie        78 
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         THETA-DELTA  
 
             wordexp    pptexp    selfest    neurotic    learngoa   comanxie 
            --------   --------   --------   --------   --------   -------- 
  wordexp        48 
  pptexp         55          0 
  selfest        59         60         61 
  neurotic       67          0         68         69 
  learngoa       72          0         73          0          0 
  comanxie       79          0         80          0          0          0 
 
 
 TI                                                                              
 
 Number of Iterations =312 
 
 LISREL Estimates (Maximum Likelihood)                            
 
         LAMBDA-Y     
 
              comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 wordself      0.378       - -        - -        - -  
              (0.126) 
               3.007 
  
 pptself       0.401       - -        - -        - -  
  
 wordgoal       - -       0.838       - -        - -  
  
 pptgoal        - -        0.875       - -        - -  
                         (0.087) 
                          10.011 
  
 wordper        - -        - -        - -       2.273 
  
 pptper         - -        - -        - -       2.330 
                                               (0.214) 
                                                10.879 
  
 goalcomm       - -        - -       0.476       - -  
  
 
         LAMBDA-X     
 
             prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  wordexp      - -        - -        - -        - -  
  
  pptexp      0.609       - -        - -        - -  
             (0.015) 
              40.389 
  
  selfest      - -       0.229       - -        - -  
                        (0.051) 
                         4.481 
  
  neurotic     - -       0.372       - -        - -  
                        (0.047) 
                         7.965 
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  learngoa     - -        - -       0.518       - -  
                                   (0.013) 
                                   40.326 
  
 comanxie      - -        - -        - -       1.052 
                                              (0.026) 
                                               40.505 
  
 
         BETA         
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself       - -        - -        - -        - -  
  
 goallevel    0.269       - -        - -        - -  
             (0.080) 
              3.364 
  
 goalcomm     0.349       - -        - -        - -  
             (0.126) 
              2.772 
  
 comper      -0.027      0.309      0.338       - -  
             (0.072)    (0.060)    (0.071) 
             -0.372      5.120      4.754 
  
 
         GAMMA        
 
              prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
 comself      -0.014      0.877      0.408     -0.516 
              (0.336)    (0.541)    (0.240)    (0.354) 
              -0.041      1.341      1.703     -0.634 
  
 goallevel      - -        - -        - -        - -  
  
 goalcomm       - -        - -        - -        - -  
  
 comper         - -        - -        - -        - -  
 
 
         Covariance Matrix of ETA and KSI         
 
            comself    goallevel   goalcomm   comper     prevexp   trainper    
            --------   --------   --------   --------   --------   -------- 
comself      1.000 
goallevel    0.670      1.000 
goalcomm     0.869      0.234      1.000 
comper       0.434      0.377      0.388      1.000 
prevexp     -0.122     -0.033     -0.043     -0.021      1.000 
trainper     0.891      0.382      0.495      0.248      0.009      1.000 
learngoa     0.667      0.179      0.233      0.116      0.119      0.156 
comanxi      0.295      0.279      0.362      0.181      0.149      0.901 
 
         Covariance Matrix of ETA and KSI         
 
            learngoa    comanxi    
            --------   -------- 
 learngoa      1.000 
 comanxi       0.100      1.000 
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         PHI          
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
prevexp      1.000 
  
trainper      0.009      1.000 
             (0.065) 
              0.132 
  
learngoa      0.119      0.156      1.000 
             (0.034)    (0.068) 
              3.544      2.279 
  
comanxi       0.149      0.901      0.100      1.000 
             (0.033)    (0.101)    (0.034) 
              4.587      8.942      2.941 
  
 
         PSI          
         Note: This matrix is diagonal. 
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
                - -       0.842      0.699      0.739 
                        (0.119)    (0.089)    (0.090) 
                          7.097      7.879      8.175 
  
 
 
         Squared Multiple Correlations for Structural Equations   
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
               1.000      0.176      0.302      0.242 
 
         Squared Multiple Correlations for Reduced Form           
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
               1.000      0.176      0.302      0.242 
 
         Reduced Form                 
 
             prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
  comself    -0.014      2.434      0.408     -1.195 
             (0.336)    (1.815)    (0.240)    (1.884) 
              -0.041      1.341      1.703     -0.634 
  
  goallevel  -0.004      0.654      0.110     -0.321 
             (0.090)    (0.473)    (0.057)    (0.508) 
              -0.041      1.382      1.927     -0.633 
  
 goalcomm     -0.005      0.849      0.142     -0.417 
             (0.117)    (0.516)    (0.072)    (0.606) 
              -0.040      1.647      1.983     -0.688 
  
   comper     -0.002      0.424      0.071     -0.208 
             (0.059)    (0.288)    (0.040)    (0.312) 
              -0.040      1.472      1.766     -0.668 
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         THETA-EPS    
 
             wordself   pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordself     -0.001 
             (0.077) 
             -0.013 
  
pptself     -0.064      0.093 
            (0.106)    (0.230) 
            -0.605      0.402 
  
wordgoal       - -      -0.009      0.470 
                        (0.075)    (0.072) 
                         -0.118      6.560 
  
pptgoal     -0.036      0.029       - -       0.414 
            (0.023)    (0.083)               (0.077) 
            -1.579      0.353                 5.382 
  
wordper      0.037     -0.137       - -        - -       3.375 
            (0.117)    (0.062)                          (0.461) 
             0.319     -2.219                            7.316 
  
pptper      0.114       - -        - -        - -        - -       4.504 
           (0.121)                                                (0.504) 
            0.942                                                  8.938 
  
goalcomm   -0.087     -0.111       - -        - -        - -        - -  
           (0.035)    (0.046) 
           -2.460     -2.412 
  
         THETA-EPS    
 
             goalcomm    
             -------- 
  goalcomm       - -  
  
 
         Squared Multiple Correlations for Y - Variables          
 
            wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
               0.859      0.812      0.605      0.654      0.599      0.540 
 
         Squared Multiple Correlations for Y - Variables          
 
             goalcomm    
             -------- 
               1.000 
          
 

THETA-DELTA-EPS  
 
           wordself     pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordexp      0.099      0.121      0.220      0.189      0.247      0.219 
            (0.013)    (0.016)    (0.024)    (0.024)    (0.060)    (0.065) 
             7.683      7.772      9.078      7.878      4.125      3.395 
  
   
pptexp      0.120      0.171      0.181      0.239      0.214      0.176 
           (0.018)    (0.023)    (0.025)    (0.026)    (0.061)    (0.065) 
            6.788      7.414      7.220      9.310      3.538      2.710 
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selfest       - -      -0.005      0.038      0.056       - -        - -  
                       (0.043)    (0.015)    (0.020) 
                       -0.104      2.527      2.773 
 
neurotic     -0.128     -0.150       - -        - -     0.299      0.217 
            (0.058)    (0.070)                         (0.099)    (0.104) 
            -2.198     -2.134                           3.007      2.085 
  
learngoa       - -      -0.014       - -       0.013       - -        - -  
                        (0.046)               (0.018) 
                        -0.311                 0.718 
  
comanxie     -0.203     -0.281       - -        - -       0.674      0.539 
             (0.108)    (0.134)                          (0.179)    (0.186) 
             -1.885     -2.097                           3.770      2.900 
  
 
         THETA-DELTA-EPS  
 
             goalcomm    
            -------- 
  wordexp      - -  
  
  pptexp       - -  
  
  selfest      - -  
  
  neurotic    0.036 
             (0.029) 
              1.229 
  
  learngoa       - -  
  
 comanxie      0.007 
             (0.053) 
               0.125 
  
 
         THETA-DELTA  
 
             wordexp    pptexp    selfest    neurotic    learngoa   comanxie    
            --------   --------   --------   --------   --------   -------- 
  wordexp     0.382 
             (0.019) 
              20.175 
  
  pptexp     0.313       - -  
             (0.017) 
              18.251 
  
  selfest      0.030      0.035      0.162 
             (0.010)    (0.012)    (0.023) 
               3.044      2.856      6.981 
  
  neurotic    0.005       - -      -0.021      0.398 
             (0.015)               (0.018)    (0.036) 
               0.370               -1.132     11.117 
  
  learngoa    0.034       - -       0.124       - -        - -  
             (0.011)               (0.012) 
               3.135                10.576 
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 comanxie     0.122       - -      -0.165       - -        - -        - -  
             (0.022)               (0.067) 
              5.647                -2.460 
  
 
         Squared Multiple Correlations for X - Variables          
 
             wordexp    pptexp    selfest    neurotic    learngoa   comanxie    
            --------   --------   --------   --------   --------   -------- 
              0.757      1.000      0.244      0.258      1.000      1.000 
 
 
                           Goodness of Fit Statistics 
 
                             Degrees of Freedom = 11 
               Minimum Fit Function Chi-Square = 9.146 (P = 0.608) 
       Normal Theory Weighted Least Squares Chi-Square = 9.065 (P = 0.616) 
                  Estimated Non-centrality Parameter (NCP) = 0.0 
              90 Percent Confidence Interval for NCP = (0.0 ; 8.866) 
  
                       Minimum Fit Function Value = 0.0113 
                 Population Discrepancy Function Value (F0) = 0.0 
              90 Percent Confidence Interval for F0 = (0.0 ; 0.0109) 
              Root Mean Square Error of Approximation (RMSEA) = 0.0 
            90 Percent Confidence Interval for RMSEA = (0.0 ; 0.0315) 
               P-Value for Test of Close Fit (RMSEA < 0.05) = 0.999 
  
                  Expected Cross-Validation Index (ECVI) = 0.211 
            90 Percent Confidence Interval for ECVI = (0.211 ; 0.222) 
                         ECVI for Saturated Model = 0.224 
                       ECVI for Independence Model = 6.778 
  
     Chi-Square for Independence Model with 78 Degrees of Freedom = 5477.822 
                           Independence AIC = 5503.822 
                               Model AIC = 169.065 
                             Saturated AIC = 182.000 
                           Independence CAIC = 5577.932 
                               Model CAIC = 625.123 
                             Saturated CAIC = 700.767 
  
                          Normed Fit Index (NFI) = 0.998 
                       Non-Normed Fit Index (NNFI) = 1.002 
                    Parsimony Normed Fit Index (PNFI) = 0.141 
                       Comparative Fit Index (CFI) = 1.000 
                       Incremental Fit Index (IFI) = 1.000 
                         Relative Fit Index (RFI) = 0.988 
  
                            Critical N (CN) = 2196.118 
  
  
                     Root Mean Square Residual (RMR) = 0.0201 
                            Standardized RMR = 0.0184 
                       Goodness of Fit Index (GFI) = 0.998 
                  Adjusted Goodness of Fit Index (AGFI) = 0.986 
                  Parsimony Goodness of Fit Index (PGFI) = 0.121 
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 TI                                                                              
 
         Fitted Covariance Matrix 
 
         wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself    0.355 
 pptself     0.314      0.493 
 wordgoal    0.212      0.216      1.187 
 pptgoal     0.186      0.264      0.750      1.197 
 wordper     0.410      0.258      0.718      0.750      8.413 
 pptper      0.496      0.406      0.736      0.769      5.164      9.798 
 goalcomm    0.070      0.055      0.093      0.097      0.419      0.430 
 wordexp     0.099      0.121      0.220      0.189      0.247      0.219 
 pptexp      0.092      0.141      0.164      0.221      0.185      0.146 
 selfest     0.123      0.126      0.112      0.132      0.129      0.132 
 neurotic    0.072      0.062      0.119      0.124      0.508      0.432 
 learngoa    0.131      0.124      0.078      0.094      0.137      0.140 
 comanxie    0.209      0.157      0.246      0.257      1.107      0.982 
 
         Fitted Covariance Matrix 
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
  goalcomm    0.227 
  wordexp       - -      0.382 
  pptexp     -0.012      0.313      0.371 
  selfest     0.054      0.030      0.036      0.214 
  neurotic    0.124      0.005      0.002      0.064      0.537 
  learngoa    0.057      0.034      0.038      0.143      0.030      0.269 
 comanxie     0.188      0.122      0.096      0.052      0.353      0.054 
 
         Fitted Covariance Matrix 
 
            comanxie    
            -------- 
 comanxie      1.106 
 
         Fitted Residuals 
 

      wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself     0.004 
 pptself      0.004      0.005 
 wordgoal     0.005      0.005      0.011 
 pptgoal      0.006      0.006      0.011      0.010 
 wordper      0.010      0.010      0.018      0.015      0.066 
 pptper       0.022      0.026      0.044      0.060      0.063      0.060 
 goalcomm     0.006      0.008      0.015      0.017      0.025      0.008 
 wordexp      0.007      0.006      0.010      0.010      0.041      0.054 
 pptexp       0.006      0.004      0.007      0.007      0.031      0.047 
 selfest      0.003      0.004      0.004      0.003     -0.003      0.001 
 neurotic     0.004      0.004      0.018     -0.001      0.011      0.001 
 learngoa     0.002      0.003      0.004      0.006      0.002      0.037 
 comanxie     0.008      0.007      0.022      0.008      0.032      0.027 
 
         Fitted Residuals 
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
  goalcomm     0.000 
  wordexp      0.026      0.000 
  pptexp       0.022     -0.002     -0.003 
  selfest     -0.001      0.006      0.006      0.001 
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  neurotic     0.000      0.015      0.011     -0.001      0.000 
  learngoa     0.004      0.006      0.005      0.001      0.002      0.001 
  comanxie     0.009      0.021      0.016      0.001      0.005      0.005 
 
         Fitted Residuals 
 
            comanxie    
            -------- 
 comanxie      0.014 
 
 Summary Statistics for Fitted Residuals 
 
 Smallest Fitted Residual =   -0.003 
   Median Fitted Residual =    0.006 
  Largest Fitted Residual =    0.066 
 
  
 
Stemleaf Plot 
 
 - 0|3321110000  
   0|111111222333444444444555555666666666777788889  
   1|00000111145556788  
   2|12225667  
   3|127  
   4|147  
   5|4  
   6|0036 
 
         Standardized Residuals   
 
      wordself   pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself     2.421 
 pptself      2.465      2.423 
 wordgoal     0.747      0.778      2.237 
 pptgoal      1.338      1.358      2.303      2.233 
 wordper      0.728      0.689      0.355      0.348      2.443 
 pptper       1.380      1.498      0.757      1.135      2.443      2.443 
 goalcomm     2.171      2.275      1.109      1.508      1.796      0.502 
 wordexp      2.093      2.008      1.681      1.819      1.971      2.437 
 pptexp       2.203      2.107      1.346      1.448      1.736      2.375 
 selfest      1.817      1.876      1.285      1.264     -0.126      0.048 
 neurotic     2.319      1.664      1.405     -0.058      1.075      0.124 
 learngoa     0.871      1.096      1.298      1.929      0.074      0.988 
 comanxie     2.070      1.777      1.435      0.674      2.588      2.187 
 
         Standardized Residuals   
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
 goalcomm       - -  
 wordexp      2.499     -0.447 
 pptexp       2.528     -1.864     -2.282 
 selfest     -0.303      2.517      2.524      2.337 
 neurotic    -0.256      2.600      2.221     -0.428     -0.277 
 learngoa     0.868      2.089      1.909      2.428      0.708      2.467 
 comanxie     2.506      2.460      2.229      0.331      1.966      1.166 
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         Standardized Residuals   
 
            comanxie    
            -------- 
 comanxie      2.558 
 
 Summary Statistics for Standardized Residuals 
 
 Smallest Standardized Residual =   -2.282 
   Median Standardized Residual =    1.681 
  Largest Standardized Residual =    2.600 
 
 Stemleaf Plot 
 
 - 2|3  
 - 1|9  
 - 1|  
 - 0|  
 - 0|443331100  
   0|11334  
   0|5777778899  
   1|0111123333344444  
   1|557778888999  
   2|00011112222222333344444444  
   2|55555555666 
 Largest Positive Standardized Residuals 
 Residual for  neurotic and  wordexp   2.600 
 Residual for comanxie and  wordper   2.588 
 
 
 TI                                                                              
 
                         Qplot of Standardized Residuals 
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   -3.5                                                                      
3.5 
                             Standardized Residuals 
 
 TI                                                                              
 
 Modification Indices and Expected Change 
 
         Modification Indices for LAMBDA-Y        
 
            comself     goallevel   goalcomm     comper    
            --------    --------   --------   -------- 
 wordself      - -        0.148       - -       0.148 
 pptself       - -        - -        - -        - -  
 wordgoal      0.040       - -       0.151      0.172 
 pptgoal       0.040       - -       0.420      0.345 
 wordper       0.059      0.381      0.343       - -  
 pptper        0.059      0.381      0.343       - -  
 goalcomm       - -       0.148       - -       0.148 
 
         Expected Change for LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper    
            --------   --------     --------   -------- 
 wordself      - -       -0.023       - -      -0.074 
 pptself       - -        - -        - -        - -  
 wordgoal      0.008       - -      -0.015     -0.023 
 pptgoal      -0.009       - -       0.025      0.037 
 wordper      -0.044     -0.101      0.103       - -  
 pptper        0.045      0.104     -0.105       - -  
 goalcomm       - -       0.010       - -       0.032 
 
         Standardized Expected Change for LAMBDA-Y        
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 wordself      - -       -0.023      - -       -0.073 
 pptself       - -        - -        - -        - -  
 wordgoal      0.013       - -      -0.015     -0.023 
 pptgoal      -0.014       - -       0.025      0.037 
 wordper      -0.069     -0.102      0.103       - -  
 pptper        0.070      0.105     -0.105       - -  
 goalcomm       - -       0.010       - -       0.032 
 
         
 
 

 Completely Standardized Expected Change for LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper    
              --------   --------   --------   -------- 
 wordself      - -       -0.039       - -      -0.122 
 pptself       - -         - -        - -        - -  
 wordgoal      0.012       - -      -0.013     -0.021 
 pptgoal      -0.013       - -       0.023      0.034 
 wordper      -0.024     -0.035      0.035       - -  
 pptper        0.023      0.034     -0.034       - -  
 goalcomm       - -       0.021       - -       0.067 
 
         Modification Indices for LAMBDA-X        
 
               prevexp     trainper   learngoa    comanxi    
               --------   --------   --------   -------- 
  wordexp       5.702      5.702      5.702      5.702 
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  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
         Expected Change for LAMBDA-X     
 
               prevexp     trainper   learngoa    comanxi    
               --------   --------   --------   -------- 
  wordexp      -1.193      0.103      0.219      0.140 
  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
         Standardized Expected Change for LAMBDA-X        
 
                prevexp     trainper   learngoa    comanxi    
               --------   --------   --------   -------- 
  wordexp       -1.193      0.103      0.219      0.140 
  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
         Completely Standardized Expected Change for LAMBDA-X     
 
                prevexp     trainper   learngoa   comanxi    
                --------   --------   --------   -------- 
  wordexp       -1.929      0.166      0.354      0.227 
  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
          

Modification Indices for BETA            
 
               comself    goallevel   goalcomm   comper    
               --------   --------   --------   -------- 
 comself         - -        - -       0.148      0.148 
 goallevel       - -        - -       0.148      0.148 
 goalcomm        - -       0.148       - -       0.148 
 comper          - -        - -        - -        - -  
 
 

 Expected Change for BETA         
 
              comself    goallevel  goalcomm   comper    
             --------   --------   --------   -------- 
 comself       - -        - -       0.094      0.279 
 goallevel     - -        - -       0.025      0.075 
 goalcomm      - -       0.021       - -       0.068 
  comper       - -        - -        - -        - -  
 
         Standardized Expected Change for BETA            
 
             comself   goallevel goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -        - -       0.060      0.179 
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 goallevel    - -        - -       0.025      0.075 
 goalcomm     - -       0.021       - -       0.069 
 comper       - -        - -        - -        - -  
 
         Modification Indices for GAMMA           
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  goallevel   0.089      0.089      0.089      0.089 
  goalcomm    0.365      0.666      0.584      0.732 
  comper      0.089      0.089      0.089      0.089 
 
         Expected Change for GAMMA        
 
             prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
  comself       - -        - -        - -        - -  
  goallevel   0.277     -0.102      0.034     -0.099 
  goalcomm    0.151     -0.081      0.026     -0.082 
  comper      0.086     -0.032      0.011     -0.031 
 
         Standardized Expected Change for GAMMA           
 
              prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  goallevel   0.274     -0.101      0.034     -0.098 
  goalcomm    0.151     -0.081      0.026     -0.082 
  comper      0.087     -0.032      0.011     -0.031 
 
 No Non-Zero Modification Indices for PHI          
 
         Modification Indices for PSI             
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself     - -  
 goallevel   - -        - -  
 goalcomm    0.148      0.148       - -  
 comper       - -        - -        - -        - -  
 
         Expected Change for PSI          
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -  
 goallevel    - -        - -  
 goalcomm    0.066      0.018       - -  
 comper       - -        - -        - -        - -  
 
 
         Standardized Expected Change for PSI             
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -  
 goallevel    - -        - -  
 goalcomm     0.042      0.018      - -  
 comper       - -        - -        - -        - - 
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         Modification Indices for THETA-EPS       
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself      - -  
 pptself       - -        - -  
 wordgoal     0.148       - -        - -  
 pptgoal       - -        - -        - -        - -  
 wordper       - -        - -       0.024      0.037       - -  
 pptper        - -        - -       0.000      0.140       - -        - -  
 goalcomm      - -        - -       0.178      0.488      0.495      0.495 
 
         Modification Indices for THETA-EPS       
 
             goalcomm    
            -------- 
  goalcomm       - -  
 
         Expected Change for THETA-EPS    
 
           wordself     pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself      - -  
 pptself       - -        - -  
 wordgoal    -0.016       - -        - -  
 pptgoal       - -        - -        - -        - -  
 wordper       - -        - -      -0.011     -0.014       - -  
 pptper        - -        - -      -0.001      0.030       - -        - -  
 goalcomm      - -        - -      -0.005      0.010      0.043     -0.044 
 
         Expected Change for THETA-EPS    
 
             goalcomm    
            -------- 
  goalcomm       - -  
 
         Completely Standardized Expected Change for THETA-EPS    
 
           wordself       pptself   wordgoal   pptgoal    wordper    pptper    
           --------   --------   --------   --------   --------   -------- 
 wordself      - -  
 pptself       - -        - -  
 wordgoal    -0.025       - -        - -  
 pptgoal       - -        - -        - -        - -  
 wordper       - -        - -      -0.004     -0.005       - -  
 pptper        - -        - -       0.000      0.009       - -        - -  
 goalcomm      - -        - -      -0.011      0.018      0.031     -0.030 
 
         Completely Standardized Expected Change for THETA-EPS    
 
             goalcomm    
            -------- 
 goalcomm       - -  
 
         Modification Indices for THETA-DELTA-EPS 
 
            wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
  wordexp      - -        - -        - -        - -        - -        - -  
  pptexp       - -        - -        - -        - -        - -        - -  
  selfest     0.873       - -        - -        - -       0.042      0.227 
  neurotic     - -        - -       0.576      0.576       - -        - -  
  learngoa    0.571       - -        - -        - -       0.311      0.747 
  comanxie     - -        - -       0.069      0.069       - -        - - 
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         Modification Indices for THETA-DELTA-EPS 
 
             goalcomm    
            -------- 
 wordexp      5.702 
 pptexp       - -  
 selfest      0.640 
 neurotic      - -  
 learngoa     0.375 
 comanxie      - -  
 
         Expected Change for THETA-DELTA-EPS  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordexp      - -        - -        - -        - -        - -        - -  
 pptexp       - -        - -        - -        - -        - -        - -  
 selfest     0.014       - -        - -        - -       0.006     -0.016 
 neurotic     - -        - -       0.016     -0.016       - -        - -  
 learngoa    -0.013      - -        - -        - -      -0.019      0.032 
 comanxie     - -        - -       0.008     -0.008       - -        - -  
 
         Expected Change for THETA-DELTA-EPS  
 
             goalcomm    
            -------- 
 wordexp      0.024 
 pptexp       - -  
 selfest     -0.005 
 neurotic     - -  
 learngoa     0.004 
 comanxie      - -  
 
         Completely Standardized Expected Change for THETA-DELTA-EPS  
 
           wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordexp      - -        - -        - -        - -        - -        - -  
 pptexp       - -        - -        - -        - -        - -        - -  
 selfest     0.050       - -        - -        - -       0.005     -0.011 
 neurotic     - -        - -       0.020     -0.020       - -        - -  
 learngoa   -0.041       - -        - -        - -      -0.013      0.020 
 comanxie     - -        - -       0.007     -0.007       - -        - -  
 
         Completely Standardized Expected Change for THETA-DELTA-EPS  
 
             goalcomm    
            -------- 
 wordexp     0.082 
 pptexp       - -  
 selfest    -0.023 
 neurotic     - -  
 learngoa    0.018 
 comanxie     - -  
 
 
 TI        
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 Factor Scores Regressions 
 
         ETA  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
comself      1.689      1.110     -0.053      0.145     -0.044     -0.085 
goallevel    0.333      0.099      0.417      0.559      0.017      0.000 
goalcomm     0.465      0.425     -0.050     -0.027      0.009     -0.021 
comper      -0.078      0.261      0.076      0.060      0.190      0.129 
 
         ETA  
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
comself      0.664      0.095     -1.215     -0.269      0.262      0.009 
goallevel   -0.084     -0.245     -0.482     -0.365      0.004      0.115 
goalcomm     2.145     -0.025     -0.152     -0.239     -0.160     -0.222 
comper       0.343     -0.170     -0.121     -0.070     -0.116     -0.015 
 
         ETA  
 
            comanxie    
            -------- 
comself      0.519 
goallevel    0.042 
goalcomm    -0.053 
comper      -0.174 
 
         KSI  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
prevexp      0.050     -0.716      0.445     -0.584     -0.026      0.030 
trainper     0.863      0.613     -0.013     -0.005     -0.051     -0.053 
learngoa     0.204      0.191      0.115     -0.007     -0.001     -0.009 
comanxi      0.414      0.393      0.053     -0.127     -0.067     -0.039 
 
         KSI  
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
prevexp      0.232     -4.770      6.001     -0.185     -0.070      0.383 
trainper     0.242     -0.363     -0.232      0.681      0.040     -0.829 
learngoa     0.141     -0.701      0.561     -2.018      0.149      2.767 
comanxi     -0.016     -1.005      0.667      0.925     -0.086     -0.756 
 
         

 KSI  
 
            comanxie    
            -------- 
   prevexp      0.247 
   trainper     0.723 
  learngoa     -0.071 
   comanxi      1.013 
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 TI                                                                              
 
 Standardized Solution            
 
         LAMBDA-Y     
 
           comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
wordself     0.597       - -        - -        - -  
pptself      0.633       - -        - -        - -  
wordgoal      - -       0.847       - -        - -  
pptgoal       - -       0.885       - -        - -  
wordper       - -        - -        - -       2.244  
pptper        - -        - -        - -       2.301 
goalcomm      - -        - -       0.476       - -  
 
 
 
         LAMBDA-X     
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
wordexp        - -        - -        - -        - -  
pptexp        0.609       - -        - -        - -  
selfest        - -       0.229       - -        - -  
neurotic       - -       0.372       - -        - -  
learngoa       - -        - -       0.518       - -  
comanxie       - -        - -        - -       1.052 
 
         BETA         
 
             comself  goallevel   goalcomm    comper    
            --------   --------   --------   -------- 
comself      - -         - -        - -        - -  
goallevel    0.420       - -        - -        - -  
goalcomm     0.550       - -        - -        - -  
comper      -0.043      0.317      0.342       - -  
 
         GAMMA        
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
comself     -0.009      1.542      0.259     -0.757 
goallevel     - -        - -        - -        - -  
goalcomm      - -        - -        - -        - -  
comper        - -        - -        - -        - -  
 
         Correlation Matrix of ETA and KSI        
 
         comself    goallevel   goalcomm     comper    prevexp    trainper    
         --------   --------   --------   --------   --------   -------- 
comself      1.000 
goallevel    0.420      1.000 
goalcomm     0.550      0.231      1.000 
comper       0.279      0.378      0.392      1.000 
prevexp     -0.077     -0.033     -0.043     -0.022      1.000 
trainper     0.900      0.378      0.495      0.251      0.009      1.000 
learngoa     0.422      0.177      0.232      0.118      0.119      0.156 
comanxi      0.658      0.276      0.362      0.183      0.149      0.901 
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         Correlation Matrix of ETA and KSI        
 
            learngoa    comanxi    
            --------   -------- 
 learngoa      1.000 
  comanxi      0.100      1.000 
 
         PSI          
         Note: This matrix is diagonal. 
 
             comself    goallevel  goalcomm   comper    
            --------   --------   --------   -------- 
                - -       0.824      0.698      0.758 
 
         Regression Matrix ETA on KSI (Standardized)  
 
            prevexp    trainper   learngoa   comanxi    
            --------   --------   --------   -------- 
comself     -0.009      1.542      0.259     -0.757 
goallevel   -0.004      0.647      0.109     -0.318 
goalcomm    -0.005      0.848      0.142     -0.416 
comper      -0.002      0.430      0.072     -0.211 
 
 TI                                                                              
 
 Completely Standardized Solution 
 
         LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 wordself     0.973       - -        - -        - -  
 pptself      0.901       - -        - -        - -  
 wordgoal      - -       0.778       - -        - -  
 pptgoal       - -       0.809       - -        - -  
 wordper       - -        - -        - -       0.774 
 pptper        - -        - -        - -       0.735 
 goalcomm      - -        - -       1.000       - -  
 
         LAMBDA-X     
 
            prevexp    trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 wordexp      0.980       - -        - -        - -  
 pptexp       1.000       - -        - -        - -  
 selfest       - -       0.494       - -        - -  
 neurotic      - -       0.508       - -        - -  
 learngoa      - -        - -       1.000       - -  
 comanxie      - -        - -        - -       1.000 
 
         BETA         
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  goallevel  0.420       - -        - -        - -  
  goalcomm   0.550       - -        - -        - -  
  comper     -0.043      0.317      0.342      - -  
 
         GAMMA       
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              prevexp   trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
 comself     -0.009      1.542      0.259     -0.757 
 goallevel    - -        - -        - -        - -  
 goalcomm     - -        - -        - -        - -  
 comper       - -        - -        - -        - -  
 
          
 
 

Correlation Matrix of ETA and KSI        
 
         comself    goallevel   goalcomm   comper    prevexp    trainper    
         --------   --------   --------   --------   --------   -------- 
comself    1.000 
goallevel  0.420      1.000 
goalcomm   0.550      0.231      1.000 
comper     0.279      0.378      0.392      1.000 
prevexp   -0.077     -0.033     -0.043     -0.022      1.000 
trainper   0.900      0.378      0.495      0.251      0.009      1.000 
learngoa   0.422      0.177      0.232      0.118      0.119      0.156 
comanxi    0.658      0.276      0.362      0.183      0.149      0.901 
 
         Correlation Matrix of ETA and KSI        
 
            learngoa    comanxi    
            --------   -------- 
 learngoa      1.000 
  comanxi      0.100      1.000 
 
         PSI          
         Note: This matrix is diagonal. 
 
           comself    goallevel   goalcomm    comper    
            --------   --------   --------   -------- 
              - -       0.824      0.698      0.758 
 
         THETA-EPS    
 
           wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordself    -0.003 
pptself     -0.153      0.188 
wordgoal       - -     -0.012      0.395 
pptgoal     -0.055      0.038       - -       0.346 
wordper      0.022     -0.067       - -        - -       0.401 
pptper       0.061       - -        - -        - -        - -       0.460 
goalcomm    -0.305     -0.332       - -        - -        - -        - -  
 
         THETA-EPS    
 
             goalcomm    
            -------- 
  goalcomm       - -  
 
         THETA-DELTA-EPS  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordexp     0.269      0.278      0.326      0.280      0.138      0.113 
pptexp      0.331      0.399      0.273      0.358      0.121      0.092 
selfest      - -      -0.014      0.076      0.110       - -        - -  
neurotic   -0.294     -0.292       - -        - -       0.141      0.095 
learngoa     - -      -0.039       - -       0.022       - -        - -  
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comanxie   -0.324     -0.380       - -        - -       0.221      0.164 
 
         THETA-DELTA-EPS  
 
              goalcomm    
              -------- 
  wordexp        - -  
  pptexp         - -  
  selfest        - -  
  neurotic      0.103 
  learngoa       - -  
  comanxie      0.013 
 
         
 

 THETA-DELTA  
 
             wordexp    pptexp    selfest    neurotic   learngoa   comanxie    
            --------   --------   --------   --------   --------   -------- 
  wordexp     1.000 
  pptexp      0.832       - -  
  selfest     0.104      0.125      0.756 
  neurotic    0.012       - -      -0.061      0.742 
  learngoa    0.107       - -       0.518       - -        - -  
  comanxie    0.187       - -      -0.339       - -        - -        - -  
 
         Regression Matrix ETA on KSI (Standardized)  
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself     -0.009      1.542      0.259     -0.757 
  goallevel   -0.004      0.647      0.109     -0.318 
  goalcomm    -0.005      0.848      0.142     -0.416 
   comper     -0.002      0.430      0.072     -0.211 
 
 
 TI                                                                              
 
 Total and Indirect Effects 
 
         Total Effects of KSI on ETA  
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself     -0.014      0.877      0.408     -0.516 
             (0.336)    (0.541)    (0.240)    (0.354) 
              -0.041      1.341      1.703     -0.634 
  
  goallevel   -0.004      0.654      0.110     -0.321 
             (0.090)    (0.473)    (0.057)    (0.508) 
              -0.041      1.382      1.927     -0.633 
  
  goalcomm    -0.005      0.849      0.142     -0.417 
             (0.117)    (0.516)    (0.072)    (0.606) 
              -0.040      1.647      1.983     -0.688 
  
  comper     -0.002      0.424      0.071     -0.208 
             (0.059)    (0.288)    (0.040)    (0.312) 
             -0.040      1.472      1.766     -0.668 
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         Indirect Effects of KSI on ETA   
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself       - -        - -        - -        - -  
  
  goallevel   -0.004      0.654      0.110     -0.321 
             (0.090)    (0.473)    (0.057)    (0.508) 
              -0.041      1.382      1.927     -0.633 
  
  goalcomm    -0.005      0.849      0.142     -0.417 
             (0.117)    (0.516)    (0.072)    (0.606) 
              -0.040      1.647      1.983     -0.688 
  
  comper     -0.002      0.424      0.071     -0.208 
             (0.059)    (0.288)    (0.040)    (0.312) 
             -0.040      1.472      1.766     -0.668 
  
 
         Total Effects of ETA on ETA  
 
            comself    goallevel   goalcomm     comper    
           --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  
  goallevel   0.269       - -        - -        - -  
             (0.080) 
              3.364 
  
  goalcomm      0.349       - -        - -        - -  
             (0.126) 
               2.772 
  
  comper      0.174      0.309      0.338       - -  
             (0.097)    (0.060)    (0.071) 
              1.801      5.120      4.754 
  
    Largest Eigenvalue of B*B' (Stability Index) is   0.217 
 
         Indirect Effects of ETA on ETA   
 
          comself    goallevel   goalcomm     comper    
           --------   --------   --------   -------- 
 comself       - -       - -        - -        - -  
  
 goallevel     - -       - -        - -        - -  
  
 goalcomm      - -       - -        - -        - -  
  
 comper      0.201       - -        - -        - -  
            (0.051) 
             3.964 
  
         Total Effects of ETA on Y    
 
       comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
wordself     0.378       - -        - -        - -  
            (0.126) 
             3.007 
  
pptself      0.401       - -        - -        - -  
  
wordgoal     0.225      0.838       - -        - -  
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            (0.067) 
             3.364 
  
pptgoal      0.235      0.875       - -        - -  
            (0.071)    (0.087) 
             3.294     10.011 
  
wordper      0.396      0.703      0.768      2.273 
            (0.220)    (0.137)    (0.162) 
             1.801      5.120      4.754 
  
pptper       0.406      0.721      0.787      2.330 
            (0.227)    (0.143)    (0.167)    (0.214) 
             1.788      5.056      4.700     10.879 
  
goalcomm     0.166       - -       0.476       - -  
            (0.060) 
             2.772 
  
         Indirect Effects of ETA on Y     
 
             comself    goallevel   goalcomm     comper    
             --------   --------   --------   -------- 
 wordself      - -        - -        - -        - -  
  
 pptself       - -        - -        - -        - -  
  
 wordgoal     0.225       - -        - -        - -  
             (0.067) 
              3.364 
  
 pptgoal     0.235       - -        - -        - -  
            (0.071) 
              3.294 
  
 wordper     0.396      0.703      0.768       - -  
            (0.220)    (0.137)    (0.162) 
             1.801      5.120      4.754 
  
 pptper      0.406      0.721      0.787       - -  
            (0.227)    (0.143)    (0.167) 
             1.788      5.056      4.700 
  
 goalcomm    0.166       - -        - -        - -  
            (0.060) 
             2.772 
  
         Total Effects of KSI on Y    
 
              prevexp     trainper   learngoa    comanxi    
              --------   --------   --------   -------- 
 wordself     -0.005      0.920      0.154     -0.452 
              (0.127)    (0.567)    (0.077)    (0.662) 
              -0.040      1.623      1.995     -0.682 
  
  pptself     -0.005      0.976      0.164     -0.479 
             (0.135)    (0.728)    (0.096)    (0.755) 
              -0.041      1.341      1.703     -0.634 
  
  wordgoal     -0.003      0.548      0.092     -0.269 
             (0.076)    (0.397)    (0.048)    (0.425) 
              -0.041      1.382      1.927     -0.633 
  
  pptgoal     -0.003      0.573      0.096     -0.281 
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             (0.079)    (0.422)    (0.050)    (0.448) 
              -0.041      1.357      1.924     -0.628 
  
  wordper     -0.005      0.964      0.162     -0.473 
             (0.133)    (0.655)    (0.092)    (0.709) 
              -0.040      1.472      1.766     -0.668 
  
  pptper     -0.006      0.988      0.166     -0.485 
             (0.137)    (0.674)    (0.094)    (0.728) 
              -0.040      1.466      1.766     -0.667 
  
  goalcomm     -0.002      0.404      0.068     -0.198 
             (0.056)    (0.245)    (0.034)    (0.288) 
              -0.040      1.647      1.983     -0.688 
  
 TI                                                                              
 
 Standardized Total and Indirect Effects 
 
         Standardized Total Effects of KSI on ETA 
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 comself     -0.009      1.542      0.259     -0.757 
 goallevel   -0.004      0.647      0.109     -0.318 
 goalcomm    -0.005      0.848      0.142     -0.416 
 comper      -0.002      0.430      0.072     -0.211 
 
         Standardized Indirect Effects of KSI on ETA  
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 comself     - -        - -        - -        - -  
 goallevel  -0.004      0.647      0.109     -0.318 
 goalcomm   -0.005      0.848      0.142     -0.416 
 comper     -0.002      0.430      0.072     -0.211 
         Standardized Total Effects of ETA on ETA 
 
            comself    goallevel   goalcomm   comper    
            --------   --------   --------   -------- 
 comself      - -        - -        - -        - -  
 goallevel   0.420       - -        - -        - -  
 goalcomm    0.550       - -        - -        - -  
 comper      0.279      0.317      0.342       - -  
 
         Standardized Indirect Effects of ETA on ETA  
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -        - -        - -        - -  
 goallevel    - -        - -        - -        - -  
 goalcomm     - -        - -        - -        - -  
 comper      0.321       - -        - -        - -  
 
         Standardized Total Effects of ETA on Y   
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
wordself     0.597       - -        - -        - -  
pptself      0.633       - -        - -        - -  
wordgoal     0.356      0.847       - -        - -  
pptgoal      0.371      0.885       - -        - -  
wordper      0.625      0.711      0.769      2.244 
pptper       0.641      0.729      0.788      2.301 
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goalcomm     0.262       - -       0.476       - -  
 
         Completely Standardized Total Effects of ETA on Y    
 
            comself    goallevel   goalcomm   comper    
            --------   --------   --------   -------- 
wordself     1.001       - -        - -        - -  
pptself      0.901       - -        - -        - -  
wordgoal     0.326      0.778       - -        - -  
pptgoal      0.339      0.809       - -        - -  
wordper      0.216      0.245      0.265      0.774 
pptper       0.205      0.233      0.252      0.735 
goalcomm     0.550       - -       1.000       - -  
 
          

Standardized Indirect Effects of ETA on Y    
 
             comself    goallevel   goalcomm   comper    
              --------   --------   --------   -------- 
 wordself      - -        - -        - -        - -  
 pptself       - -        - -        - -        - -  
 wordgoal     0.356       - -        - -        - -  
 pptgoal      0.371       - -        - -        - -  
 wordper      0.625      0.711      0.769       - -  
 pptper       0.641      0.729      0.788       - -  
 goalcomm     0.262       - -        - -        - -  
 
         Completely Standardized Indirect Effects of ETA on Y     
 
             comself    goallevel   goalcomm   comper    
            --------   --------   --------   -------- 
 wordself     - -         - -        - -        - -  
 pptself      - -         - -        - -        - -  
 wordgoal     0.326       - -        - -        - -  
 pptgoal      0.339       - -        - -        - -  
 wordper      0.216      0.245      0.265       - -  
 pptper       0.205      0.233      0.252       - -  
 goalcomm     0.550       - -        - -        - -  
 
         Standardized Total Effects of KSI on Y   
 
             prevexp     trainper  learngoa   comanxi    
            --------   --------   --------   -------- 
 wordself    -0.005      0.920      0.154     -0.452 
 pptself     -0.005      0.976      0.164     -0.479 
 wordgoal    -0.003      0.548      0.092     -0.269 
 pptgoal     -0.003      0.573      0.096     -0.281 
 wordper     -0.005      0.964      0.162     -0.473 
 pptper      -0.006      0.988      0.166     -0.485 
 goalcomm    -0.002      0.404      0.068     -0.198 
 
         Completely Standardized Total Effects of KSI on Y    
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 wordself    -0.009      1.544      0.259     -0.758 
 pptself     -0.008      1.390      0.233     -0.682 
 wordgoal    -0.003      0.503      0.084     -0.247 
 pptgoal     -0.003      0.523      0.088     -0.257 
 wordper     -0.002      0.332      0.056     -0.163 
 pptper      -0.002      0.316      0.053     -0.155 
 goalcomm    -0.005      0.848      0.142     -0.416 
 
                           Time used:    0.621 Seconds 
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ประวัติผูเขียนวิทยานิพนธ 
 
 นายชุติวัฒน สุวัตถิพงศ  เกิดเมื่อวันที่  5 พฤศจิกายน  พ .ศ .2525 สําเร็จการศึกษา                
ครุศาสตรบัณฑิต (เกียรตินิยมอันดับ 2) วิชาเอกคอมพิวเตอรเพื่อการศึกษา - วิทยาศาสตรทั่วไป 
ภาควิชาหลักสูตรการสอนและเทคโนโลยีการศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย  
เมื่อปการศึกษา 2547 และเขาศึกษาตอในหลักสูตรครุศาสตรมหาบัณฑิต สาขาวิจัยการศึกษา 
ภาควิชาวิจัยและจิตวิทยาการศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย ในปการศึกษา 
2550 ตําแหนงหนาที่ปจจุบัน ครูโรงเรียนมาแตรเดอีวิทยาลัย แขวงลุมพินี เขตปทุมวัน 
กรุงเทพมหานคร   
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